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What’s new in software version 3.17?

Display
Command line Blind mode and ScrollWin indications appear on an orange field.
Cue sheet The new Param Time field, displayed on the cue sheet, shows the
fade progress of the parameter with the longest fade-in time.
Desktop Create Desktop displays and populate them with short cuts f r

quick operation of many console functions.

See “Desktop” page 40.

Device headers

A title bar graphically separates device types in the live display.

See “Device headers” page 52.

Full screen view

When switching to Full Screen view an info message with instruc-
tions for exiting the Full Screen v ew, s displayed.

See“To switch to full screen view on page 32.

Grid editing These values can be dite dire tly in the grid format:
* QList modes and text
* Cue propertie canb edited directly on the cue sheet
» Library properties
* Time ine values
See “Editing objects on the grid display” page 329
Menus con in the menus have been upgraded.
See “Menus and toolbars” page 49.
Parked dimmer display There is a dedicated display for parked dimmers.
Scrolling You can use the mouse to scroll views even if they are not active.

See, “To scroll in panes” on page 40.

Touch screen b ghtness

Control the light level on the integral touch screens.

See, “To control the light level on the integral touch screens” on
page 6.

Workspace

Workspaces are additional display screens that provide additional
display areas. Workspaces are accessed via tabs in the general
window pane. Each window can contain up to 7 workspace tabs.

See “Workspaces” page 47.

Workspace tree

The Workspace tree opens automatically each time a new tab is
added to a pane.

See “Adding tabs to panes” page 30.




Editing

Chasers with animated gifs The CREATE CHASER tool on the Matrix screen, automatically
programs chasers for animated gif files

“To automatically program chasers” on page 293.

Highlight/Lowlight Cycle through fixtures without exiting highlight/lowlight mode.
See “About highlight/lowlight” page 321.

Updating cues during their fade A set of rules govern how cues updates behave during fade

See “Updating cues during their fade” page 148.

Releasing parameter time for Enter  The procedure used to release parameter fade times has been
syntax improved.

See, “To release parameter fade times” on page 168

Media Server

Arkaos Support for Arkaos.

See “Arkaos media server” pa e 3 3.

Hippo version 3 Support for Hippotizer V3.

See “Hippotizer V3 media server” page 357.

Catalyst Improved support for Catalyst V4.

See “Cataly t media server” page 359.

MIDI
MIDI MIDI tables have been expanded.
e MIDI functionality has been improved to include more MIDI
notes.
See “MIDI tables” page 397.
mMsc MIDI Show Control (MSC) functionality has been improved.
See “MIDI Show Control (MSC)” page 392.
Note: MSC (and SMPTE) require a hardware upgrade.
Patch
DMX i put patch New procedure to clear the DMX input patch.
“To clear the DMX input patch” on page 371.
Matrix Drag and drop a range of fixture to selected matrix cells.
“To map fixtures to selected matrix cells” on page 289.
Parked display Park now has a dedicated display.

See, Figure 50.




Playback input patch

Operate Vector playback devices through an external console.

See “Playback input patch” page 374.

Playback

Flash indications

* The playback device’s LED blinks while its flash is active.

* The flash level is displayed in orange in the Playback display
Fader Level field.

See “Flash keys” page 189.

Goto time

Specify time-in when fading to a selected cue on the mast r play-
back and other playback devices.

“To specify a fade time on the master playback” np 197.

Latch flash key

The flash key can be locked for continual flash g until it is
released.

See “Flash keys” page 189

Master playback indication

The master playback display has g een bars to differentiate it from
the other playbacks.

See “Master playback displ " page 209.

Playback selection Select multiple play ck for global control.
See “Playback selec ion” page 202.
Playback wing displays * Each layb ck key has its own field.

See _F der wing display” page 212.

T ere are three options for the QList field display: QList
number and name, Qlist number only, Qlist name only.

Show file conversion

Sabre & 4D file names

The names of show files that were converted from Sabre and 4D
consoles, specify the source of the converted file.

See “File conversion” page 242.

System Settings

Art-Net

When Art-Net is enabled, the IP Subnet setting defaults to 0.
See “Art-Net” page 377.

Operation mode and syntax
settings

Compulite mode and Action syntax are automatically set when
loading shows converted from Sabre or 4D.

System Settings tabs

The Communication tab has been replaced by three new tabs: DMX
Protocol, Network, and MIDI/SMPTE.

See “System Settings” page 333,




Timing

Default system time is automatically entered in the Time field if
the CUT button is disabled.
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See “Timing” page 338.

Topo

Topo display

* The zoom and show/hide grid tools are always available on
Topo views.

* Change stage element text.

» Show/hide stage element text.

» Show/hide the fixture name for fixtures hung on st ge el ments.
* New icon for a stage element.

See “Topo” page 305.
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Introduction

Getting started

Ease of use has been the watchword for Vector ‘s development team. However, as Vector controls
complex lighting rigs as well as simpler rigs, console operation may also be complex sometimes. The
purpose of this guide is to help you become a skilled Vector programmer.

Experienced Compulite programmers will find much in Vector that is familiar. We recommend that
you use the Quick Start Guide to familiarize yourself with Vector’s unique capabilities

New and experienced users will find the General Information chapter useful. The Gen ral nformation
chapter describes the user interface, windows use, color code conventions, and st ndard procedures’
syntax that is common to many show elements.

This guide generally follows your work flow, from patching through programming cues to playback.

Text conventions

m Vector offers two programming syntaxes for pro dures: Action syntax and Enter syntax. both
programming syntaxes appear in this Referen e Guide.
Action syntax procedures are preceded by: ,
Enter syntax procedures are preceded by
Some procedures are common to both Action and Enter syntax and have no graphic indicators.
Some procedures show the icon that are mostly the same for both syntaxes, but have a
slight variation that is pointed out in the procedure itself.

m The actual keys on the console panel are referred to as KEYS. Panel KEYS are in BOLD CAPS.

m The keys on th ouch screens are referred to as BUTTONS. Touch screen BUTTONS are BOLD,
ITALIC ZED CAP .

m Command | e refers to area at the bottom of the screen where the command chain is displayed
and err r messages appear. Command line text is in italics.

m Dialog box captions, window titles, and field names appear in this font.
m # refers to numbers entered on the numeric keypad.

m [n operation sequences, optional keys or buttons appear in parentheses. Example: SPOT # (2#)

@ 65.

m Key presses are separated by commas when operation sequences are written in a single line.
Example: SPOT, #,— #, ACTIVE

m When + appears between key or button names, it means: Press THIS (and) THAT at the same
time. Example: SHIFT + FREE. Generally used only in conjunction with shift pairs.

m The term Tap is used for touch or click when referring to the touch screen buttons.

m Fixture is used for any lighting device.



Compulite

m Channel is a one parameter (usually dimmer) lighting device.

m Spot is a multiparameter lighting device.

m PBD stands for playback device.

m MPB stands for master playback device.

m SKs refers to Soft Keys.

m Desk, console, and system are used interchangeably.

m Cells refer to the smallest information unit, such as one parameter of a moving device,

displayed in grid format.

Notes: The screen captures appearing in this guide may not look exactly like the ens on your
Vector. In the interest of visual clarity, a different skin was used for the guides’s il ustra ions. The
content of the illustrations is identical to the content seen on Vector.



Chapter 1 Setting up Vector

This chapter contains the following sections:

m Setting up Vector (see page 4)

m Connecting external screens (see page 5)

m Calibrating touch screens and adjusting brightness (see page 6)

m Adjusting desk lights and LCD displays (see page 7)

m Connecting external devices (see page 7)

m Language options (see page 8)

m Settings (see page 7)

m Software installation and upgrade (see page 8)
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Setting up Vector

1 Place the console on a clean, stable, and level surface.

2 Make sure the voltage selection switch, located on the power supply is correctly set to
230V AC or 110V AC.

Connect the Vector to the mains supply using the cable upplied.

4 Connect any peripherals to their connectors on the r rp nel. All connectors are labelled

with names and standard icons.

Figure 3: Detail Ve tor rear panel - AC input connector

To power pV ctor

1 Switc on the power, using the switch located on the power supply on Vector’s back panel.

The soft switch located on the front of the console is lit.

2 Open the door, on the front of the console, protecting the soft switch and press the soft
switch once. Wait for Vector to complete boot up.

3 Connect the DMX cables to the appropriate ports.

IMPORTANT! MAKE SURE the voltage selector is set to the voltage that is correct for
your mains power supply.




Connecting external screens

VECTOR

SETTING UP VECTOR

External touch screen displays can be connected on the USB and Comm connectors.

Display Properties

| Thermes || Desktop || Screen Saver || Appearance | Settings

Dirag the monitor iconz to match the phpgical arangement of pour monitors,

Dizplay:
2. Plug and Play Moritar on ATl Radeon 9600 / X1050 Series Second |
Screen resolution Colar quality
Less Mot Highest (32 bif v|
1024 by 758 pisele 1 /N ' |'®m

Lze thiz device as the primarny monitor.
Estend my "Windows desktop onta thiz manitor.

[ Identify ”_ Troubleshont. . ] [ Advanced ]

Figure 4: Display Properties dialog box

Console Touch screens External screens

Vector Red 2,3, 4. 1,5,6

Vector Blue 2,3 1,4,5

Vector Green 2 1

Vector Orange | 1 2

Vector Ultr 1,3 2

Violet

V tor Violet 3 1,2

Newly connected displays show the Vector logo. You must open a new window for the
new display. See “Opening new windows” page 31.

To connect external displays

1 Go to Tools menuP Settings.

The System Settings dialog box opens.
2 Tap the Hardware tab.

Tap Display Settings.

4 Tap IDENTIFY to see how the monitors are numbered.

;O
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5 Right click on a number for the external monitor and, from the fly-out menu, click

ATTACHED.

6 Tap APPLY.

To orient the mouse and the display screens

Click on and drag the numbered screens, so they represent the physical order of the displays.

Calibrating touch screens and adjusting brightness

You may find that occasionally the touch screens require calibration.

To calibrate the touch screens

D AW N -

—

O 0o N o o,

Open the System Settings dialog box through the Tools menu

Tap the Hardware tab.

Tap Touch Screen Calibration.

Tap the center of the x that appears in the upper eft ¢ rner of the display.
Tap the center of the x that appears in the | w r right corner of the display.

Continue steps 4 - 5 for each screen.

Press SCROLL WIN to enable wind ws mode.
Press @ to open the Start menu.
On the task bar, doub click on the Pointer Device Settings icon.

The Pointer Dev ce P operties dialog box opens. if the icon is not visible, click the arrows
to expand the sk bar.

In the Point r Device Properties dialog box, select a display from the Installed Devices list.

F gure 5: Pointer Device Settings icon
Tap CALIBRATE.

Tap the center of the x that appears in the upper left corer of the display.
Tap the center of the x that appears in the lower right corner of the display.
Repeat steps 4 - 7 for each screen.

Tap OK.

To control the light level on the integral touch screens

1

2

Press SETUP.
The tool bar is now in setup mode.

Tap DESK LIGHT.
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3 Use wheel 4 (Vector Touch Screen Backlight) to adjust the light level.

Adjusting desk lights and LCD displays

You can dim the brightness for the desk lights, located in the screen handles, and auxiliary lights.
The brightness and backlight for the master playback LCD backlight is also adjustable.

To dim the desk lights

1 Press SETUP.
2 On the Editor toolbar, tap DESK LIGHTS.
3 Use the DESK LIGHT wheel (wheel 1) or FULL, ON, or ZR to adjus thei tensity.

To adjust the auxiliary lights

There are manual adjustment knobs on the back panel next to th auxiliary light connectors.

To adjust the master playback LCD display
1 Press SETUP.
2 On the Editor toolbar, tap DESK LIGHTS
3 Use the LCD BRIGHTNESS wheel to set he brightness.
4 Use the LCD BACKLIGHT whe 1 o adjust contrast.

Connecting external devices

External pointing d vic s, such as a mouse, joystick or trackball, can be connected to the back
panel USB or S-2 onnectors. It is recommended to have an external pointing device connected.
Some functi ns ar easier using a mouse.

Vector mes quipped with a mini keyboard in the slide out tray under the panel. Keyboards are
connect d at the USB ports or the PS-2 keyboard port on Vector’s back panel.

Settings

General system defaults for Vector shows are defined in the System Settings dialog box. You can
customize any of these settings. See “About system settings” page 333.

General window settings can be changed through Start menu® Control Panel» Display.

Set the Vector’s clock through: Start menu» Control Panel» Date/Time.
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Language options

Vector’s menus, tool tips, and dialog boxes can be localized so Vector speaks your language. For

information on localization contact your local Compulite distributor.

Software installation and upgrade

Vector application software is installed in drive C:\ and D:\. Drive C:\ contains windows sy tem

files and the Windows XP installation. These files are locked and may not be changed. rive D:\

contains Vector’s system files, show files, layout files, and visualizers.

These instructions assume:

1. Vector is running.

2. An alphanumeric keyboard is connected.

3. An external mouse is connected.

Before installing new software, we recommend saving back up cop es of your shows and any

customized devices.

To upgrade software

1
2

Access the Task Bar by pressing the Star key on the Vector Keyboard.
Right click the RT Interface icon i nd select Exit RT Interface.

IMPORTANT! After this step, you will not be able to use the track ball as a mouse.
Continue with an external mouse.

Exit the Vector application.

Remove th Compulite Vector program using the Add/Remove Program tool in window’s
Control Panel.

5 Del e the Compulite Vector folder in C:/Program Files.

6 Pro ed to install the new software using the new software package downloaded from

7
8
9

ompulite’s FTP site.
Extract the “Vector.xxx.zip” folder to D:\Vector Data.\Vector Installations.
Run the Setup.exe file to start the installation wizard.

Tap NEXT on first Screen.

10 On Setup Type choose the type of installation.

Example: If you have a RED Vector choose Red Vector.

11 Continue tapping NEXT until you get the Installation progress message.

12 When it becomes available, press FINISH on the Compulite Vector Setup wizard.

The new Vector Console program is now installed.

13 Run the program from the Start Menu.
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When the application starts it automatically performs a real time software update.

14 When the update is complete, the run time status is displayed as a green check mark in the
status bar.

15 Refresh windows by clicking the ViewP Refresh.
16 When the console is running, verify that the IP address is correct and your defaults in the

System Settings Dialog box are correct.

To shutdown Vector

1 Press the soft switch located on the front of the console.
2 Tap Turn Off in the Turn Off Computer box.

Vector shuts down.

IMPORTANT! It is strongly recommended to use a UPS (minimum 60 VA) to protect
the console and your work.
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Chapter 2 General Information

This chapter contains the following sections:

m Vector operation modes and programming syntax (see page 11)

m The user interface (see page 13)

m Using the trackball for mousing (see page 13)

m Scrolling and navigating grids (see page 14)

m Command line and system status (see page 15)

m Selecting objects (see page 18)

m Adding text tags to objects (see page 18)

m Deleting objects (see page 19)

m Copying, cutting, and pasting, objects (see page 21)
m Examining objects (see page 20)
m Storing changes and updating objects (see page 21)

m Using undo and redo (see page 22)

Vector operation modes and programming syntax

Vector has two operation modes:
m Tracking mod
m Compulite m de

Vector rs two syntaxes for programming procedures.
® Ac ion syntax

m Enter (Broadway style) syntax

The operation mode and programming syntax are set in the System Settings dialog box » Behavior
tab. See “About system settings” page 333

T acking mode

In tracking mode, Vector stores only the changes or moves from one cue to the next. Parameter
levels that do not change are tracked through cues following the cue where the level was originally
set. Levels that are being tracked are not stored again in each cue. Thus there are two types of
parameter values:

m Hard values (new or changed values) - values that are stored in the current cue.

m Tracked values - unchanged values that are tracked from an earlier cue.
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After storing a cue, the editor is released.

This table shows the total output and the levels that are recorded in each cue:

Console output (lighting state) Information recorded in each cue
Channel | 1 2 3 1 2 3
Cue 1 50 FL 40 50 FL 40
Cue 2 25 FL FL 25 FL
Cue 3 25 80 FL 80

Note that only the new or changed values are stored in each cue.

Sometimes you want to cancel all tracking values, for instance, when starting a new scene. Block
cues are used to reset the tracking, Block cues must be specifically programmed.

See “Programming and update options in tracking operation” page 157
The benefits of tracking mode are:

m Tracking changes throughout a series of cues.
Example: Assume that in cue 1 you set the bac ligh wash at 60%. The hard value is stored in
cue 1 and this level does not change during the en re scene, therefore the level in cue 1 tracks
through all the cues in the scene. After programm ng all the cues, you see that the back light
level is too low. Change the level only i cue 1; the new value is tracked through all the subse-
quent cues.

®m Running simultaneous cues.
Example: The scene is an interior night scene with room practicals on. As dawn breaks and
natural light fills the room the characters switch off the practicals. How does tracking mode
help you set up this cue progression? Program one cue that is running a slow fade for the
general interior lighting Program other cues that snap off the practicals. Assume that the slow
fade is cue 10 and the practicals off cues are 11 and 12. While the fade to cue 10 is still
running, yo can give go commands to cues 11 and 12 without interrupting cue 10’s fade.

Vector autom tically maintains the cue state when playing back cues out of sequence, as often
happens du ing rehearsals.

Compulit mode

Compulite mode is a cue only mode, where all fixtures and values that comprise the lighting state
are stored in each cue.

The editor is not released after storing a cue. You can continue programming cues based on the
editor group or reset the editor. See “Resetting the editor” page 102.
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Programming syntax

Action syntax - Enter syntax - @

Output convention

» Parameter levels that are set using @, are » Parameter levels that are set using @, are not
immediately output. output until ENTER is pressed.

» Parameter levels set using the wheels, FULL, | + Parameter levels set using the wheels, U L,
ZERO, or ON are immediately output. ZERO, or ON are immediately output.

Procedure syntax

Generally, action syntax is: Generally, enter syntax is:
LE]

1. Select items. 1. Select items

2. Select the object. 2. Selectth op tion.

3. Press STORE. 3. Select th object.

4. Pess NTER

Example: Store a group. Example: Store a group.

1. Select fixtures (the items). 1. Select fixtures (the items).

2. Press GROUP and choose a group n mb 2. Press STORE (the operation).

(the object). 3. Press GROUP and choose a group number
3. Press STORE (the operation). (the object).
The group is stored. 4. Press ENTER

The group is stored.

The user interface

Ve tor use a combination of command line and graphical user interface.

K yp esses and button taps appear in the command line, showing a clear progression of the current
programming sequence.

Many operations can be done using the touch screen buttons, menus, tool bars, file trees, and dialog
boxes on Vector’s graphical user interface (GUI). Your pointing device can be an external mouse,
connected at the mouse port on the back panel, or the trackball set to mouse function. The display is
completely flexible. You can set up the GUI to display what you need at each stage of your work.

Using the trackball for mousing

Vector's dual mode trackball is used for setting pan/tilt values and as a mouse. The keys located at
the lower left of the trackball function as right and left mouse buttons.

13 &)
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L—Arrow up
QO () O +—Arrow right

4 T Arrow e
—Arrow down

\ }4—-Trackball / mouse
O«——-Tilt lock /Left mouse button

Pan lock / Right mouse button
Intensity / scroll wheel

To set the trackball for pan and tilt editing
The default trackball mode controls pan and tilt.
Make sure MOUSE is not enabled.
To set the trackball for mousing

Press MOUSE.

The MOUSE LED flashes. The trackball is illum nat d and available as a pointer device.

Scrolling and navigating grids

Playback and live displays are shown in gri form t. Soft key displays can also be toggled to show

information in grid form. The vertical whe 1, which by default controls dimmer intensity, can also
be used as a scroll wheel in grid display .

The extreme right encoder can o be used to as a scroll wheel in grid and soft key displays.

To use the wheel for scrolling
Press SCROLL WIN.
The S RO L WIN LED flashes. Windows Mode Active! is displayed in the command line.
To naviga e in grids
1 Press SCROLL WIN.

2 Use the arrow keys above the trackball to move from cell to cell.
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Using console keys in window mode

When the SCROLL WIN key is active, the console number pad and other console keys can be used
to enter numbers and traverse dialog box fields. Console keys that are active in scroll win mode are:

Console key ’e(:lll/ ﬁzxg ¢ Console key ’e(:x ;‘);;xg ¢
+ plus sign CE Backspace
— minus sign DELETE Delete

/ slash EFFECT Ctrl

® dot, decimal point ENTER Enter

- Tab NEXT Page Up

@ Open Start menu SHIFT Shift

0-9 numbers 0 -9 PREVIOUS Page Down
arrow keys arrow keys

SCROLL WIN is automatically enabled when workin ind log boxes. SCROLL WIN is automati-
cally released when exiting a dialog box.

IMPORTANT! When SCROLL WIN is enabled, the numeric keypad is disabled for
fixture editing and the wheel cannot control intensity. The message Windows Mode
Active!ll overlays the command lin

Command line and system status

The command lin is the area where commands, entered using the console keys or touch buttons,
are displayed Each screen has a command line.

The command line shows:
m The active command sequence
m Real time connection status
m System clock
m General master status

Command sequence RT status GM status

b>Spot 1 Dimmer @30 (+16% | Jo0:00:00.0|w]12:55:28 Jom: 100 3

SMPTE/TimeLine Clock
Figure 6: Main screen command line

159



Compulite
Chapter 2

Progress bar
A progress bar is displayed on the command line for operations that may take some time. The
progress bar is displayed when:
m Opening shows
m Saving shows
m Automatic saves are in progress
m Uploading data to the real time processor

m Uploading software to the real time processor

The bar shows the operation in progress. It appears to the left of the real time connecti n status.

Numeric entry default

The command line can be set for a numeric default selection; the first umbe pressed is recognized
as a default selection. Example: The default is Channel. Pressing 5, on the numeric keypad, selects
channel 5. It is unnecessary to press CHANNEL before entering he number selection.

The default command line options are:
m Spot
m Channel
= Group
m Cue

® Dim

To set the command line numeric default

Example: Set the comm nd line default to Spot.

Press SPOT twice. potis now the numeric selection default. When selecting spots, choose
only the po number.

Clearing the command line

You ¢ n reset the entire command line to its idle state or regressively clear the entries in the
co mand line.

To clear each entry (backspace)

Press CLEAR. The last entry is cleared. Continue pressing CLEAR. Each press clears the last
entry in the command line.

To reset the command line

Press SHIFT + CLEAR. All the entries in the command line are cleared and the command line
is reset to idle.

Note: This does not clear the last selection from wheel control.
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System indications bar

The Indications bar shows system status information. You can choose to show or hide the Indica-
tions bar.

The system indications bar shows:
m Console operation mode (Tracking or Compulite)
m Procedure syntax (Action or Enter)
m MIDI (enabled or disabled)
m MSC (enabled or disabled)
m Active snap
m Active editor
m QList on the master playback
m Last stored cue
m Master/slave status (if configured for master/slave operation)
m SMPTE/TimeLine clock (when SMPTE is enabled)

Syntax MSC status Active snap  Qlist on master playback

Indication '*ar
Mode: | T|| A MIDI MSC WC  Snap:| 2| Editor: | 2| Qlist:| 1] Cue: | 48

£ f 1 f f

Operation mode MIDI status VC status Active editor Last cue stored
Figure 7: The Indications bar shows ge ral system status information and active show objects

To show or hide the Indicat ns bar

1 Open the Viewm u.
2 Tap Indications Bar

This s ttin is s ved with your display layout.

Editors

Ve tor has 7 live editors. The editors can simultaneously contain fixture selections and parameter
levels. Fixtures may be active in more than one editor at the same time.

m Parameter levels, in the active editor, are displayed on a white field.

m Parameter levels, in the editors that are not active, are displayed on a dark field.
Pressing RESET resets only the active editor.

The active editor is displayed in the (System) Indications bar.

To switch active editors

1 Press EDITOR.

17D
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2 Press anumber (1 - 7), on the keypad.
3 Press ENTER.
The selected editor is now active. All editing is done only in the active editor.
Universal procedures

Selecting objects, copying and pasting objects, adding text tags to objects, deleting objects and
editing objects, (such as cues, QLists, groups, snaps, libraries, and macros) follow the s me b sic

procedure and invoke the same dialog boxes.

More detailed explanations appear in sections dealing with specific objects.

Selecting objects

You can select cues, QLists, snaps, groups, libraries, macros, channels, or spots using a key
sequence or soft keys.
To select objects using console keys
Press the object key (CUE, QLIST, SNAP, MACR etc.) and enter in its number on the
keypad.
To select objects using soft keys

Activate the appropriate soft key t b and tap the object’s number.

Adding text tags to objects

All show objects can be label ed with meaningful text tags.

To add te ttags to objects
1 Se ect the object.
2 P ess TEXT.
The Text dialog box opens.
Use the keyboard to type the name.
4 Press STORE or tap OK.
The dialog box closes.
OR
Immediately after storing the object, press TEXT and follow steps 3 and 4.
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To add text tags to objects

N =

Press TEXT.
Select the object.

3 Press ENTER.

The Text dialog box opens.

4 Use the keyboard to type the name.

Press ENTER or tap OK.

The dialog box closes.

OR

Immediately after storing the object, press TEXT and follow steps 4 and 5.

Deleting objects

The same procedure is used to delete cues, groups, snaps  d al other show elements.

A warning/confirmation box is always displayed for his peration.

Qlist 1 Delete!
Are you sure?

Delete

Cancel

x|

Figure 8: Delete operations always require confirmation

To delete obje ts

1 Selec the object.

2 Press DELETE.

The Delete warning and confirmation box opens.

3 Tap DELETE to confirm the operation.

Tap CANCEL to exit the operation without deleting the object.

(E]

To delete objects

1 Press DELETE.

2 Select the object.

Press ENTER.

The Delete warning and confirmation box opens.

19 &)
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4 Tap DELETE or ENTER to confirm the operation.
Tap CANCEL to exit the operation without deleting the object.

Examining objects
Lists of objects and specific objects can be viewed.

To view a list of objects

Example: View a list of groups

Toggle the group soft keys to grid view by tapping . A list of groups is d splayed in the
active pane.

OR

Press GROUP and press EXAM.

LE]

Press EXAM and press GROUP.

To examine a specific object

Example: Examine group 5.
1 View the groups in grid f rm t.

If the group tab is in oft k y format, toggle to grid view.
2 Double click on group 5.

The content of the group are displayed in the active pane designated exam pane.
1 Sel ct group 5.
2 Pr ss EXAM.

he contents of the group are displayed in the active pane or the designated exam pane.

_E]
1 Press EXAM.
2 Select group 5.

3 Press ENTER. The contents of the group are displayed in the active pane or the designated
exam pane.
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Copying, cutting, and pasting, objects
The copy, paste, and cut functions work similarly to these functions in personal computers.

A copied or cut object is placed on the internal clipboard. It can be pasted multiple times. The
object remains on the clipboard until replaced by copying or cutting another object.

Pasted objects that were put on the clipboard using COPY are tagged Copy of (source object). You
can, of course, change the text tag. Pasted objects that were put on the clipboard using CUT retain
their original text.

The COPY key’s LED shows the clipboard status:
m LED on - There is an object on the clipboard.
m LED off - There is nothing on the clipboard.

To copy and paste objects
1 Select the source object.
2 Press COPY.
3 Select the target object.
4 Press PASTE.

To clear the clipboard

SHIFT + RESET clears the clipboard.
When the clipboard is empty, the OPY key’s LED is off.

Storing changes and updating objects

When storing changes to ues, groups, snaps, and libraries, the Store Options dialog box opens
directly after pressing STORE This dialog box acts as a warning, letting you know that the object
exists, and provide stor options.

x
Group 1.Red Wash Exists!

LCreate
Hewy

Ovenprite Update Release

Cancel

Figure 9: The Store Options dialog box

The store options are:
m Overwrite - The object is replaced with the active editor.
m Update - Opens the Update dialog box.
m Release - Used to remove fixtures from groups and libraries.

m Create New - Creates a new QList. The new QList number is the last QList incremented by 1.
This option is only available when editing cues. See “Temporary Cues” page 183

Note: When editing cues, press UPDATE instead of STORE. See “Using the Update
dialog box options” page 143

21 &)
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To store changes to objects
Example: Store changes to a group.
1 Press CHANNEL or SPOT and select fixtures.
2 Select the target group.
3 Press STORE.
The Object Exists dialog box opens.
4 Tap OVERWRITE, UPDATE, or RELEASE.
LE]
To store changes to objects
Example: Store changes to a cue.
1 Select fixtures and assign values.
2 Press ENTER.
3 Select the target cue.
4 Press STORE.
The Object Exists dialog box opens.
5 Tap OVERWRITE, UPDATE, or RE EASE.

Using undo and redo

The undo feature provides a regres ive restoration of previous editor values. It also restores deleted
objects, such as cues, snap , libr ries, etc.

When restoring a range of deleted objects, the Object Exists dialog box offers three options.

Options What it does
RETURN & OVERWRITE Overwrites all objects
RETURN & SKIP NEW Does not overwrite the existing objects, but restores those

whose object number has not been used.

REMOVE CURRENT FROM UNDO | Delete this operation from the undo list.

To restore a previous editor value or restore a deleted object

Press UNDO.

To restore a range of deleted objects

1 Press UNDO.
The Object Exists dialog box opens.

2 Choose one of the three options.
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3 Click OK.

The deleted objects are restored.

To redo an undo

Press SHIFT + UNDO.

Vector default fade times

You can set default fade times for a number of operations.

See “Timing” page 338

Getting Help
Vector has on line help for both Action syntax and Enter (B oadw y style) syntax.

To open help

1 Open the Help menu.
2 Tap Context.

The on-line help file opens. Browse according to topic, index entries, or search.

Note: Choose the help for the syntax that you are using.

23 &)
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Chapter 3 Displays and Menus

This chapter contains the following sections:

m Basic display layouts (see page 26)

m Setting up and saving display layouts (see page 28)

m Workspace Tree (see page 34)

m Setting up Soft Keys (see page 38)

m Desktop (see page 40)

m Workspaces (see page 47)

®m Menus and toolbars (see page 49)

m Editor Toolbar (see page 58)

m Wheel Assignments (see page 59)

m Grid properties (see page 59)

259
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Basic display layouts

On start up the touch screens open with basic display layouts. The layouts are completely customi-
zable and you can change the layouts to suit your show and work habits. We recommend that you
familiarize yourself with the layouts supplied before changing them.

Pane containing:
+ 4 tabs for object soft keys
+ 1 tab for playback displays

Display navigation and configuration

Window title bar —> X R 2l R L R T e

Menu bar ——p | B o Ik Fomx Uetode wniom atacmer () © JE@@M

Show - Libranes - 1.Position Show - Groups

1 2 3 4 5
’ I l A Ch |-Ch 0dds  |ChEvens Il:h 3rd ICh 4th

Pane containing:
+ 6 tabs for library soft keys
+ 1 tab for playback displays

1Posktion | 2.Color | 7.Image | 4.Effect | 6.Intensity

10.Tracking General = Master

ity Pan_ Tilt _Dimmer s Shutte: olot Wheel _Cyan Magenta Yellow CTO Mixer Focus Zoom Rotating Gobe 2 R A
VL3000 5 pot

351

Pane containing:

« 2 tabs for live fixture displays 8

+ 1 tab for playback displays L
«+ 1 tab for show information Fiste b [Pzt [Pon [T it_IDimmer liis [Shutier  [Color Wheat [Cran Magenta ¥ clow [CTO Mixer (Focs [Zoom Iotating Gabo 2 8
W

swklwmm wingl | Qeey

s1 | Show
PN . [ [ | (57 | i [ | | ||

Wheel bank —> || N [ | |
IS == Y ——

[lv]i507:15]
Moda: I@ Edor: [1] Snsp: [1] Qist: [None | Cue:
|

Indications bar Status bar shows:
« Real time verification
« System clock
« General master level

Command line =

Figure 10 Main Screen - basic layout
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Screen element

What does it show?

Window title bar

* The show file name is displayed on the right.

* Minimize, maximize, and close window controls are displayed on
the left.

The title bar can be hidden to maximize display real estate. See “Full
screen view” page 32.

Menu bar

Seven menus are available on the menu bar. Tap a menu to view the
options offered. The menu bar appears on all display screens. Th men
bar can be hidden to maximize display real estate. See “Men s and

toolbars” page 49.

Display navigation

+ Standard display controls: go to previous view, g to last view, go up
on level.

* Vector icons to: open the Workspace tree, show/hide the Window
title bar, toggle soft key display form ts a d lock the display.

Tabs for soft keys

* Tabs, which are added to panes di play soft keys for show objects
and playback components. The obj ct category is set using the Work-
space tree.

* Soft keys access most p gramming and components. Use the pane
splitter to pile soft k ys on top of each other. When piled, a tab is
automatically creat d for each set of soft keys. Soft key elements are
set using the W rkspace tree. The soft key view can be toggled to
show soft keys or a list of the relevant elements. See “Setting up Soft

Keys” pag 38.

Tabs for playback
displays

Cur en status of output on the playback wings (faders and QKeys), AB
cros fader, and the master playback. See “Playback displays” page 208.

Editor tool bar

Ve tor’s system tool bar is context sensitive, changing according to the
current function. See “Editor Toolbar” page 58.

Wheel Assignm nts

The wheel display is context sensitive showing the parameters for the
selected moving device. Wheels are also used for programming effects
and fade rate control. See “Wheel Assignments” page 59.

Lived plays

Patched fixtures and their current output is displayed in a grid format.
The live display grid setup can be modified in the Grid Properties
dialog box. See “Grid properties” page 59.
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Screen element What does it show?

Command line The command line is the area where commands, entered using the
console keys or touch buttons, are displayed. Each screen has a

command line. See “Command line and system status™ page 15

Indications bar The Indications bar shows system status information. You can choose to
show or hide the Indications bar. See “‘System indications bar” page 17.

Status bar The status bar appears on the main screen only. The status bar show :
m Real time connection verification
m System clock

m General master status

Setting up and saving display layouts
Each screen has one general window, containing:
m One window pane
m A title bar with the window control icons (sh ink, maximize, minimize, close)
m Menu bar

The tools for customizing the displ ys ar found in the Windows menu. See “Window menu and

display toolbar” page 57.

Locking windows
It is recommended o lock the windows to prevent accidentally moving or resizing display
elements.
To lock the windows
Go to the Windows menu: Windows » Lock all.

OR
If the Window Set Up tool bar is displayed, tap Q

Tip! Always display the lock icon to verify window lock status at a glance

Q Locked
‘1 Unlocked
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Setting up the display

Opening new view panes

A window can be split into multiple view panes. View panes can contain multiple tabs. The splitter
mechanism is used to segment the display area and create new view panes.

There are three options for segmenting the display area:
m Split horizontally - split the active pane horizontally.
m Split vertically - split the active pane vertically.
m Add a tab to an existing pane - open a new tab in the active pane.

Split horizontally

Split vertically

Add tab to the pane

Showthide title bar
Toggle soft keys
Full screen

Displar Sefup

Figure 11: Window (Display) Setup tool bar

Display shortcut menu

The display shortcut menu offers window an pane control options.

A/B Qlisk 1. | I Grolns | Snans | Marras | ¢
[t_T:I Togagle Lock
"] Toggle workspace Tree
E Toggle Soft Keys
[ Toggle Pane Title
2] Add Tab
x Close Current Tab
W Close all Tabs
x Close Pane
[1 Add Deskrop

[ Add workspace
l] Rename Ackive Workspace
x Close Active Warkspace

Figure 12: Display shortcut menu

Option What it does

Toggle Lock Lock/unlock window display.

Toggle Workspace tree Display/hide the Workspace tree
Toggle soft keys View soft keys or grid

Toggle pane title Display/hide the active pane’s title bar.
Add tab Add a tab to the active pane.

Close current tab Delete the active tab from the pane.
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Option What it does

Close all tabs Close all tabs in the active pane.

Close pane Remove the active pane from the display.

Add Desktop Add a Desktop that can be populated with shortcuts for various
console functions.

Add Workspace Add a Workspace to the window. Each window can contain up to 7
Workspaces.

Rename active Workspace | Change the name of the Workspace that is currently disp ayed.

Close Active Workspace Close the Workspace that is currently displayed.

To access the display shortcut menu

Right click in any pane on the display.

Identifying the active pane

The splitters affect the active pane. The active pane has ligh red (orange) frame. If the title bar is
displayed, the active pane’s title bar is dark red. Only ne pane can be active at a time.

Paging and close controls for each pane appear on 1 s title bar. A pane’s title bar can be shown or
hidden.
To activate a pane

Tap the pane or its tab.

To show/hide the pane titl bar

Open the Window menu; Window » Show title bar or press D .

Adding tabs to panes

Multiple tab can be added to each pane.

Note: The Workspace tree opens automatically each time a new tab is added to a pane.

To add tabs
1  Tab a pane to make it active.
2 Open the Window menu and choose Add Tab.
A tab is added to the active pane and the Workspace tree opens.
3 Choose the tab’s contents from the Workspace tree.
OR
1 Right click anywhere in the active pane.
2  Choose Add Tab.
A tab is added to the active pane and the Workspace tree opens.
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3 Choose the tab’s contents from the Workspace tree.

Setting a default exam pane

The Exam display allows you to view lists of objects, contents of QLists, and cue contents. Exam
displays open on the active pane. However, some panes, such as the Editor tool bar and Wheel
Assignments, do not support exam displays.

You can set up a pane or a tab in a pane as the default exam display; whenever you request an exam,
the exam is always displayed in the same place.

To set the default exam view

Go to the menu bar. Tap Window» Exam» Use this view as default.

To activate the default exam view for all exams

Go to the menu bar. Tap Window » Exam» Always open exams on default view.

Opening new windows

If you have added monitors to Vector, you must open ane wind w and set up the display. New
windows open, in reduced size, on the main screen

To open and dock a new window

1 Go to the Window menu and tap N w.
A new window opens on the ma n display screen.

2 Using the mouse, a stylu , or th trackball (set to the mouse option) drag the new window
to one of the display ¢ ens.

3 When the window is 1 cated on the display screen, maximize it.

Dragging a tab to a new loca ion

You can change he order of tabs in each pane.

To change tab order

-

1 Ifthe display is locked, unlock it by clicking | (£ | or through the display short cut menu
(right click in the pane and click Toggle Lock).

sran

Point at the tab you want move, click and hold the mouse button.
3 Drag the tab to a new location within the pane and then release the mouse button.

Don’t forget to lock the display again!
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Navigating displays
The display navigation tool bar is always available and appears in the menu bar between the Attach-
ment menu and the Help menu.

Refum 1O previous screen

GO1o next screen _
| GO up one level in the workspace tree

S b

Figure 13: The navigation toolbar

Full screen view

To take advantage of the maximum display real estate, hide the window’s title b r and menu bar
(elements that belong to the general window) by setting the window display o Full Screen view.

Note: The window control icons are displayed with the titl bar If the title bar is hidden,
the window controls are not available.

When the full screen display is enabled, the Windo (Display) Setup toolbar is automatically
displayed. This allows you to return the menu bar

To switch to full screen view

Go to the Window menu.

2 Tap @ Full Screen |-
An info message is d splayed.

The window title bar  hidden and an info message, with instructions for exiting the full
screen view, is disp ayed.

x

! 5 To Exit Full Screen Press 'ESC' On the Keyboard Or the Full Screen Icon

To exit full screen view

Tap @ Fulscreen | on the Window (Display) Setup toolbar.
The window title bar is displayed.

OR

If you have closed the toolbar:

1 Click one of the panes.

2  Press Esc on the keyboard.
The window title bar is displayed.

Note: This must be done for each monitor.
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Saving and loading display layouts

Display layouts are saved in dedicated files. The extension for layout files is *.cfg
There are three default folders that contain display layouts:

m D:\Program Files\Compulite Vector\WorkDir\Show\Layout - This is the default location for
saving layouts for the current show. When saving a show, the screen layout is automatically
saved with same file name as the show. The layout file is saved in the default location. The
contents of this folder are overwritten when starting a new show.

m D:\Program Files\Compulite Vector\Config\Layout - The layouts stored here are system you s.
These are the basic layouts included in the Vector software. If you store your own system
layouts, give them a unique name so they are not overwritten when upgrading software.

m D:\Program Files\Compulite Vector\My Layouts - The contents of this folder are never over-

written. Copy display layouts that you want to save and reuse to this fo der.

To save a display layout

1  Tap WindowP Layout P chose Save System Layout or ave Show Layout.
The Save As dialog box opens to the default fold r
Optional - browse to a different folder
Type a name in the File Name field.

4 Tap SAVE.

The display layout is saved.

To load a display layout

1  Tap WindowP Layou Pc¢ ose Load System Layout or Load Show Layout.
The Open dial g box opens.
Select alay t fr m the list of *.cfg files.

3 Tap PEN
The layo tis loaded.

Tp B kupsaved layouts by copying the files to a different location on the hard disk.

Dialog boxes

Many of Vector’s features are controlled through dialog boxes. Dialog boxes always open in their
last position. If a Vector dialog box has been moved to an area where it is invisible or cannot be
grabbed, you can reset its position.

To reset dialog box position
Open the Windows menu and choose Reset Dialog Position.

Note: This does not reset Windows’ dialog boxes, such as the Open and Save dialog
boxes.
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Each time a dialog box opens, Vector automatically enables SCROLL WIN so you can use the
console number pad and other console keys to enter numbers and traverse dialog box fields. Exiting
a dialog box automatically disables SCROLL WIN.

Workspace Tree

The Workspace tree is a browser containing a navigable tree. Tapping an object in the Work pace
tree displays the selected item in the active pane.

The browser works like a file manager tree: a plus sign (+) indicates sub nodes under the m in node.

To expand a node, tap the plus sign (+). To collapse node, tap the minus sign ().

Workspace Tree X
C

=4 Show

Qlists

Libraries

[} Groups
i) Snaps

[+ Macros
TimeLine

7 Look Ahead Mask
[:'q. Home Cue

- Patch

= Live

~..Channel

;...Spot

F

-Matrix
Matrix List
-Media Server
-Topo View

[+ Playback

[+ Editor Tools

Shaw
Figure 14: The W rkspace tree

Display can  grid style, soft key format, or unique formats like those for playback displays and
other hing specific to lighting consoles.

he g id properties can be changed in the Grid Properties dialog box. See “Grid properties”
page 59.

To display the Workspace tree
Tap || .

To collapse all nodes

Tap €



Show node

Tap Show to view general show information.

Fixtures Cues Show
Set Fixtures Devices Qlist Cues Name
Channel 64 1 QList 1 17 Author
Spok -] 1 QList2 15 Company
Qlisks 7 Date
Qlisk 9 11
Qlisk 99 35

Figure 15: Show information

Expand Show to view nodes:

* QLists * Snaps ¢ LookAhead Mask
e Libraries <+« Macros * Home Cue

» Groups * Time Line

Each expansion shows more and more detail.

To view cue sheets
Example: View QListl and examine cue 1
1  Expand Show.
2 Tap QLists.

A list of QLists is di played in the active pane.

Show - Qlists
Qlist Name Cue Count
Main Qlist Mormal
Color chase Chaser
Aud sweep FX Mormal
Small stage Mormal
Media Chaser
QList 6 Mormal
Expand QLists.
4  TapQList 1.

VECTOR
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A list of cues in QList 1 and cue information is displayed in the active pane.

Show - Qlists - 1.0QLisk 1

List TSheet

Cue Name Time ln Time Dut %W ait
Preset 2 1 Manual

Sound cue 2 Manual
Fiano sole 16 Follow-0On
Dancers ent & Manual
Gong Cut Manual
Setfliesin 2 Manual

5 Expand QList 1 and tap Cue 1. The fixtures in cue 1 are displayed with their parameter

values.
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6 Expand Cue 1 and tap a fixture set tab (All, Channel, Spot, Matrix, or Media Server).
The cue’s parameter levels for the selected fixture set are displayed.
See “Examining cues” page 137.
Patch node
Tap Patch to view the number of fixtures and types of devices used in the current show.
Expand Patch to view nodes:
» Devices -« DMX Out * Park
» Sets + DMXIn See “Patch manager workspace tree” page 64.
Live node
Node Function
Channel Displays the channels in the show and th i cur ent output.
Spot Displays the spot in the show and t eir urr nt output.
Matrix Displays the matrix programmer
Matrix List Displays a list of all matrix s def ned in the Patch Manager.
Media Server | Displays the media s rvers in the show and their current output.
Topo View Displays the topo m p as defined in the Patch Manager.
Tip! Use a large display pane for live channel and spot displays.
Playback node
Node Sub Nodes Function
Wing 1 Playback Faders | Shows cue assignments and other information pertaining to
1-10 playback wing 1.
Selecting one of the playback devices, displays only the selected
device.
Wing 2 Playback Faders | Shows cue assignments and other information pertaining to
11-20 playback wing 2.
Selecting one of the playback devices, displays only the selected
device.
QKeys 1 | QKeys 1-10 Shows cue assignments and other information pertaining to
QKeys 1 - 10.
Selecting one of the QKeys, displays only the selected QKey.
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Node

Sub Nodes

Function

QKeys 2

QKeys 11-20

Shows cue assignments and other information pertaining to
QKeys 11 - 20.

Selecting one of the QKeys, displays only the selected QKey.

A/B

Shows cue assignments and other information pertaining to the
A/B playback. The display has side headers and includes fade
progress bars.

Cue Sheet

Shows the cue sheet for the QList loaded on A/B. The display
format has top headers and fade progress bars.

Master

Shows cue assignments and other information p tain ng to the
Master playback.

Cue Sheet

Shows the cue sheet for the QList loaded on the master playback
device. The display format has top h ders and fade progress
bars.

Attachment

Attach and delete attachments o cues sequencing on the master
playback. Add text not s to n attachment.

Note: You can toggle between Qkeys and PB wing displays by pressing PB/QKEY.

Tip! Reserve a pane dedicated to the m  ter p ayback. Another pane can be reserved for a

cue sheet that shows the list of cue and other cue information for the QList running on

the master playback.

Editor Tools node

Node

Function

Context

The contents of a Context Sensitive (CS) tab change according to the
current selection type. These soft keys can then be used to make selec-
tions. Example: Press CHANNEL. The CS soft keys are set to channel.
Tap soft keys to select channels.

Wheel Assignments

Show/hide the Wheel Assignments display.

Editor Toolbar

Show/hide the Editor toolbar

Attachment Viewer

Attach and delete attachments to show objects. Add text notes to an
attachment.

See “Attachment viewers” page 347.
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Setting up Soft Keys

s

Node

Function

Camera Viewer

View images seen by the camera connected to Vector on the USB port
or via IP address.

See “Receiving video transmission” page 349.

Scheduler

Show/hide the Scheduler.
See “Scheduler” page 386.

Desktop List

Show/hide the Desktop selected from the list.

3

See “Desktop” page 40.

Soft keys are used to access programming and playback componen s, su  as libraries or snaps.

Each display pane can contain many soft key tabs. Tabs can be d fine as soft keys for libraries,

QLists, groups, snaps, macros, or any object that appears in the Wo kspace tree. Each tab has

multiple pages.

Soft keys also provide rapid store sequences. See “Using soft keys to store cues” page 132.

Soft key pane title bar

|

First number on current page
Use arrows to page soft keys

Show - Libraries - 1.Position

Soft Key pane with no tabs

Figure 16: S ft keys

Toopenan wtab

d [ P x |show-Libraries-1Posiion 4 [i P x

IM| 2.Color ‘ Groups |
Soft key pane with three tabs

1 Go to the Window menu and tap .

A new tab is added to the active pane and the Workspace tree opens.

2 In the Workspace tree, tap an item to choose the tab’s contents.

To set a tab’s contents

Example: Set a tab for groups.

1 Tap the tab to make sure it is the active tab.

2 Open the Workspace tree.

3 Tap the Group node.

If the grid view is active, tap to display soft keys.

4 Go to the next tab and repeat step 3 until all of the soft keys are set.
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Paging soft keys
The number of soft keys displayed depends on the size of the pane.

To page soft keys
Press SCROLL/WIN and page using NEXT and PREVIOUS.
OR
Press SCROLL/WIN and scroll using the dimmer (vertical) wheel.
OR
Use PageUp and PageDown on the keyboard.
OR
If the pane’s title bar is displayed, page using the arrow controls in the ti le ba . Using the pane
header arrows, the soft key display jumps according to the size of the pane.
To jump to a specific soft key
Example: Jump to soft key 120.
1 With the pane’s title bar open, click in th soft ey n mber field.
See, Figure 16.
2 Enter 120 using the external keyboa
Or
Press SCROLL WIN and use Vector’s keypad to select 120.
3 Press ENTER
The display jumps to the selected soft key.

ATTENTION! When u ing the external keyboard to enter the soft key number, the pane’s
title bar must e op n to show the soft key number field.

Soft key and grid format displays

The soft ey display can toggled show the soft keys or display the information in grid style on the

active tab.

Show - Groups L] IT p = Show - Groups
4001 Used In Show
11 Red Wash
12 Aud Sweep
13 All Blue
16 Sp piano

1.Position | 2.Color  Groups | 18 Drum riser
17 Doumbeks

Figure 17: Soft key display Figure 18: Grid display
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To toggle the display between soft keys and grid format

Tap , on the menu bar or under the Window menu to toggle the two views.
Note: To view more details, double click on an item in the grid.
To scroll in panes

You can use the mouse to scroll in panes even if they are not active.

Make sure mouse is active (LED on), hover on any pane and scroll as usual.

Context sensitive soft keys

Use the Context option in the Editor tool bar node to set up a tab that responds to the cu rent selec-

tion. When using a Context soft key display, the active objects appear on an range field in the soft
key display. See “Editor Tools node” page 37.

Desktop

Desktop is a special display area that functions just li e th desktop on your pc. Populate it with
icons for one click or hot key operation.

The icons and text can be changed for all obj cts populating the Desktop.

<«——From the Topo map
Ch_1

2]
A

From the Gobo picker — ler . <«—From the Color picker
alm
Leaves Orange

Soft key (macro)—> m H <+<——From the File menu

MI-Snap  Save
4+ PBGo Ctr+S

>\0pening presentation
Fig e 19: Desktop populated with icons

Desktop panes and icons populating the desktop can be customized through the Desktop and icon
right click menus.
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Setting up a Desktop

ATTENTION! When populating the Desktop, the display must be unlocked: ﬁ?
(when unlocked the Desktop pane has a cyan colored frame)
When finished, be sure to lock the display: 0

The Desktop icons function only if the display is locked!

View manipulation on the desktop is through the Desktop tool bar.

ZooIn in T
Zoom out
Hand tool
Fit to screen

Enable/Disable Hot Keys
Figure 20: Desktop navigation tools

To set up a Desktop

1 Open the Workspace tree and expand the De ktop List node.
2 Activate a pane and right click anywhere in the pane.

The display control shortcut menu opens.

| aI: Toggle Lock

] Toggle workspace Tree
E Toggle Soft Keys
l [_‘, Toggle Pane Title
i ] add Tab
l E Close Current Tab
: B Close all Tabs

Yy

¥ | Close Pane

|D &dd Deskbop o

I add ‘Warkspace
F- Rename Active workspace
x Close Active Warkspace

Figure 21: The display shortcut menu
3 Tap Add Desktop.

In the Workspace tree, a Desktop is added to the Desktop List.
4  In the Workspace tree, tap the new Desktop.

A new tab, labeled Desktop #, is added to the active pane.

To rename a Desktop

1  Inthe Workspace tree, tap the Desktop List node.
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Workspace Tree

Show

Patch

Live

Playback

E] Editor Tools
Context
Wheel Assignments
Editor Toolbar
Attachment Viewer
Camera Viewer

Scheduler

=8 Desktop List
Openin N resentation

Desktop 2

The active pane shows the Desktops in grid format.

2 Double tap in the Name column of the new Desktop.

¢ .

N KO Ce
Opening presentation No

Deskto

3 Type the Desktop’s name.
This name is displayed on th Desktop’s tab.

To delete a Desktop
1 Make sure that the D sktop you are deleting is active.
2  Right click anywher in the Desktop.

The Deskt p right click menu opens.
Arrange Icon By »
Refresh

Fit To Screen
Set Deskkop Size

Rename Desktop
v Auto Resize

v Edit Mode(Unlock Window)

Select All
Paste

Background Image >
Colors 3

Figure 22: Desktop right click menu
3 Choose Delete.

4 The Desktop is deleted.
OR
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1  Open the Workspace tree, tap the Desktop List node.

The active pane shows the Desktops in grid format.

Right click in any column in the Desktop row.

Choose Delete.

4  The selected Desktop is deleted and no longer appears in the Desktop List.

To customize the Desktop appearance

Right click anywhere on the Desktop and choose an option from the menu.

Arrange Icon By
Refresh

Fit To Screen

Set Desktop Size

Delete Deskkop

Rename Desktop
v Auto Resize

v Edit Mode(Unlock Window)

Select All
Paste

Backaground Image
Colors

Arrange icons (flyout menu)
Refresh after Desktop changes
Fit to screen

Set Desktop size

Delete active Desktop

Rename Desktop

Auto Resize

Toggle the display lock

Select all icons on the Desktop
Paste objects from the clipboard

Change the Desktop background

Change the background color,
icons’ text and background color

Figure 23: Desktop right click m nu

Populating the Desktop

The Desktop is populated by dragging and dropping:

m Object soft key
® Menus

®m Menu i ems
mT ol robjects

Pic ritems

ATTENTION! To populate a Desktop, the display must be unlocked. Either click the lock
icon or Edit mode must be enabled in the Desktop right click menu.

To populate a Desktop

Example: Place a shortcut to macro 999 on the Desktop.

1  Display the macro soft keys.

2 Right click the soft key for macro 999 twice and hold down the right mouse button.

3 Drag the soft key onto the Desktop and release.
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Now you can trigger macro 999 by tapping its icon or using its hot key (See, “To create
hot keys™ on page 46).
4  Repeat steps 1 through 3 for as many items as required.
Note: To drag a soft key, it is always necessary to right click twice in order to grab it.
Example: Place a shortcut to a picker item on the Desktop.
1 Open the picker.
2  Right click on the image required and hold down the right mouse button.
3 Drag the image onto the Desktop and release.
4  Repeat steps 1 through 3 for as many items as required.
5 When finished, close the picker.
Editing Desktop icons
The Desktop icon right click menu provides tools for editing icons.

Change Icon

Transparent Color

Transparent Corner

Disable Transparent

Delete

Copy

Rename

#Add Hotkey

Delete Hotkey

Figure 24: Right click a Desktop ic n to open this menu

Change icon Automati ally opens a folder in Windows Explorer where you can find
many .ico and *.bmp files to use as icons in the Desktop.

Transparent olor choose one color, used in the icon, to make transparent. Improves visi-
bility of icons.

Transparent orner |Make the color in the corner of the icon transparent.

Disable transparent | Remove the transparency for the selected icon(s).

Dele e Delete the selected icon(s).

Copy Copy the selected icon(s).

Rename Change the text tag for the selected icon.

Add Hot Key Open the Add Hot Key dialog box to set a hot key for the selected icon(s).
Delete Hot Key Delete the hot key for the selected icon(s).

ATTENTION! To change icons or text, the display must be unlocked. Either click the
lock icon or Edit mode must be enabled in the Desktop right click menu.
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To change an change an object’s icon and text tag

Right click the icon and, from the shortcut menu, choose Change Icon.
Browse to the folder where icons are stored and select an icon.

Click OK.

A WO DN =

Right click the icon and, from the shortcut menu, choose Rename.
The text field is now selected

5 Type the new name.

To change the icon for more than one object

Example: Change the icon for all the soft key groups appearing on the Deskt p.
1 Select multiple icons by holding down Ctrl and clicking each icon
Or
Hold down the left mouse button and drag a rectangle around th icons.
2 Right click one of the selected icons and, from the sho tcut menu, choose Change Icon.
3 Browse to the folder where icons are stored and  lect n icon.
4 Click OK.
The icon is applied to the selected objects

5 Remember to lock the display by cl cking the lock icon on the toolbar or right click in the
desktop and, in the shortcut menu, ¢ ick Edit Mode to remove the check and lock the
display.

To use transparency for improved visibility

1 Right click an icon or elect a group of icons.

The icon shortcut menu opens.

Rename

Transparent Carner !q

Copy
Cuk

Delete

I Change Icon

2  Choose Transparent Color.
The Color dialog box opens.
3 Tap the color.
4 Tap OK.
The selected color is now transparent on the Desktop icon.
OR
1  Right click an icon or select a group of icons.

The icon shortcut menu opens.
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Change Icon
Rename
Transparent Color I
Copy
Cut
Delete

2  Choose Transparent Corner.

3 The color that appears in the corner of the icon is now transparent.
Setting up hot keys

You can set up hot keys that will operate the Desktop icons with one press on the keyboard. Hot key
status is saved with the show.

ATTENTION! Hot keys will not work hot keys are not enabled - - or if the display
is not locked.

To .enable or disable hot keys

On the Desktop tool bar, click the hot key icon (enabled) . (disabled). Also make
sure the display is locked 8 .

To create hot keys

1 Make sure that hot keys are enabled.
2 Right click an icon.

The icon shortcut menu opens.
3 Choose AddH tK y

The Add H tKe dialog box opens.

xi
Select Hotkey
| click on the keyboard
Save Cancel |

Figure 25: Add HotKey dialog box
4 Enter a hot key string by typing on the keyboard.

One capital letter, one small letters, one number, or combinations using CRTL can be
used.

5 Tap SAVE.

The dialog box closes. The hotkey is displayed, in parentheses, as a prefix to the icon’s
name. Example: The palm leaves gobo hot key is (p).
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HotKey —»(p)Falm
Leaves

To delete a hot key

1 Right click an icon.
The icon shortcut menu opens.
2 Choose Delete HotKey.

The hot key is deleted and the is no longer displayed with the icon.

ATTENTION! Hot keys are global; they are valid for all Desktops.

To use hot keys

Type the hot key on the keyboard.

OR

You can operate more than one hot key at the same time

1  Press and hold the left house button.

2 Drag arectangle around a group of icon on the Desktop.
3 Release the mouse button.
4

All hot keys within the rectangl are triggered.

Workspaces

Workspaces are dditional display screens that provide more work areas. You can create a dedi-
cated work ace for playback information, live displays, etc.

Each main window can contain more than one workspace. Workspaces are accessed by tabs located
ab ve the ommand line, so switching is very simple.

Work paces are saved as part of the layout or they can be saved separately and loaded for re-use.
The Workspace display file extension is: csl.

The default Workspace is called Main and is the first workspace tab. Workspace tabs can be
renamed and their order can be changed.
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s

Jump to first workspace tab

Jump to last workspace tab

Advance to next Return to previous

Figure 26: View tabs and their navigation controls

When requesting an exam the current Workspace is swapped with the one containing the def ult

€xam pane.

To add and configure Workspaces

1

Right click anywhere in a window and, choose Add Workspace from he right click menu.

“, Toggle Lock
|| Toggle Workspace Tree
EZ] Toqgle Soft Keys
D Toggle Pane Title
Add Tab
) close Current Tab
) Close all Tabs
Close Pane

[ Add Desktop

[E=_Add Workspace E ]|
E Rename Active WorkSpace

x Close Active Workspace

Figure 27: View controls rght click menu
Or
Go to the Window menu » Window Options and choose Workspace.
A Worksp ¢ is dded to the window. Its tab appears to the right of the last tab.
Righ click th new tab.
The display control, right click menu opens.
hoose Rename View.
Type a new name for the Workspace and press ENTER.

Using the tools in the Window menu divide the workspace into panes and add tabs, as

necessary
Open the Workspace tree and set up the view as is suitable.

Example: If you have created a Live workspace, you will probably want to show the live
fixture displays, the master playback display, and the playback wing display.

Optional - Save this as a display layout.

See, “To save a display layout” on page 33.

To change the order of the Workspace tabs

1

Make sure the display is not locked.
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2 Drag the tab to a new position.

To save a Workspace

1

Go to the Window menu P Layout » chose Save Workspace.
The Save As dialog box opens to the default folder.
Optional - browse to a different folder

Type a name in the File Name field.

Tap SAVE.

The Workspace is saved. The Workspace file extension is: csl.

To load a Workspace display

1

Tap WindowP Layout P chose Load Workspace.
The Open dialog box opens.

Select a Workspace from the list of *.csl files.
Tap OPEN.

The Workspace is loaded.

Menus and toolbars

Vector’s menus contain save file and open file functions, show/hide options for tool bars, access to
setup dialog boxes, and tool bars

Showing a toolbar, floats the t olbar on the display. You can move and dock this toolbar. You can
customize the toolbar di plays to permanently show frequently used icons.

To dock a floating t olbar

Grab the toolbar with the mouse, a stylus, or your finger and drag it under the menu bar.

Wh n correctly docked, a row opens under the menu bar to accommodate the entire
t Ibar.

To add icons to the default display

a A WON =

Tap the Tools menu.

Tap Customize.

In the Commands tab, tap a category.

Drag an icon from the commands pane to the toolbar area.

Tap close to close the Customize dialog box.
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File menu

The File menu contains the standard items that are found in this type of menu, in many software

applications.

Menu items Function

New Show Open an empty show file. All current data, including patch, are erased.

Open Show The Open File dialog box is displayed. Browse and open files as in all
windows programs.

To open a Sabre or 4D show file
Select the appropriate file type in the Files of Type ¢ mbo box.
See “File conversion” page 242.

Import Import selected objects or patch information from saved shows.
See “Importing objects and patch” page 240

Save Save the open file. If the show has bee saved previously, it is saved
under the same name. If the show is an w show, the Save dialog box
opens.

Save As Open the Save As dialog box save a show file under a new name. It is
recommended to use this pt on when saving show files to organize
saved versions.

Print Open the Print dialog box.

Print Preview

Not implemented.

Print Setup

Ope the Print Setup dialog box.

Last used files

A li t of the recently used show files.

Exit

Close the application.




View menu and toolbar

VECTOR

DISPLAYS AND MENUS

The View Setting tool bar allows you to customize the column width, header displays, and behavior

of each display grid. The settings applied using this menu are saved with the display layout. See,

“To save a display layout” on page 33.

CHTT L
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View Setup Toolbar

Indication Bar

Headers Per Device

Fit Columns Width by Title

Fit Columns Width by Value

Fit Columns Width by Title and Yalue

Fit Columns Width to Screen

Yiew Properties

Show/Hide Headers

Jump ko Fixture

Jump to Parameter

Interactive Fixture Selection

Refresh

Indications bar

Show / hide View tool bar

Show / hide Indications bar

Show / hide device separators

Set column width according to parameter names

Set column width according to parameter values

Set column width to accommodate name and values

Set column width according to the available space in the pane

Open the Grid Properties dialog box

Show / hide field names in the live channel display

Jump to the selected fixture
Jump to the selected parameter

Allow fixture selection on the touch screen

Refresh the display

The Indicati ns bar shows system status information. You can choose to show or hide the Indica-

tions bar.

Whatever is enabled in Settings » Communication tab is displayed in the indications row. This
i cludes:

= MIDI
= MSC
mVC’s

m Art-Net

® DMX Input

516D
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Syntax MSC status Active snap  Qlist on master playback

Indication '3ar

Mode: | T| A| MIDI MSC VC  Snap:| 2

£t F ot

Operation mode MIDI status VC status Active editor Last cue stored
Figure 28: Indications Bar

To display the Indications bar

Open the View menu.
2 Tap Indications Bar.
The Indications bar is now displayed.
3 Drag it to dock at any convenient place.
This is saved with your display layout.
4  Repeat steps 1 and 2 to hide the

Device headers

In the live display, a device title bar (header) separates g oups of devices by type. Example: There
are 24 patched VL 3000Spot fixtures (spots 1 = 24) nd 12 patched VL3000Wash (spots 25 -

36). A device header is placed between spots 24 a d 25

Grid columns are common to the entire displ y. If particular type of device does not contain
certain parameters, the column for that par met r is left blank. Example: Varilite 3000Spot and
Varilite 3000Wash are used in the show Of ourse, the VL 3000Spot has gobo parameters and the
VL3000Wash does not, so the gobo p rameter column shows no values in the VL.3000Wash section

of the live display. Scrolling is also common to the entire display.

Fixture # Fixture Pan Tilt

VL3000 Wash

Device headers

Figure 29: Live spot display with headers separating types of devices
To show device headers

Open the View menu and choose Headers Per Device.
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Column width

Adapt the column with according to:
m Title
m Value
m Value and title

m Screen

To change the column width

Tap View to open the view menu and choose one of the column width options.

Jump to display
Use the Jump items to automatically show the fixture or parameter as they ar selected:
m Fixture
m Parameter
To activate the jump feature

Tap View to open the view menu and choose Fi ure r Parameter.

Interactive selection feature

Interactive Fixture Selection allows you to sel ct fixtures by tapping or clicking on their number in
the live display.

To activate the selection feature

Tap View to open the view menu and choose Interactive Fixture Selection.
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Tools menu

The Tools menu is the gateway to many dialog boxes and customization options.

g

V4

% Patch Manager Open the Patch Manager

g Generate Groups and Libs Open Generate Groups & Libs dialog box

:ﬂ Settings Open the Settings dialog box

l‘iﬁ Device Builder Open the Device Builder

a Software Update Open the Updates folder

% RT Status View Real Time software information
Advanced » | Advanced Function real-time flyout menu

% Grid Options... Open the Grid Options dialog box

Eg.: Customize Menus Open the Customize Menus dialog box

sy
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The Format menu items control how parameter values are displayed in the live fixture displays and

what information is displayed.

Format

Format Toolbar

Text

Decimal Yalue

Percent Yalue

e

Hex Value

o=
‘1

NG 3 (|

Time

Playback Source

Library

Effect

Profile

Auto Hide Options

»

Show/hide the format toolbar

Show parameter text tags

Display parameter values in decimal format

Display parameter values in percent format

Display parameter values in hexadecimal format

Show cell time and delay settings
Show output source

Show library types settings

Show effect name

Show profile name

Hide active format options

There are two basic typ s of information that you can display in the parameter cell:

m Parameter alue can be displayed in decimal, percent, or hexadecimal format

m Param er text. Example: The value for a step in gobo wheel 1 appears as “Stars” on the live

spot isplay.

In dditi nto parameter values or text, the live display can show various attributes:

m Time, if a unique fade time was set for the parameter

m The name of the playback device (PB) that is responsible of the output

m Library flags
m Profile flags
m Effect flags

Time, playback source, library, effect, and profile attributes can be displayed on separate rows in
the live display. You can also hide all or some of the parameter value attributes.
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Parameter output Values row s

Parameter fade time row

Library identifiers (# or name) row s

Spot 1

The live spot display formatted with rows for:
¢ Parameter time settings
¢ Library identifiers

Spot 1 displayed without rows for parameter fade times and library identifiers.
The time and library icons are displayed next to the parameter’s output value

Figure 30: Parameter attributes in the live spot display

To display parameter value attributes

1  Tap Format.

2  Tap one of the format options.

To hide attributes

Tap Format.

2  Tap Auto Hide.

A list of the attributes is displayed.

Choose one of the attributes.

4 Repeat to hide additional attri ute .

LiveMode menu and tool bar

The items in this menu contro which fixtures are shown in the live displays

Live Mode

Live Mode Toolbar

ll Show all
’rf Active In Editor

Active On Stage

Used In Show

>
v Patched
-

[%—

Show/hide toolbar

Show all fixtures

Show only fixtures active in the editor

Show all fixtures output from the editor or playback device
Show all patched fixtures

Show all fixtures used in show
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Window menu and display toolbar

The items in this menu are used to setup the display panes, save and load layouts, and lock displays.

Window

Iy

Window Setup Toolbar

= 86| Show/Hide Window Title

Split Pane Horizontally
Split Pane Yertically

@ Add Tab
O

Show/Hide Pane Titlebar

Toggle Soft Keys

‘Window Options

f Reset Dialog & Toolbar Position
é\ Lock all Windows

Exam...

Layout

@ Full Screen

Show/Hide the tool bar

Show/hide the Window title bar

Split the active pane horizontally
Split the active pane vertically

Add a tab to the active pane

Show/hide the pane’s title bar
Toggle between graphic soft key display and grid display
Add a new window or workspace

Return dialog box to its default position

Lock the display or unlock it for editing

Choose the default pane for exams

Switch to full screen mode

Attachment menu

Media and te t file can be attached to show objects, such as cues, macros, snaps, groups, and

libraries. See “Fi e attachments” page 347

Attachment

@ Maote Mode
E[J_% Add Attachment

K Delete Attachment

Select Video Source

e
A

Add a note to the attachment

Add attachment to selected object

Delete attachment from selected object

Configure Vector to communicate with a camera
connected at Vector’s USB port or, via an IP address,
a camera on the general network.

57 €
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Editor Toolbar

The Editor toolbar contains buttons used when programming a show. The Editor toolbar is context
sensitive; the buttons change according to the current editing function.

13 buttons per row are displayed on the toolbar. There are two arrow keys at the end of a toolbar

row for paging the buttons, if necessary.

Dss

Library

Edit Cue | Load Cue |Load State | Library

Editor tool bar modes

m Cue mode

m Delta

®m Dimmer (patch) mode
m Every (selection) mode
m Fan

m Fixture (selection) mode
m Library mode

m Loop mode

m Macro

m Pan/tilt

m Playback

m Parameter mode

m Profile mode

m Rate

m Store op ions mod

m Time mode

m Timel e mode

BIndPE [ .. . ‘
Preview | lavBack Editor Try Cue
Edit Edit Fade

Blind PB

e PlayBack Editor

Library g . Edit Edit Fade

Figure 31: Editor tool bar default (idle) mode

See “Cue mode on the Editor tool bar” page 157

3

See “Delta mode on the Edit r ool bar” page 153
See “Dim (patch) mode on the _ditor toolbar” page 78

See “Every (selection) mode on the Editor tool bar” page 93
See “Fan toolbar” pa e 176

See “Selection m de on the Editor toolbar” page 93
See “Library mode on the Editor tool bar” page 252
See “Loop m_de on the Editor tool bar” page 172
See “Macro mode on the Editor tool bar” page 299
Se “Pan/Tilt mode on the Editor tool bar” page 114

S e “Playback selection” page 202.

See “Parameter mode on the Editor tool bar” page 107
See “Profile mode on the Editor tool bar” page 320

13

See “Rate mode on the Editor tool bar” page 223

See “Store options mode on the Editor tool bar” page 134
See “Time mode on the Editor tool bar” page 164

See “Time line mode on the Editor tool bar” page 380

To sh w the Editor tool bar

Open the Workspace tree.

Expand the Editor Tools node.

Tap Editor Tool Bar.

4 Optional: adjust the number of rows displayed by dragging the tool bar’s upper edge up or

down.
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Wheel Assignments

The Wheel Assignments display shows the parameters, for the selected fixtures, in their wheel
banks assignments. It is most convenient to open the Wheel Assignments on the main screen, so it is
positioned above the physical wheels.

Figure 32: The Wheel Assignments display
To open the Wheel Assignments display

1 Open the Workspace tree and expand the Tools node.
2 Tap Wheel Assignments.
3 Optional: adjust the number of rows displayed by the upp r edge dragging up or down.

Playback displays

See “Playback displays” page 208.

Grid properties

Grid properties include:
m Text that appears in the g id headers
m Which inform tion s displayed
m The ord r in which the headers appear
m Font and font color
m Backg ound color
m Row and column weight

® Row and column line color

Grid properties can be changed in the Grid Properties dialog box. The options available in the
dialog box correspond to the active display pane. Example: The active pane is live spots. The Show
fields tab contains items relevant to the spot display.
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x
Show Fields | Celumn: | Gid |
Available lields: Shaw these fields in this order
Fizture Name
SetNo Add > | Dimmer
Calor Scroller

<- Remove | Fan Speed

Default | Hovellp I Move Down

Figure 33: The Grid Properties dialog box

Tab What you can do

Show Fields | The Available Fields appear in the left list box. The Show Fields list box, the right
list box, contains the fields that are displayed a dth o der in which they are

displayed.

Columns Edit the text that appears in the column head rs.

Grid Customize fonts, font color, backgrou d color, grid line weights and line color for
specific display panes.

To open the Grid Properties dialog box

1 Position the pointer on one of  grid headers and right click.
2  Tap Properties.
3 The Grid Properti s di log box opens.

OR
View menu b @ Properties
To add fi ds to headers

In the how Fields tab, select an item in the Available fields list box and tap ADD.

To r move fields from headers

In the Show Fields tab, select the field from in the Show Fields list box and tap REMOVE.

To change the order of the fields
Select an item in the Show Fields list box and tap MOVE UP or MOVE DOWN until the item is

in the desired position.
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Customizing column headers

The fields in the Columns tab are used to edit the text that appears in the grid headers. The number
of characters in the header affects the width of the header and the amount of information displayed
in one display pane, without having to scroll.

Grid Properties x|

Show Fields  Columns | Grid |

 General

% Field IFixtureNo 'l
Ll

Title IFixture Ma

width I

r~ Colurmn Locking

Lock columns to: [none] -

i~ Channel Dizplay

Mo. of Columns |2D
Default |

Figure 34: Columns tab in the Grid Properties dialog box

Sections | Controls What it does
General Field (radio button) | Select a pa ameter name from the drop down list.
All (radio button) Wh n All is selected, the Width field is enabled.
Title Type the parameter name as you want it to appear in the
header.
Width For spots only. Preset an absolute width for grid columns.
Column Lock column to Locking columns together fixes the columns in place and
Locking excludes them from horizontal scrolling. Example: Fixture
name and number are usually locked, so are always
displayed.
Channel No. of Columns Set the number of columns per row for the live channel
Display display. This determines how many channels are displayed.

Customizing grid appearance for specific display panes

In the Grid tab, you can customize the look for specific display panes.

To customize grid properties
Example: Customize the grid look for the master playback pane.
1 Point to one of the headings in the master playback pane and right click.
2 Choose Properties from the fly out menu.
The Grid Properties dialog box opens.
3 Go to the Grid tab.
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Tap Custom to enable the fields.
Set the fields.
Tap OK to save and exit.

These settings will be saved with your layout.

To return to default grid properties

Point at one of the headings in the master playback pane and right click.
2 Choose Properties from the fly out menu.

The Grid Properties dialog box opens.

Go to the Grid tab.
4  Tap Custom to disable.

All fields return to their factory default settings.

Tap OK to save and exit.



Chapter 4 Patching

At start up, Vector's patch configuration is empty. The system must be configured for the types of
devices and the number of fixtures that will be used in the show. Opening a new show file also
resets the patch to empty.

This chapter contains the following sections:

m Patch manager toolbar (see page 64)

® Importing devices (see page 65)

m Creating fixtures and patching DMX addresses (see page 66)

m Creating and patching fixtures with scrollers (see page 70)

m Creating fixtures for selections in fixture mode (see page 71)

m Applying the patch and exiting the patch manager (see page 72)
m Deleting fixtures and clearing patch assignments (see page 73)
m Editing fixture properties (see page 74)

m Changing a device setup (see page 77)

m Editing DMX channel properties (see page 76)

m Patching to DMX addresses in the editor (see p ge 8)

m Test fixtures, dimmers, and DMX offsets (se _pag 82)

m Using park (see page 85)

Patch Manager

Determining the type and number of fixtures used in the show and patching these fixtures is done in
the Patc Manager.

Th atch Manager’s features include all patch and configuration activities:
m Determining the type of fixtures used in the show.
® The number of fixtures.
m Assigning fixture numbers used when programming.
m The pan and tilt orientation for moving devices.
m Patching fixtures to DMX addresses.
The patch schedule is arranged in spreadsheet (grid) style.

Fixtures are organized into sets. Each set has its own grid.
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To open the Patch Manager

Tap Tools menu) Patch Manager.

Patch manager toolbar

Tapping an icon on the Patch Manager toolbar opens the dialog box or wizard for the selected
function.

Exit Patch
Patch Properties range Manager

! | ' ' ) !
CRvXE{E al P
L T
Delete  Clear Create &
fixture  patch patch

Figure 35: The patch manager tool bar

Create
fixture

Modify Import

device

Export
device

Apply
patch

Patch manager workspace tree

The nodes in the Patch Manager workspace change t

information displayed in the main pane.

C S (N

=) Patch
Devices
#-0.Channel
1.Spot
2.Matrix
- DMX
- Matrix List
MyMatrix
- PyschoSwirl
SuperSign
- Jugglers
-Topo View

Figure 36 Patch manager Workspace tree
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Node Sub Node Function
Devices | Available devices » Tap + to expand and view the imported devices.
* Tap a specific device to view the device's parameters
and a grid showing the device set up.
» Tap a parameter to view the set up for that parameter.
Sets Spot » Tap Channel, Spot, Matrix, or Media Server to view the
Channel patch schedule for that set.
Matrix » Tap + to expand and view the fixtures in each e Tap
Media Server ping a ﬁxtu're displays a grid showing the cue where
the fixture is used.
DMX Ports (universes) 1-16 |+ Tap + to expand and view a list of DMX ports.
» Tapping a specific port shows its p tch schedule.
Matrix User defined matrixes * Define matrixes and sele t a matrix for mapping.
List
Topo » Display Topo map. See, Chapter 13, “Topo”
View
The Patch Manager workspace tree has th ee operation modes
COLLAPSE (C) Tap to collapse the ent e tree to display only the main nodes.
SELECTION (S) Tap when expand ng nodes or to select more than one node. This is
generally u ed when working with TOPO or matrix. It allows you to
make select ns without changing the main display.
NAVIGATION (N) | Tap to display the grid for the selected node.

Working in the Patch Manager

The Patch Manager work flow is:

1. Import devices.

. Create fixtures.

Apply the patch.

2
3. Patch fixtures.
4
5

Exit the patch manager.

Importing devices

You must import the devices that you intend to use in your show. Devices are imported from a list
of devices accessed via the IMPORT DEVICE button, which is available in the Import Device and
the Create & Patch dialog boxes.
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Devices are organized in subdirectories according to manufacturer. As in most GUI file systems,
press and hold CTRL while clicking on devices to select more than one device.

To import a device
1 Tap E
A dialog box containing a list of devices opens.
2 Double click the device file.
Or
Tap the device file and tap OPEN.

The device is imported to Vector's Patch Manager. It appears under the Device folder in the
workspace tree.

3 Repeat this procedure to add more devices to the Patch Manager’s Device folder.

Note: To select more than one device, hold down Cntrl and cli k on more devices.
When your selection is complete, tap OPEN.

Creating fixtures and patching DMX addresses

Patching fixtures is a two-step procedure:
1. Creating fixtures
2. Patching fixtures to DMX addresses

There are separate dialog boxes for creating fixtures and patching fixtures. There is also a wizard
for creating and patching.

Create and Patch Fixtures

Figure 37: Creating fixtures in the Create & Patch wizard

Dss



CTETTTTE— F
Device: T -
Import Device
Mo of Fistures o Create 1
Staat Wurnber B
Name: [+
Set: Spat |
ientation

v Par

et Tik

Swap PanTik

coak [ Mes | Ceneel |

Figure 38: Create and patch fixtures wizard

VECTOR

[Lrese andratchriures
Main
Part i
Address: E5
Interval 38
Extemnel
Part i
Address: 1
Interval i

< Back I Finish I

Cancel

PATCHING

Create fixture
fields

Field Information

Device

The drop down list shows the devic s imported to the patch manager.

Number of
fixtures to create

Choose the number of fixtures fo the selected device.

Start number

Assign the first fixture numbe for the selected device. Vector automatically
assigns sequential number according to the number of fixtures as defined in
the Create numbe of fixtures field.

Name

Type anam for the device. The name is displayed in the live editor display if
Fixture N me i included in the live display grid properties.

Set

Set 0 - Channel
Set 1 - Spot
Set 2 - Matrix

Set 3- Media server

Set orga ize the fixtures into generic groups:

O ienta ion

Change the pan/tilt orientation for the fixtures created here.
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Create and Patch Fixtures

Figure 39: Patching DMX channels in the Create & Patch wiza d

Ffatch fixture Field Information
fields
Main This is the default.
Port Enter the DMX univer (por ) number for the fixture(s). The default is the
first universe contai ing a ailable DMX channels.
Address Vector automatical y displays the next available address.
Vector aut  atica ly calculates the DMX length starting from the address in
this field Example: If the address is 5, patching fixtures that use 10 DMX
channels assigns DMX addresses 5 through 14 to the first fixture, 15 through
24 to the second fixture, etc.
Interval When in the channel set, the default is 1.
When in the spot set, the default interval is the DMX length of the device.
External Check this to patch an external dimmer.
IMPORTANT!
For scrollers: The dimmer is Main. The scroller is External.
For yokes: The yoke is Main. The dimmer is External.

To create and patch fixtures

Example: Create 12 fixtures for VL2402 devices. The fixtures start number is 24. Patch the 12
fixtures to DMX universe 3, starting at DMX channel 1.

1 Tap %. The Create and Patch dialog box opens.
2 Select VL2402 from the device drop down list.
3 Enter 12 fixtures in the Create Number of Fixtures field.

Dss
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Enter 24 in the Start Number field.

Type a name for the device in the Name field. This name will appear in the live display.
Tap NEXT.

Enter 3, the DMX universe number, in the Port field.

Enter 1, the DMX start address, in the DMX address field.

© oo N o a b

Optional - change the patch interval in the Patch interval field. The default interval is the
length of the device.

10 Tap FINISH. The dialog closes.

The fixtures and their patch information appear in the spot set grid.

To leave intervals between DMX addresses

Example: Allow 5 DMX addresses between each fixture.

Stand on the Patch interval field and enter the number 5.

To patch more than 1 DMX address to a fixture (soft tch)
Example: Add Port 1, DMX address 55 to fixture 1, which  patched to Port 1 DMX 1. If
DMX 55 is in use, you first must clear it.
1 In the Patch Manager workspace tree, sel ct th channel set under the Set node.
2 Right click on the cell for fixture 1.

A fly out menu opens.

Patch - Sets - 0.Channel

Device

Create

Patch

Create and Pakch
Clear Patch

Delete
Madify Fange
Properties

Figu 40: Fixture cell flyout menu

3 Choose Properties.

The Fixture Properties dialog box opens.
4 Tap the Patches tab.

Tap NEW.

Enter the connector and address that will be added to the current patch. In this example,
enter 55 in the DMX address field.
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Fixture Properties x|
General Patches I
DMX Channel Properties [

Patch Properties I

Connector:

I 1
DM¥ addrese: |55

I Main
Ezternal I

Figure 41: Adding a DMX address in the Fixturés Properties dialog b x
7 Tap OK.

8 Tap OK.

The additional DMX address can be seen in the channel set pread sheet.

Patch - Sets - 0.Channel

Fixture # FixtureDevice diain Paich_
1 iCh_1 Channel 1/ 1,155
"

Figure 42: Channel patch display

Creating and patching fixtures with scrollers

Fixtures with scrollers can belong o either the channel set or the spot set.

Scrollers are usually part of the channel set and appear in the live channel display. The frame value
is displayed in the color row Scrollers that are part of the spot set appear in the spot display. The
frame value is disp ayed n a color parameter row. In both cases, it is necessary to select only the
spot or channel number to access the dimmer and the scroller.

Scrollers in the channel set - live display

O T

(o N FririS-5.40%  FrmS-5.40%  FrmS-5,40%

Scrallers in the spot set - live display

Fixture |Fixture # |Pan Tilt Dimmer |Color lris |
S0% [S0% [S6% Orange-5,32 (

87%

69%

69%

Figure 43: Scrollers as channels and spots
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To create and patch scroller fixtures

Example: Create 12 fixtures for 16 frame scrollers. The fixtures start number is 1. Patch the 12
fixtures to DMX universe 1, starting at DMX channel 1. Patch the scrollers to DMX universe 3
starting at DMX channel 1.

1 Tap %_
The Create and Patch dialog box opens.
2 Tap IMPORT DEVICE.
The Import Device dialog box opens.
Expand the Generic node and select Ch+Scroller 16F from the device drop down list.
Enter 12 fixtures in the Create Number of Fixtures field.

Enter 1 in the Start Number field.

(=TS ) B ]

Type a name for the device in the Name field.
This name will appear in the live display.
7 Tap NEXT.
8 Enter 1, the DMX universe number, in the Port fi 1d
9 Enter 1, the DMX start address, in the Addr ss fi 1d
10 Tap EXTERNAL.
The external Port, Address, and Interval f elds are now active.
11 Enter 3, the DMX universe numb r, in he Port field.
12 Enter 1, the DMX start address, in he Address field.
13 Tap FINISH.

The fixtures and their p tch information appear in the channel set grid.

Main patch External patch
for dimmer control  for scroller control

Main Patch Extern Patch

Ch+Scroller 16F |17 2 37/ 2

Ch+Scroller 16F 17 3 37 3
Ch+Scroller 16F |17 4 37 4

Ch+Scroller 16F |17 1 37 1 I

Figure 44: Patched fixtures with scrollers

Creating fixtures for selections in fixture mode

Patching fixture sets using consecutive fixture numbers allows you to select fixtures, when
programming your show, without specifying the fixture type. See “Command line numerical

default” page 95.

An example of fixtures patched with no overlap is:
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Fixture set Fixture numbers
Channel 1to 100

Spot 201 to 300

Matrix 401 to 512

Media server 513 to 1024

Applying the patch and exiting the patch manager

Apply the patch when you want to save the patch, update the show, and continue worki g in the
patch manager. Neglecting to apply the changes in the patch while continuing to work in the patch
manager may cause anomalies. For instance, you have cleared the patch for a number of fixtures
and now attempt to patch using the DMX addresses you just cleared If you have not applied the
patch after clearing, the system generates the message: Patch Exist . App ying the patch after the
clear operation prevents this.

To apply the patch
Tap ] -
To exit the Patch Manager
1 Tap o).
You are prompted to save the p tch data.

2 Tap YES to save chang

Tap NO to exit withou saving.

Note: If you chose YES, exiting the patch manager automatically applies the patch.

Editing the patch

Edit the patch to:

m Add or delete fixtures

m Change DMX addresses

m Renumber or rename fixtures

m Change the pan/tilt orientation

m Change a device setup

m Change DMX channel properties
All of these features can be accessed via the icons on the Patch Manager tool bar. See “The patch
manager tool bar” page 64.

They can also be accessed through a shortcut menu.
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To open the shortcut menu

1 In the Patch Manager workspace tree, expand the Set node.
2 Choose a set.

The main patch display shows a spread sheet for the selected set.
3 Right click on a fixture cell.

A shortcut menu opens.

Patch - Sets - 0.Channel

Fixtur¢Device

Create
Patch

Create and Pakch

Clear Patch
Delete

Madify Range
Properties

Figure 45: Fixture cell flyout menu

4 Choose one of the options.

The appropriate dialog opens.

Deleting fixtures and clearing patch assignments

You may want to repatch fixtures.

PATCHING

IMPORTANT! Always clear patch a signments before reassigning DMX addresses.

To delete fixtures
1 Select the appropriat set.

2 Tapx

Or
Righ click on the fixture cell and choose Delete from the shortcut menu.
The Delete Fixture dialog box opens.
Enter the fixtures’ numbers in the From No. and To No. fields.
4 Tap OK to update and close the dialog box.
Or
Press APPLY to update the show and keep the dialog box open.

To clear patch assignments

1 Select the appropriate set.

2 Tap R
Or

Right click on the fixture cell and choose Clear Patch from the shortcut menu.
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The Clear Patch dialog box opens.

3 Enter the fixtures’ desk numbers in the From No. and To No. fields.

4 Tap OK to update and close the dialog box.

Or

Tap APPLY to update the live functioning and keep the dialog box open.

Editing fixture properties

® Renumber fixtures

m Rename fixtures

Use the Modify Fixtures wizard to:

m Change the pan/tilt orientation. Pan/tilt orientation is also available on t e Ed tor toolbar in

spot mode.

Modify Fixtures Range

Device: I Channel 3
Import Device... |

Renumber Starting From: I

Rename To: IHed wash

Set: IChanneI j

 Drientation

Invert Pan |
Invert Tilt |
Swap PanTilt |

Figure 46: M dify Fixtures wizard

Modify fixt re fields

Field Information

Set This field is disabled. Make sure this shows the appropriate set. If not,
exit the wizard and choose the correct set.

Fixture no. Select a range of fixtures for modification.

Device The drop down list contains the devices imported to the patch

manager.
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Modify fixture fields | Field Information

Rename to Type a new name for the selected fixtures. The name is displayed in
the live spot or channel display if Fixture Name is included in the live
display grid properties.

Set This field is disabled. Make sure this shows the appropriate set. If not,
exit the wizard and choose the right set.

Orientation Change the pan/tilt orientation for the fixtures.

To rename fixtures

1

Select the set.

2 Tap gﬁ.

3
4
5
6

Or

Right click on the fixture cell and choose Modify Range from the shortcut menu.

The Modify Fixtures wizard opens.

Note: Ifediting a range of fixtures, select the first ixture in the range. This
fixture number will appear in the Fixture no field.

Enter the range of fixtures in the Fixtu no. field.

Tap NEXT.

Type a name in the Rename T field

Tap FINISH.

To adjust pan and tilt orie tation in the patch manager

1
2

Select the spot set
Tap 8,
Or
Right click on the fixture cell and choose Modify Range from the shortcut menu.
The Modify Fixtures wizard opens.
Enter the range of fixtures in the Fixture no. field.
Tap NEXT.
Choose:
mINVERT PAN
mINVERT TILT
BmSWAP PAN/TILT
Tap FINISH.
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To adjust pan and tilt orientation in the editor

Select the spots.

On the Editor toolbar, tap PAN/TILT PATCH.

Tap:

mINVERT PAN
mINVERT TILT
uSWAP PAN/TILT
Press STORE.
5 Press ENTER.

Editing DMX channel

properties

Editing DMX channels is done in the DMX Channel Properties alog box.

DMX Channel Properties {X\

DM Channel Properties |

Port

Addiess: 2

Proportional Patch (%) 100 -

| Linear

Curve: Invert A
Non-Dim
Park Grand Master I
Pre-heat 10%
Pre-heat 5%
Radnoti
S-cuve

F gure 47: DMX Channel Properties dialog box

Dimme curves

The Port and Address fields
show the DMX address for the

selected DMX channel

Set the proportional patch level

Choose the dimmer curve
from the drop down menu

Enable or disable grand master control

over the selected DMX channel

The dimmer curve is the dimmer behavior when fading from 0%-100%. There are 5 dimmer curves

available.
Curve Type | Description System | Output
Linear Dimmer behavior default. 10% 10%
Inverted Output is inverted 10% 90%
Non-dim Output is either 0 or FL <50% 0
>50% FL

D7




VECTOR

PATCHING
Park Dimmer output level is always at the parked level. — 100%
Dimmers can only be parked at 100%.
Preheat 10% | The dimmer is always maintained at 10%. _ 10%
Preheat 5% The dimmer is always maintained at 5%. _ 5%
S-Curve Softer rise than the linear curve. 10% 10%

To change DMX channel properties

-—

Display the DMX universe (port) grid.

Right click on the DMX channel you want to modify.

If editing more than one DMX channel, right click on the first channel int e r nge.
If editing one DMX channel, choose Properties from the fly out me u.

If editing more than one channel, choose Modify Range.

Make sure the address number in the Address field is correct

If editing a range of channels, enter the last channel number in the To field.

To change the proportional patch, use the Propor ional patch spin box to set the value.
To change the curve, select a curve from the Curve combobox.

To disable grand master (GM) control ove the selected DMX channel(s), uncheck the GM
check box.

Tap OK.
The dialog box closes.
Tap ¢4 to apply the cha ges.

Changing a device setup

To change a d vice s par meter set up and wheel assignments, open the Device Builder from the

Patch Manager.

Toop the Device Builder

1
2

In the Patch Manager workspace tree, tap Devices.

Right click on the device being modified and choose Properties from the fly out menu. The
Device Builder opens.

Change the device setup and save the device.
Optional: to make the device generally available, save it in the device library:

Tap SAVE IN LIBRARY» Browse to your device library P Tap OK.

ATTENTION! Devices modified in the Device Builder via the Patch manager are saved
only in the current show.
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Patch and test functions in the editor

Patch functions that can be done in the live editor, without opening the patch manager are:
m Patching fixtures to DMX channels
m Clearing patch
m Parking dimmers

m Testing dimmers and DMX channels

Patching to DMX addresses in the editor

Pressing DIM on the console puts the toolbar in patch mode.

5 Clear
)
Clear External Park mTeortlona T

patch | Prameter lovel
Figure 48: Dim (patch) mode on the Editor toolbar
The Editor toolbar buttons in dim mode are:
m CLEAR PATCH
m EXTERNAL PARAMETER (patch address for a ext rna dimmer)
m PARK
m PROPORTIONAL LEVEL

m CLEAR PROPORTIONAL LEVEL

‘When patching in live mode it is useful o view the patch sheet. Open the patch sheet through the
Workspace. See “Patch manage work pace tree” page 64.

Fixtures that have no patch assi nments are flagged in the live display.

Fixture Fixture # Pan Tilt Dimmer Color
1 50% 5S0% 0.W.-1.29

‘S 1

F gure 49: Fixtures flagged as not patched

To patch channels or spots
Example: Patch channel fixture 5 to DMX address port 2 dimmer 24.
1 Select channel 5.
2 Press DIM.

3 Press 2 (the port) / (slash) 24 (dimmer) or use the direct dimmer number, in this example,
536.

4 Press STORE.
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The command line shows Assigned when the operation is successful.

OR

1 Press DIM.

2 Enter the dimmer number on the numeric keypad.
3 Press CHANNEL and 5.

4 Press STORE.

To patch more than 1 DMX address to a channel (soft patch)

Example: Patch Port 2, DMX addresses 12 - 24 to channel 1. [f DMX 12 - 24 are p ched to
other channels, you first must clear these assignments.

1 Press DIM.

2 Select the DMX addresses: 2/12 = 2/24.

3 Press CHANNEL and enter 1 on the numeric keypad.
4 Press STORE.

To clear patching
Example: Clear the patch assignment for chann 15 whi h is patched to port 1, DMX offset 5.
1 Select channel 5.
2 Press DIM.
3 Press DELETE. The Delete dialog box opens.
4 Press DELETE again. or tap DE ETE in the dialog box.
The command line shows Released when the operation is successful.
OR
1 Select channel 5.
2 Press DIM.
3 Tap CLEAR PATCH (on the Editor tool bar).
T eD lete dialog box opens.
4 Pr ss DELETE.
R
1 Press DIM.
2 Tap CLEAR PATCH (on the Editor tool bar).
The Delete dialog box opens.
3 Tap DELETE.

To patch external dimmers

Example: Channel 8, patched to DMX channel 8, is a fixture with a scroller. Patch the external
dimmer number, for the scroller, to DMX channel 108.

1 Press DIM and select the dimmer number, 108.
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2 Tap EXTERNAL PARAMETER.
3 Select fixture channel 8.

4 Press STORE.

To set proportional dimmer levels

1 Press DIM.
2 Enter the DMX address on the numeric keypad.
3 Tap PROPORTIONAL PATCH.

4 Press @ and enter the proportional level on the numeric keypad or use the whe 11lab lled
Proportional Level.

5 Press STORE.

OR

1 Select a fixture.

2 Press DIM.

3 Tap PROPORTIONAL PATCH.

4 Press @ and enter the proportional level o the ume ic keypad or use the wheel labelled
Proportional Level.

5 Press STORE.

To clear proportional patch

1 Press DIM and chose the dimm number using the numeric keypad.
2 Tap CLEAR PROPORT ONAL LEVEL.
3 Press STORE.

LE]
To patch fixture

Examp e: Patch channel fixture 5 to DMX address port 2 dimmer 24.
1 P ssDIM.

2 Enter the dimmer number on the numeric keypad.

3 Press CHANNEL and 5.

4 Press ENTER.

OR

1 Select channel 5.

2 Press DIM.

3 Press 2 (the port) / (slash) 24 (dimmer) or use the direct dimmer number, in this example,
536.

4 Press ENTER.
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To patch more than 1 DMX address to a channel (soft patch)

Example: Patch Port 2, DMX addresses 12 - 24 to channel 1. If DMX 12 - 24 are patched to
other channels, you first must clear these assignments.

1 Press DIM

2 Select the DMX addresses: 2/12 = 2/24.

3 Press CHANNEL and enter 1 on the numeric keypad.
4 Press ENTER

To clear patching
Example 1: Clear the patch assignment for channel 5 which is patched to port 1 DMX offset 5.
1 Press DELETE.
2 Select channel 5.
3 Press DIM.
4 Press ENTER.
The Delete dialog box opens.
5 Press ENTER again or tap DELETE in the dialog box

1 Press DELETE.
2 Press DIM.
3 Select the dimmer by pressing 1 5.
4 Press ENTER.
The Delete dialog box pens.
5 Press ENTER ag in o tap DELETE in the dialog box.
OR
1 Press DIM
2 Sele the dimmer by pressing 1/5.
3 Press CLEAR PATCH. The Delete dialog box opens.
4 Press ENTER or tap DELETE in the dialog box.

To patch external dimmers

Example: Channel 8, patched to DMX channel 8, is a fixture with a scroller. Patch the external
dimmer number, for the scroller, to DMX channel 108.

1 Press DIM and select the dimmer number, 108.
2 Tap EXTERNAL PARAMETER.

3 Select fixture channel 8.

4 Press ENTER.
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To set proportional dimmer level

Press DIM.
Enter the DMX address on the numeric keypad.
Tap PROPORTIONAL LEVEL.

W N -

Press @ and enter the proportional level on the numeric keypad or use the wheel labelled
Proportional Level.

5 Press ENTER

Select a fixture.
Press DIM.
Tap PROPORTIONAL PATCH.

W N -

Press @ and enter the proportional level on the numeric keypad or use the wheel labelled
Proportional Level.

5 Press ENTER
To clear proportional patch

1 Press DIM and chose the dimmer number u ing the numeric keypad.
2 Tap CLEAR PROPORTIONAL LEVEL
3 Press ENTER.

Test fixtures, dimmers, and DMX offsets

Test channels, dimmers, and DMX ffsets when in editor mode.

ATTENTION! When a d mmer is selected, the trackball can control the dimmer intensity.

To test dimmers

DIM # to select a dimmer.
2 Press @ ##, ZERO, FULL, or ON to set the test level.
3 Press NEXT or PREVIOUS.
The current selection fades to zero and the next (or previous DMX offset) fades to the set

level.

To test DMX offset

1 Press DIM and select the dimmer number using #/# format.

The first number is the DMX universe and the second number is the offset. Example: 2/4 is
DMX port 2, dimmer 4.

2 Set alevel using @ or ZERO or FULL or ON.
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Press NEXT or PREVIOUS.

The current selection fades to zero and the next (or previous DMX offset) fades to the set
level.

Note: When reaching the last offset for the DMX port, Vector automatically test the first
offset in the next port.

To test channels or spots

1
2
3

(E]

Select the spot or channel.
Set a dimmer level using @ ##, ZERO, FULL, or ON.
Press NEXT or PREVIOUS.

To test dimmers

1
2

DIM # to select a dimmer.

Press @ ##, ZERO, FULL, or ON to set the test level

Press ENTER.

Skip this step if you used the trackball to set he immer level.
Press NEXT or PREVIOUS.

The current selection fades to zero and th next (or previous DMX offset) fades to the set
level.

To test DMX offset

1

Press DIM and select the d mmer number using #/# format.

The first number is the DMX universe and the second number is the offset. Example: 2/4 is
DMX port 2 dimmer 4.

Set a level using @ or ZERO or FULL or ON or the Dimmer Test wheel.
Pres EN ER.
Press NEXT or PREVIOUS.

The current selection fades to zero and the next (or previous DMX offset) fades to the set
level.

Note: When reaching the last offset for the DMX port, Vector automatically test the first
offset in the next port.

To test channels or spots

1
2
3

Select the spot or channel.
Set a dimmer level using @ ##, ZERO, FULL, or ON.
Press NEXT or PREVIOUS.
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Tip! After pressing RESET you can still select the next or previous dimmer by pressing
DIM NEXT or PREV

To exit test mode

Press CLEAR, RELEASE, or RESET or move the intensity wheel. The last channel, spot,
dimmer, or offset tested, returns to its previous level.

To restore dimmer selection

Press DIM and @ to restore the last dimmer selection.

Identify fixtures and dimmers using Flash

The flash feature is an easy way to identify fixtures or dimmers.

To flash fixtures or dimmers

1 Select a single dimmer or fixture or select a range of d mmer or fixtures.
2 Tap FLASH on the Editor tool bar.
The selected dimmers or fixtures blink betw en 0% and 80%.

Examining the patch

You can examine the patch for all chann 1 and spots or individual channels and spots.

To examine the channel patc
1 Press CHANNEL.
2 Press EXAM. A list of the channels and their patch information is displayed.
OR

1 Press CHANNEL and select the channel number.

2 Pre s EXAM. The patch information for the selected channel is displayed.

To exam ne the spot patch

1 Press SPOT.
2 Press EXAM. A list of the channels and their patch information is displayed.

OR
1 Press SPOT and select the channel number.

2 Press EXAM. The patch information for the selected channel is displayed.

To examine the patch by sets

1 Press SET and select the channel number.

2 Press EXAM. The patch information for the selected set is displayed.
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Using park

Dimmers, spots, spot parameters, channels and cues can be parked at a specified level. Parked items
remain at the specified level and do not respond to level changes in the editor or to the general
master.

Park levels must be set using FL, ZERO, or @ and a numerical entry.
Note: The black out key (B.O.) also blacks out parked items.

There are two ways to view parked dimmers:

m [n the live fixture display - Parked dimmers are designated by an icon alongside th fixtu e
number.

m Through the Workspace - Parked dimmers and their parked values are di played

Parked dirmimer icor

M |ag

Figure 50: Parked dimmers on the live fixture display

Patch - Park

Dimmer Nu Fixture Parameter Fixt Park Value Dimmer Park Val
5.Ch_5 Dimmer
8.Ch_8  Dimmer Parked value
9.Ch_9 Dimmer
10.Ch_10 Dimmer

Figure 51: Parked dimmer exam via th Workspace tree » Park node

To park dimmers or DMX offsets
1 Press DIM
2 Enter the dimmer number (or DMX offset) on the numeric keypad.
3 Tap PARK (on the Editor tool bar).

4 Press @ and enter a level.

To r lease all parked dimmers or DMX offsets

DIM, PARK, RELEASE

To release selected parked dimmers

RELEASE, PARK, DIM, #, ENTER

To park a channel
Example: Park channel 8 at 25%.

1 Select channel 8.
2 Press PARK.
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3 Press @ and 25.
4 Press STORE.

Channel 8 is now parked at 25% intensity.

To release specific parked channels

CHANNEL # (- #), PARK, RELEASE

To park a spot’s dimmer parameter

1 Select spots.
2 Press FULL or ON.
3 Press PARK.

To park a parameter

1 Select the spot.
2 Select a parameter.
3 Press PARK.

4  Set the parameter’s parked level.

To park all parameters

1 Select spots.

2 Press @.

3 Press FULL or ON.
4 Press PARK.

To park multiple parameters

Example: Park all he parameters for a range of spots.
1 Selectt esp s.

2 Set arameter values.

3 Pr sSHIFT + PARK.

4 Press STORE.

To release all parked spots

SPOT, PARK, RELEASE

To release specific parked spots

SPOT # (— #), PARK, RELEASE

To release specific parked parameters

SPOT # (— #), parameter type and parameter, PARK, RELEASE
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To view parked dimmers and fixtures
1 Press DIM.
The Editor tool bar is now in dim mode.
Tap PARK.
3 Press EXAM.
The parked dimmers are flagged with an icon.
OR
Open the Workspace tree, expand the Patch node, and choose Park.

See, Figure 51

(E]

To park dimmers or DMX offsets

1 Press PARK.
Press DIM.

Press @ and enter a level.

a A WO DN

Press ENTER.

To release all parked dimmers or DMX offsets

RELEASE, PARK, DIM, ENTER

To release selected parked dimmers

RELEASE, PARK, DIM, #, ENTER

To park a channel

Example: Park hannel 8 at 25%.
1 Pr ss PARK.
2 S lect channel 8.
3 P ess@and 25.
Press ENTER.

Channel 8 is now parked at 25% intensity.

To release all parked channels

RELEASE, PARK, CHANNEL, ENTER

To release specific parked channels

RELEASE, PARK, CHANNEL # (= #), ENTER

To park a spot’s dimmer parameter

1 Press PARK.

Enter the dimmer number (or DMX offset) on the n mer keypad.

PATCHING
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2 Select spots.
3 Press FULL or ON.
4 Press ENTER.

To park a parameter
1 Press PARK.
2 Select the spot.
3 Select a parameter and set its level.

4 Press ENTER.

To park a spot’s dimmer parameter

1 Select spots.

Press PARK.
Press @.

Press FULL or ON.

g s W N

Press ENTER.

To park multiple parameters

Example: Park all the parameters for ara ge of pots.
1 Select the spots.

2 Set parameter values.

3 Press SHIFT + PARK.

4 Press ENTER.

To release all parked sp ts

RELEASE, PARK SPOT, ENTER

To releas specific parked spots

RELE SE, PARK, SPOT # (— #), ENTER

To r lease specific parked parameters

RELEASE, PARK, SPOT # (- #), parameter type and parameter, ENTER

To view parked dimmers
1 Press EXAM.
2 Press DIM.
The Editor tool bar is now in dim mode.
Tap PARK.
4 Press ENTER

The parked dimmers are flagged with an icon.
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Examining patch information

You can examine:

m Patch information for specific fixtures

m Each DMX universe

m Parked dimmers

To exam patch information for a specific fixture

1
2
3
4
5

Open the Workspace tree.
Expand the Patch node.
Expand the Sets node.
Expand the appropriate set.
Choose the fixture.

The fixture’s patch information is displayed in the activ pane or the default exam tab.

To exam patch information for a specific fixtu e

A WO DN -

(E]

Press CHANNEL or SPOT.

Enter the fixture number on the nume ic keypad.
Press DIM.

Press EXAM.

To exam patch informat on for a specific fixture

a A~ WOWDN =

Press EXAM

Press CHANNEL or SPOT.

E ter he fixture number on the numeric keypad.
Pr ss DIM.

Press ENTER.

To examine the patch for a DMX universe

H WO DN -

Open the Workspace tree.
Expand the Patch node.
Expand the DMX node.
Choose the DMX universe.

The patch information is displayed in the active pane or the default exam tab.
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AE

To view parked dimmers

Open the Workspace tree.
Expand the Patch node.

Tap DMX.

The DMX address exam opens.

g A W N -

Tap the Park tab to view parked dimmers.

Parked dimmer levels are displayed here.

To view parked dimmers

1 Press DIM.
2 Tap PARK. Parked dirmmer icor
3 Press EXAM. M |maz

The parked dimmer exam looks like this:




Chapter 5 Selecting and Controlling Fixtures

This chapter includes the following sections:

m Selecting fixtures (see page 91)

m Working with groups (see page 96)

m Resetting the editor (see page 102)

m Spot ignition (see page 102)

m Selecting parameters and controlling parameter values (see page 103)

m Selecting fixtures using Active (see page 118)

Selecting fixtures

Fixtures must be selected, so they are available for editing. Fixtures that have been assigned values
in the editor can then be stored as cues.

Selection options are available through th tou h screen buttons, on the Editor tool bar, and through
dedicated console keys. When the Inte activ Fixture Selection option (under the View menu) is
enabled, fixtures can be selected by t pping directly on the live fixture display.

Console keys used for fix ure selection

Key What it does

SPOT S t the keypad for spot selection.

CHANNEL Set the keypad for channel selection.

MATRIX Set the keypad for matrix or media server selection.

If both matrix and media server are patched, this key defaults to MATRIX.

Tip! If both matrix and media server are patched, program a macro
(SHIFT + SET 3/) for one press access to the media server set.
See “Storing macros” page 299.

MEDIA SERVER | Set the keypad for matrix or media server selection.
MEDIA SERVER shares the MATRIX key and is accessed using SHIFT.

Note: If there is no matrix patched the MATRIX key defaults to MEDIA
SERVER.

91%)
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Console keys used for fixture selection

Key What it does

SET Select fixtures using the set organizer.

Example: SET 0/ 1 = 12, selects channels 1 through 12.
Example: SET 1/ 1 = 12, selects spots 1 through 12.
Example: SET 2/ 100 = 200, selects fixtures in a matrix.
Example: SET 3/ 1 = 12, selects media server fixtures.
SET shares the GROUP key and is accessed using SHIFT.

0-9 Use for numeric entries.

- “Thru’ for range selections.

— Use to remove a fixture from a range selection.
Example: CHANNEL 1 - 5 — 4, selects channels 1 2, 3, 5.

+ Functions as an “and” key when used betwe n fixture selections.

Example: CHANNEL 1+ 3+ 7 +11, 1 cts hannels 1, 3, 7, and 11.

® or wheel Makes the last selection availab Ex mple: Before pressing RESET, the
selection was spots 1, 3, 6, and 8.

Press SPOT @ or move a p rameter wheel to access the last fixture selection.

Fixture Note: This is not a key on he console panel.

When fixture set numbe s are consecutive (not overlapping), the command
line numeric de ult is automatically set to Fixture.

Example Channels are numbered 1 = 100. Spots are numbered 101 — 164.

Sele t98 and channel 98 is selected; select 124 and spot 124 is selected.

To select sin le fixture

SPOT, 1. Sp t 1is displayed in the command line. All spot 1 parameters can now be assigned
paramet r values using the parameter wheels or console keys.

CHANNEL, 1. Channel 1 is displayed in the command line. The channel’s dimmer and, if
present, scroller can now be assigned values using the wheels or console keys.

To select a sequential range of fixtures

SPOT, 1, =, 24. Selects all the spots in the range.

To select a non-sequential range of fixtures

SPOT, 1, +, 6, +, 9. Selects spots 1, 6, and 9.

To clear a selection

Press RESET.
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Clears the editor, but the last selection is still available on the wheels and the fixture names
appear in yellow in the Live display.

OR
Press SHIFT + @,

The fixture selection and command line are cleared, but the editor values remain. The
command line defaults to the numeric default setting.

Note: To completely reset Vector, press SHIFT + RESET. Until this is done the last
selection is always available on the wheels.

Quick selection options

In selection mode, the Editor tool bar offers quick selection options for frequ ntly used selection

types.

Figure 52: Selection mode on the Editor toolbar

Button What it does g:&i‘;i:; y
LAST SELECTION Re-selects the last selecti n ® or wheel
ALL EDITOR Selects the entire e itor output. ACTIVE
EVERY Opens additi nal s lection filters.
USED IN SHOW Selects all th patched fixtures that have been used

inc es.

Filtering selections

The Editor tool ar p ovides selection filters. Pressing EVERY opens the selection filter options.

Intersect | Inwert Al

Figure 53: Every (selection) mode on the Editor tool bar
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BUTTON | What it does Console key
equivalents
EVERY Opens filter options. none
ODDS Selects every other fixture, within the designated range, starting 1
with the first fixture.
Examplel: The range 1 thru 8 is selected. Tapping ODDS selects 1,
3,5,and 7.
Example 2: The range 2 thru 8 is selected. Tapping ODDS selects
2.4, 6, and 8.
EVENS Selects every other fixture, within the designated range, starting 2
with the second fixture.
Examplel: The range 1thru 8 is selected. Using EVENS select 2,
4, and 6.
Example 2: The range 2 thru 8 is selected. Using EVENS s lects 3,
5,and 7.
3RD Selects every third fixture, within the designated r nge, starting 3
with the first fixture.
4TH Selects every fourth fixture within the de ignated range, starting 4
with the first fixture.
Note: Even though the T olbar buttons are only up to
4th (every fourth fi ture) you can enter any number on
the keypad.
/ Advance selection by a specified increment. /

Example: 4 /2, sel cts the second fixture in each group of four
fixtures.

Ther fore CHANNEL 1 = 20 EVERY 4 /2, selects channels 2, 6,
1 14, nd18.

To us the quick selection buttons

1 Press SPOT or CHANNEL.

Skip this step if the command default is the fixture type you want.

2 Select a range of fixtures.

3 Tap one of the quick selection buttons.

The selected fixtures are displayed in yellow in the live display (and are shown in the

command line) and are available for editing.

To grab the last selection

The last fixture selection can be quickly accessed.

Tap LAST SELECTION on the Editor tool bar.




VECTOR
SELECTING AND CONTROLLING FIXTURES

The last selection is highlighted in the live display and is displayed in the command line.

OR

Move any wheel. The wheel grabs the last selection.

OR

Press @. The last selection is highlighted in the live display and is displayed in the command
line.

Interactive fixture selection

You can select fixtures directly from the live channel, spot, media server, and matri displ ys. The
default setting for this feature is disabled.

To enable interactive fixture selection

Go to the View menu and tap @ (Interactive fixture selection)

To use the interactive fixture selection feature

In the live display, tap the fixture numbers to select th m

Selecting fixtures via the topo map
The topo map can be used to select fixtures See “Topo” page 305.
To select fixtures via the topo map
Tap single fixtures or drag y ur ointing device to mark multiple fixtures.

Note: Make sure the top view is not in edit mode. If topo is in edit mode dragging
fixtures moves them to a new location on the topo map.

Command line numerica default

A command line default can be set so Vector recognizes the first number entered as a belonging to
the def u obj ct. The default selection makes it unnecessary to select the object type. When the
editor is idle the command line default appears in parenthesis.

Command line default

I Mode: [T]la] Editor: [1]
Figure 54: Spot is the command line default

The command line numerical default can be set for:

* Spot * Channel <« Matrix * Media Server ¢ Fixture

* QList * Cue * Group * Dimmer
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To set the command line selection default

Example: Set the command line default for spot or channel.

1 Press SPOT twice. Spot appears in the command line. Vector now recognizes the first
number selection as spot selection, making it unnecessary to press this key before the
number selection.

Or
2 Press CHANNEL twice. Channel appears in the command line. Vector recognizes the first

number selection as a channel without needing to press this key.

Note: In the selection sequences examples, the instruction to press the keys SPOT r
CHANNEL is included for clarity. If the command line default is appropriatet the pe of
fixture selection there is no need to press these keys.

Working with groups

Groups are collections of frequently used fixture selections. They are used for quick editing selec-
tions. Groups can be combined and manipulated lik all her selection sequences. It is convenient
to save groups of fixtures that are related by type, unct n, or hanging position.

Automatic groups

Through the Generate Groups and Libs dial g box, Vector automatically generates fixture groups.

The automatic fixture group opti ns fo spots per device, channels, scrollers, matrix devices, and
media server devices, are:

m All

m Even

m Odd

m Every ird - counting from the first fixture of a device type.

m Every fourth - counting from the first fixture of a device type.
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You can choose to generate groups for some or all of the fixtures used in the show.

® Generate Groups and Libs

Generate All — Optian:

Color Start From:

Append |

] [1
[P Intensity

Align: I'ID
Image

Generate For Devices I All I Even I Odd

1.Channel I
502.Ch+Scrl 11F
1113.Mac 600 m:

3 | 4th

[<[<]<]

— If Exist

| Leave Ovenwrite

Update |

Figure 55: Generate libraries and groups dialog box

You can number groups to your convenience in the dialog box’s numbering area. The numbering

option fields are:

Start From Store the first generated group to the numb in his field and sequentially incre-

Align

ment the groups.

Choose an offset to leave space f r groups that will be stored later on. Generally,
it is convenient to chose an offs t that corresponds to your display set up.

Example: Assume that you h ve sized the soft keys pane to show 5 soft keys per
row. You choose to generate 5 groups for each fixture type. If the start number is
1 and the offset is 10, th generated groups will appear in every other row.

If there are existing groups yo can choose to:

m Leave them as is

m Overwrite them

m Update them

To ge

1

F N

0 N o O

rate groups automatically

Open the Tools menu and tap Generate Groups and Libs.
The dialog box opens.

Expand Generate All.

Make sure Groups is checked.

Expand Generate for Devices and make sure the devices you want organized into groups
are checked.

Set the start number in the Start from fields and the offset in the Align field.
Select the type of group (Even, Odd, All, 3rd, 4th).
Select the behavior (Leave, Overwrite. or Update).

Tap APPLY.
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Storing user-defined groups

Groups can contain any number of fixtures and fixture types.

To store groups
1 Select fixtures using any selection sequence.
2 Press STORE.
3 Tap a number on the group soft keys.
OR
1 Select fixtures using any selection sequence.
2 Press GROUP and enter a number on the numeric keypad.

3 Press STORE.

LE]

To store groups
1 Select fixtures using any selection sequenc
2 Press STORE
3 Tap a number on the group soft keys
OR
1 Select fixtures using any select n equence.
2 Press STORE.
3 Press GROUP and ente a number on the numeric keypad.

4 Press ENTER.

Tip! The elec ion order is saved with the group. Selection order controls how fan and

effects re applied to the selection.

Adding text tags to groups

To add text tags to groups
1 Select the group.
2 Press TEXT.
The Text dialog box opens.
Use the keyboard to type the group’s name.
4 Press STORE or tap OK.
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The dialog box closes.

OR

Immediately after storing the group, press TEXT and follow steps 3 and 4.

(E]

To add text tags to groups

1
2

Press TEXT.

Select the group.

Press ENTER.

The Text dialog box opens.

Use the keyboard to type the library name.

Press ENTER (on the console or the keyboard) or tap OK.
The dialog box closes.

OR

Immediately after storing the group, press TEXT and fo low teps 4 and 5.

Deleting groups

To delete groups

1
2

3

(E]

Select the group or select mo e than one group: GROUP # = #.
Press DELETE.

The Delete dial gb x opens.

Press DELETE gain or tap DELETE in the dialog box.

To delete groups

1

4

Press DELETE.

Select the group or select more than one group: GROUP # = #.
Press ENTER.

The Delete dialog box opens.

Press DELETE or ENTER again or tap DELETE in the dialog box.

OR

1
2
3

Press DELETE.
Tap the group soft key.
Press ENTER.
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Examining groups

To view a list of groups

Toggle the group soft keys to grid view by tapping . A list of groups is displayed in the
active pane.

Press GROUP and press EXAM.

LE)

Press EXAM, GROUP, and then press ENTER.

To examine a group
Example: Examine group 5
1 View the groups in grid format. If the group tab s in oft key format, toggle to grid view.
2 Double click on group 5.
The contents of the group are display d inth active pane.
Select group 5 and press EXAM.
The contents of the group ar displayed in the active pane.
Press EXAM, select he group, and press ENTER.
The conten s of the library are displayed in the active pane.

Copying groups

To copy roups
1 Select the source group.
2 Press COPY.
The group is copied to the clipboard.
Select the target group.
4 Press PASTE.
The new group is named Copy of Group # (source group).

Editing groups
When editing groups you can choose to:

m Overwrite the existing group with the selection.
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m Update by adding the selection to the group.

m Release the selected fixtures from the group

To add fixtures
1 Select fixtures.
2 Select the target group.
3 Press STORE.
The Object Exists dialog box opens.
4 Tap UPDATE.

The dialog box closes and the group is updated with the new inform tion

(E]

To add fixtures
1 Select fixtures.
2 Press STORE.
Select the target group’s number on the keyp d and press ENTER.
Or
Tap the group’s number on the group soft key pane.
4 Tap UPDATE.

The dialog box closes and th group is updated with the new information.

To release fixtures from groups
1 Press RELEASE
2 Select the ixtur s.
3 Tap the g oup’s soft key.
The group is updated.

Output location color code

The default color scheme for the console’s output shows the output source:
® Yellow - Fixture numbers for fixtures that are active in the editor.
m Red - Values currently under wheel control.
m White - Values in the editor, but not currently under wheel control.
m Blue - Output from AB.
m Yellow - Output from the faders or QKeys.

m Purple - Tracking on the master playback. (tracking mode only).
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m Red - Redundant tracking. (tracking mode only).

Values displayed in white and red are, by default, the values included when storing a cue.

Resetting the editor

Resetting the editor clears all selections and values in the editor. However, the last selection
remains active on the wheels. Example: Set a dimmer value for channel 1. Pressing RESET cle rs
channel 1 from the editor. Move the dimmer wheel and channel 1 is active. Your last sel ctio is
available until it is totally released.

To reset the editor
Press RESET. All values held in the editor are released in a 2 second fad
Or
Press RESET RESET quickly. All values held in the editor ump ut.
To clear the editor and release the last selection

Press SHIFT + RESET.

Note: This also clears the clipboard.

Default stage values

Pressing RESET, sends the paramete values to their default stage values.

Default stage values can be se as a device’s home values or as the last editor value. Set this option
in the Settings dialog box. See “About system settings” page 333.

Spot ignition
The Control picker allows access to all control features. The functions available in the picker
depend on the type of spot. Typical functions are:
Lamp on
m Lamp off

m Lamp reset

D
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VL2500 5 pot
RESET
Display
1.Lamp O 2RESET 3. Lamp OFF 4 Digplag OM

Figure 56: Control picker

To turn the lamp on
1 Select the spots.
2 On the Editor toolbar, tap CONTROL.
The Control picker opens.
3 Tap LAMP ON and CLOSE.

IMPORTANT! Spot ignition is a stand alone function. To on inue working, spots must
be selected again.

To turn the lamp off

1 Select the spots.
2 On the Editor toolbar, tap CON ROL.
The Control picker opens

3 Tap LAMP OFF and CLOSE.

To reset the fixture

1 Select the pots

2 On the Editor toolbar, tap CONTROL.
The Control picker opens.

3 Tap RESET and CLOSE.

Selecting parameters and controlling parameter values

Parameter values are set for channels, scroller channels, spots, matrix fixtures, and media server
fixtures. The wheels and keypad access all parameters.

Parameter values are displayed in the live displays. The parameter’s display format options are
found under the Format menu. See “Format menu and toolbar” page 55.
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Trackball

The trackball is generally reserved for pan and tilt. When fixtures do not have pan and tilt parame-
ters, such as RGB devices, the trackball will also function as a dimmer wheel.

Parameter wheels

The five flat encoders control all parameters. The Wheel Assignments (parameter to wheel) are
organized in banks. Parameters can be assigned to up to eight times in any wheel bank or layer.
Wheel assignments are made in the Device Builder.

Each parameter wheel has 2 associated keys. The left key pages the bank layer. The right ey
selects the parameter.

Wheel 1 - Switch wheel layer

Select parameter controlled by wheel 1

|| N N —

Parameter wheels
Figure 57: Parameter wh els parameter keys, and wheel bank paging keys

The vertical wheel con rol he dimmer for all fixtures. Intensity parameters are also assigned to
wheels in the ten ity wheel bank.

Although pan and t 1t are controlled by the trackball, they are also assigned to wheels in the position
wheel b k. Wheels work in normal or fine resolution (for 16-bit parameters). Wheels 3 and 4 are

used for fine resolution for 16-bit parameters.

ee, “To open the Wheel Assignments display” on page 59

Wheel banks

(Parameter types) Possible parameters

Intens | PO!

Figure 58: Parameter (type) bank keys

INTENSITY Dimmer, strobe

POSITION Pan, tilt, movement speed
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Wheel banks Possible parameters

(Parameter types)

COLOR Cyan, yellow, magenta, color wheels, color speed.
BEAM Focus, zoom, iris

IMAGE Gobo wheels, prism, gobo spin.

SHAPE Framing shutters, frost

To switch wheel banks

Press a wheel bank (parameter type) key.

The Wheel Assignments display shows the wheel bank for the select d parameter type. The
wheels can now be used to set values for the selected parameters.

To use the wheels at fine resolution
Press and hold SHIFT while turning the parameter wheel

Note: This is for 16-bit parameters only.

Selecting parameters

A parameter is automatically selected when s wheel is moved. When setting values for one param-
eter, all the parameters in that bank are act ve (appear in white) in the editor.

Individual parameters are selected by pre sing on the right side key of the key pair associated with
a particular wheel.

igure 59: Select a parameter by pressing the right key of the key pair (detail from Vector PC panel)

ATTENTION! In Vector Violet you can select a parameter by clicking on the wheel
itself

Double clicking on the wheel opens the picker for the parameters if the picker exists (for
example color wheel picker)

To switch bank layers and select a parameter

Use this procedure to select a parameter when there is more than one layer in the wheel bank.
Example: Go to layer 2 in the image bank wheels.

1 Select fixtures.
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2 Press IMAGE.

3 Press IMAGE again
Or
Press the left key of the key pair associated with a particular wheel.
Or

If there is more than one layer row displayed in the Wheel Assignments pane, click on the
layer displayed in blue. The selected parameter jumps to the first row. This is useful for
Vector Green and Vector Orange and also when working with blade parameters

Selecting parameters by parameter banks
Parameters can also be selected per parameter bank. Some uses for this feature include:
m Setting the same level for all parameters in a bank.
m Releasing all parameters in a bank.

m Ensuring all parameters in the bank are included when stor ng with the ONLY SELECTED
(RED) store option. See “Using store options” page 134.

To select parameters by bank
Press SHIFT + parameter bank.
The relevant parameters are selected
OR
1 Select fixtures.
2 Press SHIFT + parameter ank.
The relevant parameters are selected.
OR
1 Selecta gr up
2 Press SHIFT + parameter bank.

T ere evant parameters are selected for the fixtures in the group.

Adding parameters to the selection

Parameter selections remain active until the editor is cleared, by pressing RESET, CLEAR or
ENTER or by completing a procedure with STORE or UPDATE. This allows setting parameter time
across cells.

To add parameters to the selection
Example: Select spot 1 cyan and add spot 2 magenta to the selection.
1 Press SPOT and 1.
2 If necessary, press COLOR.
The wheels switch to the color bank.

3 Select cyan.
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4 Press SPOT and 2.

5 Select magenta.

Parameter modes

There are two modes of parameters:

m Continuous parameters wheel up from 0 (zr) to 100% (FL) with no internal divisions.

m Step parameters are defined with internal divisions. There can be continuous control between

steps or a step can transmit a preset value. Steps are commonly used for parameters ¢

both dimmer intensity and strobe and with gobo wheels and color wheels.

rolling

The display format for step parameters depends on the step’s definition in the Dev ce Builder

application. Some examples of step displays are: 2.FL (step 2 at its maximum alue) or text,

such as, Fast Strobe.

Step parameters can be defined with a stopper between steps or without a stopper between

steps. For steps with stoppers, a specific command must be giv n

For more information on step parameters. See “Editing paramet rs” page 422

To move from step to step

move between steps.

Use the parameter wheel to set the step values. When th re are no stoppers between steps,

moving the wheel moves from the highest value of one step to the lowest value of the next

step.

OR

Tap STEP UP or STEP DOWN, located on the Editor tool bar, to jump from step to step.

When there are stoppers betw en steps, the only way to move to the next or previous step is

by using these button

Setting parameter values

The wheels and trackball are used to set values for moving light parameters, channel dimmers, and

scrollers. Absolute values can be set using the numeric keypad.

When et g pan and tilt for 16-bit parameters, wheels 3 and 4 are used for fine movement.

S meb ons on the Editor tool bar, in parameter mode, can also be used for setting values.

Step Down Step Up

Figure 60: Parameter mode on the Editor tool bar

Button What it does

STEP DOWN Goes to the previous step.

STEP UP Goes to the next step.

+@ Adds the selected value to the parameter’s current value.

-@ Subtracts the selected value from the parameter’s current value.
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To set dimmer intensity
Select the fixtures and use the vertical wheel.

OR
Switch to the INTENS(ity) wheel bank and use the encoder dimmer wheel.

To set position
Select the fixtures and use the trackball to set pan and tilt

OR

Switch to the POS(ition) wheel bank and use the encoder wheels for pan and tilt

[ Intensity

Figure 61: Pan and tilt | locks are located adjacent t the trackball

To set parameter values

Example: Set parameter values for dimm r intensity, the color wheel, and the rotating gobo.
1 Select the fixtures.

2 Set the dimmer intensity using the vertical dimmer wheel or the encoder wheel that
controls the dimmer in the Intensity wheel bank

Or

Press @ and en er a two digit number on the numeric keypad. The spot's lamp is on at the
select d in nsity. The value is displayed on a red field in the editor.

3 Press COLOR to switch to the color wheel bank and use the appropriate wheel to set the
color value.

Or

Press the associated parameter key or tap COLOR WHEEL in the wheel assignment display
to select the parameter and enter a value on the numeric keypad.

4 Press IMAGE to switch to the image wheel bank and use the appropriate wheel to set the

gobo value.

Or

Press the associated parameter key or tap ROTATING GOBO in the wheel assignment
display to select the parameter and enter a value on the numeric keypad.
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To set parameter values

Example: Set values for dimmer intensity, the color wheel, and the rotating gobo.
1 Select the fixtures.

2 Set the dimmer intensity using the vertical dimmer wheel or the flat encoder the controls
the dimmer in the Intensity wheel bank

Or
Press @ and set a value using the numeric keypad. Then press ENTER.

The spot's lamp is on at the selected intensity. The dimmer intensity is displaye on a white
field.

3 Press COLOR to switch to the color wheel bank and use the appropr te wheel to set the
color value.

Or

Tap COLOR WHEEL in the wheel assignment display and set a value using the numeric
keypad.

4 Press ENTER. The color wheel goestothen wv 1 e.
Press IMAGE to switch to the image whee bank

6 Use the appropriate wheel to set th gobo
Or

Select the parameter by pr sing the associated parameter key or tap ROTATING GOBO in
the wheel assignment display, and enter a value on the numeric keypad.

7 Press ENTER. The rotat ng gobo goes to the new value.

Setting values using pickers
Vector has prese pickers for color and image parameters.

Gobo 1 Step B x|

Open Fylem Fin Fan Welvet Fold
v _.- —
.
Lumail Cybdg Broadband Parguet Tunnel

Figure 62: Gobo picker

Some pickers have more than one page. Use the PREVIOUS and NEXT buttons to page the picker
dialog box.

In the color pickers, you can design your own custom colors or choose colors from the Roscolux or
Lee Designers swatch book.
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2

Colors EHZ|

Work Mode:
Roscolux \ Store In Delste '
R | o | (T
R || RO (value )10 ]
R10 | R11 | Rz | R Display Uit

cyan: [0 |
O] ——cn
= =
——

Figure 63: Color picker for designing custom colors or choosing colors from swatch books
To set values using pickers

Example: Set a gobo value

1 Select fixtures.

2 Press IMAGE to switch to the image wheel ank
Skip this step if the wheels are already se to th image parameters.

3 Double click one of the gobo parameters in the Wheel Assignments display.
The gobo picker opens.

4 Tap the gobo of your choice.
The choice is immedia y app ied to the selected fixtures.

5 Tap CLOSE to close th picker.
Or

Mov gawhee closes the picker.

Or

pen nother picker by selecting a different parameter type and a parameter.

To cre e custom colors

1 Select fixtures.
2 Press COLOR to switch to the color wheel bank.
Skip this step if the Wheel Assignments already show the color parameters.
3 Double click a color parameter (not Color Wheel) in the Wheel Assignments display.
The color picker opens. Custom is the default that appears in the drop down list.
4 1In the Display Unit group, choose RGB or CMY.
Tap in the color palette area to select a color. This is the Hue.
The choice is immediately applied to the selected fixtures.

The color values are shown in the Display Unit fields.

Do
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To change the hue, tap in the color palette choosing another color,

Or
In the Work Mode group, tap HUE and use the color bar slider to change the hue.

To adjust the intensity of the hue, tap SATURATION and use the color bar slider to change
the tone.

All changes in the hue and saturation are immediately output to the fixtures.
When you are satisfied with the color, tap store in and tap a button.
The color is stored.

Tap CLOSE to close the picker.

Setting values for multiple parameters using one wheel

Using one wheel to simultaneously assigning values for multiple parameters is especially useful

when adjusting blades and shutters.

To set values for multiple parameters

1
2

3

Select the fixtures.

Select the parameters by pressing their sele t n keys.

Or

Press SHIFT + a parameter bank key o select all the parameters in the bank.

Press @ and move any wheel ssoci ted with one of the selected parameters.

Setting absolute values

Absolute values are set by select ng a parameter and entering a value on the numeric keypad.

To set values using the numeric keypad

Examp : Set dimmer at 60%, pan at 40, tilt at 35, and cyan at 20.

1
2

N o g A~ W

Se tthe fixtures.

Press @ 60.

The dimmer intensity is set to 60%.

Press POSITION to switch the wheel bank.

Tap PAN to select the parameter and enter 40 on the numeric keypad.
Tap TILT and enter 35 on the numeric keypad.

Press COLOR to switch the wheel bank.

Tap CYAN and enter 20 on the numeric keypad.
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To set values using the numeric keypad

Example: Set dimmer at 60%, pan at 40, tilt at 35, and cyan at 20.
1 Select the fixtures.

2 Press @ 60.

3 Press ENTER.

The dimmer intensity is set to 60%.

Press POSITION to switch the wheel bank.

Tap PAN to select the parameter.

Enter 40 on the numeric keypad.

~N o o S

Press ENTER.

The position is updated with the new value.

©

Tap TILT and enter 35 on the numeric keypad.
Press ENTER.

The position is updated with the new value

10 Press COLOR to switch the wheel bank.

11 Tap CYAN and enter 20 on the numeric eypad.
12 Press ENTER.

The color is updated with the n w value.

Quick value keys

Frequently used values h e dedicated keys and buttons:

FULL Sets he elected parameter to 100%.

ON Sets the selected parameter to the value set in the System Settings dialog
box. the default value is 50%.

Z RO Sets the selected parameter to 0%.

HOME Sets the selected parameter to its home value. Home values are defined in
the Device Builder.

+@ Increase the parameter level by a specific percent. This button is located

on the Editor toolbar in selection mode.

-@ Decrease the parameter level by a specific percent. This button is located
on the editor toolbar in selection mode.

O Apply last value. The last parameter value chosen remains available until
a new value is set. Thus, you can reuse the same value many times.

D
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Note: @ FULL, ON, ZERO, and HOME are immediately output. There is now need

to complete the command by pressing ENTER.

To change the level by a specific percent

1 Make sure the fixture and parameter are selected in the editor.

2 Tap +@ or -@ on the Editor toolbar.

3 Enter a percentage on the numeric keypad. Example: -@ 10 brings the level down 10%.

To apply last parameter value

Example: Spots 1 - 6 have cyan set at 20%. You can easily apply the same value to magenta.

1 Select the spots and select cyan.
2 Press @. and 20 on the keypad.
Cyan is now set to 20%.
Select magenta.
4 Press @.
Press @.

Magenta is now set to 20% also.

Copying and pasting values
Parameter values can be copied from one pot nd pasted to other spots.

Copy and paste:
m All values
m Values from an entire parameter bank

m The value from a single parameter

To copy and paste all values

Examp : Copy the all parameter values from spot 1 to spots 6 through 8.

1 Se ctspotl.

2 Press COPY.
all parameters values are copied to the clipboard.
Select spots 6 through 8.

4 Press PASTE.

To copy and paste parameter bank values

Example: Copy the color values from spot 1 to spots 6 through 8.
1 Select spot 1.

2 Press COLOR to choose the color bank.

3 Press COPY.
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The spot 1 color values are copied to the clipboard.
4 Select spots 6 through 8.
5 Press PASTE.
The color values copied from spot 1 are pasted to spots 6 through 8.

To copy and paste values for single parameters
Example: Copy the cyan value from spot 1 to spots 6 through 8.
1 Select spot 1.
2 Press COLOR to choose the color bank.
3 Press the selection key for Cyan.
4 Press COPY.
Cyan’s value is copied to the clipboard.
Select spots 6 through 8.
6 Press PASTE.

Cyan’s value is pasted to spots 6 through 8.

Flip pan and tilt

The flip feature reverses the pan and tilt axes 180 degrees, returning to the fixture’s current position.
This is useful for yokes and fixtures whose h  ds have 360 degree movement.

Example: In its current position, a yok 1 at he limit of its pan movement. To continue moving the
yoke on its pan axis, apply the flip fe ture. The yoke returns to its current position without the
movement limit.

To flip a fixture

1 Select the fixtur (s).
2 Tap FLIP on the Editor toolbar.

Changing pan and tilt orientation

You can change the pan and tilt orientation for any spot from the Editor tool bar without going into
th P tch Manager.

Tapping PAN/TILT PATCH, on the Editor tool bar, provides three options to logically orient the
pan and tilt directions to trackball movement.

- Swap
Invert Pan Invert Tile ‘ Pan/Tit

Figure 64: Pan/Tilt mode on the Editor tool bar
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Button What it does

INVERT PAN Switch the full and zero values for pan.

INVERT TILT Switch the full and zero values for tilt.

SWAP PAN/TILT | Pan becomes tilt and tilt becomes pan.

To change pan/tilt orientation
1 Select spots.
2 Select pan or tilt.
Tap PAN/TILT PATCH.
The Editor tool bar switches to pan/tilt mode.

4 Tap the required option.

Parameter grouping

The PARAM GROUPING button appears on the Editor tool rin election mode. When PARAM
GROUPING is enabled all parameters belonging to he s me parameter type are active in the editor
during editing.

Example: If you are setting levels for cyan, all  lor parameters are active in the editor and will
subsequently be stored in the cue or library.

By disabling parameter grouping, you an is late a parameter. This allows you to filter libraries or
cues by storing only the selected par meter(s).

Example: The color paramete type includes cyan, magenta, yellow, color wheel 1, and color wheel
2. To store a library or cu that includes only color wheel 1, set parameter grouping to off and then
set the level for color wheel 1

The paramete grouping default is set in the System Settings dialog box and can be toggled on or
off from the Edit r tool bar. PARAMETER GROUPING always resets to the default setting in the
System Sett gs dialog box.

To iso ate parameters

Example: Parameter grouping is enabled in the System Settings dialog box. You want to store
a beam library that will contain only the iris levels.

1 Select the spots.
2 Tap PARAMETER GROUPING on the Editor toolbar.
The command line displays: Parameter Grouping Off.
3 Set the levels for the iris.
Only the iris is active in the editor.
4 Store a library using the usual procedure.
The library contains the iris parameter only.

The parameter grouping setting defaults to on.
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Resetting parameter values

Pressing RESET to clear the editor, returns parameter values to either their default stage values or
their home values. See “Default stage values” page 335.

Releasing parameter values

You can release fixtures, single or multiple parameters, or all parameters in the selected bank.
Released parameters and fixtures are not included when storing a cue. Released parameters fade to
default stage values in system release time.

To release fixtures
Select fixtures and press RELEASE.
_E]
To release fixtures

1 Press RELEASE.
2 Select fixtures.
3 press ENTER.

To release one or more parameters

1 Select fixtures.

2 Select the parameter by tapping h parameter in the wheel display or pressing the param-
eter key.

3 Press RELEASE.
To release all the parameters in a parameter bank

Example: Rele se all parameters in the color bank.
1 Sel ctfixt res.

2 P ssCOLOR.

3 Press RELEASE.

Homing parameter levels

Home levels are defined in the Device application for each device type.

To home all parameters

1 Select the spots.
2 Press HOME.

All parameters, for the selected spots, are forced to home values and are active in the editor.

To home a selected parameter

1 Select the fixtures.

s



If necessary, select a parameter type.
Select the parameter.

Press HOME.
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The selected parameter goes to its home values in default sneak time.

To home parameters grouped in the same wheel bank

Example: Home values for all parameters in the image bank.

1
2
3

Select the fixtures.
Press IMAGE.
Press HOME.

The parameters go to their home values in default sneak time.

Programming a home cue

Occasionally a parameter’s home level, as set in the device definition, is not compatible with some

fixtures because of, for example, their hanging positions. You can store a fixture specific home cue,

which overrides home levels set in the device definition. V lues r fixtures not included in the

home cue go to the levels set in the device definitio

To program the home cue

1

a A W DN

Select the fixtures.

Select the parameters and  t the parameter levels.

Press CUE.
Press HOME.
Press STORE

To examine t e home cue

1
2
3

[E]

Pres CUE.
Pre HOME.
Press EXAM.

To program the home cue

o a A W DN

Select the fixtures.

Select the parameters and set the parameter levels.

Press STORE.
Press CUE.
Press HOME.
Press ENTER.



Compulite

Chapter 5

To examine the home cue
Press EXAM.

Press CUE.

Press HOME.

W N -

Press ENTER.

To delete the home cue
1 Press DELETE.
2 Press CUE.
3 Press HOME.
4 Tap DELETE or press ENTER.

Selecting fixtures using Active

Active is a selection tool. Pressing ACTIVE sets the Edit too bar to active mode. Use the tool bar
buttons to select fixtures, specify the output source, a d se onditions for selections.

Figure 65: The Editor tool bar in active mode

Note: For ACTIVE to work corr ctly, the command line must be idle. Press ENTER to
idle the command line befor b ginning these procedures.

Selection sources

There are three sources for fixture selection:
m Stage
m Editor
m Maste Playback

Button What it does

STAGE Grabs all parameters for all fixtures that comprise the lighting
state, on the condition that their dimmer values are more than
zero. It is unimportant whether the dimmer value is a hard value
or derived from tracking. This is the default.

EDITOR Grabs everything in the editor.

MASTER PB Grabs the parameters output from the master playback device.
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To select without specifying a source

You can make selections without specifying a source. The fixtures selected depends on the
console’s current state. If the last selection is still active on the wheel, all fixtures in the last
selection will be selected. If not all output will be selected. (See “Resetting the editor”
page 102)

Press SHIFT + ACTIVE.

The fixtures in the last selection are selected or all fixtures currently output are selected.

To select all active fixtures and parameters

SET, SHIFT, ACTIVE

To select all active spots and parameters

SPOT, SHIFT, ACTIVE

To select all active channels and values

CHANNEL, SHIFT, ACTIVE

To select fixtures output from the editor

Example: Channels 1 -> 10 are output from a pbd, hannels 15,25, 35, 45, 55, are in the editor.
Select only the editor channels.

1 Select channels: CHANNEL 1 55,

2 Press ACTIVE.

3 Press EDITOR. Channels 15 25, 35, 45, 55, are now under wheel control.
4 Press ENTER.

To select fixtures output from the master playback

1 Press ACT VE.
2 Tap MA TER PB.
3 Pres ENTER.

To select all active parameters in a parameter bank
Press SHIFT + a bank key.
OR

1 Select fixtures.

2 Seclect a parameter bank - press COLOR, BEAM, INTENSITY, POSITION, IMAGE, or
SHAPE.

3 Press ACTIVE.
The Editor tool bar is now in active mode.
4 Optional: choose a selection filter on the Editor tool bar.

Press ENTER.
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To select some of the fixtures comprising the lighting state

Example: Channels 1 thru 10 are output from the master playback, channels 70 through 82 are
output from QKey 1, and channels 15, 25, 35, 45, and, 55 are in the editor. Select the channels
from the master playback and the editor.

1 Select channels: CHANNEL 1-> 55.
2 Press ACTIVE.

Channels 1 thru 10, 15, 25, 35, 45, 55 are now under wheel control.
3 Press ENTER.

To select active fixtures by groups
Example: Select the even numbered spots that are active.
1 Press GROUP and select the group number.
2 Press ACTIVE.

The even numbered active spots are selected.

To remove fixtures from the selection

Example: Channels 1thru 10 are output from a pbd, hannels 15, 25, 35, 45, 55, are in the
editor. You want to select all the channels, ex ept hannels 8 and 45.

1 Select channels: CHANNEL 1 —55.

2 Press — (minus) and 8 on the numeri keypad. Press — (minus) again and 45 on the
numeric keypad. The command line shows the selection.

3 Press ACTIVE. Channels 1 thru 7, 9, 10, 15, 25, 35, 55 are now under wheel control.

Conditional selections

After choosing the sele tion source, you can apply conditions to refine the selection.

Button What it does

INVISIBLE PARAMETERS | Grabs parameters not visible onstage because dimmers are at zr.

INACT VE Grabs fixtures whose parameters are gray (not output from a play-
back device or not active in the editor).

EVERYTHING Grabs all fixtures and parameters, visible and not visible, that are
active in the editor or output from a playback device.

=@ Grabs a parameter at selected level.

<@ Grabs a parameter when it is less than the selected level.

>@ Grabs a parameter when it is more than the selected level.

To grab fixtures not visible on stage

1 Press ACTIVE.

2 Choose the output source.

i
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3 Tap INVISIBLE PARAMETERS.

To grab inactive fixtures
1 Press ACTIVE.

2 Choose the output source.

3 Tap INACTIVE.

To grab fixtures visible and not visible on stage

Fixtures who have no dimmer output are not visible, although parameters other than th
dimmer may be active.

1 Press ACTIVE.
2 Choose the output source.

3 Tap EVERYTHING.

To grab fixtures (parameters) at specified levels
Example 1: Grab all fixtures whose dimmer level is 75%.

Press ACTIVE.

If necessary, choose the output source.

Select the dimmer parameter.

Tap =@.

Press 7 and 5, on the keypad, to cho se the dimmer level.

o a A ON =

Press ENTER.

Fixtures, from the de gnat d output source, whose dimmer level is 75% are available for
editing.

Example 2: Grab all fixtures whose dimmer level is less than 75%.
Press ACT VE.

If necessary, choose the output source.

S lect he dimmer parameter.

Tap <@.

Press 7 and 5, on the keypad, to choose the dimmer level.

Press ENTER.

O O A W DN =

Fixtures, from the designated output source, whose dimmer level is 75% are available for
editing.

Example 3: Grab all fixtures whose dimmer level is more than 75%.
1 Press ACTIVE.

2 If necessary, choose the output source.

3 Select the dimmer parameter.

4 Tap >@.
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5 Press 7 and 5, on the keypad, to choose the dimmer level.
6 Press ENTER.

Fixtures, from the designated output source, whose dimmer level is 75% are available for
editing.

D



Chapter 6 Programming and Updating Cues
and QLists

All cues are organized into QLists. QLists can be played back on all of Vector’s playback devices.

This chapter contains the following sections:

m Working with QLists (see page 123)

m Working with cues (see page 126)

m Updating cues (see page 142)

m Programming and update options in tracking operation (see page 157)

m Fade times (see page 164)

m Loops (see page 172)

m Linking Cues (see page 174)

m Fan (see page 175)

m Temporary Cues (see page 183)

m Using the faders in channel mode (see page 185)
m Blind Editor (see page 185)

Working with QLists

All cues are org niz d nto QLists.

The default QList is the QList where new cues are automatically stored, unless Vector is instructed
to stor to ome other QList. The default QList is the QList loaded to the master playback.
See “M st r playback” page 196. Cues can be stored to QLists resident on all playback devices.

Playb ck device SELECT keys are used to store QLists and cues.

Vector supports 999 Q-Lists. Playback properties can be defined for individual QLists. See “Setting
up playback devices” page 215

Opening new QLists

New QLists can be opened on the master playback device and on all playback devices. Each new
QList automatically contains cue 0. Cue 0 is an empty cue.

To open a new QList

Example: Open a new QList, QList 1, on the AB crossfader.
1 Press QLIST and 1 on the numeric keypad.
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2 Press SELECT for AB. The command line shows: Playback AB Assigned. QList 1 will be
output from AB.

Adding text tags to QLists

QLists can be given text tags.

To add text tags to QLists
1 Directly after storing a QList, press TEXT. A text field opens.
2 Type a name on the alphanumeric keyboard.
3 Press STORE.
OR
1 Select the QList.
2 Press TEXT.
3 Type a name on the alphanumeric keyboard.
4 Press STORE.

_E]

To add text tags to QLists
1 Directly after storing a QList, press TEXT. A text field opens.
2 Type a name on the alphan meri keyboard.
3 Press ENTER.
OR
1 Select the QLi t
2 Typeanam on the alphanumeric keyboard.

3 Pre sENT R

Deleting QLists

To delete QLists

1 Select a QList or a range of QLists.
2 Press DELETE.
The Delete dialog box opens.
3 Press DELETE again or tap DELETE in the dialog box.
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To delete QLists
1 Press DELETE.
2 Sclect the QList.
3 Press DELETE or ENTER.
The Delete confirmation box is displayed.
4 Press DELETE or ENTER.again.
Or

Tap DELETE in the confirmation box. Deleted, displayed in the command line onfirms a
successful operation.

Examining QLists

To examine a list of QLists
Press QLIST and press EXAM.
OR
Toggle the QList soft keys to grid view y tapping . A list of QLists is displayed in the
active pane.
To examine a QList
Example: Exam QList 5
1 Select QList 5.
2 Press EXAM.
The con ents fthe group are displayed in the active pane.
OR
1 Ift QList tab is in soft key format, toggle to grid format.
2 Double click on QList 5.

The contents of the QList are displayed in the active pane.

[E]

To examine a list of QLists

1 Press EXAM.
2 Press QLIST.
3 Press ENTER.

OR



Compulite
Chapter 6

Toggle the QList soft keys to grid view by tapping . A list of QLists is displayed in the
active pane.

To examine a QList
Example: Exam QList 5.
1 Press EXAM.
The contents of the group are displayed in the active pane.
2 Select QList 5.
Press ENTER.
OR
1 If the QList tab is in soft key format, toggle to grid format.
2 Double click on QList 5.

The contents of the QList are displayed in the active pane.

Copying QLists
All cues in the source QList are copied to the new QList

To copy a QList
Example: Copy QList 1 to a new QList QL1 21.
1 Select QList 1.
Press COPY.
Press QLIST and 21.
Press PASTE. In the QList soft tab, the text for soft key 21 is: Copy of 1.

g s W N

Optional: rename the new QList.

Working with cues

P ogramming cues consists of:

m Selecting fixtures

m Assigning parameter values

m Setting the fade times

m Storing the resulting lighting state as a cue in a QList.
In Compulite mode, storing a cue does not clear the editor.
In tracking mode, storing a cue clears the editor.
Cues can be numbered from 0.1 to 9999.99.

Much of Vector’s behavior when storing cues, is determined by the settings in the System Settings
dialog box P Behavior tab (See “‘Behavior” page 335.):
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m By default Vector is set to automatically load the stored cue on the master playback device.
You can change this setting in the System Settings dialog box P Behavior tabP Automatically
Assign to Playback.

Note: There are two conditions that, when present, do not load the stored cue to the
master playback: 1) If you are working in the blind editor and 2) If the intensity fader is at
Zero.

m The next available number is the current cue number incremented by the number that is set in
the Next Store Increment by Field in System Settings dialog box P Behavior tab.

m The STORE+ increment is set in the System Settings dialog box.

Storing cues

If you are storing cues to the QList on the master playback it is not necessary o pecify a QList
number, as Vector defaults to the QList on the master playback. If no cue number is specified when
storing a cue, the next available number in the QList is assigned to he n w cue.

Using STORE and SELECT is a fast way to store cues directly t a playback device.

STORE+ stores the editor as the next cue on the master playb ck device.

To store a cue to the master playback device

Example: Store a cue to the default QList the QList loaded to the master playback).
1 Select fixtures and assign value
2 Press CUE and enter a number on the numeric keypad.
3 Press STORE.
The cue is automatic 1ly added to the QList on the master playback.

The comm nd 1 ne shows: Playback AB Assigned: QList 1 Cue 1 Stored.

To add cues to he QList on the master playback device

Exam le: Store a new cue to the default QList (the QList loaded to the master playback).
1 S lect fixtures and assign values.
2 Press CUE and press NEXT.

The next available cue number is displayed in the command line with the QList number for
the cue on the master playback.

3 Press STORE.

The cue is automatically added to the QList on the master playback.
OR
1 Select fixtures and assign values.

2 Press STORE +.
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The editor is stored to the next available cue number. It is displayed in the command line
with the QList number for the cue on the master playback.

To store a cue to any playback device

Example: Store cue 1 in QList 11. QList 11 is resident in fader 6.
1 Select fixtures and assign values.
2 Press STORE.
3 Press SELECT for fader 6.
The command line shows: Playback 1/6: QList 11 Cue 1 Stored.
OR
1 Select fixtures and assign values.
2 Press QLIST 11.
3 Press CUE 1.
4 Press STORE.
The command line shows: Playback 1/6: QList 11 Cue 1 St red.

To add cues to the QList on any playback d vic

Example 1: Store cue 2 (the next available cu number) in QList 11, loaded on fader 6. The
next cue number is the current cue incremen ed by one.

1 Select fixtures and assign values
2 Press SELECT for fader 6.
The command line show : Playback 1/6: QList 11 Cue 2 Stored and the new cue is output

from the playback de ice.

Note: When storing cu us ng the default increment, it is not necessary to specify the cue
number before p essing STORE, SELECT.
Example 2: The last cue in QList 11 is cue 15. Store cue 20 in QList 11.
1 Sele fixtures and assign values.
Press QLIST 11. Skip this step if you are storing this cue to the master playback.
Press CUE and 20 on the numeric keypad.
Press STORE.
Press SELECT for fader 6.

g s WwN

The command line shows: Playback 1/6: QList 11 Cue 20 Stored and the new cue is output
from the playback device.

Note: If the fader (as intensity master) is at its bottom end stop, the QList does not
advance to the new cue.
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To store point cues

Example: Store cue 2.5 in QList 1 that is on the AB playback.

1
2
3
4

(E]

Select fixtures and assign values.
Press STORE.

Press 2 @ 5.

Press SELECT.

The command line shows: Playback AB Assigned: QList 1 Cue 2.5 Stored. Cue 2.5 is ou put
from AB.

To store a cue to the master playback device

Example: Store a cue to the default QList (the QList loaded to the master playback).

1 Select fixtures and assign values.
2 Press ENTER.
The values are output.
Press STORE.
4 Enter a cue number on the numeric keypad.
Press ENTER.
The cue is automatically added to the QList on the master playback.
OR
1 Select fixtures and assi ~ valu s.
2 Press ENTER. The val es are output.
3 Press STORE.

The editor s sto ed to the next available cue number. It is displayed in the command line
with th QList number for the cue on the master playback.

To add cues to the QList on the master playback device

Ex mple: Store a new cue to the default QList (the QList loaded to the master playback).

1
2

Select fixtures and assign values.
Press ENTER.

The values are output.

Press STORE+.

Press ENTER.

The editor is stored to the next available cue number. It is displayed in the command line
with the QList number for the cue on the master playback.

OR

1
2

Select fixtures and assign values.

Press ENTER.
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The values are output.
Press STORE.
4 Press CUE and press NEXT.

The next available cue number is displayed in the command line with the QList number for
the cue on the master playback.

5 Press ENTER.

The cue is automatically added to the QList on the master playback.

To store a cue to any playback device

Example: Store cue 1 in QList 11. QList 11 is resident in fader 6.
1 Select fixtures and assign values.

2 Press ENTER. The values are output.

3 Press STORE.

4 Press SELECT for fader 6.

The command line shows: Playback 1/6: QList 11 Cue 1 Sto ed and the cue is output from
the playback device.

OR

1 Select fixtures and assign values

2 Press ENTER. The values are output

3 Press STORE.

Select QLIST 11. Skip this s p if you are storing this cue to the master playback.
Press CUE, 1.

(<22 S ) B

Press ENTER.
The command line shows: Playback 1/6: QList 11 Cue 1 Stored and the cue is output from the
playb ck d vice.

To add cues to the QList on any playback device

Exampl 1: Store cue 2 (the next available cue number) in QList 11, loaded on fader 6. The
nex cue number is the current cue incremented by one.

Select fixtures and assign values.

2 Press ENTER. The values are output.

3 Press SELECT for fader 6.
The command line shows: Playback 1/6: QList 11 Cue 2 Stored and the cue is output from
the playback device.

Note: When storing cues using the default increment, it is not necessary to specify the cue
number before pressing STORE, SELECT.

Example 2: The last cue in QList 11 is cue 15. Store cue 20 in QList 11.

1 Select fixtures and assign values.
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Press ENTER. The values are output.

Press STORE.

Press QLIST 11. Skip this step if you are storing this cue to the master playback.
Press CUE and 20 on the numeric keypad.

Press SELECT for fader 6.

The command line shows: Playback 1/6: QList 11 Cue 20 Stored and the cue is output from
the playback device.

Note: If the fader (as intensity master) is at its bottom end stop, the QList does not

advance to the new cue.

To store point cues

Example: Store cue 2.5 in QList 1 that is on the AB playback.

1

a A WD

Select fixtures and assign values.
Press ENTER.

Press STORE.

Press 2 ® 5.

Press SELECT.

The command line shows: Playback AB Assig d: QList 1 Cue 2.5 Stored. Cue 2.5 is output
from AB.

Opening new QLists when storing cues

It is possible to store a cue and sim Itaneously open a new QList. The new QList uses the next

available QList number, which i the last stored QList number incremented by one.

To store a cue and open a new QList

Examp 1: Open a new QList and store the editor as cue 1.

1

2
3
4

(E]

Se ct fixtures and assign values.

Press STORE.

Press CUE.

Press SELECT for an empty playback device.

A QList, using the next available QList number, is created and the editor group is stored as
cue 1 in this new QList.

To store a cue and open a QList

Example 1: Open a new QList and store the editor as cue 1.

1
2

Select fixtures and assign values.

Press ENTER. The values are output.
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3 Press STORE.
4 Press CUE.
5 Press SELECT for an empty playback device.

A QList, using the next available QList number, is created and the editor group is stored as
cue 1 in this new QList.

Using soft keys to store cues

Using soft keys for a specific QList greatly enhances programming speed. See “Setting u_Soft
Keys” on page 38.

To store a cue to a QList using the soft keys

Example: Store cue 12 to QList 2.

1 Select fixtures and assign values.

2 Press STORE.

3 Tap 12 in the QList 2 soft key tab.

4 Optional - add a text tag to the cue. Press TE T to open the Text dialog box.

_E]
To store a cue to a QList using the sof keys

Example: Store cue 12 to QList 2.

—

Select fixtures and assig valu s.

2 Press ENTER. The val s are output.

3 Press STORE.

4 Tap 12inthe Q ist 2 soft key tab.

5 Optional add a text tag to the cue. Press TEXT to open the Text dialog box.

Preview cues wi h Try Cue

RY CUE allows previewing a cue before storing it. The editor is saved and can be previewed at
any me. The preview includes cue times and cell times. TRY CUES are not saved with the show
and therefore cannot be deleted. Saving a new TRY CUE overwrites the previous one. After saving
a try cue, TRY CUE has a light orange field.

To save a Try Cue

Select fixtures and set values.
Optional: Program unique parameter times.

If you have entered time values, press ENTER now.

W N -

On the Editor tool bar, tap TRY CUE.

The editor is now saved. The look can be recalled at anytime.
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At this point you can continue working, saving cues, saving libraries, etc.

To preview the Try Cue
1 On the Editor tool bar, tap TRY CUE.
2 Optional: enter fade-in time.
3 Press ENTER
The look fades in according to time settings.

You can now save the editor as a cue.

Note: If no fade time is specified, cut time (0 seconds) is used.

Using cues as programming building blocks

A quick way of selecting fixtures is by entering cues into the editor as an editable group. It is also
possible to load only specified values from cues to the editor or copy s cified values from cues to
the clipboard.

To use cues for fixture selection

1 Select the cue.
The command line shows the QList and the cue number.
2 Turn the dimmer wheel.

The fixtures, in the cue, are ent red int the editor. Turning the dimmer wheel, fades their
intensity from zero. Notice tha he ue has become a group in the editor and is no longer
linked to the source cue

3 Edit and save as a cu

To load values from elected fixtures to the editor

Select one or m re fixtures in the cue.
Sele t par meters.
Press @.

Se ect the cue.

a A WO N =

Press ENTER

All values from the selected fixtures are loaded from the cue to the editor.

To copy values from fixtures in a cue

1 Select one or more fixtures in the cue.

2 Select a parameter by choosing the parameter type (INTENS, POS, COLOR, BEAM,
IMAGE, SHAPE) and then selecting the specific parameter.

Press @.
4 Select the cue.

Press COPY.
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All parameter values from the selected fixtures are copied to the clipboard.

Using store options

The STORE OPTIONS button, on the Editor toolbar, provides added control over what is stored in
cues. You can choose to store all fixtures active in the editor or just some of them and whether all
parameters for the active spots are stored in the cue or not. The store options always revert to the

default as defined in the System Settings dialog box. STORE OPTIONS is available on the Editor
toolbar in select mode, parameter (levels) mode, and cue mode.

All Editor Only All Params alp MUl
(Red + Selected | All Stage for i Aa;ims E d'Lt] )
White) (Red) Selected e Sk

Figure 66: Store options mode on the Editor tool bar

Store options What is stored

ALL EDITOR (RED + WHITE) | All fixture values displayed in red ( lect d in the editor) and
white (active in the editor) are stored n the cue.

ONLY SELECTED (RED) Only fixture values displayed nr d (selected in the editor) are
stored in the cue.

ALL STAGE The entire lighting tate is stored in the cue.

ALL PARAMS FOR All parameter value for the selected (displayed in yellow)

SELECTED spots even if th dimmer is not active in the editor.

ALL PARAMS FOR ACTIVE | All arameter values for the active spots (displayed in yellow)
if the dimmer intensity for the fixture is more than zr.

Note: If the dimmer level is set at zr, this is also
considered as active parameter output.

MULTI EDITORS All data from the active editors is stored in the cue.
Note: Multi Editors can be enabled in Settings » Behavior.

To view t e store options

P ess TORE OPTIONS on the Editor toolbar. The option buttons are displayed.

Note: STORE OPTIONS is available after pressing CUE.

To program cues using store options
1 Select fixtures.
2 Setlevels.
3 Tap STORE OPTIONS.
The Editor tool bar shows the store options. ALL EDITOR is the default.
4 Tap one of the store options.

5 Press CUE and enter a cue number.
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6 Press STORE.

The cue is stored. The contents of the cue is determined by the selected store option.

(E]

To program cues using store options

1 Select fixtures.

2 Set levels.

3 Tap STORE OPTIONS.

The Editor tool bar shows the store options. ALL EDITOR is the default.
Tap one of the store options.

Press STORE

Press cue and enter a cue number.

N o o b~

Press ENTER.

The cue is stored. The contents of the cue is determine by th selected store option.

Adding text tags to cues

Text tags can be added to cues. Cues’ text tags appear i cue and playback displays.

To add text tags to cues

1 Directly after storing a cue, press TEXT. A text field opens.
2 Type a name on the alphanumeric keyboard.

3 Tap OK or press ENTER

OR
1 Select he QLi t (skip this if referring to the QList on the master playback).
2 Sel ctthe cue.
3 P ssTEXT.
The Text dialog box opens.
Type a name on the alphanumeric keyboard.

5 Tap OK or press ENTER.

(E]

To add text tags to cues

1 Directly after storing a cue, press TEXT. A text field opens.
2 Type a name on the alphanumeric keyboard.

3 Press ENTER.
OR
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Press TEXT.
Select the QList (skip this if referring to the QList on the master playback).

Select the cue.

W N -

Press ENTER.
The Text dialog box opens.
5 Type a name on the alphanumeric keyboard.

6 Press ENTER or tap OK.

Deleting cues

Individual cues or a range of cues can be deleted from QLists.

To delete a single cue

Example: Delete cue 9 from QList 5.
1 Select QList 5: QLIST, 5.
2 Select cue 9: CUE, 9.
3 Press DELETE.
The Delete confirmation box is displayed
4 Press DELETE again.

Or
Tap DELETE in the con mati n box.

Deleted, displayed in th command line confirms a successful operation.

To delete arange fcu s
Example: Dele cue 9 through 15 from QList 5.
1 Select QList 5: QLIST, 5.
2 S lect cues 5 through 9;: CUE 9 - 15.
3 P ess DELETE.
The Delete confirmation box is displayed.
4 Press DELETE again.
Or
Tap DELETE in the confirmation box.

Deleted, displayed in the command line confirms a successful deletion.

Diss
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To delete a single cue
Example: Delete cue 9 from QList 5.
1 Press DELETE.
2 Select QList 5: QLIST, 5.
3 Select cue 9: CUE, 9.
4 Press DELETE or ENTER.
The Delete confirmation box is displayed.
5 Press DELETE or ENTER again.
Or
Tap DELETE in the confirmation box.

Deleted, displayed in the command line confirms a success ul o eration.

To delete a range of cues
Example: Delete cue 9 through 15 from QList 5.
1 Select QList 5: QLIST, 5.
2 Select cues 5 through 9; CUE, 9,~,15
3 Press DELETE or ENTER.
The Delete confirmation box i displayed.
4 Press DELETE or ENTER ag in.
Or
Tap DELETE in he onfirmation box.

Deleted, di played in the command line confirms a successful operation.

To delete the urrent cue on the master playback device

1 Press DELETE.
2 Se ect the cue number.
Press ENTER.
The Delete confirmation box is displayed.

4 Press DELETE or ENTER.again.

Examining cues

Select cues for examination using the console keys, the soft tabs in grid mode, or the workspace
nodes. You can also view a track sheet that shows where specific fixtures are used in cues.

When examining cues, parameter levels are displayed using the playback color code. See “Master
playback color code” page 197. The title bar for cue sheet displays shows the playback device

source, if the cue is currently output, and the QList number and name.
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To examine a cue

1 Select the QList. Skip this step if the QList on the master playback.
2 Select the cue.

3 Press EXAM.

The cue details are displayed in the active pane.

LE]

To examine a cue
Press EXAM.
2 Select the QList.
Skip this step if the QList is on the master playback.

Select the cue.

4 Press ENTER.

The cue details are displayed in the active pane

To examine a cue using the workspace

See,“To view cue sheets” on page 35

To examine a cue using the soft ke s

See “Soft key and grid format displays” page 39

To view the track sheet

1 Select a fixture

2 PressE AM.

3 Tap he tab labelled Exam.

A tof QLists and the cues, where the selected fixture is active, is displayed.

E
To view the track sheet

1 Press EXAM.

2 Select a fixture.

3 Tap the tab labelled Exam.

A list of QLists and the cues, where the selected fixture is active, is displayed.

D iss
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Examining a QList track sheet

QList track sheets show the cues, the fixtures used in the cues, and the parameter levels in each
QList. You can view channels’ dimmer levels or spots’ parameter levels. You select what is
displayed, by choosing the fixture type and parameter in the controls located in the view pane’s
header.

fixture selection

parameter selection
T number of columns displayed

Dimmer ~ |M|Channel =

Figure 67: Track sheet controls in the pane header

IMPORTANT! To switch from viewing channels to viewing spot parameters the view
pane’s header must be visible.

To examine a QList track sheet

1 Select a QList.
2 Press EXAM.
3 Tap the tab labelled TSheet.

A list of cues, the fixtures in each ¢, and the cues where the selected fixture is active is
displayed.

4 To view channels, choose Chan el in the combo box list in the pane header.
To view spots, choose Sp t in the combo box list in the pane header.
To view matrix fixtures choose Matrix in the combo box list in the pane header.

To view media server devices, choose Media Server in the combo box list in the pane
header.

5 Select th parameter that you want to view in the combo box list in the pane header.

[E]

To exam ne a QList track sheet

Press EXAM.
2 Select a QList.
Press ENTER.
4 Tap the side tab labelled TSheet.

A list of cues, the fixtures in each cue, and the cues where the selected fixture is active is
displayed.

5 To view channels, choose Channel in the combo box list in the pane header.
To view spots, choose Spot in the combo box list in the pane header.

To view matrix fixtures, choose Matrix in the combo box list in the pane header.
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To view media server devices, choose Media Server in the combo box list in the pane
header.

Select the parameter that you want to view in the combo box list in the pane header.

Examining fixture usage

Vector tracks patched fixtures that are used in the show and fixtures that are patched, but not used in

the show. The mechanism that tracks this data is groups. Vector creates two groups, one for fixtures

used in the show (group 9001) and one for free fixtures (group 9002). These groups are aut m  i-
cally updated.

To view fixtures used in show

1

Press SPOT or CHANNEL.

The Editor tool bar is in fixture selection mode.
Tap USED IN SHOW.

Press EXAM.

The fixtures that are used in cues are group are displayed.

To view free fixtures

1

LE]

Press SPOT or CHANNEL.

The Editor tool bar is in fixtur selection mode.
Tap FREE IN SHOW.

Press EXAM.

The fixtures that have not been used yet are displayed.

To view fixtur s used in show

1
2

4

Press EXAM.

Press SPOT or CHANNEL.

The Editor tool bar is in fixture selection mode.

Tap USED IN SHOW.

The fixtures that are used in cues are groups are displayed.

Press ENTER.

To view free fixtures

1
2

3

837

Press EXAM.
Press SPOT or CHANNEL.
The Editor tool bar is in fixture selection mode.

Tap FREE IN SHOW.
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The fixtures that have not been used yet are displayed.
Press ENTER.

Copying and pasting cues

When copying cues or QLists, you copy the source cue (or QList) to the internal clipboard and then

paste it to the target cue number (or QList).

When the console is operating in Tracking mode, copying a cue opens the Copy Cue dialog box

which offers two options:

m STATE - Copies the entire cue state. including values that are tracking.

MOVE ONLY - Copies only the hard moves stored in the cue.

To copy and paste cues - Tracking mode

1
2

Select the cue.

Press COPY.

The Copy Cue dialog box opens.
Tap STATE or MOVE ONLY.

The cue data, according to the option you ele ed, is copied to the clipboard.

To copy and paste cues - Compulite mode

1

a A W DN

6

Select the source QList.

Skip this step if the QList on th master playback.
Select the source cue.

Press COPY to copy th cue to the clipboard.

Select the target QLi t and the new (target) cue number.
Press PASTE.

A su cessful operation is verified in the command line. The new cue’s text is: Copy of QList
# (s urce QList).

Opt onal - Rename the cue using the text editor.

To ¢ py an entire QList

Example: Copy all the cues from QList 1 to QList 2.

QLIST 1, COPY, QLIST 2, PASTE; The new QList’s text is: Copy of QList # (source QList).
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Editing cues

The STORE and the UPDATE keys can both be used when editing cues. The key you choose
depends on the type of sequence you have used.

As a rule of thumb, use UPDATE to edit cues that are output on one of the playback devices. Use
STORE for cues that are not output on a playback device.

Updating cues

Use UPDATE to modify cues that are currently output. Pressing UPDATE opens the Upda e ltems
dialog box.

The Update Items dialog box allows you to update cues and libraries. The cues affected by the
update are displayed in the cue column. The libraries affected by the update a  displayed in the
library column. You can update all the items that appear in the columns or update items selectively.

Undo is valid for all update actions.

a4 Cue ) Library

PB1/30L 4/Cuel ] Pasition 2/

AN QL1400 2 F sk ] Libraries that can

PB1/20L 3/ Cue 2 be updated.

PB1/1QL2/Cue5
\l /

Cues that are output from
playback devices and can
be updated at this time

Track Master PB Only Libs Delta

[ Cue Only Back Grab Al New To Master PB | |Update All | | Copy New

Update options
Figure 68: Update Items dialog box

S
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Using the Update dialog box options

Option What it does
GRAB ALL New values can be stored to cues currently output from playback devices,
on the condition that the cues are selected in the Cue column.
NEW TO MASTER | New values are stored in the cue output from the master playback. This is
PB the default.
MASTER PB Updates the cue on the master playback only.
ONLY
UPDATE ALL Updates all libraries where appropriate. The relevant libraries e di played
LIBS in the library column.
COPY NEW Copy the values active in the editor to the clipboard and us as a delta.
DELTA See “Delta options” page 153.
CUE ONLY The updated value(s) are for the current cue nly When fading to the next
(Tracking mode) cue the updated values return to the track d v lue.
BACK TRACK Change the value(s) in all the previ scu s
Tracki d
(Tracking mode) To update cues using ba ktr k
Example: Channel 1 is racking through the cues at 70%. Update cue 5
for channel 1 at 35% nd update the previous cues (cues 1 - 4) with
same value
1 Select ¢ annel 1 and set the intensity to 35%.
2 P ss UPDATE. The update items dialog box opens.
3 Tap BACK TRACK.
4 Tap OK. The value for channel 1 is updated in cues 1 - 5.
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Grab all

The term “new values™ refers to values for fixtures or parameters that are not in the cues output

from a playback device. Example:

loaded Channel/ . Channel/

Fader with Output Editor Fader Output
1QList 1 Cue 1 1-FL CHAN1->5@ 30 1QList 1 Cue 1 1-30
Choosing 4-30
GRAB ALL 5 30
2 QList 2 Cue 4 2-FL results in: 2QList 2 Cue 4 2-30
4-30
5-30
3QList 3 Cue 9 3-FL 3QList 3 Cue 9 3-30
4-30
5-30

Notice that the values for channels 1, 2, and 3 are updated in the cues where they originate and not
added to other cues. Channels 4 and 5, which do not ap ear in the original cues, are added to all of
the cues.

To update cues live 1

Vector’s current output is:

Playback Device QList | Cue |Spot |Dimmer

AB 2 2 10 65
(master playba k)

m Ch
d vice

ge t e dimmer value for the fixture in QList 2 cue 2 that is output from the A/B playback

1 Select spot 10 and modify the dimmer value.
2 Press UPDATE.

The Update ltems dialog box opens.

Make sure that AB/QL 2/CUE 2, in the Cue column, is selected.
4 Press UPDATE again or tap OK.

The cue is updated with the editor values.

The dialog box closes.

D1
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To update cues live 1

Vector’s current output is:

Playback Device QList Cue | Spot | Dimmer

AB 2 2 10 65
(master playback)

m Change the dimmer value for the fixture in QList 2 cue 2 that is output from the A/B playback

device.

1
2

Select spot 10 and modify the dimmer value.

Press ENTER.

The new dimmer value is output.

Press UPDATE.

The Update Items dialog box opens.

Make sure that AB/QL 2/CUE 2, in the Cue olumn i selected.

5 Press UPDATE again or tap OK or press ENTE

The cue is updated with the editor values

The dialog box closes.

To update cues live 2

Vector’s current ou put is:

Playback Devic QList | Cue | Spot |Dimmer | Pan/Tilt | Cyan
AB 2 2 10 Full 50/50

(master playback)

PBD 5 3 3 10 80

m Update QList 2 cue 2 (on AB) by changing the pan/tilt values to 60/60.

m Update QList 3 cue 3 (on playback device 5) by changing the cyan value to 50.

1

o aa A~ W DN

Select spot 10.

Set the pan/tilt values to 60/60.
For Enter syntax - Press ENTER.
Set the cyan value to 50.

For Enter syntax - Press ENTER.
Press UPDATE.
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The Update Items dialog box opens.

7 Make sure that both AB/QL 2/CUE 2 and PB1/QL 3/CUE 3, that appear in the Cue column,
are selected.

8 Deselect NEW TO MASTER PB.
Press UPDATE again or tap OK.
The dialog box closes.
Cues are updated with the editor values for the parameters that originate from each cue.

:The updated output is:

Playback Device QList | Cue |Spot |Dimmer |Pan/Tilt |Cyan

AB 2 2 10 Full 60/ 0
(master playback)
PBD 5 3 3 10 50

To update cues live 3

Vector’s current output is:

Playback Device QList | Cue | Spot | Dimmer | Pan/Tilt | Cyan

AB 2 2 10 Full 50/50
(master playback)
PBD 5 3 10 80

m Update List 3 cue 2 (on playback device 5) by changing the pan/tilt values to 60/60.
m DO NOT upd te values in QList 3 cue 3 (on AB).
1 S lect spot 10.
Set the pan/tilt values to 60/60.
For Enter syntax - Press ENTER.
Set the cyan value to 50.

For Enter syntax - Press ENTER.

A s W N

Press UPDATE.

The Update ltems dialog box opens.

AB/QL 2/CUE 2 and PB5/QL 3/CUE 3 appear in the Cue column.

Attention! Both cues are selected.

7 Make sure that only PB5/QL 3/CUE 3 selected and tap GRAB NEW VALUES.
Press UPDATE again or tap OK.
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The dialog box closes. The cue on PBS5 is updated.
The updated output is:

Playback Device QList | Cue |Spot |Dimmer |Pan/Tilt | Cyan

AB 2 2 10 Full 50/50
(master playback)
PBD 5 3 3 10 60/60 80

Updating cues that are not output

Edit cues that are not currently output from a playback device and without entering hem to the
editor.

To update or overwrite a cue

1 Select fixtures and assign values.
2 Select the QList and the cue.
3 Press STORE.
The Object Exists dialog box opens.
4 Tap UPDATE or OVERWRITE.

(E]

To update or overwritea u

Select fixtures and assig values.
Press ENTER
Press STORE.

Select the QList and the cue.

a A O N -

ess ENTER.
The Object Exists dialog box opens.
6 Tap UPDATE or OVERWRITE.

Tip! Use the blind editor to update cues and avoid interfering with the lighting state on
stage. See “Blind Editor” page 185
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Updating output from selected playback devices

When cues are output from many playback devices, it is sometimes difficult to know exactly which
cue we want to update. PLAYBACK EDIT isolates the output from a specific playback device for
cue editing. For information about loading QLists to playback devices, see See,“To load a QList to
a playback device” on page 195

To edit output from a playback device

1 Press EDITOR.
Skip this step if the editor is idle.

2 Tap PLAYBACK EDIT.

3 Press SELECT for the playback device controlling the cue.
The cue is now active in the editor.

4 Edit the cue.

5 Press STORE.

LE]
To edit output from a playback device

1 Press EDITOR.
Skip this step if the editor is idl .

2 Tap PLAYBACK EDIT.

3 Press SELECT for the pl yback device controlling the cue.
The cue is now active in the editor.

4 Edit the cue.

5 Press UPD TE.

6 Pres ENTER.

Updating cues during their fade

Wh t happens when updating cues while they are fading in or out?

Example 1
The parameters have values in both cue 1 (fading out) and cue 2 (fading in).
Update cue 1.

Cuel Chan 1 @ FL | Editor: Press UPDATE:

(outgoing) Chan2 @ FL | Chan 1 @ 80 | The editor is released, in default system time,
Chan2 @80 |to the parameters’ current values and, if neces-

C'ue 2 ) Chan 1 @ 50 sary, the values complete their fade in the
(incoming) Chan 2 @ 50 remaining cue time.

s
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What happens when updating cues while they are fading in or out?

Example 2

Update cue 1.

The parameters do not have values in cue 2 (fading in).

Cue 1 Chan 1 @ FL Press UPDATE:

(outgoing) Chan 2 @ FL | Editor: Compulite mode - The editor is released and

Cue 2 Chan 3 @ 80 | Parameters fade to their released (or home)

.ue . value in system default time.

(incoming)
Tracking mode - The editor is release and
parameters fade to their tracked valu in
system default time.

Example 3

Update cue 2 (is fading in)

Cue 1 Chan 1 @ FL Press UPDATE:

(outgoing) Chan 2 @ FL | Editor: The editor is r leased in system time, but the

Cue 2 Chan 1 @ 50 Chan 3 @ 80 upifgeci eV lue tays where it is until the fade is

(incoming) Chan 2 @ 50 .

Updating fade times (Action syntax: CUE #, TIME # UPDATE) (Enter syntax: CUE #, UPDATE,
ENTER) during a fade does not change the t me f r the fade in progress. The new fade time is
used the next time the cue is running.

To edit cues during fades

Select fixtures and dit values, CUE #, UPDATE.

OR
CUE #, Sele

[E]

fixtures and edit values, STORE.

Select fixtures and edit values, CUE #, UPDATE, ENTER.

Releasing fixtures or parameters from cues

You can release fixtures or parameters from a range of cues.

When a fixture’s dimmer level is at zr (0%) Vector automatically releases it from the editor or the

cues:

m Compulite mode! When a fixture’s dimmer level is set to zr, it is released from the editor and

not stored.
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m Tracking mode! When a fixture’s dimmer level is set to zr, this is stored in the cue. If the
dimmer level remains unchanged in the next cue, no longer appears. The level zr does not
track. Example: In Cue 1, channel 1 intensity is at 75, in Cue 2, channel 1 intensity is set at zr
and it saved in the cue, in Cue 3 there is no change to channels 1’s intensity therefore is no
longer tracked and does not appear in cue 3.

Note: To change the parameter values’ fade time when releasing fixtures or parameters,
See “Default release time” on page 338.

To release fixtures from a range of cues

1 Select the cues.

2 Select the fixture(s).
3 Press RELEASE.

4 Press STORE.

The selected fixtures are released from the range of cue and the cues are stored.

To release parameters from a range of cues

Example: Release cyan and magenta fromcu s 1  orough 6.
1 If necessary, select the QList.
2 Select cues 1 thorough 6: CUE1 —> 6
3 Select the fixture(s).
4 Press COLOR.
The color wheel bank is now available.
5 Tap CYAN and MAGENTA.
6 Press RELEASE
Press STORE.

The selected parameters are released from the range of cues and the cues are stored.

LE}

To r lease fixtures from a range of cues
1 Select the cues.
2 Press RELEASE.
3 Select the fixture(s).
4 Press ENTER
The selected fixtures are released from the range of cues and the cues are stored.
OR
1 Tap EDIT CUE.

2 Select the cues.

Diso
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Select the fixture(s).
Press RELEASE.
Press ENTER.

The selected fixtures are released from the range of cues and the cues are stored.

To release parameters from a range of cues

Example: Release cyan and magenta from cues 1 thorough 6.

1
2
3
4

5
6

Press RELEASE.

Select the fixture(s).

Select cues 1 thorough 6: CUE 1 = 6.
Press COLOR.

The color wheel bank is now available.
Tap CYAN and MAGENTA.

Press ENTER.

The selected parameters are released from the range of cue and the cues are stored.

OR

O O A WO DN =

Tap EDIT CUE.

Select the fixture(s).
Select the cues.

Tap CYAN and MAGENTA
Press RELEASE.

Press ENTER.

The selected fix res re released from the range of cues and the cues are stored.

To change cue ext

1
2
3
4

(E]

S lect the QList and the cue.
P ess TEXT.
In the Text dialog box, overwrite the old text with the new text.

Press STORE

To change cue text

AW DN =

Select the QList and the cue.
Press TEXT.
In the Text dialog box, overwrite the old text with the new text.

Press ENTER.
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Exchanging parameter values

There may be instances where you need to exchange parameter values between two fixtures in one
or more cues.

There are two exchange options available on the Editor toolbar in select mode:
m EXCHANGE - Swap the values for all the parameters in the selected fixtures.

m EXCHANGE HTP - Set the dimmer value according to the highest value. Example: channel 1
is set at 80%; channel 10 is set at 35%. EXCHANGE HTP sets both channels at 80%.

To exchange parameter values

Example: Channel 1 is temporarily substituting for channel 10. You want to transfer channel
10’s dimmer levels to channel 1 in cues 5 through 12.

1 Select cues 5 through 12.

Press CHANNEL and 1 on the keypad to select channel 1.
Tap EXCHANGE.

Press 10 on the keypad to select channel 10

Press STORE.

g A~ WN

The dimmer levels in channels 1 and 10 are wapped in the selected cues.

LE]

To exchange parameter values

Example: Channel 1 is temp rarily substituting for channel 10. You want to transfer channel
10’s dimmer levels to channel 1 in cues 5 through 12.

Select cues 5 thr ugh 12.

Press CHANNE and 1 on the keypad to select channel 1.
Tap EXCHANGE.

Press 10 on the keypad to select channel 10.

Press UPDATE.

Press ENTER.

D s W N -

The dimmer levels in channels 1 and 10 are swapped in the selected cues.

Using Delta

D52

A delta saves absolute and relative modifications of spot parameter levels, channel intensity, and
scroller frames. Example: In a certain, channel 1 is at 50%. You update the level to 80% and copy
this value as a new delta. The delta values are: Absolute 80%, Relative +30.

Delta is used to edit cues by pasting the levels in the delta to the target cue. The levels stored in the
delta the values appearing in red or white, grabbed from the editor. The delta feature uses the copy
and paste functionality, therefore anything copied to the clipboard overwrites the delta. You can
store a new delta at any point in programming sequences. Vector supports one delta.
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There are three options when pasting the delta:
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m RELATIVE - Paste the relative values stored in the delta. This is the default option.

m ABSOLUTE - Paste the absolute values stored in the delta.

m ADD NEW - Paste delta values to parameters that have no values stored in the cue or tracking

through.

m COPY NEW DELTA - Grab the editor values and copy to the clipboard as the new delta

m PASTE NEW DELTA - Paste the contents of the clipboard according to the delta featur
constraints.

Figure 69: Delta mode on the Editor tool bar

Relative delta

Delta (as copied when editing Target Cue Ta get Cue after pasting

acue) elta

Channel 1 Absolute: 90 ||Channel | @ 35 Channel | @ 65
Relative: +30

Channel 2 Absolute: 90 ||Channel 2 @ 50 Channel 2 @ FL
Relative: +60

Channel 3 Absolute: 80 |{Chan el3 @ 30 Channel 3 @ 60
Relative: +30

Channel 4 Absolute: 30 ||Channel4 @ 80 Channel 4 @ 40
Relativ 4

Absolute del a

Delta (as c pied when editing Target Cue Target Cue after pasting

acue) delta

Channel 1 Absolute: 90 ||Channel 1 @ 60 Channel 1 90
Relative: +30

Channel 2 Absolute: 90 || Channel 2 @  zr Channel 2 90
Relative: +60

Channel 3 Absolute: 80 ||Channel 3 @ 30 Channel 3 80
Relative: +30

Channel 4 Absolute: 30 ||Channel4 @ 80 Channel 3 30
Relative: -40
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Add New delta

Delta (as copied when editing Target Cue Target Cue after pasting

a cue) delta

Channel 1 Absolute: 90 ||Channel 1 @ 60 Channel 1 @ 60
Relative: +30

Channel 2 Absolute: 90 || Channel 2 @ not in cue Channel 2@ 90
Relative: +60

Channel 3 Absolute: 80 ||Channel3 @ 30 Channel 3 @ 30
Relative: +30

Channel 4 Absolute: 30 ||Channel4 @ 80 Channel 4 @ 80
Relative: -40

To copy the delta from the editor

1 Select fixtures and adjust levels.
2 Press @.
3 Press COPY.
The absolute and relative values are ¢ pied f om the editor to the clipboard and are ready
for pasting.
OR
1 Select fixtures and adjust lev Is.
2 Press UPDATE.
The Update dialog b x opens.
3 Tap COPY NEW DELTA.
The abs lute nd relative values are copied from the editor to the clipboard and are ready

for pasting

To paste delta values

Example: Update cues 5 through 9 by pasting the levels in the delta.
1 Press CUE, 5, =, 9 to select cues 5 through 9.
2 Press PASTE.

The cues are updated with the new values.
Note: Using this sequence assumes pasting the relative values in the delta.

OR

1 Select cues.

2 Tap DELTA.

3 Optional: tap RELATIVE, ABSOLUTE, or ADD NEW.

D54
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4 Tap PASTE on the delta toolbar.

The cues are updated with the new values.

Renumbering cues

Renumber cues to eliminate point cues.

A few rules govern the renumbering of cues:

m Force-black cues retain their point numbering (#.#).

m Follow-on settings are deleted.

A warning message appears if the renumbering will overwrite existing cues.

ATTENTION! There is no undo after renumbering.

To renumber all the cues in the QList

A WO DN -

5

Select the QList.

Tap RENUMBER on the Editor tool bar.
Enter the start number for the first cue.
Press STORE.

Confirmation is requested.

Tap RENUMBER to confir ort p CANCEL to abort the renumbering operation.

To renumber a range of ues

a A WON =

6

Select the QLis

Select the ange of cues (CUE # = #).
Tap RENUMBER on the Editor tool bar.
Ent r the start number for the first cue.
Pre s STORE.

Confirmation is requested.

Tap RENUMBER to confirm or tap CANCEL to abort the renumbering operation.

To renumber cues with intervals

1
2

Select the QList.

Optional: Select the range of cues (CUE # = #).

If no range is selected, all the cues in the QList are renumbered.
Tap RENUMBER on the Editor tool bar.

Enter the start number for the first cue.

Tap JUMP EVERY.
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6 Enter the interval.
Press STORE.
Confirmation is requested.

8 Tap RENUMBER to confirm or tap CANCEL to abort the renumbering operation.

_E]
To renumber all the cues in the QList
1 Select the QList.
2 Tap RENUMBER on the editor tool bar.
3 Enter the start number for the first cue.
4 Press ENTER
Confirmation is requested.

5 Tap RENUMBER to confirm or tap CANCEL to abort the renumbering operation.

To renumber a range of cues
1 Select the QList.
2 Select the range of cues (CUE # - #).
3 Tap RENUMBER on the editor tool bar.
4 Enter the start number for the first ¢ e.
5 Press ENTER

Confirmation is requested

6 Tap RENUMBER to confirm or tap CANCEL to abort the renumbering operation.

To renumber cues with intervals

Select the QLis
Select th range of cues (CUE # = #).
Tap RENUMBER on the editor tool bar.

Tap JUMP EVERY.

1
2
3
4 En r the start number for the first cue.
5
6 Enter the interval.

7

Press ENTER.
Confirmation is requested.

8 Tap RENUMBER to confirm or tap CANCEL to abort the renumbering operation.

Diss
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Programming and update options in tracking operation

The Editor tool bar, in cue mode, shows buttons for editing cues in tracking mode.

S | i

Unblock :' 3 . Skj Prafile Delka

Figure 70: Cue mode on the Editor tool bar

Cue only

Updated values are valid only in the current cue. When fading to th nex cue, the parameters fade

to their tracked values.

ATTENTION! Cue Only interrupts the tracking. Ex mpl : In cues 1 through 5 cyan is set
at FL. Cue 3 is cue only with cyan at 50%. If yo go a k to cue 1 and adjust the cyan

value to 80%, cues 1 and 2 will be updated w h th new value. Since the tracking update

is interrupted at the Cue Only cue, the cy leve in cue 4 will be at FL, its original value.

The last cue in the QList cannot be programmed as Cue Only.

In Tools > System Settings > Behavio you can set cue only to be Vector’s default behavior for cue

editing.

Example: Update the pan value in cue 12 to 65% using the Cue Only feature.

Original Moves Tracking || Moves/Tracking after updating with Cue Only

Cue 11 Tracking 80 Cue 11 Tracking
Cue 12 Tr cking 80 Cue 12  Move
Cue 13 Tracking 80 Cue 13 Move - Fading from cue 12 to 13, the pan

value moves to original value

Cue 14 Tracking 80 Cue 14  Tracking

80
65
80

80

To store a cue as cue only

1 Select fixtures and assign values.

2 Press CUE and select a cue number.
3 Tap CUE ONLY.

4 Press STORE.

157 €
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To store a cue as cue only

Select fixtures and assign values.
Press ENTER.
Press STORE.

1
2
3
4 Press CUE and select a cue number.
5 Tap CUE ONLY.

6

Press ENTER.

To paste Cue Only cues
CUE ONLY can be applied when pasting cue data from the clipboard.
1 Copy cues or some of the cue information.

See “Copying and pasting cues” page 141.

2 Press CUE and select the cue number.
3 Tap CUE ONLY.
4 Press PASTE.

Edit cue

The selected cue is loaded to the maste playback and its fixtures and levels are active in the editor.
For use in tracking or Compulite modes

To edit a cue

—

Select the QL1 t and cue.

N

Tap EDIT CUE
Sel ct a fixture.
Th cue is loaded to the master playback and output.
4 Edit the cue.
5 Press UPDATE.
The Update dialog box opens.
6 Optional - choose on of the options in the dialog box.

Tap OK.

OR
Press CUE # ENTER. and continue with step 3.

Diss
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To edit a cue

-—

Select the QList and the cue.

N

Tap EDIT CUE.

w

Select a fixture.

The cue is loaded to the master playback and output.
Edit the cue.

Press UPDATE.

Optional - choose one of the options in the dialog box.

Press ENTER.

N o a M~

OR
Press CUE # ENTER and continue with step 3.

Load cue

The selected cue is loaded to the editor, but not outp t fr m the master playback.

To edit a lighting state
Press LOAD CUE.
Select the cue.
Carry out modificati ns.

1

2

3

4 Press ENTER.
5 Press UPDAT
6

Press NTER

(E]

To edit a ghting state

1 Press LOAD CUE.

2 Seclect the QList and the cue.
3 Carry out modifications.

4 Press ENTER.

5 Press UPDATE.

6 Press ENTER.
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Load state

The entire lighting state, including all tracked values, is loaded to the editor. This feature can be

used with Compulite mode also. Where appropriate (in tracking mode), new values are back-

tracked.

To edit a lighting state

1 Select the cue.
2 Press LOAD STATE.
3 Carry out modifications.
4 Press ENTER
5 Press UPDATE.
6 Press ENTER

_E]

To edit a lighting state
1 Press LOAD STATE.
2 Select the QList and the cue.
3 Carry out modifications.
4 Press ENTER
5 Press UPDATE.
6 Press ENTER

Skip

D60

Values in skip cues or sk p parameters are valid only for that particular cue. Fading to the next cue
restores paramet r values to the levels used in the cue before the skip cue.

Example: In ues 1 through 5 cyan is set at FL. You insert cue 2.5 with cyan at 50%, which is the
value orth cue only. In cue 3 you want the value to return to tracking (FL). In this case, program
cue 2.5 a “skip” cue.

Ski cues do not interrupt tracking. Example: In cues 1 through 5 cyan is set at FL. Cue 2.5 is a skip
cue with cyan at 50%. If you go back to cue 1 and adjust the cyan value to 80%, cues 2, 3, 4, and 5
will be updated with the value. The tracking update will ignore the skip cue.
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Example: Update the pan value in cue 12 to 65% using the Skip feature.
Original Moves/Tracking || Moves/Tracking after Skip
Cue 11 Tracking 80 Cue 11 Tracking 80
Cue 12 Tracking 80 Cue 12  Move 65
Cue 13 Tracking 80 Cue 13 Tracking - Fading from cue 12 to 13, the 80
pan value returns to tracked value.
Cue 14 Tracking 80 Cue 14  Tracking 0
It is also possible to skip specific parameters.
Example: Skip only the cyan parameter. Do not skip the yellow parameter.
Cue Egﬁ: or Cyan || Yellow || Cue| Moves/Tracking aft r Skip || Cyan || Yellow
11 Tracking 80 FL 11 Tracking 80 FL
12 Tracking 80 FL 12 Move - Only yan is set to skip. 65 50
13 Tracking 80 FL 13 * Cy returns to original 80 50
racked value.
* Yellow begins tracking from
its new value
14 Tracking 80 FL 14 Tracking 80 50

To program a skip cue

1 Selec the ue.

2

Tap SKIP

3 Press STORE.

T skip specific parameters

Example: Skip only the cyan parameter. Do not skip the yellow parameter.

1

a A WD

Select fixtures.

Set a value for yellow.

Set a value for cyan.

Make sure that the cyan values appear on a red field and tap SKIP.

Store the cue
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To program a skip cue
1 Select the cue.
2 Tap SKIP.
3 Press ENTER
To skip specific parameters
Example: Skip only the cyan parameter. Do not skip the yellow parameter.
1 Select fixtures.
2 Set a value for yellow and press ENTER.
3 Set a value for cyan and press ENTER.
4 Press STORE.
5 Enter the cue number.
6 Make sure that the cyan values appear on a red field nd tap SKIP.
7 Press ENTER.
Back track
Changes the value(s) in all the previous cue
To update cues using back trac
Example: Channel 1 is track ng t rough the cues at 70%. Update cue 5 setting channel 1 at
35% and update the prev ous ues (cues 1 - 4) with same value.
1 Select channel 1 and set the intensity to 35%.
2 Press UPDATE
The Update ltems dialog box opens.
Tap BACK TRACK.
4 Ta OK.
The value for channel 1 is updated in cues 1 - 5.
Block

D

‘When updating cues, no information tracks past the block cue.

To program a block cue
1 Select the cue.
2 Press BLOCK.
3 Press STORE.
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To program a block cue
1 Select the cue.
2 Tap BLOCK.
3 Press ENTER

Unblock

Cancel the block cue and reinstate tracking when updating cues.

To cancel a block cue
1 Select the cue.
2 Press UNBLOCK.
3 Press STORE.

(E]

To cancel a block cue
1 Select the cue.
2 Press UNBLOCK.
3 Press ENTER.

Loading cues to the editor

You can load cues to the editor retaining the link between the cue information and the cue or enter
cues to the editor with o t retaining the link to the specific cue.

When updating ¢ es, you will want to retain the link to the specific cue. If you are using the cue

information s a building block for a new cue, you will not care about maintaining the original cue’s
identit .

Ald
To load a cue to the editor for updating
1 Select the QList and the cue.
2 Press SPOT or CHANNEL.
The cue is now active in the editor and is captured on the master playback.
OR

1 On the Editor toolbar, tap LOAD STATE or LOAD CUE.
2 Press ENTER.
3 Select the QList and the cue.
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The cue is active in the editor.

To load a cue to the editor and store a new cue

Example: Load cue 5 to the editor, modify the values, and store a new cue.
1 Press CUE and 5 to select the cue.

Or

If the cue is available on a soft key, tap the cue’s soft key.

Press ENTER.
3 Modify the values in the editor, add fixtures, or remove fixtures.

4 Enter a number for the new cue and press STORE.

LE]

To load a cue to the editor and store a new cue

Example: Load cue 5 to the editor, modify the values, and s ore a new cue.

1 Press CUE and 5 to select the cue.

Or

If the cue is available on a soft key, tap the s soft key.

Press ENTER.

Modify the values in the edito add fixtures, or remove fixtures.
Press ENTER to see the changes.

Press STORE.

Press CUE am enter number for the new cue.

Press ENTER.

~N oo g A WN

Fade times

ime- n, time-out, delay-in, delay-out, and wait times may be set for cues and parameters.

If no times are set, the cue default time is used. The default cue time is 2.0 seconds. You can change
the default cue time in: Tools P Settings» Timing.

Press 0 to set a cut (bump) time.

Time-In Time-Out Delay-ln DeIay-Out Wait ‘ Profile

Figure 71: Time mode on the Editor tool bar

D164
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TIME

TIME IN

TIME OoUT

DELAY IN

DELAY oUT

WAIT

FOLLOW ON
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Function

Set the Editor toolbar to cue time mode. Set fade times for the
current cue on the master playback device.

On Go, all fixtures fading to higher values begin their fade. The
fade takes place in the set time.

On Go, all fixtures fading to lower values begin their fade. The
fade takes place in the set time.

If no time-out is set, time-out is identical to the time-in setting

On Go, all fixtures fading to higher values begin to coun the
delay time before beginning their fade.

On Go, all fixtures fading to lower values begin to count the
delay time before beginning their fade.

Pressing WAIT opens two options ont e Ed  toolbar:
FOLLOW ON and MANUAL.

Fade to the next cue with ut w iting for a Go command. Loops
use this setting.

A cue can be given a spe ific wait time. This is the move fade
time - the time that the f llowing cue waits before fading in. You
can use this to begin fade to the next cue before the fade to the
current cue is complete. Example: Cue 2’s fade time is 8 and
waittim 4. Four seconds after the fade to cue 2 begins, the
fade to will start. The fade to cue 2 continues until it is
complete. Both cues are fading at the same time.

Wait for a Go command before fading to the next cue. This is the
default.

Setting and editing fade times

You ¢ n set fade times for cues, parameters, or entire parameter banks.

To set cue fade times when programming

Example: Program fade times for cue 5 in QList 1.

Time:

Time in | Time out Delay in | Delay out Wait

Set to:

Default (4.5) 3.0 2.0 No assignment

1 Select fixtures and assign values.

2 Select QList 1: press QLIST, 1.

3 Press CUE and 5 on the numeric keypad.
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4 Press TIME.

The Editor tool bar is now in time mode.

Tap TIME IN and press 4.5 on the numeric keypad.
Tap DELAY IN and press 3 on the numeric keypad.
Press DELAY OUT and 2 on the numeric keypad.

0 N o o,

Press STORE.

To edit cue fade times

Example: Set 4.5 seconds fade- in time for QList 1 cue 5.
1 Select QList 1.
2 Select cue 5.
3 Press TIME.
The Editor tool bar is set to time mode.
4 Tap TIME IN and press 4.5 on the numeric keypad.
5 Press STORE.

OR
1 Press EXAM.
2 Select the QList.
3 Switch to grid view by tapping .
The cues in QList 1 are display d
Select cue 5.
Tap a fade time field to select it and enter the new time on the console’s number keypad or
on the external keyb ard.
To edit fade times for a range of cues
Example: Set 4.5 seconds fade- in time for QList 1 cues 5 — 10.
1 S lec QList 1.
2 Seectcues 5 - 10.
3 Press TIME.
The Editor tool bar is set to time mode.
4 Tap TIME IN and press 4.5 on the numeric keypad.
5 Press STORE.

To edit fade times for the current cue on the master playback device

Example: Set 4.5 seconds fade- in time for QList 1 cue 5.
1 Press TIME.
The Editor tool bar is set to time mode.

2 Tap TIME IN and press 4.5 on the numeric keypad.

D65
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Press STORE.

To set fade times for parameters

Example: Set a delay-in of 5 seconds for the color wheel.

1
2

(=]

Select the spots and set values.

Press COLOR.

The wheel assignments switch to the color bank.

Tap COLOR WHEEL or press the color wheel parameter key.
Press TIME.

The Editor tool bar is now in time mode.

Tap DELAY-IN and press 5 on the numeric keypad.

Optional - Display the time value in the parameter cell: Format» Time

To edit bank time

6

Select spots.

Select the bank by pressing one of the bank keys (IN ENS, POS, COLOR, BEAM, IMAGE,
SHAPE).

Press TIME.

The Editor tool bar is now in time mode.
Choose a time setting from the Ed ort ol bar.
Use the wheels or the keypad t set the time.

Press UPDATE, if editing a cue, or store a new cue.

To edit parameter fa e times

Example: Set a de y in time of 5 seconds for the color wheel parameter in QL1 Cue 5.

1
2
3

Select QLis 1 and cue 5.

Sel ct spot(s).

P ss COLOR

The wheel assignments switch to the color bank.
Tap COLOR WHEEL or press the color wheel key.
The Color Wheel parameter is selected.

Press TIME.

The Editor tool bar is set to time commands.

On the Editor tool bar, press DELAY IN and 5 on the numeric keypad.
Press STORE.

The parameter's time assignment is stored in the cue.

Optional - To display a time assignment in the parameter cell, choose the time icon in the
Format menu or tool bar.
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To release parameter fade times
1 Select QList 1 and cue 5.
2 Select spot(s).
3 Select the parameter.
4 Press TIME.

The Editor tool bar is set to time commands.

(3,

Press RELEASE.
6 Press STORE.

The parameter's time assignment released.
To set cue fade times when programming

Example: Program fade times for cue 5 in QList 1.

Time: Time in | Time out Delay in | De ay out Wait

Setto: |45 Default (4.5) 3.0 20 No assignment

1 Select fixtures and assign values.
2 Press ENTER.
3 Press STORE.
4 Select QList 1: press QLIST, 1.
5 Press CUE and 5 ont e numeric keypad.
6 Press TIME.
The Editor tool bar is set to time mode.
7 Tap TIME IN nd press 4.5 on the numeric keypad.
8 Tap DELAY IN and press 3 on the numeric keypad.
9 Pr ss DELAY OUT and 2 on the numeric keypad.
10 ess ENTER

To edit cue fade times
Example: Set 4.5 seconds fade- in time for QList 1 cue 5.
1 Select QList 1.
2 Select cue 5.
3 Press TIME.
The Editor tool bar is set to time mode.

4 Tap TIME IN and press 4.5 on the numeric keypad.

D iss
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Press ENTER.

OR

1
2
3
4

Press EXAM.

Select QList 1.

Press ENTER.

Switch to grid view by tapping .
The cues in QList 1 are displayed.
Select cue 5.

Tap a fade time field to select it and enter the new time on the console’s numb r keypad or
on the external keyboard.

To edit fade times for a range of cues

Example: Set 4.5 seconds fade- in time for QList 1 cues 5 = 10

1
2
3

Select QList 1.

Select cues 5 = 10.

Press TIME.

The Editor tool bar is set to time mode.

Tap TIME IN and press 4.5 on the num ic keypad.
Press ENTER.

To set fade times for the current ue on the master playback device

1

2
3

Press TIME.

The Editor tool ba is se to time mode.

Tap TIME IN and pre s the fade time on the numeric keypad.
Press ENT R.

To set pa ameter fade times

Example: Set a delay-in of 5 seconds for the color wheel.

1

2
3
4

[3,]

Select the spots and set values.

Press ENTER.

The values are output.

Press COLOR.

The wheel assignments switch to the color bank.

Tap COLOR WHEEL or press the color wheel parameter key.
Press TIME.

The Editor tool bar is now in time mode.

Tap DELAY-IN and press 5 on the numeric keypad.

Optional - Display the time value in the parameter cell: Format» Time.
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9

Press ENTER.

To edit bank time

0 N O 0 A~ W

Select spots.

Select the bank by pressing one of the bank keys (INTENS, POS, COLOR, BEAM, IMAGE,
SHAPE).

Press TIME.

The Editor tool bar is now in time mode.
Choose a time setting from the Editor tool bar.
Use the wheels or the keypad to set the time.
Press UPDATE, if editing, or store a new cue.

Press ENTER.

To edit parameter fade times

Example: Set a delay-in time of 5 seconds for the color wheel parameter in QL1 Cue 5.

1

g s, W N

8
9

Tap EDIT CUE.

Select QList 1 and cue 5.

Press ENTER.

Select spot(s).

Press COLOR.

The wheel assignments switch  the color bank.
Tap COLOR WHEEL or press the color wheel key.
The Color Wheel parameter is selected.

Press TIME.

The Editor ool ar is in time mode.

On the E itor tool bar, press DELAY IN and 5 on the numeric keypad.
Press ENTER.

10 Press UPDATE.

11 Press ENTER.

The parameter's time assignment is stored in the cue.

12 Optional - To display a time assignment in the parameter cell, choose the time icon in the

Format menu or tool bar.

To release parameter fade times

1
2
3

Select the cue.
Select the fixtures.

Select a parameter.
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More than one parameter can be selected and entire parameter banks can be selected via
Intens, Pos, Color, Beam, Image, Shape.

Press time.
Tap time In or Delay In or both.
Press delete.

Press update.

o N o a M

Press enter.

The fade times, for the selected parameters, are deleted.

=
~

Tap EDIT CUE.

Select QList 1 and cue 5.
Press ENTER.

Select spot(s).

Select the parameter.
Press RELEASE.

Press TIME.

0 N O g A ON -

Press ENTER.

The UPDATE LED blinks, indicatin UPDATE is required.
9 Press UPDATE.

10 Press ENTER.

Using the slash key (/) to set fade times

Each press on /, cycles through the time options. The current option is displayed in the command
line.

To use the slash key for setting fade times

—

Se ect the cue.

N

P ess TIME.
The command line displays QList # Cue # (parameter) Time-in #.
For time-in, enter the number of seconds now.

4 For Time-Out, Delay-In, Delay-Out, and Wait times, press the slash key (/) until the
required option is displayed in the command line.

5 To return to a previous option press SHIFT + /.

6 Press NEXT or PREV to toggle between manual and follow-on.

Deleting delay times

ATTENTION! Only delay times can be deleted.
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To delete delay times

Example: Delete the delay- in time set for cue 3 in QList 1.
1 Select QLists 1 and cue 3.
2 Press TIME.
The Editor toolbar is in time mode.
Tap DELAY - IN.
4 Press DELETE.
The delay time is deleted.

Loops

The loop feature strings together sequential cues. Loops can be used wi in QLists, like mini
chasers, to repeat a series of cues. Cues in loops fade according o th ir et fade times. Loop infor-
mation is displayed in the cue sheet, the playback displays, and the playback displays.

Loop type About

AUTO LOOP * Pressing GO to fade to the first cue in the loop initiates the entire loop.
The loop runs without any operator interference.

» Can repeat an infinite umber of times or can run a specified number of
loops. The def ult n mber of repeats is set to infinite. The digit O repre-
sents infini  loops.

* When to ing auto loops, Vector automatically sets the looped cues’ wait
time as follow-on.

MANUAL LOOP |+ Requ esa GO command for each cue in the loop sequence.

» Can repeat an infinite number of times or can run a specified number of
loops. The default number of repeats is set to infinite.

» The wait time for cues in this type of loop is manual.

AUT FO LOW | When reaching the end of a loop sequence Vector automatically fades to the
cue that follows the loop. Example: Cues 5 through 10 are set to loop 3
times. When auto follow is set, Vector fades to cue 11 after completing the
loops. This is not a valid selection if the auto loop is infinite.

Manual Auto Loop

Auto Loop Loop Follow Count

Figure 72: Loop mode on the Editor tool bar

S



VECTOR

PROGRAMMING AND UPDATING CUES AND QLISTS

Working with loops

To program an infinite auto loop

Example: Program a loop in QList 1, where cues 5 through 10 automatically loop an infinite.
number of repeats

1

2
3
4

Select QList 1. Skip this step if QList 1 is on the master playback.
Select cues 5 through 10: CUE, 5, =, 10.

Tap LOOP on the Editor toolbar.

Press STORE or ENTER.

To program a finite auto loop

Example: Program a loop in QList 1, where cues 5 through 10 loop thr e tim s.

1
2
3
4

5

Select QList 1. Skip this step if QList 1 is on the master playback.
Select cues 5 through 10: CUE, 5, =, 10.

Tap LOOP on the Editor toolbar.

Press 3 on the numeric keypad.

On the Editor toolbar, loop count is displaye in o nge.

Press STORE or ENTER.

To program an infinite manual loop

Example: Program a loop in QLis 1, where cues 5 through 10 automatically loop.

1

a A WD

Select QList 1. Skip this tep if QList 1 is on the master playback.
Select cues 5 through 10: CUE 5 = 10.

Tap LOOP on the Edi or toolbar.

Tap MANUAL OORP.

Press STOR or ENTER.

To program an infinite manual loop

Ex mple: Program a loop in QList 1, where cues 5 through 10 automatically loop.

1

a A WO DN

Select QList 1. Skip this step if QList 1 is on the master playback.
Select cues 5 through 10: CUE 5 = 10.

Tap LOOP on the Editor toolbar.

Tap MANUAL LOOP.

Press STORE or ENTER.

To program a finite manual loop

Example: Program a loop in QList 1, where cues 5 through 10 automatically loop 6 times.

1
2

Select QList 1. Skip this step if QList 1 is on the master playback.
Select cues 5 through 10: CUE 5 = 10.
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3 Tap LOOP on the Editor toolbar.
4 Press 6.

5 Tap MANUAL LOOP.

6 Press STORE or ENTER.

To program an auto follow loop

Example: Create a looped chase in QList 1, where cues 5 through 10 automatically loop 6
times. Upon completion the is an automatic fade to cue 11 (the next cue).

1 Select QList 1. Skip this step if QList 1 is on the master playback.
2 Select cues 5 through 10: CUE 5 = 10.

3 Tap LOOP.

4 Press 6.

5 Tap AUTO FOLLOW.

6 Press STORE or ENTER.

To delete loops
1 Select the first cue in the loop.
2 Tap LOOP.
3 Press DELETE.

_E]
To delete loops

1 Press DELETE.

2 Select the frst ue in the loop.
3 Tap LOOP.

4 Pre sENTER

Playing back loops

S  “Loop playback” page 226

Linking Cues

You can link nonsequential cues.

m A forward link skips the cues in between the link. Example: Cue 5 is linked to cue 8. When cue
5 is the current cue, a go command initiates a fade to cue 8. The playback skips cues 6 and 7.

m A backward link returns to the first linked cue. Example: Cue 8 is linked to cue 5. When cue 8
is the current cue, a go command initiates a fade to cue 5.

D4
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To link cues

Example: Link cue 8 to cue 2.
1 Select cue 8.

2 Tap LINK on the Editor toolbar.
3 Press 2.

4 Press STORE or ENTER.

To delete links

Example: Delete the link from cue 8 to cue 2.
1 Select cue 8.

2 Tap LINK on the Editor tool bar.

3 Press DELETE.

(E]

To delete links
Example: Delete the link from cue 8 to cue 2
1 Press DELETE.
2 Select cue 8.
3 Tap LINK.
4 Press ENTER.

Fan

The fan feature ap lies spread values to spot parameters, channel intensity, and scroller values
according to heir selection order. The parameter wheels are used to set the spread. Spot parameters,
scroll rs a d channels can be fanned from the side, center, or mirrored.

Fan direction is selected on the Editor toolbar in fan mode:
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Fan toolbar

What it does

Left - Spread parameter values from the first fixture in selection. The
base value is taken from the first fixture in the selection. The offset
values decrease from the base value (the first fixture) to the last fixture.

Right - Spread parameter values from the last fixture in selection. The
base value is taken from the first fixture in the selection. The offset
values increase from the base value (the first fixture) to the last fixture.

Center mirror - Fan equally from center. The base value is taken from
the center fixture. Parameter values are fanned from the selection’s
center fixture to the last fixture and from the center fixture to th firs
fixture. The offset values increase from the middle to the ends.

Center diagonal - Fan from the center. The base value is t ken from the
center fixture. Fan from the center fixture to the last fixture in the selec-
tion with ascending values and from center to th firs fixture in the
selection with descending values. This can be use to create a seesaw
effect with pan or tilt.

Spread
MNegative

Flip the direction of the fan offset.

Fan
Groups

When fixture selection is through groups, fan values according to the
groups.

Fan Blocks

Create ad hoc block of sequential fixtures and fan parameter values
accordingly

When fan is active he k y’s LED is on. Selecting another parameter turns off the fan feature. Press

FAN again to re tivate.

The fan featu e can also be applied in the Effect Editor.

Exampl s of fan use:

m Colors - Apply fan to cyan. The result is light cyan to dark cyan according the selection order.

You can add a fan applied to yellow and get graduated shades of green.

m Iris - Applying fan to the iris, when the starting value of the first spot in the selection is a small

iris, gives you beams that ascend or descend in size.




Examples of fan types

Fan Left
The selection order:
fixtures 1 --=> 7

Values decredse

>
Q0O®®® OO

A

Base value
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Fan Right
The selection order:

fixtures 1 --> 7

Values increase

>
0O®®W®B OO

A

Base value

Center mirror
The selection order:
fixtures 1 --=> 7

Values increase  Values increase
<« } P
QO@0@6 ®@

Base value

Center diagonal
The selection order:
fixtures 1 --> 7

Values decrease  Values increase

« } '
Q26 e
A

Base value

Figure 73: Fan types

Tip! Use fan for qu ck library programming.

Working with the fan feature

Setting the spread

To choose the fan type and set the fan spread

1 Select a range of fixtures.

2 Optional - Select a parameter.

If no parameter is selected, the fan defaults to the dimmer parameter.

3 Press @ and enter a value range. Example: SPOT 1 > 6 @ 25 - 85.

The Editor tool bar in now fan mode.

Fan right is the default selection.

177 &)
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4 Optional - change the fan type.
5 If necessary, adjust the value offset using the appropriate parameter wheel.

6 Store as a cue.

OR
1 Select a range of fixtures and set values.
For spots, select a parameter and set the start or base value.
For channels, set the start or base value.
Base values are the value reference for the fan offset.
2 Press FAN.
The Editor tool bar in now fan mode.
Optional - change the fan type.
4 Use the appropriate parameter wheel to fan the selection.
Vector sets the offset according to the selected fan type and the fixture selection order.

5 Store as a cue.

_E]

To choose the fan type and set the fan sp ead

Select a range of fixtures.

2 Optional - Select a parameter.
If no parameter is selected the an defaults to the dimmer parameter.

3 Press @ and enter a pa meter value range. Example: SPOT 1 = 6 @ 25 — 85.
The Editor tool bar swit hes to fan mode.
Fan right is the defau t selection.
Press ENT R.

4

5 Opti nal change the fan type.

6 Opti nal - adjust the value offset using the appropriate parameter wheel
7

Store as a cue.

1 Select a range of fixtures and set values.
For spots, select a parameter and set the start or base value.
For channels, set the start or base value.
Base values are the value reference for the fan offset.
Press ENTER.
Press FAN.
The Editor tool bar in now fan mode.

4 Optional - change the fan type.

s
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5 Use the appropriate parameter wheel to fan the selection.
Vector sets the offset according to the selected fan type and the fixture selection order.

6 Store as a cue.

Fan timing

Use fan timing to create a quick and simple effect.

Tip! To view the fan time, change the display format to time settings: Format menu >
Time.

To set fan timing

Select fixtures.

Select a parameter and assign values.

Press TIME.

Optional - choose DELAY.

Enter a time range on the numeric keypad # = #.

Optional - change the fan type.

N o g A WON -

Store as a cue.

-—

Select fixtures.

Select a parameter an  assign values.

w

Press TIME.

The tool ba is n time mode.
Option 1 -ch ose DELAY.
Pre s FAN.

Ch ose the fan type.

Use the parameter wheel to set the spread.

o N o a b

Store as a cue.

[E]

To set fan timing

Select fixtures.
Select a parameter and assign values.

Press ENTER.

A WO DN -

Press TIME.

The tool bar is in time mode.
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5 Optional - choose DELAY.
6 Enter a time range on the numeric keypad - # = #.
7 Press ENTER.
8 Optional - change the fan type.
9 Store as a cue.
OR
1 Select fixtures.
2 Select a parameter and assign values
3 Press ENTER
4 Press TIME.
5 Optional - choose DELAY.
6 Press FAN.
7 Choose the fan type.
8 Use the parameter wheel to set the time.
9 Store as a cue.
Fan Group
When fixture selection is through groups, FAN GROUPS button fans values according to the
groups.
Group | Channels | Base level | Wheel After Group Fan
1 1+2 20%
2 3+4 40%
20% +60%
3 5 6 60%
4 +8 80%
1
<‘” F
20% 20% 40% 60% 60% 80% 80%

To fan values among groups

Press GROUP and select the groups (# — #).
2 Optional: Select a parameter.

The default parameter is dimmer.
3 Optional: Set the base value.

When no base value is set the fan begins from the current value.

Diso
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4 Press FAN.
5 Tap GROUP FAN on the Editor tool bar.

6 Turn the wheel that controls the selected parameter to fan values.

Note: Cancelling GROUP FAN reverts to the standard per fixture fan.
Enabling GROUP FAN again restores this function and again fans values per group.

Three parameters define the blocks of fixtures and application of the Fan Blocks feature

1

. Fixture block - The number of fixtures in each block. Each block is manipulated as a roup.

Example: If the fixture selection is 1 = 12 and the number of fixtures in the block s 4, the
fixture blocks are 1 = 4,5 = 8,9 = 12.

. Subdivide fixture blocks - Each subdivision is manipulated as a group. F  ning is applied to

each subdivision in each block. Example: If the fixture selection 1->12, and the number of
fixtures in the block is 4 with each block subdivided into 2 then the first two fixtures in each
group are subdivision 1 (fixtures 1 and 2, 5 and 6, 9 and 10) the next pair of fixtures are subdi-
vision 2 (fixtures 3 and 4, 7 and 8, 11 and 12). The dot (®) key precedes the number of subdi-
visions.

Offset fixture block: - The start fixture for fanning The slash key (/) precedes the offset selec-
tion. Example: If the fixture selection is 1 >12 nd the number of fixtures in the block is 4,

setting the offset to 2 makes fixture 2 th first fixture in the first block.Thus the fixture blocks
arenow 2 25,6 >9,10 = 12.

G

Fixtures 1 2 |3 |4 |5 |6 7 |18 |9 10 |11 |12
Define fixture blocks.
FAN BLOCKS value is 4 Block 1 Block 2 Block 3

4 is the number of fixtu es per 0 0 0 0 10 10 10 10 20 20 20 20
block. 12 fixtu es, ith4

fixtures per block produces 3
blocks

Note This s similar to the

up F n feature.

ubdivide the fixture blocks

FAN BLOCKS value is 4.2: Block 1 Block 2 Block 3

4 is the number of fixtures 0 0 20 20 0 0 20 20 0 0 20 20
per block

2 is the number of fixtures in
each subdivision.
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sz

Fixtures 17 (2 (3 (4 |5 (6 (7 (8 (9 (10 (11 (12

FAN BLOCK value is 6.2: Block 1 Block 2

* 6isthe numberof fixtures  §4 1o [10 |10 |20 [20 Jo |o |10 |10 |20 [20

per block

» 2 is the number of fixtures in
each subdivision.

Offset fan

FAN BLOCK value is 4/2: Block 1 Block 2 Block 3

* 4 is the number of fixtures NCclo 0 0 0 10 10 10 10 2 20 20

per block. *

» The fan is offset by 1. The
fan skips the first fixture.

Note the allocation of fixtures
into the blocks has changed.

* NC = No Change

To set the number of fixtures in a block

Example: Twenty fixtures are selected. Divid the selection into 4 blocks of 5 fixtures each.

D s W -

Select fixtures.

Press FAN.

Tap FAN BLOCKS.

Enter the number of fixtur s in the block. For this example, enter 4.
Use the paramet r wheel to set the fanned values.

Optional: Set fan timing by pressing time and enter an absolute value range (# g #) on the
keyp d or use the parameter wheel.

The time s allocated according to the blocks. Example:

To set a block’s internal subdivisions

Example: Twenty-four fixtures are selected. Divide the fixture selection into 4 blocks of 6

f xtures and subdivide each block into 3 groups of 2 fixtures each.

1
2

~N OO O A W

Select fixtures.

Press FAN.

Tap FAN BLOCKS.

Enter the number of fixture grouping.

Press @.

Enter the number of fixtures in each subdivision.

Use the parameter wheel to set the fanned values.
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To define the offset

1
2
3
4
5
6
7

Select fixtures.

Press FAN.

Tap FAN BLOCK.

Enter the number of fixture grouping.
Press /.

Enter the offset value.

Use the parameter wheel to set the fanned values.

Temporary Cues

Temporary cues are editor groups loaded to an empty playback dev ce T mporary cues can be

used, in conjunction with the Active feature, as building blocks f r cu s Temporary cues can easily

be stored as cues in QLists.

There a two methods for loading the fixtures for tempor ry cu s:

m Load fixtures without setting parameter levels Th fader controls the output level from zr -

FL, ignoring the values in the editor.

m Load fixtures with parameter levels. Th fader controls the output level from zr to the highest

specified level.

Working with temporary cues

To load a temporary cue

Example: Load s lect d fixtures to fader 6.

1

2

Select fixtu s
Or
Se cta group.
ess SELECT for fader 6

The command line shows: Playback 1/6: Temporary Cue Assigned. The fader controls the
output level from zr - FL.

To load a temporary cue with specific values

Example: Load the editor to fader 6.

1
2
3

Select fixtures or a group and set values.
Press STORE.
Press SELECT for fader 6.

The command line shows: Playback 1/6: Temporary Cue Assigned. The fader controls
values from zr to the level set for each fixture.
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To add fixtures to a temporary cue
Example: Add the editor group to the temporary cue on fader 6.
1 Select fixtures.
2 Press STORE.
3 Press SELECT for fader 6.
The Object Exists dialog box opens.
4 Tap UPDATE.

The new fixtures are added to the temporary cue.

To release fixtures from a temporary cue

Example: Release the fixtures in the editor from the temporary cue on fader 6.
1 Select fixtures.
2 Press STORE.
3 Press SELECT for fader 6.
The Object Exists dialog box opens.
4 Tap RELEASE.

The fixtures are removed from the tempo ary c

To overwrite a temporary cue

Example: Replace the temporary ue on fader 6 with the fixtures selected in the editor.
1 Select fixtures.
2 Press STORE.
3 Press SELECT f r fader 6.
The Object E ists dialog box opens.
4 Tap OVERWRITE.

The editor ontents replaces the fixtures the temporary cue.

To name emporary cues

1 Press TEXT. The text dialog box opens.

2 Press SELECT for the playback device with the temporary cue.
3 Use the keyboard to type the group’s name.

4 Tap OK.

To convert a temporary cue to a cue in a new QList

Example: The show contains QLists 1- 3. Covert the temporary cue on fader 6 to cue 1 in a
new QList (QList 4) and store the active editor as cue 2 in QList 4.

1 There is a temporary cue already loaded to fader 6.

2 Select fixtures and assign values.
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3 Press STORE.
4 Press select for fader 6.

The Object Exists dialog box opens.
5 Choose Create New QList.

The dialog box closes.

The command line shows: QList 4 Cue 2 Assigned. The new QList now has two cues; the
original temporary cue is now cue 1.

Using the faders in channel mode

You can create a look using the faders in channel mode and then store the loo as a cue.

When the faders are in channel mode, each fader controls one channel The number of fader pages
available are as many pages as necessary for the number of channels

Setting a channel level by moving a fader off its bottom end stop enters the channel to the editor.
Pressing RESET, fades the channel to zr in default sneak ime The fader automatically returns to its
bottom end stop.

Working in channel mode

To switch faders to channel mode

Press CHANNEL (located to h left of the faders)

To set levels and store a ue

Press CHANNE (loc ted to the left of the faders) to set the faders to channel mode.
If necessary, pa e to the channel needed.

Bring ch nnels into the editor by setting levels using the faders.

A WO DN -

Stor a cue using STORE+
Or
QLIST # CUE # STORE, or STORE SELECT.

5 Press RESET to release the channels from the editor.

Blind Editor

You can program and update cues in the blind editor. When the blind editor is active, the fixture
values in the live editors are not output.

When BLIND is active it is indicated in the command line: [[(z18L =) 2 =151 B =11 {13
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Using the blind editor

To activate the blind editor

Press BLIND.
The key’s LED is on.

To store cues in blind mode
1 Press BLIND to switch to the blind editor.

2 Select fixtures and assign values.
3 Use any store sequence, including STORE, SELECT.

Note: When storing a cue in blind mode, the playback device does not advan  to the

new cue.

To exit the blind editor

Press BLIND.

The key’s LED turns off and the blind editor indication i r moved from the command line.

Blind editing for incoming cues

This feature provides quick, blind editing of the incoming cue. When editing is completed, exiting
the blind editor is automatic.

To edit the incoming cue n the blind editor

1 Tap BLIND PB PREVIEW EDIT.
The blind editor is now active.
2 Press SEL CT for the playback outputting the cue.
The conte ts of the next (incoming) cue are active in the editor.

The ¢ mmand line shows the QList, cue number, and fixtures in cue. Example: QList 3, cue
6, hannel 3 > 14, spot 1 —> 12.

Select fixtures and set parameter levels.
4 Press UPDATE.
5 For Enter syntax - Press ENTER.

The incoming cue is updated and the blind editor closes.
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Chapter 7 Playback Devices and QList
Playback

This chapter includes the following sections:

m About playback devices (see page 187)

m Playback priorities (see page 193)

m Loading and freeing playback devices (see page 194)

m Master playback (see page 196)

m Playback device controls (see page 199)

m Vector Violet Playback and Q-Key functionality (see page 204)

m General master (see page 207)

m Playback displays (see page 208)

m Setting up playback devices (see page 215)

m Controlling fade rates (see page 222)

m Loop playback (see page 226)

m Snaps (see page 231)

m Chases (see page 228)

m Editor fades (see page 224)

About playback devices

Vector' p yback devices are:
m AB ossfader
m Motorized (or non-motorized) faders
m QKeys

All playback devices have a Select key (top key) that allows loading a QList or a temporary cue and
also serves to designate the master playback device, see "Master playback” page 196. When the

playback device is designated as the master playback the Select key’s LED is on.

Each playback device has a LED above the Select key. The LED’s color represents load types.
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LED Color Load

Green QList
Red Chase
Orange Temporary cue

The default functions for the playback devices’ control keys and faders can be changed.
see ”Setting up playback devices” page 215.

AB crossfader

The AB crossfader. is the default master playback and the master playback dedicated control keys
execute playback functions for AB. see "Master playback™ page 196.

When AB is not the master playback device, use the AB control keys f r playing back QLists on the
crossfader. The default key functions are:

m BACK/HOLD - left key
m GO -right key

Select
Back/Hold | Go

Figure 74: AB cr ssfader and its playback controls

The key and fader functions can be changed in the Playback Properties dialog box > Playback Defi-
nitions tab (see “Setting up playback devices” page 215).

The crossfader can work in dipless mode, where:
m In fader - fades incoming values.
m Out fader - fades outgoing values.

The crossfader can also work in dip mode, where:
m In fader - fades incoming values.

m Out fader - blacks out the HTP output. In effect, it works like a submaster.

To change the crossfader mode

1 Open the Tools menu.

2 Choose Settings.
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3 Tap DIP XFADE to toggle between enable or disable.

| Load LED
Toggle faders/QKeys m
Page up T 1
Poge%owh E Fader controls

Fader LCD display | ad

Fader mode
% | Motorized fader

O | L @

m ﬁ | _Flash button

Figure 75: Motorized fader with related keys and displays

Each fader has a programmable flash key and two programmabl control keys. The fader function
can also be changed. The fader control keys and fader functions re onfigured in Playback Defini-
tions tab of the Playback Properties dialog box (see ”Setting p p ayback devices” page 215).

The default functions are:

Load LED
Select

Go/f Hold
Bock / Hod

IWotorized foder

g m ]

Flcsh key

Figure 76: Faders and control keys

Press a la h key to bump parameter values, for the fixtures output from the specific playback
evic , to their maximum level. The flash level is shown in orange in the Fader Level field and the
playback device’s LED blinks while flash is active.

Hid/Bck

Active flash level ||Fader/Level

Bottom Key Flash Latch
Figure 77: Fader level field
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A latched flash key (see “’Flash behavior” page 220) toggles the values in the current cue on or off.
Flash keys always work in cut time. The Bottom Key row, in the Playback Wing display, shows the
latched flash keys’ indication.

PB
Qlist Ql: 1.0pening nu
Current Cue
Next Cue 1.Cue 1
Next Cue Time [
Type/Rate Nrm,R:100%
Go,Pr: 11
Hid/Bck

Active flash level
Flash latch indication |iBottom Key Flash Latch

Figure 78: Bottom key indication on the Playback Wing display

To latch flash keys
Press SETUP.
2 Press the select key for a playback.
The Playback Properties dialog box open

3 On the Playback Definitions tab, click th arrow to view the flash behavior options.

Behavior

Flash Behavior:

Latch

Release On Release
Pure LTP
Go On Flash

Figure 79: Flash behavior options
4 Cick LATCH.

5 Click CLOSE.
T operate latched flash keys
1 Press the flash key to output all parameter values in the current cue.
This turns on the dimmer also, regardless of the fader position.

2 Press again to turn off.

Values bump out.

Fader modes

The faders work in four modes:

S
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Mode What it does

PB (Playback) The faders are intensity masters.

RATE The faders are rate masters.

CHN (Channel) Each fader controls one channel. Channel pages are unlimited.

Fader modes are global, affecting all of the faders, unless specified otherwise in the Pl yba k

Properties dialog box.

Note: Motorized faders (Vector Red and Vector Blue) automatically jump to the correct
level when changing the fader mode or paging the faders. Non-motorized faders (Vector
Green, Vector Orange and Vector Violet) may be mismatched when changing the fader
mode or paging. If the fader level is mismatched an indication (an up or down arrow)
appears on the wing display. To match the level to the current equi ment, move the

fader handle up or down according to the indication.

Paging faders

There are 5 fader pages for Vector Red and Violet The e are 10 fader pages for Vector Blue and
Vector Green.

Motorized faders remember their level on ea h page and jump to that position when paging.
Example: On page 1 fader 8 is set at 50% and on page 2 fader 8 is at full. Paging from page 2 to
page 1, the fader jumps to 50%. Paging o page 2 the fader moves to full.
To page faders
UP to page up; the page number appears in the LCD display and on the playback wing.
DOWN to page down; the page number appears in the LCD display and on the playback wing.

Toggle playback display

Page up

Page down

Page display [

Figure 80: Playback device paging controls for faders and QKeys.

Note: When paging the faders, the QKeys are also paged in the background.

Qkeys

QKeys are playback devices without a physical fader. Each QKey has a Select key and one
programmable control key. The default control key command is Go and can be changed in the Play-
back dialog box P Playback Definitions tab. There are 10 QKey pages.
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Touch Screen

QKEYS
Figure 81: QKeys are located below the touch screen

Playback control key LEDs

Key LED
Go (top key) * LED blinking - A fade is in progress.
* LED on - The playback device has ctiv output. No fade is in progress.
* LED off - There is nothing load d on the pbd or there is no output.
Back / Hold * LED blinking - A fadeisinpr ess.
(bottomkey) | . LED on - The playback device is paused.

Do
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Output priority is determined by playback priority maps.

Vector contains two priority maps

Priority map Default mapping
LTP priority All playbacks are of equal priority and are mapped to the
This is the default same priority number. The last device that executed a play-

back command grabs priority.

The default priority mapping for LTP is:

* AB is priority 1 (the lowest priority).

» All Playbacks and QKeys are priority 11.

Ordered priority

Playback devices are set in a rigid hiera hy. D vices are
mapped to a unique priority number or groups of devices may
be mapped to the same priority num er. The priority range for
playback devices is 1 - 210.

The default priority m pping for rdered priority is:
« AB-1

+ All QKeys - 10

* All faders-1 thro gh 110

To select the priority map

1 Go to ToolsP Settings» Be avior tab.
2 Tap ORDERED PLAYBACK PRIORITY.

When this button is enabled (light colored), the Ordered priority map is active.

When this utton is disabled (dark colored), the LTP priority map is active.

Mapping priority per playback device

You can al o map the priority for specific playback devices. Operator defined priority maps are

tored in snaps and restored when the snap is applied.

— Properties

Exclude From Snap

Exclude From Paging

Exclude From Active

Prevent Snap Ovemnmide

HITF:

Set gz Spsten Detault

Pricrity:

1

Friority

‘l’\J
L&

Figure 82: Playback Definitions - Properties group
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ATTENTION!

Playback devices mapped to the same priority become an LTP group (they adopt LTP
behavior within the group) regardless of the priority map chosen in the Systems Settings
dialog box.

Playbacks that have different priorities do not adopt LTP behavior, even when the default
priority map is LTP.

To map specific playback devices with unique priority

1 Open the Playback Properties dialog box, by pressing SETUP and then Select for th play-
back device.

2 Tap the Playback Definitions tab.

3 In the Properties group, tap the up or down arrow buttons until the re uire priority number
is displayed in the Priority field.

4 Tap STORE to exit the dialog and store the new priority setting

Note: If the priority map is changed in the System Setting dialog box, priorities
mapped by the operator are overridden by the default ap.

Controlling output priority on-the-fly

When output priority is LTP you can quickly cha ge playback device priority from the console
panel, fading from the output of the one playb ck device to the output from the selected playback
device.

When switching priority, the cros fad takes place in default GoTo time as set in System Settings
» Timing.

Note: For LTP pr ority, ORDERED PLAYBACK PRIORITY must be disabled in System
Settings » Behavi r

To change output priority

1 Pres PRIO(rity).
2 Press the Select key for the required playback device.

This initiates a crossfader between the current playback device output priority and the new
one.

Loading and freeing playback devices

To playback QLists they must be loaded to a playback device. Each fader can host only one QList
to a page. Different QLists can be loaded to the same fader on different pages.

Example: Load QList 3 to playback wing 1 fader 1, go to page 2 and load QList 13 to playback
wing 1 fader 11 (fader 1 one page one), etc.
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Groups and fixtures can also be loaded to faders as temporary cues. Text tags can be appended to
temporary cues that are output on the faders.

To load a QList to a playback device
1 Choose the QList: QLIST #.
2 Press Select for a playback device.

The QList is loaded to the selected device. The LED above the Select key is lit; it is green.

To load a range of QLists

Select the QLists (QLIST # = #) and press Select for a playback device.

The selected QLists are loaded to consecutive playbacks.

ATTENTION! If the selected range contains more QLists than the play ack devices
available on the current page, the remainder is loaded to the next page.

Example: The selected range of QLists is 1 through 15 with QList 1 loaded to playback 1
on page 1; QLists 11 through 15 will be loaded to playback 1 through 5 on page 2.

To load a group to a playback device

1 Choose the group.
2 Press Select for a playback device.
The QList is loaded to the selected device.

The LED above the Select key i lit it is orange.

To load fixtures

see “Temporary Cues” page 183

To free one playba k device

FREE, Sele t; the playback device’s LED is extinguished.

To free mo e than one playback device

1 Pr ss and hold FREE

2 Press Select for as many playback devices as you want.
The load LEDs are extinguished. as the playback is freed.
Or

3 Press FREE twice to lock.
When locked the key's LED blinks.

4 Select (for any playback device).

5 Any key press (except Select) releases the FREE lock.

To free all playback devices

Press SHIFT + FREE.
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The load indication LEDs are extinguished.

To add text tags to objects on a playback device

Add text tags to groups, cues, or temporary cues that are output from a playback device.
1 Press TEXT.
2 Press Select for the playback device where the object is located.
The Text dialog box opens.
3 Type text.
4 Tap OK.

Master playback

The master playback is the default playback device, which means that unless specified otherwise
new cues are appended to the QList loaded on the master playba k. see ”Working with QLists”

page 123.

The AB crossfader is the default master playback, b t any other playback device can be designated
as the master playback device. The designated ma ter p yback device is shown in the playback
displays with on a green field.

The playback keys, located above and below he master playback LCD, are dedicated to master
playback control. The LCD display sh ws the current and next cues on the master playback:

GOTO- Fade to selected cue or interrupt a fade in progress

Master Playback LCD display

HOLD - Pause a fade in progress
BACK - Fade to the previous cue

GO - Start a fade or chase
Figure 83: Master playback LCD and control keys

To designate the master playback

Press the playback device’s Select key twice; the key's LED is lit.
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Master playback color code

Color coded parameter values are shown in the live fixture displays.

While a fade is in progress, the color code for values output from the master playback show the
levels fading up, fading down or remaining unchanged.

LED Color | Parameter values

Red * Compulite mode: Values remain unchanged from the previous cue.

* Tracking mode: Values saved in the current cue are the same valuesa  the
previous cue.

Blue Values fading to a higher value.
Green Values fading to a lower value.
Purple Tracked values. (Tracking mode only)

Fading cues out of sequence on the master playback

Vector’s default settings allow using GO or GOTO to pla cu out of sequence.

To play a cue out of sequence using GO o GOTO

Example: Cue 5 is current on the master pl yback. Fade to cue 20.

CUE 20, GO; initiates a fade to cue 20 in ts cue time, executing attached macros and param-
eter time settings.

CUE 20 GOTO; fade to cue 20 in the default GOTO time. see ”Default GOTO time” page 338

CUE 20 TIME GOTO; re pect 1l time settings and execute macros (if any).

To specify a fade time o the master playback
1 Press CUE and elect a cue number.
2 Pres TIME.
3 Specify the fade time.
4 Press GOTO.
The fade to the selected cue occurs in the specified time.
OR
1 Press GOTO.
2 Select a cue number.
Important! Do NOT press CUE, just enter the cue number.
3 Press TIME.
4 Specify the fade time.
Press ENTER.

The fade to the selected cue occurs in the specified time.
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To specify a fade time on the playback devices
1 Press GOTO.
2 Select a cue number.
Important! Do NOT press CUE, just enter the cue number.
Press TIME.
Specify the fade time.
5 Press the Select key for the playback device.

The fade to the selected cue begins.

Changing the co key function

The functionality of the GO key can be changed to prevent using the GO key to fade cues out of
sequence. This is useful when you want to prepare an out of sequence fade, but, in the meantime,
continue fading through the normal cue sequence.

Scenario: The current cue is cue 4. You are planning to fade to ¢ e 20 after the fade to cue 10 is
complete. Select cue 20; the selection is displayed in the command ine. Continue pressing GO until
the fade to cue 10 is complete. Now press GOTO to fade to cu 20.

To change the GO key function

Go to Tools P Settings » Behavior and disable GO AS GOTO WITH CUE TIME.

Fading cues on the playback devices

Playback devices includ th faders, QKeys, and the AB crossfader. Each playback device has keys
for playback control By d fault the keys are defined as Go and Hold/Back. The default functions
can be changed in e P ayback Properties dialog box, Playback Definitions tab. (see ”Setting up
playback devices” page 215).

To fa e to the next cue

Pre the GO key.

To specify a fade time on the playback devices
Press GOTO.
2 Select a cue number.
Important! Do NOT press CUE, just enter the cue number.
Press TIME.
Specify the fade time.
5 Press the Select key for the playback device.

The fade to the selected cue occurs in the specified time.
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Playback device controls

The playback device controls provide expanded functionality for playback devices. The function

El

can be applied to single playback devices or to a group of playback devices (see ”Playback selec-

tion” page 202).

Many of the playback function keys can be locked to allow choosing more than one fader’s Select
key. When locked, the key's LED blinks. When the key has been pressed, and not locked, the LED
is on. The LED is extinguished after choosing a Select key.

To lock a playback control key

A double hit on the key locks it.

To free a locked key

Pressing any key (except Select) frees the lock.

Key Name What it does and how to use it
JOIN Links (joins) a number of playback device a owing you to start fades on
multiple playback devices with a ing go command.
To join playback devices
1 Press JOIN.
The key’s LED blinks.
2 PressS ct for each participating playback device.
The de ice’s LED flashes red when joined.
To rele e a playback device from join
When JOIN is active, press Select for the fader you want to remove. The
fader’s LED is no longer red.
To release all playback devices from join
Press JOIN and then RELEASE.
PRIO(rity) Switch output priority between playback devices. Priority is always LTP.
SUBMASTER | Set a fader to act as an inhibitive submaster for fixtures.
To set inhibitive submasters
1 Select fixtures.
2 Press SUBMASTER.
3 Press Select for a fader.
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Key Name

What it does and how to use it

SEQ(uence)

* On - Cues fade in numerical sequence.
* Off - Only possible to fade between the current cue and cue 0.
Note: The default setting for SEQUENCE is on.

To enable/disable sequencing

1 Press SEQUENCE.
2 Press Select for a playback device.

TRIGGER

* On - Triggering macros that are attached to cues is enabled.

* Off - Triggering macros that are attached to cues is disabled.

FREE

Free QLists and temporary cues loaded on playback devic s. se “Loading and
freeing playback devices” page 194.

ON

Restore a released cue.

To restore a released cue

1 Press ON.
2 Press Select for the playba k device.

The released cue is resto ed in cut time.
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Key Name What it does and how to use it

SOLO Black out all playback device output except the output from the selected play-
back device. Solo can fade or bump the output.

To use solo by fading
1 Press SOLO.
2 Press Select for the solo playback device.

All output except selected fades to blackout. The output from
selected device fades to the dimmer level set by the fader.

Example: If the fader is at 80%, the solo output will no be more than
80%.
To use solo by bumping
1 Press SOLO.
2 Press the flash key for the playback d vice.

All output except selected bumps o b ack. The output from the
selected device jumps to he f xtur ’s stored dimmer levels regardless
of the fader level.

To lock solo

Hit SOLO twice to lock they key. Press Select or the flash key for any
playback devic o solo the fader’s output.

To unlock solo

P ess RESET.

STEP S ep hrough chasers manually.
STEP SELECT Lock the fader’s Go key to step through a chase.
STEP SELECT GO Release step mode.

* STEP STEP Lock the key.

PB RE EASE

PB RELEASE + SELECT Release the playback device's output without free-
ing the playback device.

* PB RELEASE - Release all playback devices.
* SHIFT + PB RELEASE Release all playback devices.

* PB RELEASE SELECT — Release all playback devices from the first
selected to the last loaded pbd.

* A double hit on PB RELEASE locks the key.
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Key Name What it does and how to use it

GO A generic go key. Use this key when there is no dedicated go key for a fader or
QKey.

Or

Give a go command simultaneously to more than one playback device.

* GO SELECT; Fade to next cue, start an effect or a chase on the selected
playback device.

* Hold down GO and press Select (for as many playback devices as y
want).

* SHIFT + GO,; starts all playback devices.
* A double press on GO locks the key.

ER * Hold (pause) the fade running on the selected fader.

» Fade back to previous cue.

© Reverse sequence direction for the QList on the sel cted faders. Generally used
with chases.

Playback selection

Select playback devices and QKeys for global respo se to a control function. Selections can include
AB, playback faders and QKeys.

Note: All playback controls can be ap lied except SUB(master).

Examples:
m Select all the playback de ices on page 1 and free them.

m Select all the playb ck d vices on page 2 and give them a go command., even if the current
page is on pag 1.

m Apply Got com ands to selected playback devices.
m Load a ange of cues to selected playback devices.

m Load range of QLists to selected playback devices.

There are three ways to select playback devices:
m Directly using the Select keys, when selecting from the current page

m The console keys, where the first number is the page and the second number is the playback
device.

m The Editor tool bar in playback selection mode.

Last

Al all Qkeys Selection

Playbacks

Figure 84: Editor tool bar in playback selection mode
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The Editor tool bar buttons in playback selection mode are:

Button What it does
PLAYBACK Sets the keypad for playback device selection.
QKEY Sets the keypad for Qkey selection.
ALL PLAYBACKS Selects all playback devices (except AB).
ALL QKEYS Selects all QKeys.
AB Selects AB.
LAST SELECTION (®) Recalls last playback selection.
Note: Another way to recall the last selection is press ng PB, ®.

TRIGGER SEQ, and PRIO are applied according to certain r les.

Control Behavior

TRIGGER | Toggled on or off according to the state of the first layback device in the selection.
Example: The selection is playbacks 2,5, TR GGER is off for playbacks 2 and 7;
playback 5 has trigger on. Pressing TRI GER turns it on for the entire selection.

SEQ Toggled on or off according to th sta of the first playback device in the selection.
Example: The selection is playbacks 2, 5, 7. SEQ is off for playbacks 2 and 7; play-
back 5 has trigger on. Pr ss ng SEQ turns it on for the entire selection

PRIO Affects only the first play ck device in the selection.

Working with playback selection

To select and opera e playbacks

1 Tap LAYBACK on the Editor tool bar or press PB on the console panel.
The Editor tool bar switches to playback selection mode.
PB is displayed in the command line.

2 All selection sequences (# = #, # + #, # - #) can be used for the current page. Use the #/#
syntax to select playback devices on other pages.

Or
Use the selection options on the Editor tool bar.
Or

Press the Select key for playback devices. Pressing and holding Ctrl (on the external
keyboard) allows you select multiple playback devices.

Or
Select playback devices by page number and playback number.
Example: (page) 2 / 5 (playback device).
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3 Press a playback control.

All selected playback devices respond to the control.

To clear playback selection
The selection remains available until manually cleared by:
Selecting a fixture
OR
Pressing SHIFT + CE
OR
Pressing SHIFT+ RESET

Using playback selection with macros

Using playback selections in macros provide a quick way to give comm nds to more than one play-
back device at the same time.

Example: Free all playback device except AB. The macro would ook like: PB, ALL PLAYBACKS,
SHIFT + FREE.

Vector Violet Playback and Q-Key functionali y

IMPORTANT! This section applies on y to Vector Violet and Ultra Violet consoles.

The Vector Violet and Ultra Violet  not have their own physical Q-Keys (see ”Qkeys” page 191).
The playback SELECT keys can unction as QKeys trigger keys in QK MODE.

The Vector Violet has 5 p ges of 20 playbacks and 5 virtual pages of 20 Q-Keys.

The Vector Violet ha 2 addi ional keys:

m Q-KEY MODE is a toggle to switch the Playback keys to function with PB or QKeys

m PLAYBACK ELECT enables to assign to Playback keys PB or QKeys depending on the
mode.

Q-KEY MODE key has a red LED. When Q-KEY MODE is pressed - the LED is on
Note: When the QKEY MODE is ON, the command line displays [Q-Key]

The PLAYBACK SELECT key allows the system to assign and store to the Qkeys and PB's when
the normal Select key is not available because the system is in Q-KEY Mode. The PLAYBACK
SELECT can also be used to assign and manipulate Playbacks when Q-KEY-MODE is off

When Q-KEY MODE is ON:

m The Select for playback is used to trigger the QKey or select it (after pressing PLYABCK
SELECT).

When Q-KEY MODE is OFF:
m After pressing PLYABCK SELECT - all PB keys can be used to select playbacks.
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O-KEY
MODE

PR/OQ=-KEY
DISPLAY

‘ ff‘ lﬁ,ﬁﬂi(HAwEL
[1 |

: PLAYBAC =
‘ ¢ | RATE l Ammlq“mj PROTECT

SNAP
GO

.

Q-Key mode & Playback select keys

Figure 85: Q-KEY MODE and PLAYBACK SELECT keys

PLAYBACK SELECT key has a green LED that turns on whenever he k y is pressed. e.g STORE,
PLAYBACK SELECT, (LED turns green), SELECT for Playba k # (A er the assignment -the LED
turns off)

|
I SELECT| |SELECT| |SELECT| |SELECT
|

(] H [1 [
Figure 86: Each PB/Qkey has 2 LEDS

Each Playback/QKEY has 2 LE S indicating whether this control is assigned. The Left higher
LED is for Playback assignment and right lower LED is for QKey assignment. The color of these 2
LEDS is as in all V ctor models (green for QList, orange for temporary cue, red for chaser)

IMPORTANT! When a show is loaded from a Vector with Qkeys assigned, the Qkey
assignm nts will be loaded to the virtual Qkeys. The right (Q-Key) LED of the PB will be
ON ac rding to the assigned object (Qlist, Chaser or temporary cue) so the user knows
that here are assignments on the Qkeys. Pressing the Qkey Mode key will give the oper-
ator physical access to the Qkeys.

To assign QLIST to Q-Key
1 Press Q-KEY-MODE to turn Q-Key mode on
2 Press QLIST, select a number
3 Press PLAYBACK SELECT
4 Press Select for a Qkey device # (for example 19).
Qkey 19 LED (above the SELECT key) is lit green
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To free QKEY 19

1 Press Q-KEY-MODE to turn Q-Key mode on
2 Press FREE
3 Press PLAYBACK SELECT
4 Press Select for a QKEY device 19
QKey 19 led (above the SELECT key) is turned off

To play QKEY 19

1 Press Q-KEY-MODE
2 Press SELECT for Q-Key device 19

To pause a running chaser on Q-Key 1

1 Press Q-KEY MODE
2 Press PAUSE (in PB control section)
3 Press PLAYBACK SELECT (in PB control section)
4 Press Select for a QKEY device 1
The Q-Key on the display screen has a pause ign

5 To re-run the chaser, press Select for QKey device 1

To free a chaser running Q-Key 1

1 Press Q-KEY MODE
2 Press FREE
3 Press PLAYBACK SE ECT
4 Press SELECT f ra QKEY device 1
QKey 1 is reed (The specific QKey LED turns off)

To release a Q Key in Q-Key mode
1 Make ure Q-KEY MODE is pressed
2 Pr ss PB RELEASE
3 Press PLAYBACK SELECT
4 Press SELECT for QKEY #

To release a playback in Q-Key mode
1 Make sure Q-KEY MODE is pressesd
2 Press PB RELEASE
3 Press PLAYBACK SELECT
4 Press any of the 3 executors except SELECT, which is for the Q-Key
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To designate a Q-Key as a master PB
1 Make sure Q-KEY MODE is pressed
2 Press and hold PLAYBACK SELECT
3 Press twice SELECT for QKEY

Tip! All playback control keys (such as FREE, SOLO, PAUSE etc) operate in similar
sequence order in QKey mode. Please look at sequences for PB RELEASE to operate any

one of them.

To play PLAYBACK 19

1 Press Q-KEY-MODE
2 Press [Top Key] (below the SELECT key)

Playback/QKEYS options table

The following table maps the various execution/assignment pti ns of playback and Qkeys based
on the Q-KEY-MODE and PLAYBACK SELECT key

Q-KEY-MODE | OFF ON ON OFF

ELIYoACK | oFF OFF ON ON

SELECT SELECT PB PLAY K SELECT QK SELECT PB

Top Key PLAY PB PLAY PB SELECT PB SELECT PB
HO D/BACK

Mid Key HOLD/BACK PB B SELECT PB SELECT PB

Bottom Key FLASH PB FLASH PB SELECT PB SELECT PB

Note: Th key functionality is customizable

General master

The general master and its associated blackout key, control Vector’s overall dimmer output. When
the grand master is at its bottom end stop, all dimmer output is at zero. When the general master is
at the top of its travel, all dimmer output is at maximum level.

The general master can be disabled in the System Settings dialog box. see ”System Settings”
page 333.

General master status is displayed in the command line’s status bar.
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General master level

[ ] 4:57.08 Jom: 100 «J§

Figure 87: General master level indication in the status bar

To blackout all dimmer output

Press B.O.
The active dimmer output bumps out.

The key’s LED is on and the GM status is displayed in red in the status line.
OR

Move the general master slider to 0%.

the active dimmer output fades out.

To cancel the GM blackout

Press B.O.
The dimmer outputs bumps in.

The key’s LED is off and the GM level is isplayed in the status line.

OR
Return the general master slider to 100%.

the dimmer output fades in.

Playback displays
Playback device displ ys a opened from the workspace. Playback displays include:

m Wing 1 m Master (playback device)
= Wing 2 m Individual playback devices

m Qkeys 1 m Individual QKey devices

m Qkeys 2 m Attachments to cues running on the master playback device

m AB Playback
Note: PB Q-KEY/ DISPLAY toggles between Fader Wing and QKey displays.

Playback display color code

Live fixture display color code

Playback device Value color

Faders Yellow
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Live fixture display color code

Playback device Value color
QKeys Yellow
Master playback see ”Master playback color code” page 197.

Playback wing display color code

Load Playback device color

No load The background color is gray.

Load The background color is black.

QList The playback device number is green.
Chaser The playback device number is red.
Temporary cue | The playback device number is yellow.

Playback device displays

Open a pane for playback display oritaddat bina existing pane.

Playback wing displays have side headers wh ch can be organized through the Grid Properties

dialog box. Use the options in the View men to resize, show, and hide columns (see

ties” page 59).

Master playback display

”Grid proper-

The master playback display has green highlight and progress bars to differentiate it from the other

playbacks.

Playback - Master - A/B Qlist

Zue Sheet

Preview | b M

Ql: 1.Main Qlist

25.Cue 25
28 Cue 28

-3 29.63

Mrm.R:100X

Hid/Bck.Pr: 11

Go

XFdiin). XFd{Out) L: FL

Figure 88: Master playback display, PB tab

To display the master playback

1 Activate a pane.

2 Open the Workspace tree.

Skip this step if the Workspace tree is open.

3 Expand the Playback node.
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4 Tap Master.

Individual playback device displays

Cue sheets, current cue exams, and next cue (preview) exams can be displayed for:
m Master playback
m AB crossfader
m Individual faders
m Individual QKeys

Playback device display

Tab Header options

PB The PB tab is for the master playback device and the AB crossfade only!

Tabbed cue displays
I |

S0

" PB Cue Sheet Exam Preview
PB
Qlist Ql: Qlist1
Current Cue 3.Piano solo
The side header order is set in L e SIS

the Grid Properties dialog box.

Next Cue Time §3

Type/Rate Nrm. R:100%

Top Key/Prio JIEHE:TS Slon g |

Mid Key Go

Mid Key Go

Fader/Level XFd(in) L: FL
Jists A/B Qlist 1.

Figure 89: Master lay ack or AB display - PB tab

Cue Sheet

* Cue number * Delay In * Link to

* Cue name * Delay out * Loop

* Time in * Wait » Trigger
Time ut » Param(eter) Time
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Playback device display ‘

Tab

Header options ‘

[l PE Cue Sheet Exam Prasisu:
Cue # Cue Mame
a8

9

10
11

Param Time shows the fade progress for the
parameter with the longest fade-in time

Figure 90: Cue sheet
Cue sheets show a fade progress bar that highlights the active cue.

Exam

The fixtures and parameter levels for the current cue.

] Cue Sheet Exam Preview

Fixture #  Fixture Fan  Tilt  Dimmer | Shutter C

Figure 91: Exam tab for playback device d spla

Preview

The fixtures and parameter levels fort  incoming cue.

1] Zue Sheet Exanm Preview 4 b
Fixture # Fixture Pan Tilk  Dimmer  Shutter Color'wWheel Color' wWheel 2 Cyan

Orange-5_

Orange-5_
Orange-5_
Orange-5_
Orange-5_
Orange-5_

Figure 92 P e iew tab for playback device display

To display t e mas er playback

1 Ac vate a pane.

2 Op n the Workspace tree. Skip this step if the Workspace tree is open.

3

xpand the Playback node.

4 Tap Master.

To display AB

1 Activate a pane.

2 Open the Workspace tree. Skip this step if the Workspace tree is open.

3 Expand the Playback node.
4 Tap AB.
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Fader wing display

Do

To display a cue sheet for a single playback device or a QKey

Example: Show the QList on playback device 4.

1
2
3
4
5

Activate a pane.

Open the Workspace tree. Skip this step if the Workspace tree is open.
Expand the Playback node.

Expand Wing 1 node.

Tap PB 4.

OR

1 Press EXAM.

2 Press the Select key for playback device 4.

Playback - Wing 1

Bottom Key Flash Flash Flash Flash

Q:1.0cQl: 4.DzQ1: 4.D=Ql: 4.D=
1.Cue 1 3.Cue 3 4.Cue 4

1.Cue 1

2

Nrm.R:" Nrm,R:" Nrm,R:" Nrm_,R:°

Go.Pr: " Go,Pr: " Go.Pr: " Go.Pr: °

HIid/Bcl HIid/Bcl HId/Bcl HId/Bcl

Intens | Intens | Intens | Intens |

Figure 93: Playback wing 1 display (par al)
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Header (row) options for playback wing displays

Header (row)

What is displayed

PB

* The playback device number is displayed as Page number / Device
number.

* Indications showing the playback status (such as pause, reverse direction,

etc.) are displayed in this field as required.
Indications

F‘aused—l |—Rever5e direction
FB [ PB 171

Dlist Mame
Cumrent Cue
Mext Cue

Mext Cue Time
FaderfLevel Intens L: FL
Tvoel/Rate Nrm_. R:100%
Too Kev/Prio REURa SR
Mid Kev Hid/Bck
Bottom Kev Flash

Figure 94: Indications, showing the playbac status, appear next to the
playback device identifier.

Fader/Level

+ Fader function according t playback setup.

» Fader output level.

Type/Rate

* Normal sequencing Q ist or a chase.

» The fade rate f r the playback device.

QList

The Qlist numbe and text tag.

QList #

The Qlist umber

QList

The Qlis text tag.

Current cue

The active cue number and text tag.

Next cue

The incoming cue number and text tag.

Nextc tim

The incoming cue fade times.

Top key* Prio

Top key function indication.

Mid key*

Middle key function indication.

Bottom key*

Bottom (flash) key function indication.

* see ”Playback Properties dialog box - Playback Definitions tab” page 218.

To display playback wings

1 Activate a pane.

2 Open the Workspace tree.

Skip this step if the Workspace tree is open.

3 Expand the Playback node.
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4 Tap Wing 1or Wing 2.

QKey display

Opening ntSmall stagiSong ABC Dance ABCQlist 5

2.Dancers 1.Cue 1 1.Cue 1 2.Cue 2 1.Cue 1
3.Cue 3 2.Cue 2 2.Cue 2 3.Cue 3

Go Go OnfOFf

Figure 95: QKey display

Header (row) options for QKey displays

Header (row) | What is displayed
PB * The playback device number is displayed as Page number / Device
number.
» Indications showing the playback status (such as pause, reverse direction,
etc.) are displayed in this field as required.
Level/Prio(rity) » Output intensity.
» Place in the priority stack.
QList The Qlist number and text tag.
QList # The Qlist number
QList The Qlist text tag.

Current cue

The active cue’s numbe and text.

Next cue

The incoming cu ’s number and text.

Next cue time

The fade mes for the incoming cue.

Key functions

Con ol keys function indications. see ”Playback Properties dialog box -
Playback Definitions tab” page 218.

To display QKeys

1 A tivate a pane.

2 Open the Workspace tree.

Skip this step if the Workspace tree is open.

3 Tap Playback.

4 Tap Qkeys 1 or QKeys 2.

To toggle the QKey and playback wing display

Press PB/QKEY to toggle the playback wing display between faders and Q-keys.

Note: Ifthe PB field is displayed, the master playback device is highlighted in green.
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Setting up playback devices

The Playback Properties dialog box is used to customize the control keys and fader default func-
tions and also to control QList playback behavior.

m QList Properties tab - control QList playback behavior.
m Playback Definitions tab - control keys and fader function.

All playback device settings are saved with snaps.

Playback Properties dialog box - QList Properties tab

The QList Properties tab is available only when there is a QList loaded on the sele ed playback
device.

i Qlist 1 PlayBack 1/1: Properties

Flayback Definitions | Qlist Properties
g Qlict Preperties Chase Properties -
Qlist Mode Chase Pattem
Chase Type——
Normal v| |Normal v| ‘
GO behavior s HEs
. -Chas= Fade In Time [Sec)—
Exit Loop v| IN
0.0
lMark Cue at lop of Iisl] I Cue only List ] - > ARandom Time
B“ET" Ve ] [ Calcuate State
eleae
Loop Caunt
=
l s ] Ino Not Calculate With < >
Jumps ‘
Release Time Rate (wheel 1) X-Fade (wheel 2) Int Limit (Wheel 3)
R
< > < » < > < »
{ Save to Qlist ] [ Close l

Figure 96 Playback Properties dialog box, QList Properties tab
QList P operties What it does

QList Mode Normal Cues run in sequence, according to cue timing,
responding to manual Go commands.

Chase Cues fade automatically after the initial Go
command. All cues are considered chase steps.

When setting the QList mode, using SAVE TO QLIST or CLOSE to exit this dialog box deter-
mines where the QList mode is stored.

SAVE TO QLIST- The QList mode is stored with the QList. Example: Change the playback
mode to chase. The QList is always a chase no matter where it is loaded.

CLOSE - The QList mode is stored in the current snap. Example: When snap 4 is active, change
the playback mode to chase. The QList is always loaded as a chase with snap 4. All other times it
is loaded as a normal QList.
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QList Properties

What it does

Go Behavior

Exit Loop Pressing GO during a loop, exits the loop and
initiates a fade to the next cue or the next loop.

Stop at Next Cue | In normal and chase modes, pressing GO advances
to the next cue or step and holds.

Restart Loop In normal and chase modes, pressing GO inter-
rupts the loop and begins a fade to first cue in he
loop.

Exit Loop at End The loop completes its final step and then uto-
matically fades to next cue or the n xt loop.

Mark cue at top of list

Set a cue, at the top of the cue list, to look ahead a d pr position
fixtures and scrollers.

Cue only list

For tracking mode operation!

Cue Only stores only the moves in th cue nd does not track the
lighting state.

Back to top on
release

After release, QLists are reset o the first cue.

Calculate state

For tracking mode opera ion!
* Enabled - Only fixtur parameter moves appear on stage.
» Disabled - Th ent e lighting state appears on stage.

Sequence * Enabl d-Th cues fade in sequence with each go command.

» Di a led - The cues do not sequence.

Note The Indications, in playback displays, show the Sequence status.
Trigger Enabled - Fading to a cue triggers attached macros and snaps.

» Disabled - Attached macros and snaps are not triggered.
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QList Properties What it does

©

Do not calculate with | Reset the show defaults. If no show defaults were saved the system
jumps defaults are referenced.

Release Time This is a QList attribute. The time set here determines the fade speed
when releasing a QList from a playback device.

To set QList release time

1 Select a Qlist.
2 Press SETUP.
The QList # Properties dialog box opens.

3 Enter a time value in the Release Time field. Use the arrows or
Click the field and use the numeric k ypad.

4 Tap STORE.
The dialog box closes.

To set QList and chase properties
1 Press SETUP.
2 Press the Select key for a playback device.
The Properties dialog box ope s.
Go to the QList Properties tab
4 Choose the options in he fields.
Tap SAVE TO QLIST or CLOSE to exit the dialog box.
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Playback Properties dialog box - Playback Definitions tab

All settings in the Playback Definitions tab are saved in the current snap.

Flayback Definitions | Qlist Properties
Properties
1 2 3 4 3
l Exclude From Snap l [ Exchude From Paging ]
Go Go Go None None
l Exclude From Active ] [ Prevent Snap Override ]
HulglfBa Hold Hold None None
|_| H H H H Priority:
11
Intensity Rate Intensity None Nane - ad g
Master Macter Master
Behavior
H H H U H Flash Behavior:
‘Release On Release V‘
Flash Necne None Mone None Intensity Behavior:

O O

0

| d

D D I Release at Bottom ]

Save to Olist Close

Figure 97: Playback Properties dialog box, Playba k Definitions tab

Playback Definitions tab - Fader and key behavior

All Parameters

All pa ameters are released when the fader is at its bottom stop
witho t advancing to the next cue.

Not : To use this feature, RELEASE AT BOTTOM must be enabled.

Intensity Master

The fader controls the intensity. Moving the fader off its bottom end
stop raises value levels. When the fader is at the top of its travel,
parameter values are at their maximum values.

None

The fader is disabled.

X- fader In

The fader controls values to fading up.

X- fader out

The fader controls values fading down.

Rate master

The fader operates as a rate master.

You can set global defaults for control keys and flash behavior and fader behavior, according to the

type of object loaded on the playback device, in System Settings » Default PB Definitions.
see "Default PB Definitions” page 345.

ATTENTION! When Default PB Definitions is enabled, the default definitions are
applied to new assignments. Faders that are already loaded with QLists, cues, or tempo-

rary cues must be manually updated and the snap must also be updated.

Dos
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To set fader and key functions

Press SETUP.
Press the Select key for a playback device. The Playback Properties dialog box opens.
Tap the Playback Definitions tab.

W N -

Tap the square under the fader to enable.

5

Nore

Nore

1

Figure 98: Tap to access settings

5 Click on a key or a fader.
The fly-out list shows the options.
Tap the function.

Tap CLOSE to exit the di 1 g box and save playback device settings.

Playback Definitions tab Control and Flash key behavior

© R verse the sequencing direction. Not implemented yet.

Back Fade to the previous cue.

Flash Flash (bump) the cue on the fader.

GO Initiates a fade.

G /Re se Fades the cue (Go) in cue fade time or releases the playback using the

default release fade time.

Hold Pauses a fade.

Hold/Back « First press pauses a fade.

* Second press fades to the previous cue.

None The key is disabled.

On/Off Toggles the cue On (Go) or Off (Release). This is especially useful
with QKeys. The go and off operations are carried out in cut time.

Note: The Back to top on release setting controls what happens
when the cue is released.
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Playback Definitions tab -

Control and Flash key behavior

Release Releases the playback device.

Sequence on/off Toggle cue sequencing to on or off.

Solo Pressing the flash key bumps or fades out other output. Not imple-
mented yet.

Step << Jump to the previous cue.

Step >> Jump to the next cue.

Trigger on/off Enable/disable automatic triggering of macros attached t cues

Playback Definitions tab -

Properties group

EXCLUDE FROM SNAP The pbd is not stored in snaps.

EXCLUDE FROM PAGING | This fader is parked and doesn’ pag ith the rest of the pbd’s.

EXCLUDE FROM ACTIVE | Functions using active will not grab output from this fader.

SET AS SYSTEM DEFAULT

PREVENT SNAP The playback load is locked cannot be overwritten by snaps.

OVERRIDE Example: House lights are on pbd 1 and podium lights are one
pbd2. To avo d overwriting these assignments set to prevent
snap o erride.

PRIORITY Use he arrow keys to set a unique priority level for the selected

pl yback device.

Playback Definiti ns tab -

Behavior group

Flash behavi r

RELEASE ON RELEASE - Releasing the flash key, releases the
dimmer.

PURE LTP - Pressing the flash key grabs the priority. The play-
back device retains priority even after releasing the flash key.

GO ON FLASH - Pressing the flash key bumps to the next cue
and flashes the dimmer value.

LATCH - A latched flash key toggles the values in the current
cue on or off.
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Playback Definitions tab - Behavior group

Intensity Behavior

INTENSITY ONLY - the fader controls the only the dimmer
value.

GO+FADE PARAMETERS - Moving the fader off its bottom
stop, initiates a fade to the next cue in the QList. The speed of
the fader movement controls the timing for the dimmer fade.
The parameter values fade according to Vector’s default cue
time.

GO+JUMP PARAMETERS - Moving the fader off its ottom
stop, bumps to the next cue in the QList. The sp ed fthe fader
movement controls the timing for the dimmer fade The param-
eter values bump in.

Release At Bottom

Each time the fader is moved to its bottom stop, the parameter
values output from this fader are rele sed.

Playback control groupings

Faders and their control keys can be setup in playb ck ¢ ntro groups.

Example:
1 2 3 4 5
Go Mone MNone MNone Mone
Elfldjaa Mone MNone MNone f{one
Intenzity »-Fader #-Fader Rate Y
b aster [In] Out b aster s
Flash Mone MNone MNone | f{one |

4d B B

B [

Figure 99: Faders 1 - 4 set up as a group of controls in the Setup dialog box

Playback Device Function Comments

Fader 1 Intensity master | Faders 1 - 4 are now a mega playback device.

Fader 2 X-fader (In) the: The control keys for each fader can also have
unique setups.

Fader 3 X-fader (Out) Always load the QList to the first fader in the

Fader 4 Rate Master control group, in this example the QList would be

loaded to fader 1.
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To setup split crossfaders

Example: Set fader 1 as the “In” fader and fader 2 as the “Out” fader.
1 Tap the Playback Definitions tab.
2 Press SETUP and then Select for fader 1.

The Playback Properties dialog box opens.

3 In the dialog box, tap the slider handle for fader 1 and choose X-FADER (IN) from the
flyout menu.

4 Enable fader 2 by tapping on the rectangle under the square representing the push k y.
5 Tap the slider for fader 2 and choose X-FADER (OUT) from the flyout menu
6 Tap CLOSE.

Now faders 1 and 2 are setup as split crossfaders.

Default playback device definitions

In the System Settings dialog box, Default PB Definitions you ca set global defaults for playback
device control keys according to the type of object loaded  the layback device (see "Default PB
Definitions™ page 345).

Default PB Definitions are applied to all empty playbac devices.

Default PB Definitions are not applied to the pl yback devices that had QLists, chasers, and tempo-
rary (single) cues loaded before the changing he default settings. However, the new default settings
can be applied to the previously loaded playback devices.

To apply playback device d fa Its

Press SETUP.
2 On the Editor to 1ba tap APPLY PB DEFAULTS.

The playback d vice defaults as defined in system Settings » Default PB Definitions tab
are applied

ATTENTION! For correct playback, you must resave the snap after using APPLY PB
DEFAULTS.

Controlling fade rates

)

Fade rates can be controlled by setting the faders to function as a rate faders, putting a specific play-
back device under rate wheel control, or putting all the playback devices, globally, under rate
control.

Global rate control uses both the options on the toolbar and the wheels.
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Using the faders for rate control

The fader function mode can be switched to rate control. When switching faders to rate control, the
faders automatically jump to 100, the default cue time. Moving the fader up increases the fade rate.
Moving the fader down decreases the fade rate. At its bottom stop the fade is paused.

To set faders to rate control

Press RATE. The faders jump to the default rate level (100).

Using wheels for rate control

You can control the rate for one or more than one playback device. Also, all playb ck d vices can
be put under global rate control.

Pressing RATE, switches the first three wheels to rate mode. The wheels in r te mode are:
m Wheel 1 - Chase Rate
m Wheel 2 - xFade
m Wheel 3 - Int Limit

To use global rate control

Press RATE; The Editor toolbar is now in rat mode and the wheels control rates. The wheels
and the toolbar buttons affect all playback vices.

To exit global rate control

Press SHIFT + RATE. Playba k devi e rates are reset to 100%.

To put a specific playback device under rate control
1 Press RATE (th la g key next to BEAT).
2 Press Sele t for he specific playback device.

Note: To bring additional playback devices under rate control, press their
Se ect keys.

3 Us the CHASE RATE wheel to control the fade rate on the selected chase or use the
toolbar buttons.

Using the rate mode toolbar

The rate mode buttons on the editor toolbar toggle between to freezing and restarting chases and
effects. These buttons are always applied globally to all playback devices.

Pressing RATE, switches the Editor tool bar to rate mode.

Freeze all

Figure 100: Rate mode on the Editor tool bar
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Button What it does

FREEZE ALL Toggles freezing and running all active
chases and effects.

FREEZE CHASE Toggles freezing and running all active
chases.

FREEZE EFFECT | Toggles freezing and running all active
effects.

Editor fades

Editor fades expand Vector’s playback abilities when using the dimmer (intensity) wheel to fade

cues.

Editor fade options are available on the default Editor tool bar a d on he Setup tool bar. The

options are:
m MOVE FADE
m X-FADE
m SHAFT FADE (HTP)
® GROUP FADE (mask)
m CLEAR ON MASTER GO

To use Editor Fade option

1 Select a cue.
2 Press SETUP
The Editor tool ar switches to Setup mode.
3 Tap EDITOR FADE.
The options are displayed on the tool bar.
4 Tap the editor fade required.
Use the dimmer wheel.

The dimmers in the selected cues fade in, according to the selected editor fade.

Move Fade

‘When there are values active in the editor, fading in a cue using the dimmer wheel fades the editor
values to the values stored in the cue. If there are fixtures active in the editor which are not in the

cue, the editor values remain active.

Doy
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Current After Move Fade
Example 1
Cue: channels 1 through 10 @ 50% Channels 1 through 10 @ 50%

Editor: channels 9,10, 11, and 12 at 100% Channels 11 and 12 at 100%

Example 2

Cue: channels 1 = 8 @ 100% Channels 1 = 8 fade @ 100%
channels 9 = 10 @50% Channels 9 and 10 at 50%

Editor: channels 1 = 12 @25% Channels 11 and 12 @25%

Note: Even though you are wheel g
channels 1 = 8 to FL, chann Is 9 and 10
reach their maximum level a 50% All values
go to the level stored in the cue.

X-Fade
When there are values active in the editor, fading in a cu usi g the dimmer wheel will crossfade
from the editor values to the values stored in the cue If th re are fixtures active in the editor which
are not in the cue, these values fade to zero.
Example:
Current After Move Fade
Cue: channels 1 = 10 @ 50% Channels 1 = 10 @ 50%
Ch Is 11 and 12 at 0%
Editor: channels 9,10, 11, an 12 at 100% anneis 11 and feat i
Shaft Fade (HTP)

Shaft fades merg the editor output and the cue levels. When wheeling in the cue it is possible to go
beyond the alues stored in the cue. Values for fixtures that are only in the editor and not in the cue
remain at e editor levels.

Note: When the dimmer level is less than or equal to the level stored in the cue, the
value is displayed in white.
When the dimmer level is greater than the level stored in the cue, the value is displayed in

red.
Example:
Current After Move Fade
Cue: channels 1 = 10 @ 50% Channels 1 = 5 @ 100%

Editor: channels 1 = 5,21 - 25 @ 100% | Channels 6 = 10 @ 50%
Channels 21 = 25 at 100%
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Group Fade

Group fade converts cues to a group of fixtures in the editor. Dimmer levels for all fixtures are
wheeled from zero to FL.

Clear on Master Go

With the go command on the master playback, this option crossfades the editor contents with the
incoming cue. Example:

Current cue: channels 1 = 10 @ 65% CLEAR ON MASTER GO option results in:
Next cue: channels 1 = 10 @ 35% Channels 1 = 5 fade from 100% to 35%

Editor: channels 1 - 5,21 - 25 @ 100% Channels 6 — 10 fade from 65% (1 vel n the
' current cue) to 35%

Channels 21 = 25 fade to zero

Tapping CLEAR ON MASTER GO to disable, enables CLEAR ON PB GO.

Loop playback

The cue sheet displays show loop information. Th cue sheet for a QList loaded to a playback
device, shows a progress bar and, when th loo is running, the loop countdown.

You can begin a loop from any cue in th 1 op or jump to a cue without exiting the loop.

Manual
Manual

I

lanual

Manual

Manual

5.3 5.3 Manual

Figure 101: layba k display cue sheet with loop assignment
To playback a loop

Press GO to initiate the loop.

To start from any cue in the loop

Example: Cues 3 through 6 are looped. Begin the loop from cue 5.
Select cue 5 and press GO.

Exiting loops

You can exit a loop at any point in a loop’s progress and fade to the cue immediately following the
loop or to any cue in the QList.

The fade to exit cue can executes in cue time or in default GOTO time. see "Default GOTO time”
page 338.

D26



VECTOR

PLAYBACK DEVICES AND QLIST PLAYBACK

The default behavior, when exiting loops, can be set in the Playback Properties dialog box. The
options are:

m Exit Loop
m Exit Loop at End
m Restart Loop

m Stop at Next Cue

see “Playback Properties dialog box - QList Properties tab” page 215

To exit a loop using GO

Note: In the following examples, the go behavior is set to Exit Loop. This is the d fault
behavior.

Example 1: Exit to the cue immediately following the loop, executing the fade in the cue time.
Press GO.

Example 2: Exit to a cue that is not directly after the loop xecu i g the fade in the cue time.
Select the cue and press GO.

Example 3: Exit to a cue that fades in a specifi d time.

1 Select the cue.

2 Press time and enter a time on the nume ic keypad.

3 Press GO.

To exit a loop using GOTO
Example 1: Exit to the cue immediately following the loop, in default GOTO time.
Press GOTO.
Example 2: Exit th ue immediately following the loop, in default GOTO time.
Press GOTO.
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Chases

Program chases by defining a QList as a chase in the Playback Properties dialog box. Panel keys are
available for on-the-fly rate and direction override. The chase designation and all chase settings are
saved with the QList. The QList's chase settings are always valid, no matter to which playback
device the QList is loaded.

Setting chases and chase properties

The Playback Properties dialog box Chase Option fields control chase settings.

2Ii# Qlist 1 PlayBack 1/1: Properties

Flayback Definitions | Qlist Properties
e C N

Qlist Properties Chase Properties
Qlist Mode Chase Pattem
Normal v/ | \Normal v|
GO behavior
. Chasz Fade In Time |Sec) [
Exit Loop v/ n B
0.0
lMaIk Cue at lop of |ISl] l Cue only List l 5 = Random Time
[
Back To Top On
HEEae ] [ Calcuate State ]
Loop Caunt
l Sequence ] [ Trigger I Infinite
l s ] Do Not Caleulate Wth] E 4
Jumps
Release Time Rate [Wheel 1) X-Fade (Wheel 2) Int Limit (Wheel 3)

| c—
\L ,

< > < > < > <

1 Save to Olist I [ Close I
Figure 102: The Playba k Properties dialog box - Chase Properties

Chase Prope ties | Options What it does Default
Chase Patte n Normal The chase is executed in sequential cue Yes
order.
Build Values for each cues are piled until reaching

the last cue. Then the first cues state is
restored and the chase starts again.

Bounce The chase runs from beginning to end and
then from the end to the beginning.

Random Steps are executed in random order or in
random time or both, depending on the
settings for random time and rate.

s
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Chase Properties | Options What it does Default
Chase Type POS(itive) The first cue’s values are off. The rest of the
cues are at their recorded values. As the
chase progresses the first cue is turned on
and the values of the second cue go to 0.
NEG(itive) This type of chase is also known as a Yes
shadow chase.
Example: Shadow chase with four steps:
Step 1 -2, 3,4 are on.
Step 2 - 1, 3, 4 are on.
Step 3 - 1, 2, 4 are on.
Step 4 - 1, 2, 3 are on.
Random Time The step order remains the same, but the rate, when fading
from step to step, is random.
Chase fade time In Use the arrows to set he hase fade in time. | 0.0 sec
Loop Count Set the number of loops the chas makes.
Rate (Wheel 1) Set the chase rate. 100%
Xfade (Wheel 2) Set the chase's crossfad properties. Note: 0% bumps from step | 100%
to step (hard chase).
Int Limit (Wheel 3) Set a proportio al le el for the fader. 255

Go behavior is integral to chase pl yback. Define the Go behavior under the QList and Temp

Assignment Properties gro p. se ”Go Behavior” page 216.

Programming chases

Chases are QLists that are designated as chases. The chase designation and all chase settings are
saved wi h the QList when exiting the Playback Properties dialog box by tapping SAVE TO QLIST;

the QList will always run as a chaser.

he QList run mode (normal or chaser) can be also be changed by editing the Mode column in the

QList exam screen display.

Tip! For chases that occur within QLists, using just some of the QList’s cues, use loops.

see ”Loops” page 172.

To designate a QList as a chase

1 Load the QList to a playback device.

2 Press SETUP.

3 Press Select (where the QList is loaded).

The Playback Properties dialog box opens.
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4 Choose Chaser from the QList Mode drop down menu.
5 Tap SAVE TO QLIST or CLOSE.

To change the run mode through the exam display
1 Press QLIST.
2 Press EXAM.
3 Tap or Click the right side of the Mode column.

1.Song 1 Normal
2. Song 2 Ll Normal k
/| Chaser

3. Song 3
4 From the drop down menu, choose Normal or Chase.

The QList will run in the selected mode.
_E]
To change the run mode through the exam display
1 Press EXAM.
2 Press QLIST.
3 Press ENTER
4 Tap or Click the right side of the Mod column.

Qlist #  Qlist Name | Cues count Mode /D
1 1.Song 1 6 Normal

2.Song 2 o L] Normal k
3. Song 3 0 | Chaser

From the drop down m nu, choose Normal or Chase.

(=223 |

The QList will run in the selected mode.

Controlling chase rate

Chase speed n be controlled on-the-fly or preset in the Playback Properties dialog box.
Pressing rate displays the rate options in the Editor toolbar:

m CHASE RATE controls the overall speed of the chase; the rate at which it fades from step to
step.

m XFADE controls the look of the chase; if it fades between the steps or jumps from step to step.

To control chase speed on-the-fly

Press the large RATE key.

2 Press Select for the pb device that is running the chase. The wheel assignments switch to
the rate bank.

3 Use chase rate wheel to adjust the chase speed.

Or

D30



VECTOR

PLAYBACK DEVICES AND QLIST PLAYBACK

4 Change the fader function to rate faders by pressing on the RATE key.

5 Use the fader to control the chase rate.

To preset the chase rate

1 Press SETUP. The Playback Properties dialog box opens.
2 Set the chase rate field, using the arrows.

3 Press OK. The chase rate is saved as an attribute of the QList.

To change the chase look

1 Press the large RATE key.

2 Press Select for the pb device that is running the chase. The wheel assignments switch to
the rate bank.

3 Use xfade wheel to fade or jump the steps.

Snaps

A snap is a snapshot of the playback devices’ state it analogous to a page. Vector stores up to
9999 snaps. Triggering a snap loads playback devi es with the contents of the snap. Snaps can be
attached to cues and automatically triggered when the fade to that cue begins.

Snaps include:
m QLists, temporary cues, and si gle es loaded on each fader page, on QKeys, and on AB.
m Fader mode on each page
m Fader levels on each page
m Load (assignment) prop rties
®m Run mod
m Priority value

m Pl y ack device setup as configured in the Playback Properties dialog box

Playback devices can be excluded from the snap. You may want to exclude your master playback
usua y the AB crossfader) from snaps. Excluding playback devices from snaps is available in the
Playback Properties dialog box. see ”Playback Properties dialog box - Playback Definitions tab”

page 218.

Active snaps

There is always an active snap. The active snap’s number is displayed in the master playback’s
LCD display and on the indications bar. Whenever you press SNAP, the active snap’s number is
displayed in the command line.

All objects loaded to empty playback devices are stored in the active snap.
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To save run modes, rate changes, fader levels, and playback modes it is necessary to update the

active snap.

‘When opening a new show, snap 1 is automatically active. When you begin programming a new
show all temporary cues, QLists, and cues loaded on the faders are automatically stored as snap 1.

‘When loading a show, snap 1 is automatically triggered.

Snap modes

Snaps work in two modes:
m Forcing snap mode - All current loads are replaced by those in the snap.

m Hold-over snap mode - The snap loads only playback devices that are released. Lo ds for
active playback devices are held over; the load “waits in the wings”. Whe the playback
device is released the waiting it is then loaded with the QList or other o ject hat was held

over.

Storing a new snap

To store snaps
1 Press STORE.
2 Tap a number on the snap soft keys.
OR
1 Press SNAP and enter a numb r on the numeric keypad.

2 Press STORE.

_E]
To store snaps

1 Press STORE

2 T p a number on the snap soft keys.

OR
1 Press STORE.
2 Press SNAP and enter a number on the numeric keypad.

3 Press ENTER

Triggering snaps
To trigger snaps in forcing mode

Tap a snap in the snap key tab.

OR
Press SNAP, type the snap number on the numeric keypad, and press ENTER.

o3
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To trigger snaps in snap-add mode
Press and hold SHIFT and tap a soft key in the snap tab.
OR
1 Select a snap.

2 Press and hold SHIFT and press ENTER.

Using Snap Go

SNAP GO, located to the left of the faders’ flash keys, is a quick way to operate the next or he
previous snap. This key can be protected to ensure that it is not accidentally pressed.

To trigger snaps using Snap Go

Press SNAP GO to operate the next snap.

Press and hold SHIFT then press SNAP GO to operate the previous snap
To protect Snap Go

1 Go to the Tools menu and choose System Settings
The System Settings dialog box opens.
Go to the General tab.

3 Tap PROTECT SNAP GO.

4 Tap OK.

To operate protected SNAP GO

Press the blank key above SNAP GO and then press SNAP GO.

Automatically triggering snaps

Automate playback by a taching snaps to cues. Fading to cue automatically triggers the attached
snap. Automatic riggering can be disabled.

Note: S aps attached to cues are triggered in forcing mode only.

T attach a snap to a cue
1 Select the cue.
2 Select the snap.
3 Press STORE.

(E]

To attach a snap to a cue

1 Select the cue.

2 Select the snap.
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3 Press ENTER.
To disable automatic triggering
OR
Press SHIFT+TRIGGER and SELECT for the fader.
Updating snaps

There is always an active snap. When you start programming a new show, snap 11 ac ive and all

objects loaded to the playback devices are added to snap 1.

In Tools » System Settings » Behavior » Auto Snap Update, you can set a d fault for the way

Vector updates snaps.

Option

What happens

No auto update

Snaps are never update utomatically. You must update
the snap manua ly.

Note: When is option is the default behavior, make
sure you ave stored your snap before using SHIFT +
FREE unload all playback devices.

On new assignments only

The s ap is updated only when objects are loaded to
em ty playback devices. Freeing a playback device and
loading a new QList does not update the snap. You must
update the snap manually.

On any change

Snaps are always and under all conditions automatically
updated.

Note: When this option is the default behavior, be careful
when using SHIFT + FREE TO unload all playback
devices.

To u date snaps manually

1 Make the modifications to the snap.

2 Enter the snap number using the numeric keypad.

3 Press STORE.

4 Tap OVERWRITE in the Store Options dialog box.

_E]

To update snaps manually

1 Make the modifications to the snap.

2 Press STORE.
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3 Enter the snap number using the numeric keypad.
4 Press ENTER. The Store Options dialog box opens.
5 Tap OVERWRITE in the Store Options dialog box.

Adding text tags to snaps

To add text tags to snaps

1 Select the snap.
2 Press TEXT.

The Text dialog box opens.

Use the keyboard to type the snap’s name.
4 Press STORE or tap OK.

The dialog box closes.

(E]

To add text tags to snaps

1 Press TEXT.

2 Select the snap.
Press ENTER.
The Text dialog box open .

4 Use the keyboard to type t e snap’s name.
Press ENTER or tap OK.
The dialogb clo s.

Deleting snaps

o delete snaps

Select the snap (or snaps).
2 Press DELETE.
The Delete dialog box opens.

3 Press DELETE again or tap DELETE in the dialog box.

To delete a range of snaps

1 Select the snaps: SNAP # > #.
2 Press DELETE.
The Delete dialog box opens.
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3 Press DELETE again or tap OK.

LE]

To delete snaps

1 Press DELETE.
2 Select the snap (or snaps).
3 Press ENTER.
The Delete dialog box opens.
4 Press DELETE or ENTER again.

Or
Tap DELETE in the dialog box.

To delete a range of snaps

1 Press DELETE.
2 Select the snaps: SNAP # — #.
3 Press ENTER.
The Delete dialog box opens.
4 Press DELETE, tap OK, or press ENTER ag in

Examining snaps

To view a list of snaps
Toggle the snap soft keys to gr d view by tapping . A list of snaps is displayed in the
active pane.

To examineas ap

1 View the snaps in grid format. If necessary, toggle to grid view.
2 Dou le click on snap 5.

Th contents of the snap are displayed in the active pane.
To view a list of snaps

Press SNAP and press EXAM.

To examine a snap

Example: Examine snap 5.
1 Select snap 5.
2 Press EXAM.

The contents of the snap are displayed in the active pane.
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To view a list of snaps

Press EXAM, SNAP, ENTER.

To examine a snap

Example: Examine snap 5.

1 Press EXAM.

VECTOR
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The contents of the snap are displayed in the active pane.

2 Select snap 5.
3 Press ENTER.

Copying snaps

To copy snaps

1 Select the source snap.

2 Press COPY.

The snap is copied to the clipboard.

Select the target snap.
4 Press PASTE.

The new snap is named Copy f Sn p # (source snap).
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Chapter 8 Saving, Loading, and Printing
Show Files

Drive D:\ contains Vector’s system files, show files, layout files, and visualizers.

This chapter contains the following sections:

m Saving Shows (see page 239)

m [ oading shows (see page 240)

m Printing shows (see page 243)

Saving Shows

Show files include all show data, patch, macros, and d play layouts. the file extension for Vector
shows is *.cvs. We recommend creating a new fol 1 to hold backup files for essential show files,
layout files, and customized device files.

Although you can save a show by repeated y saving to the same file name, we recommend that you
use the Save As option, so you can alw ys return to a previous version of the show if necessary.

IMPORTANT! Makei hab t to frequently save your work!

To save a show

Go to he F e menu and choose Save. The Save dialog box opens.

2 Browse to he location where you save shows. Vector’s default location is: D:\Program

Files Compulite Vector\Vector Shows.
Type the show name in the File Name field.
4 Tap SAVE.

OR
Press Ctrl + S on the keyboard.

To use Save As

Go to the File menu and choose Save As.

Autosave

Vector automatically saves your show every 10 minutes, if there have been changes in the show
data, or after a certain number of modifications to the show.

239 €9
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The autosave files are under D\Program Files\Compulite Vector\Config\Autosave. Autosave files are
named: ShowName ###.cvs, where ### is incremented by one each time an autosave occurs. When
reaching 999 the counter is reset to 000. the last 10 files are retained in the Autosave subdirectory.

Loading shows

‘When loading shows through the Open Show option (File menu), all show data is loaded.

To open a show

Go to the File menu and choose Open Show. The Open dialog box opens

2 Browse to where your saved shows are located. Vector’s default location is: D:\Program
Files\Compulite Vector\Vector Shows.

3 Choose a show from the list of your shows.
4 Tap OPEN.
A dynamic bar shows the load progress.

All patch information, settings, display layouts, nd s ored objects (cues, snaps, macros,

etc.) are loaded.

Importing objects and patch

You can import selected objects or pat h inf rmation from saved shows. This is useful, for
example, if you want to reuse the p tch o libraries from a previous show.

The objects you can import are:

You can import

Objects Patch

QLists Devices

Libraries Sets

Groups DMX Out patch

S ps DMX In patch

Macros Matrix List
Topo view

S
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& Import Options

Mumbering Optionz
5o i

| Sets
DM Qut Select Range
DMX In

Matrix List
Topo Yiew

Figure 103: Import Options dialog box

Color coded selection boxes

Color What it means

Orange All items in this node are sele te

Light orange Not all items in this node re s | cted

Dark orange Required selections tha cannot be changed. Examples:

* When loading QLis , it is required to also load libraries.

* When lo ding the Patch, it is required to also load DMX.

Gray Not sel ted.

Customized numbering for imported objects

Numbering imported objects is customizable in the Numbering Options group in the Import dialog

box.
Example: Your current show has QLists numbered from 1 to 5. You are importing QLists 4
th ugh 6 from a previous show.
APPEND Start numbering imported objects from the next available number.
As per the example: The imported QList 4 becomes QList 6, imported
QList 5 becomes QList 7, and imposed QList 6 becomes QList 8.
START FROM Specify the start number for the imported objects.

As per the example: Starting from 10, imported QList 4 becomes QList
10, imported QList 5 becomes QList 11, and imported QList 6 becomes
QList 12.

KEEP ORIGINAL | The original object numbers are preserved. If there are objects in the
current show with the same number, the imported object will not be
loaded.

As per the example: Only QList 6 will be imported.
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Example: Your current show has QLists numbered from 1 to 5. You are importing QLists 4
through 6 from a previous show.

OVERWRITE The imported objects overwrite the existing objects.

As per the example: imported QLists 4 and 5 overwrite the current QLists
4 and 5.

ATTENTION! When importing objects or patch, the check box next to the item must be
checked and the item must be selected. When selected, the item appears on a dark field.

To load specific objects

1 Open the File menu.

2 Choose (tap) Import.
The Import Options dialog box opens.
Tap the object you want to load.
Select the numbering option.

5 Ifrequired, tap SELECT or DESELECT in the S lect Range group. and select the range of
cues or libraries, etc.

6 Tap OK.

File conversion

Do

Loading Ovation 4D, Micron 4D and Sabre show files to Vector automatically converts them to
Vector format. File conversion is upported from OVD06R04, SPDO6R04, and SBRDO6R03. The
conversion is one sided. Once s ved in Vector format, the files cannot be re-converted to Sabre or
4D format.

Compulite mode and Ac ion syntax are automatically set in the Behavior tab when loading shows
converted from Sabr r4D.

The names of show files that were converted from Sabre and 4D consoles, specify the source of the

converted file. For Sabre shows, the show file number is preceded by the letter’C’. Example:

Tosca_ 0010. For 4D shows, the show file number is preceded by the letter V. Example:
osca_V0010.
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SAVING, LOADING, AND PRINTING SHOW FILES

Converted * QLists

* Memories (including loops, links, text, time in/out)

* Patch

» Configuration (Service Tools P Configuration» System)
» Libraries

* Groups

* Show Text

» Fixtures

Note: Sabre and 4D console devices can be opened in the Device B ilder via
the Patch Manager. You can change their profiles and save them as ew devices
or you can replace them with Vector devices.

Not * Snaps
converted « Macros
e Events

To load a 4D or Sabre show file

1

Go to the File menu and choose Open Show.
The Open dialog box opens.

Browse to the show’s location, select the fi t pe, and the file. Sabre show files: C*.CUE.
4D show files: V*.CUE.

Tap OPEN.
The show opens.

Save the show in Vector f rmat.

Printing shows

You may wis to print hard copy of your shows for archival purposes. Use the Workspace tree to

select he information you want to print.

To select items for printing

1
2

Open the File menu.

Choose Print Multiple.

The Print Multiple dialog box opens.

Open the Workspace.

Expand the Show node.

Tap the items you want to print.

To select more than one item press and hold Ctrl and click each item you want to select.

To select continuous items, click the first item then press and hold Shift and click the last
item.

243 €9
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6 Click or tap PRINT.

Doy



Chapter 9 Libraries

Libraries are a programmable database of preset parameter values.

This chapter includes the following sections:

m About libraries (see page 245)

m Working with libraries (see page 246)

m Using library storage options (see page 252)

m Editing libraries (see page 259)
m Using libraries for programming cues (see page 263)

About libraries

Libraries are user-programmed or automatically g nerated presets for parameter values. Libraries

track through the cues, thus editing a library glob lly updates cues that reference that library.

You can store up to 9999 libraries of ea h ibrary type. The numbering in this list is identical to the

numbering under the Library node in th Wo kspace tree.

1.

H
e

XN kWD

Position - all parameters in e po ition bank.

Color - all parameters in the color bank.

Beam - all paramet  in he beam bank.

Effects - all ef ect a tributes. Effect libraries are non-tracking.

Timing all iming settings.

Intensity - all parameters in the intensity bank. Intensity libraries are non-tracking.
Image all parameters in the image bank.

Shape - all parameters in the shape bank.

Palette - a device specific tracking library that can include all parameters.

Tracking - a fixture specific tracking library that can include all parameters.

Tip! Libraries can be used for assigning base values when programming effects.

245 &)
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Working with libraries

Libraries are stored using console key sequences and the Editor toolbar in library mode or using
library type soft keys.

The workflow for storing libraries is:
1. Select fixtures and assign values.
2. Access library storage by pressing LIB on the console or LIBRARY on the toolbar.
3. Choose the library type and give the library a unique number.

4. Optional - select one of the storage options available on the toolbar.

Each library type appears in a numbered list in the workspace. Library types can be selected by
their list number. You can also use the parameter type keys to select most lib ary t pes. Example:
press COLOR when storing a color library or press 2, which is color library in the numbered library
list.

Automatically generating libraries

Do

Vector can automatically generate:
m Color libraries
m Intensity libraries
m Image libraries

You can choose to generate some or all f these objects for some or all of the devices used in the
show.

Generating libraries is done in t e Generate Groups and Libs dialog box.

¥ Generate Groups and Libs

. Generate All Library numbering options

N

Intensity 7’

Ah[[ 10
Image
N
# Groups

= . Generate For Device: [ Primary Device

1.Channel
| Sepaate Libraries: |
503.Ch+Scroller

. 513.RGB Device
2234.V1.2500 Sp:
2836.ColorWash

< >

Options

Start From: |1

Append |

] 2234 V1.2500 Spot v

If Esasts

Leave Overwrite Update

Figure 104: Generate libraries and groups dialog box
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You can number the libraries to your convenience in the dialog box’s numbering area. The

numbering option fields are:

Start From

Align

Store the first generated library or group to the number in this field and sequen-
tially increment the libraries or groups.

Choose an offset. Generally, it is convenient to chose an offset that corresponds
to your display set up.

Example: Assume that you have sized the soft keys pane to show 5 soft keys per
row. You choose to generate 5 groups for each fixture type. If the start number i
1 and the offset is 10, the generated groups will appear in every other ~w.

If there are existing libraries you can choose to:

Leave

Overwrite

Update

Leave libraries as is. When Vector encounters existing librarie it skips that
library. Example: Color libraries 1 = 3 exist in the show. The first three generated
libraries will begin from 4 and automatic libraries 1 = 3 ill not be generated.

Overwrite existing libraries with the automatical y generated libraries.

Update the existing libraries. Example: You have added a new device to your rig.
You want to add the new device to the utomatically generated libraries

Color and image libraries can be generated for on device or for multiple devices. Vector generates

the libraries for multiple devices according to he primary device.

Primary Device Base librar valu on the parameters as defined in the primary device

when g erating libraries for more than one type of device. Example:
Gener te co or libraries that will be common to three devices. The
primary device has a color wheel and the other 2 devices lack a color
whee , but have CMY color parameters. The libraries are generated
ccording to the primary device’s color wheel. For the other devices,
Vector sets their CMY levels to match the primary device’s color wheel.

Separate L raries Generate separate libraries for each device.

T op the Generate Groups and Libs dialog box

Open the Tools menu and tap Generate Groups and Libs.

OR

1 Press SET.
2 Tap the GENERATE GROUPS AND LIBRARIES button on the Editor toolbar.

IMPORTANT! To generate libraries the check box next to the library type must be
checked and the library type must be selected. When selected, the library type appears on
a dark field.
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To generate common color or image libraries for multiple devices

1 Open the Tool menu.
2 Choose (tap) Generate Groups and Libs.
The Generate Groups and Libs dialog box opens.
Expand Generate All.
4 Make sure Color or Image are checked.
Tap Color or Image to select.
The item appears on a light field.
Set the start number in the Start from fields and the offset in the Align field
Select the primary device from the drop down dialog menu.
Make sure the devices are checked under the Generate for Devices I st.

Select the behavior (Leave, Overwrite. or Update).

- 0 0O N o

0 Tap APPLY or OK.

The libraries are generated according to the primary dev ce

To generate separate color or image librari s for devices

1 Open the Tool menu.
2 Choose (tap) Generate Groups and L bs
The Generate Groups and Libs di log ox opens.
Expand Generate All.
4 Make sure Color or Imag are hecked.
Tap Color or Image to  lect.
The item appear on light field.
Make sure he d vices are checked under the Generate for Devices list.
Set the s rt number in the Start from fields and the offset in the Align field.
Tap EPARATE LIBRARIES.
Se ect the behavior (Leave, Overwrite. or Update).

0 Tap APPLY or OK.

- O 0 N o

Libraries are generated for each device.

To generate intensity libraries

1 Open the Tool menu.

2 Choose (tap) Generate Groups and Libs.
The dialog box opens.
Expand Generate All.

4 Make sure Intensity is checked.

5 Make sure the devices are checked under the Generate for Devices list.

Do
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Set the start number in the Start from fields and the offset in the Align field.
Set the level increments in the% Step field.
Select the behavior (Leave, Overwrite. or Update).

Tap APPLY.

© 0 N o

Storing libraries

To store a library

Example: Store color library 8.
1 Select the fixtures and set the color values.
2 Press STORE.
3 Tap color library soft key 8.
OR
1 Select the fixtures and set the color values.
2 PressLIB.
Or
Tap LIBRARY on the Tool bar.
Press COLOR and 8.
4 Press STORE.

(E]

To store a library

Example: Stor co or library 8.

1 Selectt e fix res and set the color values.
2 Pre s ENTER. The values are output.

3 Pr sSTORE.

4 Tap an available space on the color library soft keys.

OR
1 Select the fixtures and set the color values.
2 Press ENTER. The values are output.
3 Press STORE.
4 Press LIB.
Or
Tap LIBRARY on the Editor tool bar.
5 Press COLOR and 8.
Press ENTER.



Compulite
Chapter 9

ATTENTION! Parameters that are set, in the Device Builder, to be excluded from
libraries are not included when storing libraries manually or when generating automatic
libraries. To override the exclude setting, use the All for Selected Bank option that is
available in library mode on the Editor tool bar.

Adding text tags to libraries

To add text tags to libraries
Select the library.
2 Press TEXT.
The Text dialog box opens.
3 Use the keyboard to type the library name.
4 Press STORE or tap OK.
The dialog box closes.
OR
Immediately after storing the library, press T XT a d follow steps 3 and 4.

LE]

To add text tags to libraries
Press TEXT.
Select the library.
3 Press ENTER.
The Text dialog box opens.
4 Useth key rd to type the library name.
5 Pre s ENTER or tap OK.
Th dialog box closes.

OR
Immediately after storing the library, press TEXT and follow steps 4 and 5.

Deleting libraries

To delete libraries

1 Select the library.
2 Press DELETE.
The Delete dialog box opens.

D50
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3 Press DELETE again or tap DELETE in the dialog box.

(E]

To delete libraries

1 Press DELETE.

2 Select the library.

3 Press ENTER.
The Delete dialog box opens.

4 Press DELETE or ENTER again.
Or
Tap DELETE in the dialog box.

OR

1 Press DELETE.

2 Tap the library soft key.

3 Press ENTER

Examining libraries

To view a list of libraries

Toggle the library soft keys, to gr d view by tapping . A list of libraries is displayed in
the active pane.

Press a parameter key to sel ct the library type and press EXAM.

(E]

Press EXAM, p ss a parameter key to select the library type, and press ENTER.

To examine a library

Example: Examine position library 5.

Select position library 5 and press EXAM. The contents of the library are displayed in the
active pane.

Press EXAM, select the library, and press ENTER. The contents of the library are displayed in
the active pane.

OR

1 View the position libraries in grid format. If the position library tab is in soft key format,
toggle to grid format by pressing )
2 Double click on library 5.

The contents of the library are displayed in the active pane.
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Copying libraries

To copy a library

Copy position library 1 to position library 4.

1 Select position library 1.
2 Press COPY or CUT.

Position library 1 is copied to the clipboard.

3 Select position library 4.
4 Press PASTE.

Position library 1 is copied to position library 4.

The text on the soft key for position library 4 is, Copy of 1.

Using library storage options

S )

Tapping LIBRARY or pressing LIB sets the Editor tool ba to | brary mode, which provides buttons

for expanded control over library storage.

Fixture

Specific

Figure 105: Library mode on the Editor tool bar

N All For
_‘? Ty Pattern Library Tracking | Selected Inglude fihclude Bjnk Allow
pecific Bank Time: Effect Filters  |Reference

» Off - include all active parameters regardless of their
wheel bank assignments.

Buttons What they do Default
FIXTURE This type of ibrary can be applied only to the specific | Depends on the
SPECIFIC fixtures pr grammed in the library. A value is set for library category.
each fix re in the library.
DEVICE Th type of library can be applied to fixtures of the Depends on the
SPECIFIC same device type. library category
PATTERN This type of library is analogous to effects. Not selected
TRACKING The library is tracked for global cue modification. On
ALL FOR All parameters belonging to the same parameter type as | On
SELECTED the active parameter are stored in the library.
BANK
INCLUDE TIME | Time assignments for the selected parameter will be Off
included in the library.
INCLUDE Effects running on the selected parameter will be Off
EFFECT included in the library.
BANK FILTERS |+ On - include all parameters in the bank. On
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ATTENTION! When storing a device specific library, make sure that all selected fixtures
are set to the correct values. Within device specific libraries Vector allows individual
fixtures to maintain a unique value. This is useful in cases where a fixture needs indi-
vidual correction, for instance when gobos have been switched in a fixture’s gobo wheel
and gobo 1 is in the gobo 2’s place.

Fixture and device specific libraries

Fixture libraries can be applied only to the specific fixtures programmed in the library. Dev ce
libraries can be applied to all fixtures of the same device type.

The default library for parameter types are:

Fixture Specific Device Specific Pattern
Position Color Effect
Intensity Beam Timing
Tracking Image

Shape

Palette

Library modes are displayed in the library soft keys.
m Device specific libraries are represented by D.
m Fixture specific libraries are represented y an F.

m Pattern libraries are represented by a P

To store fixture or device specific libraries

Example: Store fixtu e specific color library.
1 Select he f xtures and set the color values.
2 Pre s STORE.
3 T p LIBRARY.
(0]
Press LIB.
4 Press COLOR.
Tap FIXTURE SPECIFIC.
6 Tap a library number in the color library soft keys.
Or

Enter a number on the numeric keypad and press STORE.
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To store fixture or device specific libraries

Example: Store a fixture specific color library.
1 Select the fixtures and set the color values.
2 Press ENTER.

The values are output.

Press STORE.
4 Tap LIBRARY.

Or
Press LIB.
5 Press COLOR.
6 Tap FIXTURE SPECIFIC.
Tap a library number in the color library soft keys.

Or

Enter a number on the numeric keypad and press ENTER.

Library patterns

Library patterns are applied to fixtures eq enti lly as a repeating pattern.

Example: the library contains values for fix ures 1, 2, and 3. Apply to fixtures 1 thru 9.
m The values for fixture lare pplie to fixture 1, 4, 7.
m The values for fixture 2 ar applied to 2, 5, 8.
m The values for fixtu e 3 a e applied to 3, 6, 9.

To store libraries using the pattern option
Exam le: Store a sequential color library.
1 S lect the fixtures and set the color values.
2 Press STORE.
3 Tap LIBRARY.
Or
Press LIB.
4 Press COLOR.
5 Tap PATTERN.
6 Tap a library number in the color library soft keys.
Or

Enter a number on the numeric keypad and press STORE.
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To store libraries using the pattern option
Example: Store a pattern color library.
1 Select the fixtures and set the color values.
2 Press ENTER.
The values are output.
Press STORE.
4 Tap LIBRARY.
Or
Press LIB.
Press COLOR.
Tap PATTERN.
7 Tap a library number in the color library soft keys.
Or

Enter a number on the numeric keypad and press ENTER.

Filtering libraries

There are two buttons that filter librarie :
m ALL FOR SELECTED BANK
m BANK FILTERS

All for selected bank option

Some parameters a € no automatically included in libraries when they are not active in the editor.
Example: Posit ntyp parameters usually include pan and tilt, but certain devices might also have
move speed or mo e time. When storing a position type library, move speed is not automatically
included in th library.

What i automatically included in libraries?

Parameter Bank | Parameters

Intensity bank Dimmer only

Position bank Pan, Tilt only

Color bank All parameters: color wheels, CMY, speed, time, func
Beam bank Focus, Zoom, Iris only

Image bank Only parameters that have been edited

Shape bank All parameters: all blades, etc.




Compulite
Chapter 9

The ALL FOR SELECTED BANK option allows you to include all parameters, belonging to the
parameter bank, in the library.

To include all parameters

Example: You are storing an intensity library for a device that has a shutter and it is not active
in the editor, but you want it included in the library.

1 Select fixtures.
2 Set dimmer level.

3 Press STORE.

4 Press LIB.

5 Tap ALL FOR SELECTED BANK.
6 Store an intensity library.

The dimmer level and the shutter are stored in the library.

Bank filter option

In some cases, you might want to store parameters in libra s th do not normally accept such
parameters. Example: You might want to store dimmer, g bo, nd zoom values in a position library.

When BANK FILTER is disabled, any parameter ¢ n be ored in a library. The default is BANK
FILTER enabled and the button has an orange  1d.

The rules that control which parameters are st red in unfiltered libraries when BANK FILTER is
disabled:

1. If all the parameter values are di played in white in the editor, they are all included in the
library.

2. If there are paramet r values displayed in the red and they do not belong to the library type,
these values are stored in the library. Example: When storing a position library, you intend to
include the dimmer gobos, and zoom parameters. In the editor, pan, tilt, dimmer and zoom
parameter lues appear in white and the gobo values in red. The pan and tilt parameters and
the gobo will be stored in the library. the dimmer and zoom parameters are ignored.

To s ore an unfiltered library
Select the fixtures.
Set a dimmer level.

Set positions.

1

2

3

4 Set gobo values.
5 Setzoom values.

6 Press ENTER

All values are displayed in white.

Press LIB.

-

Press POS.
9 Tap BANK FILTERS.

Doss
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The button now has a blue background and library filtering according to parameter type is
cancelled.

10 Tap an SK on the position library tab.

The position library contains dimmer, zoom, and gobo as well as the color parameters.

To store an unfiltered library

Select the fixtures.
Set a dimmer level.
Set positions.

Set gobo values.

Set zoom levels.

O O A~ W DN =

Press ENTER.

All parameter values are displayed in white.

~

Press LIB.
Press POS.
9 Tap BANK FILTERS.

The button now has a blue background nd brary filtering according to parameter type is
cancelled.

10 Enter a library number on the keypad.
11 Press STORE.

The position library  ntai s dimmer, zoom, and gobo, as well as the pan and tilt parame-
ters.

(E]

To store an unfilt ed library

Sel t the fixtures.
Se dimmer level.
Set positions.

Set gobo values.

Set zoom levels.

O G A WO DN =

Press ENTER.

All parameter values are displayed in white.
7 Press STORE.

8 Press LIB.

9 Press POS.

10 Tap BANK FILTERS.
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The button now has a blue background and library filtering according to parameter type is
cancelled.

11 Enter a library number on the keypad.
12 Press ENTER or STORE.

The position library contains dimmer, zoom, and gobo, as well as the pan and tilt parame-
ters.

To store some of the active parameters in a library

Example: Pan, tilt, dimmer, and color parameters are active in the editor. You want to s ore
pan, tilt, and color settings in a color library, but not the dimmer.

1 Select the fixtures.
Set a dimmer level.
Adjust the pan and tilt.

Set color levels.

g s W N

Press POSITION.
The position wheel bank is now available.
6 Press the parameter keys to select pan and ti
Pan and tilt are now selected (they appear n red) in the editor.
7 Press LIB.
Press COLOR.
Tap BANK FILTERS.

The button now has a blu background and library filtering according to parameter type is
cancelled.

10 Store to a color brar .

The color brar contains pan, tilt, and the color parameters.

Storing intensity libra es as tracking libraries

By de ault, intensity libraries do not track. It is possible, however, to store intensity libraries as
tra king libraries

To store intensity tracking libraries
Select spots and set dimmer values.
Press STORE.

Press LIB.
Press INTENS(ity).
Tap TRACKING.

D s W N -

Press STORE.

EDoss
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To store intensity tracking libraries

1
2
3
4
5
6

Select spots and set dimmer values.
Press STORE.

Press LIB.

Press INTENS(ity).

Tap TRACKING.

Press ENTER.

Editing libraries

LIBRARIES

Libraries can be edited directly or when updating cues. See “‘Using the Update dialog box options”

page 143. Cues referencing a library are automatically updated when the library is modified.

The highlight feature is useful when tweaking libraries. See _Using highlight to update libraries”
page 325.

To edit fixture values in a library

Example: Edit values for spot 2 in imag library 1.

1
2

3
4

Select image library 1.
Press SPOT.

The library values  applied to the fixtures in the library.

Press 2 to selec spot 2 and adjust the values.
Press STOR
Im ge library 1 is updated.

To add fixtures to a library

Example: Add spots 3 and 4 to image library 1.

1
2

Select image library 1.

Press SPOT.

The library values are applied to the fixtures in the library.
Press 3,+, 4 to select new fixtures.

Set parameter values.

Press STORE.

Image library 1 is updated.
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To remove fixtures or parameters from a library

Example: Remove spots 3 and 4 from image library 1.

1 Select image library 1.

2 Press SPOT.
The library values are applied to the fixtures in the library.
Press 3.+, 4 to select the fixtures.

4 Press RELEASE.

5 Press STORE.

Image library 1 is updated.

_E]

To edit fixture values in a library

Example: Edit values for spot 2 in image library 1.
1 On the Editor tool bar, tap EDIT LIBRARY.
2 Select image library 1.
3 Press ENTER.

The library values are applied to the fixtu es in he library.
4 Press 2 to select spot 2 and adjust the va ues.
5 Press ENTER.

The new values are applied to he elected spot.
6 Press UPDATE.

Press ENTER.

Image library 1 is updated.

To add fixtures o a ibrary
Examp e: Add spots 3 and 4 to image library 1.
1 O the Editor tool bar, tap EDIT LIBRARY.
2 S lect image library 1.
3 Select spots 3 and 4 and set values.
4 Press ENTER.
The values are applied to the selected fixtures.
5 Press UPDATE.
6 Press ENTER.

Image library 1 is updated.

To remove fixtures or parameters from a library

Example: Remove spots 3 and 4 from image library 1.
1 On the Editor tool bar, tap EDIT LIBRARY.

D60
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Select image library 1.

w

Press ENTER.

The values are applied to the selected fixtures.
Press RELEASE.

Select spots 3 and 4.

Press ENTER.

Press UPDATE.

o N o a b

Press ENTER.

Image library 1 is updated.

Note: Adding and releasing fixtures from libraries can be applied to ara ge o libraries.

To add parameters to libraries
Example: Include beam parameters in position library 22.
1 Select spots, set the positions, and store position library 2.
2 Toggle the position library soft keys to spread she form t.
3 In the row for position library 22, tap the ch ck b x for beam library.

Fixture []
Fixture []
Fixture []

Fixture []
Fixture []
Fixture []

Toggle to view the p ition library soft keys.

Select the spots gain and set values for zoom and focus.
Press STORE

Press IB.

o N o a M

Tap position library 22.
T Object Exists dialog box opens.
9 T p UPDATE.

The beam type parameters are stored as part of the position library.

Programming reference libraries

Reference libraries contain references to other libraries, thus selecting the reference library applies
multiple libraries to a fixture selection. This is useful when certain libraries are consistently used
together.

Example: Position library 1 lights the drum riser. Position library 2 lights the keyboard area. Posi-
tion library 3 lights the vocalist downstage. Since these libraries are often used in the same cues,
create a library that references these three libraries. You could call this reference library “The
Band”.

261 &)
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The advantage of this feature is that each library is still available for stand alone use.

Reference libraries can be referenced from another library.

Example: Color library 1 lights stage right. Color library 2 lights stage left. Color library 3 lights
the cyclorama. These 3 libraries are referenced from a library called “The Set”. “The Band™ and
“The Set” libraries can be referenced from another library called “The Stage”.

Reference libraries are indicated by the letter’R’ (reference) displayed on the library soft keys.

R indicates a reterence library

Figure 106: This fixture specific (F) position library soft key indicates a reference libra y (R)

Updating reference libraries

‘When updating the source (referenced) library, all libraries referencing the so e are updated. Be
aware that updates track forwards, but not backwards., so the link to th source library may be lost.

Example:
Position library 1 is referenced in position library 10.
Position library 10 is referenced in position lib ary 2.

Referenced

Library in library

Update Result

1 10 Library 1 |+ T e link to library 10 is retained.

* Applying library 10 to a selection, sets the values as
they appear in library 1.

1 10 Library 10 | The link to library 1 is broken.

* Applying library 10 to a selection, sets the values as
they appear in library 10.

10 12 Library 10 |+ The link to library 12 is retained.
* The link to library 1 is broken.

* Applying library 12 to a selection, sets the values as
they appear in library 10.

10 12 Library 12 |+ The link to library 10 is broken.
* The link to library 1 is broken.

* Applying library 12 to a selection, sets the values as
they appear in library 12.

Bank filters and reference libraries

Do

The bank filter feature can be used with the reference libraries. Example: With BANK FILTERS
disabled, reference position and image libraries within the same library.
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To program reference libraries

Example: Program position library 10 to reference position libraries 1, 2, and 3.

1
2

9

Press POS to select position libraries.

Press 1 and ENTER.

Or

Tap position library 1°s cell on the soft keys.

The spots in position library 1 are selected and the library is applied.
Press SHIFT + @.

This cancels the spot selection and allows the next library selection.
Press POS to select position libraries.

Press 2 and ENTER

Or

Tap position library 2’s cell on the soft keys.

Press SHIFT + ®.

This cancels the spot selection and allows the next lib ary selection.
Press POS to select position libraries.

Press 3 and ENTER

Or

Tap position library 3’s cell on the soft keys.

Press STORE.

10 Press LIB.

11 Tap ALLOW REFERENCE

12 Tap a libra y sof key.

Note: Itis Iso possible perform this task by selecting the fixtures, apply the required

libraries and store as a reference library. This allows you to reference only parts of the

s urc libraries, especially when working with fixture type libraries.

Using libraries for programming cues

Using libraries to build lighting looks makes cue editing easier, quicker, and more accurate.

Use of position libraries is particularly important since updating libraries globally updates the cues

programmed with libraries. If your show moves to a new venue, updating your position libraries

ensures that the positions in cues will be on the mark.

More than one library can be selected and then applied simultaneously to the fixtures.
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To program a cue using libraries selected via soft keys
Example: Program a cue using position library 5.
1 Select the fixtures.
2 Switch to the position library tab.
3 Tap 5 on the position library soft keys.

The pan and tilt values are set according to the values stored in the library. The library icon
is displayed in the pan and tilt cells.

4 Store the cue.

To program a cue using libraries selected on the keypad

Example: Apply position library 5, color library 3, and image library 1 t selected fixtures
1 Select the fixtures.

2 Press POSITION and enter 5 on the numeric keypad.

3 Press ENTER.

The pan and tilt values are set according to the values stored in the library. The library icon
is displayed in the pan and tilt cells.

4 Press COLOR and enter 3 on the numeric k ypad.
5 Press ENTER.
The color values are set according to the values stored in the library.

The library icon is displayed i the r levant parameter cells. Press IMAGE and enter 1 on
the numeric keypad.

6 Press ENTER

The image value are se according to the values stored in the library. The library icon is
displayed in the relevant parameter ells.

7 Storethec e.

Note: After electing a library, pressing NEXT or PREV cycles through the libraries.

To apply multiple libraries simultaneously

Example: Select position library 1, color library 3, and image library 5 and then apply them to
the selected fixtures.

1 Select fixtures.
Press POS and 1 to select position library 1 (or use any other library selection procedure).
Press COLOR and 3 to select color library 3 (or use any other library selection procedure).

Press IMAGE and 5 to select image library 5 (or use any other library selection procedure).

g s W N

Press ENTER.

All of the selected libraries are applied to the fixtures.

D64
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Updating libraries when updating cues

See “Using the Update dialog box options” page 143.

Library time

The library default time, the rate at which a library fades in, is set in the System Settings dialog box
P Timing tab. You can change this default time, when the editor is in rate mode, using a rate wheel.
This is useful when running a show live, creating mock fades. When the library default time is
changed in the editor, it is changed automatically in the System Settings dialog box.

To change the library default time in the editor
1 Press RATE.
2 Use the Lib Fade Time wheel (wheel 4) to change the default fade time.
Or

Select library rate time by tapping the wheel assignment r pressing the wheel key and then
enter the rate time on the keypad.

3 Press STORE.

The new default rate time is stored.

(E]

To change the library default time n he editor
1 Press RATE.
2 Use the Lib Fade Tim wheel (wheel 4) to change the default fade time.
Or

Select libr ry ra e time by tapping the wheel assignment or pressing the wheel key and then
enter th rat me on the keypad.

3 Pre s ENTER.

Th new default rate time is stored.

Library soft keys

Library soft keys are color coded. When you select fixtures, the library soft keys’ color code shows
the applicability of the library to the selection.

Color What it means

Orange The library matches all the fixtures in the selection.

Light orange The library matches some of the fixtures in the selection.

Gray There is no match between the library and the fixtures in the selection.
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Color

What it means

Blue

» There is no selection; the system is in idle after pressing SHIFT + RESET.

* There is no such library.

Note: The same color code is used for Context soft keys displaying libraries.




Chapter 10 Effects

This chapter includes the following sections:

m About effects (see page 267)

m Storing effects (see page 271)

® Movement attributes (see page 271)

m Time attributes (see page 278)

m Releasing effects from cues or from the editor (see page 283)

About effects

Effects are continuously running fades of parameter alu  spread among a number of fixtures.
Effects on the pan and tilt parameters can be used fore mple, to create circles and figure 8s.
Effects running on color parameters can be us d to ¢ ate a rainbow effect. The use of effects is as
unlimited as your imagination.

Effects editor

Effects are programmed and dited in the Effect Editor dialog box. When the Effect Editor is open,
the parameter wheels are t to the effect wheel bank. Offset, size, rate, and duty cycle attributes
can be set using the wheels or the fields in the Effect Editor. Base values for the selected parameter
are controlled with he wheel labelled BASE. The vertical wheel controls the dimmer intensity. The
trackball contro s pa  nd tilt.

Effects can e programmed for all fixture types and all parameters. Effects can be played back on
all playba k devices and in the editor.

The defa 1t position for the Effect Editor dialog box is aligned left, so the Offset, Size, Rate, and
uty attributes appear above their control wheels.

Note: Vector remembers the dialog box’s last position, therefore if it was moved it will
not be aligned with the wheels next time it opens.
Pr built effects

Vector is supplied with prebuilt effects. All attributes of prebuilt effects can be modified. You can
also build your effects from scratch using the primitives and attributes that appear on the Effect
Editor’s Basic tab.

267&)
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Figure 107: Pre-built effects in the Effect Editor dialog box

To use prebuilt effects

1 Select fixtures.

2 Press EFFECT. The Effect Editor dialog box opens. The wheel assignments jump to the
effect wheel bank.

3 Tap the Pre-built tab. Choose an effect.
The effect immediately begins running.
4 If necessary, adjust the effect using the wheels. See “Attribut  page 268.

5 Store the effect as a cue or store it as an effect library.

Effect attributes

1 Effect Editor

Figure 108 Basic tab in the Effect Editor dialog box

Attr butes
Primitive Primitives are the effect’s basic movement pattern.
Swing Swing settings determine the value range of the effect.
Wave Functions Wave Automatically fan offset attribute
Single Automatically fan offset attribute and set the
duty cycle’s Total attribute.
Normal Cancel the wave function and reset all

attributes that were automatically changed.

9263
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Attributes

Rate Direction

Switch effect direction

Neg(ative)

Pos(itive)

Offset Controls the point at which a paramete begins its action within the time
cycle.
All etth same off set for the selection.
Fan F ns the offset on the fixture selection.
Size Determines dire tion and scope of the effect in relation to the base value.
All Set the same size for the selection.
Fan Spread the size relatively over participating
parameters.
Rate Sets the number of seconds it takes to complete one effect cycle.
All Sets the same effect rate for all participating
parameters.
Fan Fans the rate on the fixture selection.
D yC le Determines how many times the effect occurs within one time cycle.

On

How many times effect repeats

Total

Time cycle
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When editing effects, use the keys to toggle Effect attribute parameters
Primitives

Primitives are the effect’s basic movement pattern Com inin primitives is a quick way to create
effects. Example: Create a circle by assigning (primi ve) sine to pan and (primitive) cosine to tilt.
primitives are available in the Basic and Advanced tabs

Release Sin Cos Step Ramp Up Ramp D:
Figure 109: Primitives in the Basic ta
ANl N A M
FPawer wave Triangle | Tiapeze

Figure 110: Primiti es in he Advanced tab

Fan and selection order

The order i which fixtures are selected determines the order in which fan settings are executed.
Ex mpl If the spot selection was 1 = 12, spot 1 is the first spot to respond, spot 2 is the next, etc.
fthe pot selection was 12 —> 1, spot 12 is the first spot to respond, spot 11 is the next, etc. This is

also true for non-sequential spot selections.

To program an effect
1 Select fixtures and parameters.

2 Press EFFECT.
The Effect Editor dialog box opens. The wheel assignments jump to the effect wheel bank.

Choose a primitive. The effect immediately begins running.
4 Adjust the effect using the fields in the Effect Editor or the wheels.

Store the effect as a cue or store it as an effect library.

Do
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Storing effects

Once an effect is working to your satisfaction, you can store it as a cue or as an effect library.

The default for effect libraries is pattern libraries. An effect library is never specific to a device. It
can be applied to all fixtures and is not limited to the fixtures that were active when the effect
library was stored.

Effect libraries are applied as patterns. Example: when stored the effect was running 3 spots. Apply
it to 9 spots and itruns as 1, 2, 3, 1, 2, 3,1, 2, 3. Of course, when storing the effect library this
default can be changed. Using library storage options (see page 252).

Note: Choosing INCLUDE BASE, when storing effect libraries, causes base valu s in
effect libraries to override the parameter values in the editor.

To store an effect in a cue
The procedure is the same as storing any cue. Storing cues (se_pag 127).

To store an effect library

1 Designate a soft key set for effect libraries
2 Press STORE.
3 Tap a number in the effect library soft keys.

Movement attributes

Primitive

Effects’ movement attribu s are
m Primitive
m Base
m Swing

m Siz

Primitives are the effect’s basic movement pattern. Vector comes with five primitives. Different
primitives can be assigned to each parameter. Combining primitives is a quick way to create

Famp D owrl

complex effects.

&

Release

Sin Cos Step Famp Up

Figure 111: Primitives in the Effect editor, Basic tab
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A

Fower

N

‘wWave

A

Triangle

M

Tiapeze

Figure 112: Primitives in the Effect editor, Advanced tab

A primitive can be assigned at any point during effect programming. You may find that you want to
adjust the base, assign offset, and rate values before assigning the primitive.

Most primitives operate from 0% - full and back to 0%. This can be manipulated by changing the
size attribute.

To assign a primitive
1 Select fixtures and set base values.
2 Press EFFECT.

3 Tap a primitive that appears in the Basic tab. The effect is immediately applied.

Primitive schematics

S

Sine primitive

Sine starts at 50%. it runs from 50% to full to 0% and ba k to 50%. This characteristic causes the
effect to rest at 50% when the duty cycle is somethin other than 1:1 Use sine together with cosine
to program a circle effect.

Value
I |
! i
+SIZ€‘/2 ............. Jeceronatl - B - - !
I |
‘ i
Base J
I |
! |
-Size/2 > [ — i
! i
H ! Time
50% One complete
cycle
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Cosine primitive
Value

+Size/2 |

Base

-Size/f2 et I

50% One complete Time
cycle

Step primitive
Value

-I-szellfz ................... .

Base

-Sizef2

i
|
|
|
|

J
|
|
!
|
|
1
i
|
1
|
I
|
l
|
1
|
i

50% One complete Time
cycle

Ramp up primit ve

Value
Base
-Size/f2
I
: Time
50% One complete
cycle

273 9
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Ramp down primitive
Value

+Size/2

Base

Time

56% One complete
cycle

Base

Base is the parameter value that defines the effect’s starting poin . Base values are parameter and
spot specific. Set the base value prior to accessing the Eff ct Edit . Use the base wheel to change
base values. Change dimmer (intensity) values using the verti al wheel.

To modify base values

Select the fixtures and the parameter. U e the base wheel to change the parameter value.

Tip! Use libraries to set base valu s.

Swing

Swing determines th dire tion and scope of the effect in relation to the base value, the starting
point. Swing anb Up Center, or Down.

Swing——————
SN
Up Normal ~— Down

F gure 113: Swing options in the effect editor

Up swing
Value

Base+Size

Base+Size/2

Base

74



Center swing

Value

Base +Size/2 | =

Base | —

Base -Size/2 | .. .. T

Down swing

Value

Base =

Base-Size/2 i 8

Base-Size

Swing examples
Example 1
m Base 30
m Size 50%
m Swing Up

Size

The effect runs from th base (30) to 60 and to 90.

Value

BaceLGira gl - - - - - i

d,/
z’/”
t/’
Base+5izef2=60----------- spEinaney e
Pt
L e
Base=30=
Example 2
m Base 30

m Size 50%

m Swing Down

VECTOR

EFFECTS
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The effect runs from the base (60) to 30 and to 0.

Value

Base=60

Base-SiZef2=30 (s st ea st b Size=60

Base-Size=0 |- ------rrrrrrriiiienee oLl

Example 3
® Primitive - Sine
m Base 70
m Size 50%
m Swing Center

The effect runs from the base (70) to FL (100%) to 20.

Note: The top of the effect is actually 120. The effe  tay at 100% for the length of
time it takes to run from 100% to the virtual v lues above 100%).

Value
+Size/2=120%

100%

Base=70%

-Size/2=20%

Time

56% One co‘mplete
cycle

Visible
Virtual mmmms

D ss
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Size determines how much movement takes place from the effect’s starting point (the base). Size is

a percentage. The size range is from 0% to 100%. The size default is zr or 50 or FL depending on

the type of parameter.

Value
Base +8izg)2 |--=vme-emimviinnins __,-;-f-'-’:'-'-'
Base if:;:x-f ] Size
Base -Size/2 . = “_“:~_|_ .......

Example: The base is 60, size is 60, swing is center. The range of mov ment is base +30 and base -

30.
Value

Base+Size/2=90 [t g =y

Base=60  fme— Size=60

Base-Size/2=30 f--------meeee s TT?"-'-"-" -

Example: The base is 30, size 60, swing is center. The range of movement is base +30 and base -
30. The parameter value limits are 60 at the top of the effect and 0 (zero) at the bottom of the effect.

Value

Base+Sizef2=60" |- g o

Base=30 — ‘ Size=60

Base-Size/2=0 el

To change the size

Select the fixtures and the parameter.
Press EFFECT to open the Effect Editor.

If necessary, tap ALL in the Size group.

A WO DN -

Use the size wheel to set the value.

Or
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Enter an absolute value on the numeric keypad.

To apply (size) fan

Select the fixtures and the parameter.
Press EFFECT to open the Effect Editor.

Tap FAN in the Size group.

W N -

Use the size wheel to set the fan value.

Or

Enter an absolute value on the numeric keypad.

Fanning parameters

The FAN PARAMETERS option fans the effect over parameters. This allows ¢ ntrol over the
parameters in a single spot.

To fan parameters

Example: Apply a fan effect to cyan, magenta, and yell wi spot 1.
1 Select spot 1.
2 Select cyan, magenta, and yellow.
3 Press EFFECT.
The Effect Editor dialog box op ns
Select a primitive from the Pre- it, Basic, or Advanced tabs.
5 Go to the Advanced tab.
6 Tap FAN PARAM
The Offset, Size, and Rate attributes can now be set for fanning parameters.

7 Adju the Offset, Size, and Rate attributes as required.

Time attributes

Th ime attributes are:
m Rate
m Offset
m Duty Cycle

s
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Rate is how many seconds it takes to complete an effect cycle. Example: A rate setting of 4 seconds

means that the entire effect cycle is completed in 4 seconds.

Rates can be positive or negative. A negative rate causes the effect to switch directions. Example: A

circle effect assigned a rate of 10 seconds runs clockwise. A circle effect assigned a rate of -10

seconds runs counter clockwise.

To change the rate

1
2
3
4

Select the fixtures and the parameter.
Press EFFECT to open the Effect Editor.
Tap ALL in the Rate group.

Use the rate wheel to set the rate value.
Or

Enter an absolute value on the numeric keypad.

To fan the rate

A WO DN -

Select the fixtures and the parameter.
Press EFFECT to open the Effect Editor.
Tap FAN in the Rate group.

Use the rate wheel to set the fan v lue.

Or

Enter an absolute value on the numeric keypad.

The offset con rols when a parameter begins its action within the time cycle. Offset has two

settings:

m All

Sets n absolute offset value to the selected fixtures.

m Fan - Spreads the offset over the selected fixtures.

o pr vent accidentally changing the offset when setting the rate attribute, you can lock the offset.

To set an absolute offset

1
2
3
4

Select the fixtures and the parameter.
Press EFFECT to open the Effect Editor.
Tap ALL in the Offset group.

Use the rate wheel to set the offset.
Or

Enter an absolute value on the numeric keypad.
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To set fan offset

1 Select the fixtures and the parameter.

2 Press EFFECT to open the Effect Editor.

3 Tap FAN in the Offset group.

4  Use the rate wheel to set the fan offset.
Or

Enter an absolute value on the numeric keypad.

To lock the offset

In the Effect Editor on the Advanced tab, tap OFFSET LOCK.

Fixture grouping
Fixture grouping with offset determines how the offset is spread among the devices.

Example: An intensity step effect is running on spots 1 through 10. All 10 spots turn on and off at
the same time. Set the fixture grouping to 2 and tap WAVE. Now he odd spots are on when the even
spots are off and vice versa.

Examples of Offset uses

Example: program an effect for channels where gro ps of channels are on or off at the same time in
a step effect. The channels are divided like h s:

m Group 1 - channels 1, 11, 21

m Group 2 - channels 2, 12, 22

m Group 3 - channels 3, 13 23

m Group 4 - channels 4, 14, 2
Use Offset All and as gn:

m OffsetO0t gro p1

m Offset 25 to group 2

m Offs 50 to group 3

m Of set 75 to group 4

Example: Offset All and Offset Fan can be used together. Changing offset values using All does not
change the relative fan. Channels 1 through 4 have been set to fan values:

Channels | Offset using Fan | After adding 5% using All
Channel 1 0 5

Channel 2 25 30

Channel 3 50 55

Channel 4 75 80

Doso
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Duty Cycle

The duty cycle determines how many times, within one time cycle, a parameter executes its effect.
Duty cycle settings also allow some fixtures to run while other fixtures are resting.

The duty cycle is represented by two numbers- On and Total. The first number (On), the numerator,
is the number of repeats within the time cycle. The second number (Total), the denominator, is the
division of allotted time. The duty cycle default is 1:1.

The value for On may not exceed the value for Total.

Duty cycle schematics

Example: This effect is running 3 fixtures.
m Duty Cycle: 1/3
m No offset

Value

Spotl

Base|

Spot2

Base|

Spot3

33% 66% Ful Time
Example This effect is running 3 fixtures.

m Du y Cycle: 1/3

m Offset: 0/33 /66

281 &)
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Value

Spotl

Base

Spot2

Spot3

Base

66% Full Time

Some examples of duty cycles:

33%

Duty Cycle | Rate What happens

1:1 6 seconds | Parameters complet 1 effect cycle within the allotted time period
(6 seconds)

1:2 6 seconds | Parameters complete 1 effect cycle in half the allotted time (3
seconds) During the remainder of the time cycle (3 seconds) they
rest.

2:2 6 seconds | Parameters complete 2 effect cycles within the allotted time
period.

2:4 6 seconds | Parameters complete the effect cycle twice in half the allotted time
(2 complete effects in 3 seconds). During the remainder of the time
(3 seconds) they rest.

1:3 6 seconds | Parameters complete 1 effect cycle in 1/3 the allotted time (2
seconds). During the remainder of the time cycle (4 seconds), they
rest.

3:6 6 seconds | Parameters complete the effect cycle 3 times in half the allotted
time (3 seconds). During the remainder of the cycle (3 seconds),
they rest.

To change the duty cycle

1 In the Duty Cycle group, tap Total.
2 Use the duty cycle wheel to set the time division.
3 In the Duty Cycle group, tap Total.
4 Use the duty cycle wheel to set the time division.

Do
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In the Duty Cycle group, tap On.

6 Use the duty cycle wheel to set the number of repeats.

Synchronizing effects

You can synchronize effects running on different parameters. Attributes that are synchronized are:

m Offset

m Rate

m Duty cycle

To synchronize effects

Example: The effect running on cyan is ramp up and wave. The effect running on magenta is

ramp up. Synchronize the effects on cyan and magenta.

0 N O g A ON -

Select fixtures, select cyan and set a base level

Press EFFECT.

Choose RAMP UP and WAVE.

Select magenta and set a base level.

Choose RAMP UP.

Go to the Advanced tab in the Effects dialog box and tap SYNC WITH.
Select cyan.

Tap CLOSE.

Now the cyan and magenta effects are starting and finishing at the same time.

Releasing effects from cues or from the editor

You can release effect assignments from all the parameters, from selected parameters, or from

parameter types.

To r lease effects from cues

Select the cue.
Select the fixtures.

Optional - select the parameters. If no parameters are selected, then all parameters are
released.

Press EFFECT. The effect editor opens.

Press RELEASE. The selected fixtures and parameters are released from the effect. The
effects editor closes.
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6 Press UPDATE.

OR

1 Press RELEASE.
2 Press EFFECT.
3 Select fixtures.

4 Select cues.

5 Press UPDATE.

To release effects from all fixtures in the editor

1 Press EFFECT. The effect editor opens.

2 Press RELEASE. Effects are released from all parameters. The effec s editor closes.

To release effects from parameter types

Example: Release effects from all color parameters.

1 Select the fixtures.

2 Press COLOR.

3 Press EFFECT.

4 Press RELEASE. All color parameters are freed from effects.

LE]
To release effects from cues

1 Press RELEASE.
2 Press EFFECT.
3 Select cue.

4 Press ENT R.

OR

1 Tap EDIT CUE.

2 Chose the cue.

3 Press ENTER.

Press RELEASE.

Select the fixtures.

Optional - select parameters. If no parameters are selected, all parameters are released.
Press EFFECT. The effect editor opens.

Press ENTER.

0 N o g &

To release effects from fixtures in the editor

1 Press RELEASE.

2 Select the fixtures.

D os4
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Optional - select parameters. If no parameters are selected, all parameters are released.
4 Press EFFECT. The effect editor opens.
Press ENTER. The selected parameters are released from the effect. The effects editor

closes.

To release effects from all fixtures in the editor
1 Press RELEASE.
2 Press EFFECT. The effect editor opens.

3 Press ENTER. Effects are released from all parameters. The effects editor closes

To release effects from parameter types
Example: Release effects from all color parameters.
1 Press RELEASE.

Select the fixtures.

Press COLOR.

Press EFFECT.

a A W DN

Press ENTER. Effects are freed from all col r par m ters.

Note: This sequence is valid for all paramet r types.
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Chapter 11 Matrix

This chapter contains the following sections:

m About Matrix (see page 287)

m Setting up matrixes (see page 288)
m Programming cues using matrixes (see page 290)
m Image editing (see page 294)

About Matrix

Vector’s interactive matrix programmer is used to program es r:
®m RGB or CMY devices in a matrix format
m A truss wall rigged with conventional channe s or other devices

m Any configuration where the fixtures ar rigged in a matrix format.

Vector’s matrix feature supports.*gif, * ico (icon), *.bmp, and *.jpeg files including animated
graphic files.

| Matrix work flow |

Patch Manager l ::-Deﬂnflrr[latrix

\vf
Map patched fixtures to matrix cells

Save and exit Patch Manager

4

Editor l_:":}ge;lect fixtures and assign values
Load picture files
y
Store the lighting state as a cue

pY
Playback the QList

Note: Matrix capacity is limited to up to 2,500 RGB or CMY devices (7,500 DMX
channels, 16 DMX universes).

287&’)
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Setting up matrixes

Matrixes are set up in the Patch Manager. Creating a matrix means defining the number of cells
(rows and columns) and mapping patched fixtures to the cells.
To import and patch fixtures for use in the matrix
Example: Import an RGB device and create 400 fixtures for a 20x20 matrix grid.
1 Tap IE
A dialog box containing a list of devices opens.
2 Expand the Generic node and choose an RGB device.
3 Tap OPEN.

Defining new matrixes

9288

The size of the matrix is set in the Matrix Data dialog box.

Matrix Data

Number of fields

E—

ok ] Cocel |

Figure 114: Matrix Data ialog box

To create a matrix

Open he Patch Manager.

N

Make sure the Workspace is in navigation mode. (Tap N).
In the Workspace, tap Matrix List.

On the Patch Manager tool bar, tap .

The Matrix Data dialog box opens.

5 Fill in the fields in the Matrix Data dialog box.

~w

6 Tap OK. The matrix’s name appears in the Matrix List.

To map fixtures to the entire matrix grid

1 Select the matrix from the Matrix List.
2 Tap S to switch to selection mode.

3 Choose fixtures from Matrix in the Sets node.
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If there are no fixtures in the matrix set, choose fixtures from Channels or Spots in the Sets
node.

4 Drag fixtures from Matrix (or Channels or Spots) and drop them in the matrix cells. Repeat

until the matrix mapping is complete.

Note: You can select a range of fixtures, by holding down SHIFT and clicking on the
first and last fixtures in the range. Then drag the entire selection and drop it in the first
cell of the range. The selection will arrange itself 1:1.

5 Exit the Patch Manager.

Don’t forget to save the changes.

To map fixtures to selected matrix cells

You can select cells on the matrix and drag and drop fixtures to map them to the selected cells.
The cells are populated from left to right and from row 1 down.

1 Tap N to put the Workspace tree in navigation mode;
2 Select the matrix from the Matrix List.

The matrix is displayed in the main patch pane.

Tap S to switch to selection mode.

4 Select fixtures from Matrix in the Sets nod and drop them in the matrix cells.

Workspace Tree LRl Potch - Matrix List - Pops

CN

= 2.Matrix ~

1

DI ARGE DevilRGE DevilRGE Dewvil

Fixture [I-RS RG_2 RG_3

Address

Device RGB DevilRGE DevilRGB Devii

2 Fixture RG_4 RG_5 RG_6
Address
Device RGB DeviiRGE DevilRGE Deviv

3 Fizture RG_7 RG_8 RG_39
Address
Device RGB DevitRGB Devit RGB Devit

Fixture RG_10 RG_11 RG_12

Address

Device

5  Fixture

Address

13.0C 13
141G 14

TR O O O O B O B 3 O M O - e

Fi ure 115: Mapping fixtures to selected cells

o clear fixtures

1 Select the matrix from the Matrix List.

2 Select the fixtures by tapping on them in the matrix grid.
Tap l .
The Delete ltems warning is displayed.

4 Tap YES to continue and delete the fixtures.

Tap NO to cancel.

To delete a matrix

Select the matrix in the Matrix List node and tap x .
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Matrixes using conventional channels

When using convention channels with color filters in a matrix format, you may want to set the color
properties for the channels. The advantage of setting the color properties is that when programming

cues, the correct color will be displayed on the matrix grid. If the color property is not set, the
channel is shown in white.

Malrix Fixture Prop

Y Localion ]

Colar Name: Fink.

Colr [

ENEEN
EEE D
we | EEEE
we  OEEE

- L

Figure 116: Matrix Fixture Properties dialog box

Gened
Sel:

To set color properties

1 Select the fixture in the matrix grid.
2 Tap _‘;.5 . The Matrix Fixture Properties dialog box opens.

3 Choose a color from the drop down color list.

4 Tap OK.

Programming cues using matrixes

D90

Once a matri 1is set up and fixtures are mapped in the Patch Manager, you can program cues that

use th mat ix. Cues are programmed as usual and, of course, are organized in QLists. Playback
th eQ 1 tsasusual

V ct ruses a special display, the matrix programmer, for programming these cues.
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Matrix grid The rectangle shows the bitmap area that fits the matrix grid

!

Access image files

ClearImsge | — Clear loaded image

Select active matrix fixtures

wu'e it image
siege || *H™* | €— Open Vector image editor

4— Ignore transparent colors in imported image
[ [> ] — Animated image frames counter

«4—Preview animated images

4— Enable dragging across grid to select fixture

md— Show/hide matrix grid

Create Chaser 4— Create chaser

Lhan;e Color: (0,255.0)

m .<l <4— Color picker

Figure 117: The matrix grid and programmer

Matrix programmer What it does
elements
Matrix Grid » Represents the m rix grid area as defined when setting up the
matrix.
* Click on cells to select matrix RGB fixtures.
Define area Thisr ct gle defines the area of an image that is output to the matrix.
Load file Lo d a graphic file.
Clear image C ar the loaded file.
Edit Image Open the Vector Image Editor to edit the current graphic file.

Capture Stage

Grab all the active RGB fixtures.

Ignore Transparent

Manage images with transparent color layers.

Image rames

Animated graphic file frames appear here in a # of # format. Example:
2/10 means the current frame is frame 2 out of 10 frames. Use the
arrows to go to the next or return to the previous frame.

Auto run

Preview animated graphics. The cues run in default system time.

Group Selection

Enabled - Select blocks of fixtures on the matrix grid cells.

Disabled - Select select fixtures by tapping individual cells.

Show Grid

Show or hide the grid lines on the matrix grid.

Create Chaser

Automatically program chasers for animated gif files.

Color picker

Select colors using the color picker.
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Tip! Create color effects using the effect editor e or the fan feature with the RGB fixtures.

When setting color levels for RGB fixtures,

To display the matrix programmer
Activate a pane.
Open the Workspace and expand the Live node and the Matrix subnode.
Tap one of the matrix setups.
The selected matrix is displayed.
4 Optional - Toggle show/hide the matrix grid lines by tapping SHOW GRID.

To program cues using fixtures

1 Select fixtures. Tapping a cell in the matrix grid, selects the fixture mapped to that cell.
Tapping on multiple cells selects all the fixtures mapped to that ell.

Or
Select fixtures using the usual methods.

2 Assign values. The active values are display d in he matrix grid.

Figure 118: The mat ix grid shows the active fixtures and their color values

3 Save the lightin state as a cue using the usual methods for saving cues in QLists.

4 Contnue rogramming cues as necessary.

To prog am cues using bitmaps

Ve rsupports most picture formats and animated graphic files.

Image as applied Portion of image
in the matrix that is used

Figure 119: Matrix programmer grid with imported bitmap

1 Display the matrix programmer.

S
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Tap LOAD IMAGE. The Open dialog box opens.

Browse to your image, select it, and tap OPEN. The image is displayed. The usable portion
is delineated by a rectangle. The area within the rectangle is displayed in the matrix grid.
Fixture selection and setting the parameter values are automatic.

If necessary, change the portion of the image output in the matrix. Move the rectangle to
surround the portion you want to use by dragging it (the pointer becomes a hand tool) to a
different location. The editor automatically resets the fixtures and the color values.

Store as a cue in a QList.

To program cues using animated graphics

LoadFile... | ClearImage LoadFile... | Clear Image
Capture ; Capture
Stage Edit Image Shap Edit Image
Ignore Transparent ) ) Ignore Transparent
Animated image - frome 1 Animated image - frame 2
( I!T 10 2 J 2710
— 7
Auto-Run Auto-Run
Frome number
Go to previous or next fiame When enablea, frames run automatically

a A WO N =

Display the matrix programmer.

Tap LOAD IMAGE. The Open dia og box opens.

Browse to the animation nd double click to open. The first animation frame is displayed.
Store as a cue in a QL st.

Advance to the next frame and store as a cue. Continue until you have stored each frame as
a cue. You can skip or repeat frames.

To automati ally p ogram chasers

1
2

o g A~ W

Display the matrix programmer.

Tap LOAD FILE.

The Open dialog box opens.

Browse to the animation and double click to open.
The first animation frame is displayed.

Optional - tap AUTORUN to preview the animation.
Tap CREATE CHASER.

The Create Chaser dialog box opens.

Fill in the fields.
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Create Chaser @

Qlist #: 998
From Frame: |1 ToFrame: 10
CueTime [p20 |

[ Cieate ][ Cancel ]

Qlist  The chaser cues are stored in the QList designated here.
# Attention - Choose a QList number that is not used yet!

From  Start frame. It is not necessary to use all the animation
Frame frames. The chaser can start from any frame.

To Last frame. It is not necessary to use all the animation
Frame frames. The chaser can end at any frame.

Cue  The chaser defaults to system time as set in System
Time  Settings > Timing.

Figure 120: Create Chaser dialog box
8 Tap CREATE.

One cue is automatically stored for e ch f ame in the selected range. While cues are stored,
a progress bar is displayed in the Crea e Chaser dialog box.

Image editing
The Vector Image Edi r di log box provides standard image editing tools to edit graphic files used
in the matrix
Some of examples of image editing:
m Ch geb ckground color.
m Create a mirror image.

m Blur the image, return to the programmer, and save the edited image as a cue. Then return to
the Image Editor, sharpen the image, and save as the next cue. Repeat as desired; the image

goes in and out of focus when playing back the cues.

D94
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Standard Draw Tools

VECTOR

MATRIX

BE

EEEE &=

N E Y E] L ENRFata

Image E dit
Transform Tools

EREHE(E

(2 )e])[2](=] [&][s]lo]lo]

Em|

MHudge Tools:

Colors

o) [A[=](=][e]

Fant

Foreground: _ - F Times Mew Rom:

Advanced l

Cancel

Apply

Figure 121: Vector Image Editor

15,461

Standard Draw Tools

EEEE &EE |

» Pointer - When this tool is se cted, you can drag .
the blue frame that delin ates the part of the image
used.

» Rectangular selecti n tool - Define a rectangular .
area for de ting or copying.
+ Ellip ical selection tool - Define an elliptical area .
fo del ting or copying.

* Fre form selection tool - Define a freeform area for | ¢
deleting or copying.

Pencil tool - Moving the pencil point over pixels
colors them with the color that appears in the Fore-
ground field.

Erase tool - Moving the eraser over pixels erases the
color.

Fill - Clicking on a pixel, colors it with the color
that appears in the Foreground field.

Transparent dropper - Clicking on a color in the
image, makes that color transparent. This is applied
to all the pixels using that color.

D Jelle)==)la] (2] k]
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* Line tool - Draw a line in the image area. The line’s
color is the color that appears in the Foreground
field.

» Ellipse tool - Draw an ellipse. The outline of the
ellipse is the color that appears in the Foreground
field.

 Filled ellipse tool - Draw a filled ellipse. The fill
color is the color that appears in the Foreground
field.

* Rectangle tool - Draw a rectangle. The outline of
the rectangle is the color that appears in the Fore-
ground field.

Filled rectangle tool - Draw a rectangle. The fill
color is the color that appears in the Foreground
field.

Text tool - Draw a text box and then type text.

Color selection tool - Click on any pixel to set its
color as the foreground color.

Brush tool - One click colors large areas with the
color that appears in the Foreground field.

Image Edit

W & | B RB|

C E] 1:1 || & |

* Open image from file - Browse to open another
image that replaces the current image.

* Cut - Cut the area of the image defined by one of the
selection tools.

* Copy - Copy the area, defined by one of the selec-
tion tools, to the clipboard.

» Paste - Paste the clipboard contents.

Undo - Undo thel s action.

Repe t- R peat the last action.

Zoom in Enlarge the view of the image.
11- i play the image with no enlargement.

Zoom out - Reduce the view of an enlarged image.

Transform tools

i

AEEE]

* Resize image - The resize dialog box opens.
* Resize border area - The resize dialog box opens.

* Not used

Flip the image 180 degrees
Create a mirror image.
Change all colors to grayscale.

Convert the image to negative.

G|l e || E || 2=

* Rot te the image 90 degrees left.
* Rotate the image 90 degrees right.

* Rotate at an angle specified in the rotate dialog box.

» Skew the image as specified in the skew dialog box.

Brightness - Make the image lighter.
Brightness - Make the image darker.
Contrast - Increase the contrast.

Contrast - Decrease the contrast.
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* Blur - Blur the image. » Feather - Soften the image according to the value in
the feather dialog box.

Tip! Blur is useful for taking the image in

Offset - Add a random offset to each pixel.
and out of focus.

Tip! Offset is useful for scrambling and

» Emboss - Create an embossed effect. reassembling an image.

Soften the image.

« Sharpen the image. Enhance the variations between each pixel.

* Colorize - Change the colorati n of he entire image
through the color dialog box.

Colors and font

Colorz Font

Faoreground: _ - T Times Mew Fom: »
Backgraund: |:| - [ Advanced

» Foreground - Choose the color to apply to image » Font field - Select the font for free text.
pixels and free text, using the various editing to Is. |+ Advanced - Open the font dialog box.

» Background - Choose the background ¢ or.

To edit matrix images

1 Loadt e gr phics file or select fixtures to the matrix.
2 Click EDIT IMAGE on the matrix programmer.

T e Vector Image Editor opens.

Edit the image.
4 Click APPLY.

Click OK.

The Vector Image Editor closes and you can continue programming.
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Chapter 12 Macros

This chapter includes the following sections:

m Working with macros (see page 299)

m Triggering macros (see page 303)

About macros

Macros are collections of commands. Triggering a macro activates he ¢ mmands stored in the
macro. An example of a possible macro is: FREE, SELECT (for PB 2 QLIST, 5, SELECT (for PB
2), GO.

Macros are triggered manually, by selecting and op rating the macro, or automatically by attaching
a macro to a cue or including the macro as a time line vent. Macros that are attached to cues
operate when the cues sequence on a playback dev ce.

There are dedicated console keys for quick a cess to macros 101 through 106. You can also set up
soft keys for macros.

When storing macros, remember th macros are a collection of keystrokes. Manual faders are not
recognized and therefore not stor d in macros. Wheel values are recognized, however they are
treated as absolute values and t e fixture jumps to values stored in macro.

You can store up to 9999 Mac os.

Working with macros

Teach MIDI

Macro Macro

Figure 122: Macro mode on the Editor tool bar

Stor ng macros

The most efficient method for storing macros is using macro soft keys. Be sure to create a soft key
tab for macros before storing macros.

To store macros

Example: Store macro 10 that activates snap 5.

1 Press SHIFT + MACRO
Or

299 E)



Compulite

Chapter 12

LE]

Press MACRO and tap teach MACRO.

(M) is visible in the command line.

Press SNAP and 5. Then press ENTER.

The key presses are collected in the command line.

Press SHIFT + MACRO.

(END) now precedes the collected keypresses displayed in the command line.

Press STORE and tap macro soft key 10.
Or

Press MACRO, select the macro number on the numeric keypad, and p ess TORE.

Press STORE, select the macro number on the numeric keyp d and press ENTER.

Storing macros 101 - 106

Store macros 101 - 106 directly on their access keys.

To store macros 101 - 106

1

Press SHIFT + MACRO.

The system is now in teach mac  mod .

Press the keys in the sequence at will be stored in the macro.
Press SHIFT + MACRO

The system stops macr recording.

4 Press STORE.

5 Pressone fthe direct access macro keys (M.101 - M.106).

Adding text tags o macros

To add text tags to macros

1

D00

Select the macro by tapping its soft key.

Or

Tap MACRO and then enter the macro number on the keypad.
Press TEXT.

The Text dialog box opens.

Type the text and tap OK.
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To add text tags to macros

1 Press TEXT.

2 Select the macro by tapping its soft key.
The Text dialog box opens.
Or
Tap MACRO, enter the macro number on the keypad and press ENTER.
The Text dialog box opens.

3 Type the text and tap OK or press ENTER.

Deleting macros

To delete macros
1 Select the macro.
Or
Select more than one macro: MACRO # — #
2 Press DELETE.
The Delete dialog box opens.
3 Press DELETE again or t p DELETE in the dialog box.

(E]

To delete macros

1 Press DEL TE.

2 Sele t the macro.

r
Select more than one macro: MACRO # - #

3 Press ENTER.
The Delete dialog box opens.

4 Press DELETE again or tap DELETE in the dialog box.

Examining macros

To view a list of macros

Toggle the macro soft keys, to grid view by tapping . A list of macros is displayed in the

active pane.
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To examine a macro

1 View the macros in grid format. (If the macro tab is in soft key format, toggle to grid
format.)

2 Double click on macro 10.

The contents of the macro are displayed in the active pane.

To examine a macro
Example: Exam macro 10.
1 Select macro 10.
2 Press EXAM.
The contents of the macro are displayed in the active pane.
OR

1 View the macros in grid format. (If the macro tabisin ftk format, toggle to grid
format.)

2 Double click on macro 10.

The contents of the macro are displayed in the ctive pane or in the default exam pane.

LE]

To examine a macro

Example: Exam macro 10.
1 Press EXAM.
2 Select macro 10

3 Press ENTER

The ¢ nten s of he macro are displayed in the active pane or in the default exam pane.

Copying macros

To copy macros

Example: Copy the contents of macro 1 to macro 6.

1 Press MACRO and enter 1 (the source macro number) on the numeric keypad.
2 Press COPY. The macro is copied to the clipboard.

3 Press MACRO and enter 6 (the target macro number) on the numeric keypad.

4 Press PASTE. The new macro is named Copy of Macro 1.

Do
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Triggering macros

Trigger macros manually or by attaching them to cues. Macros that are attached to cues are auto-
matically triggered when the cue sequences on a playback device.

There are six dedicated macro keys for macros 101 - 106.

To operate macros manually
Go to the macro soft key tab and tab the macro.
OR

1 Press MACRO and enter the macro number on the numeric keypad.

2 Press ENTER.

Automatically trigger macros

Automate playback by attaching macros to cues. Fading to cue utom tically triggers the attached
macro. Automatic triggering can be disable for specified playba k devices.

To attach a macro to a cue

1 Select the cue.

2 Press MACRO and enter the m cro number on the numeric keypad.

3 Press STORE.

(E]

To attach a macrot a ue

1 Select the ue.

2 Press M CRO and select the macro number on the numeric keypad.

3 Pres ENTER.

Note: Make sure TRIGGER is enabled for the playback.

To enable or disable automatic triggering
1 Press SETUP and SELECT for the playback device.
The Playback Properties dialog box opens.
2 Tap Trigger on the Assignment Properties tab.
Has a light field when enabled.
OR
Press SHIFT+AUTO and SELECT for the playback device. This is a toggle:
— If TRIGGER is disabled, this sequence will enable it.
— If TRIGGER is enable, this sequence will disable it.
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Triggering macros using MIDI

Vector’s macros can be triggered by an external MIDI device.

To trigger a macro with MIDI

Example: Trigger macro 10.

MACRO 10 ENTER
Note off 90 Note on 30 Note on 15
Note on 31

D04



Chapter 13 Topo

Topo is an on-board utility that allows you to construct a topographical map of your rig.

This chapter contains the following sections:

m Working with Topo (see page 305)

m Manipulating the Topo view (see page 312)

m Printing the Topo map (see page 312)

Working with Topo

To construct a Topo map, you must be in Topo view. The basi Topo view is a top view of a stage. A
grid is superimposed on the stage to aid accurate fix ure placement. Also shown is one highlighted
vertical and one horizontal line that divide the stage int up left, down left, up right and down light
with center stage clearly marked. The stage dimens n can be modified.

Topo tool bar

ut
Ht

Spot icons

Channel icons

Figure 123: Topo view with channel and spot fixtures

In the Topo view you can:
m Set pipes and other hanging elements.
m Place and rotate fixtures in their hanging positions.

m Set placeholders to represent stage elements, such as tables, chairs, pianos, risers, etc.

m Select fixtures for editing. See “Selecting fixtures via the topo map” page 95
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To open a Topo view

1 Go to the Patch Manager: Tools» Patch Manager.

2 Make sure the Patch Manager workspace is in navigation mode (tap N) and select Topo

View.

Setting stage dimensions

Stage dimensions are set in the System Settings dialog box. They can be set before entering Topo

mode or while in Topo mode.

The stage dimensions are displayed in the Topo map’s lower right corner. The default dim nsions

are: 1800 cm. x 1200 cm. The maximum stage size is: 8000 cm. x 5000 cm.

To change the stage dimensions

1 Open the Tools menu and choose Settings.
The System Settings dialog box opens.
Open the Topo tab.
Type the new dimensions in the fields.
4 Tap OK.
OR
In the Patch Manager, open the Topo m nu and choose Settings in.
The System Settings dialog box opens to the Topo tab.
OR
If the Topo tool bar is op n, tap J .
The System Set ng dialog box opens to the Topo tab.

System Settings

Generdl Behaviotl Tim'ngl Hadnale' DMX Protc

Stage Width (cm}): |m
Stage Depth (cm): |1 200

Figure 124: Topo stage dimensions are set in System Settings

Note: If the view does not refresh and display the new stage dimensions, close the Topo

view and reopen it.
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The Topo tool bar

Topo map set up tools

Delete fixture or element
Stage fixture properties
New stage element
New fixture l

v

O RE x o

A

b |

>

1
Zoom in

B
Zoom out

Hand tool
Fit to screen —‘

| Show/Hide grid

Topo settings

View manipulation tools

Figure 125: Topo tool contains set up tools and view man pulation tools

To show the Topo tool bar

On the menu bar, tap TopoP Topo ool b r.

Topo grid

Topo view has a grid ove lay The grid points represent 50 centimeters (half a meter). You can show

or hide the grid.

To show/hid grid

.

Tap '--- .

Placing fixtures and stage elements

St g elements are basically pipes and other hanging positions. These elements can be resized and

used as placeholders for risers and other objects.

A range of fixtures can be selected. Each fixture set is represented by a different generic icon.

Channel set:

Fixture number
_ Fixture icon
Current intensity

Spot set:
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Fixture number
Fixture icon
Current intensity

Notes: When building the topo map, you may find it easier to work with a mouse or the trackball
in mouse mode.

To place fixtures

1 Tap .

The New Stage Fixture dialog box opens.

New Stage Fixture l x|

Set:

From: I ﬂ
To: I j
=

Address: I

Cancel I Insert I

Figure 126: New stage fixture ia g box
Choose the fixture set from the Set drop down list.

Select a range of fixtures using the From and To field drop down lists.
4 Tap INSERT.

The new fixture is in erted at the top left corner of the stage.
5 Click a fix ure and drag it to its correct position.

Or

Drag rectangle around multiple fixtures and drag them to their correct position.
OR

Set an absolute location in the Stage Fixture Properties dialog box.

To rotate fixtures

1 Right click on a fixture and select Rotate from the fly out menu.
The pointer changes to the rotate icon.
2 Drag the rotate icon in the direction you want to rotate the element.

3 When the fixture is positioned, exit rotate by clicking the left mouse button.



To edit fixture properties
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1 Right click a fixture and choose Properties from the short cut menu.

Or

Click the fixture to select it and click .

The Stage Fixture Properties dialog box opens. The Stage Fixture Properties dialog box can
be used to change the location of the fixture on the Topo map and record additional infor-
mation pertaining to the fixture.

S[i?:neral | hannel = Fixture identification
Fiture: | 1 =

Name: I 1 L]

Properties —

Fd I 7 L] Editable properties
¥ Location: |252

Y Location: |29?

Gel Name: Ipeacock blue

Note: Iback of window

Angle * [314

Figure 127: Stage Fixtur s Pr perties dialog box

Group Fields What is it? Edit
General
St The fixture set. This field cannot be edited.
Fixture The fixture number. This field cannot be edited.
Name The fixture’s name This field cannot be edited.
Properties
Address Fixture’s DMX address This field cannot be edited.
X Location | The fixture on the x axis. 0:0 is the map’s upper left corner
(upstage right).
Y Location | The location on y axis. Enter a new location.
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Group Fields What is it? Edit
Gel name Free text field. Type a gel name or number.
Note Free text field. Type useful information.
Angle The angle is shown in Enter an absolute value. The
degrees reference is the original angle.

2 Navigate to the relevant field and type the new information.
3 Click UPDATE.

The dialog box closes and the new information is stored.
Channel set:

Fixture number
Fixture icon
Current intensity

Spot set:

Fixture number
Fixture icon
Current intensity

Notes: When building the topo map, you may find it easier to work with a mouse or the trackball

in mouse mode.

To place stage elements

1 Tap %

By default he e ement is placed at center stage (at the intersection of the red vertical and

horizon al lin s.
2 Cli k the element to select it.
A patterned rectangle appears around the selected element.

3 Drag it to the required position.

To rotate stage elements

1 Select the element by clicking on it.
A patterned rectangle appears around the selected element.
2 Right click and select Rotate from the fly out menu.
The pointer changes to the rotate icon.
Drag the rotate icon in the direction you want to rotate the element.

4 When the element is positioned, exit rotate by clicking the left mouse button.

s
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To resize stage elements
Select the element by clicking on it.
2 Right click and select Properties from the fly out menu.
The Topo Element dialog box opens.
Type size values in the Width and Height fields.
4 Tap OK.

To change stage element text
1 Tap a stage element.
The stage element is now selected and displayed within a rectangle.
2 Right click inside the selection rectangle and, from the shortcut menu, choose Properties.

The Topo Element dialog box opens.

IIIIIIIIIIIMIIIIIIIIIIIIIIIIIIlIIIIIIIIIII

Topo Element -

Name:

Stage element name §—@3 ==

—Location
Change the location and angle CenterX: 275
by entering absolute values.
Center 35
| Angle: 0

Size
Element width4—@ 'idth: 200
Element Height §—@ Height: 10

Show/hide stage element name 4—@[] Show Title
Show hide fixture name —=@[_] Show Fisture Titles

Fi ure 128: A stage element and the Topo Element dialog box

3 ype aname in the Name field.
4 Tap OK.

The dialog box closes. The stage element’s name appears above it on the Topo display.

To remove a fixture or element

1 Select a fixture, a range of fixtures, or an element.
2 Tap ¥ .
The Delete ltems warning is displayed.

3 Tap YES to confirm or NO to escape.
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Manipulating the Topo view

You can:
m Zoom in
m Zoom out
m Fit the stage to the screen
m Slide the view with the hand tool
m Scroll the view

To zoom the view

Tap the zoom icon on the Topo tool bar. The cursor morphs into the icon. Click or tap on the
view.

To exit the zoom tool

Tap the icon again. The cursor returns to being a pointer

To scroll the view

Use the mouse scroll wheel or Vector’s vertical w eel with SCROLL WIN enabled.

Printing the Topo map

The Topo map prints on a whit b ckground while fixture icons, stage elements, and grid dots are in
black. When printed the text b x under a fixture shows its DMX address.

To print the Topo map

1 Open he F e menu.

2 Tap PRINT. The Print dialog opens.
3 1 nec ssary, set up print.

4 Tap OK.

s



Chapter 14 Advanced Editing and
Programming Features

This chapter contains the following sections:

m Dark parameter positioning (see page 313)

m Cloning parameter levels (see page 319)

m Parameter fade profiles (see page 320)

m Highlight / Lowlight (see page 321)

m [dentifying fixtures (see page 326)

m Using Sneak (see page 328)

m Editing objects on the grid display (see page 329)

Dark parameter positioning
There are three features that allow you to pr set parameter values when a fixture’s dimmer is dark,
thus avoiding visible parameter mo eme
m Look Ahead
m Mark Cue

m Force Black

Look Ahead

The Lo  Ahe d feature is used for automatic pre-positioning of selected parameters when the
fixture’s dimmer is dark, thus avoiding visible parameter movement. For Look Ahead to work, the
fixtures’” dimmer must be at zr and there must be parameter moves from one cue to the next cue.

Look Ahead fades can be set for a specified default time, which is different than the cues’ default
fade time.

Before using Look Ahead, you must create a Look Ahead mask. The Look Ahead mask tells Vector
which spots, spot parameters, or scrollers are affected by the Look Ahead feature. If you have not
specified parameters in the Look Ahead mask, all parameters will be affected. The Look Ahead
mask can contain more than one parameter.

Note: If, in specific cues, you want to prevent applying the Look Ahead mask, give
dimmers a value of 1%.
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Working with Look Ahead

To enable or disable Look Ahead

Go to Tools P Settings » Behavior and tap Look Ahead Active.

To change the default Look Ahead fade time

Go to Tools P Settings » Timing and set the time in the Default Look Ahead Time field.

To override the default Look Ahead fade time

Set unique fade times for the parameters participating in Look Ahead. See “Fade t mes”

page 164.

To program the Look Ahead mask
1 Select fixtures.
2 Optional - Select parameters.

L
3 Tap [l on the Editor tool bar.

4 Press STORE.

To delete the Look Ahead mask

1 Select fixtures.

2 Optional - Select parameters.
L

3 Tap TN on the Edito t ol bar.
Mask

4 Press DELETE.

To examine the Look Ah ad mask

1 Press EXAM.

2 Tap LOOK AHEAD MASK on the tool bar.

LE]

To program the Look Ahead mask
1 Select fixtures.
Optional - Select parameters.
Press STORE.
Optional - select parameters.
Tap ‘.{,ﬁ:}f . on the Editor tool bar.

Press ENTER.

D s W N

To delete the Look Ahead mask

1 Press DELETE.

2 Select fixtures.

s
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3 Optional - Select parameters.

4 Tap . on the Editor tool bar.

5 Press ENTER.

To examine the Look Ahead mask

1 Press EXAM.
2 Tap LOOK AHEAD MASK on the tool bar.
3 Press ENTER.

Mark cues

Mark cues are inserted between existing cues to pre-position parameters when the fixtures’
dimmers are at zero.

Mark cues pre-position all parameters whose values are moving, under he condition that the
dimmers for the fixtures included in the mark cue are at zr intensity in the cue that immediately
precedes the mark cue. If, in the cue before the mark cue, the dimmers are not at zr the move is
ignored. The cue before the mark cue is automatically set fo w on cue to provide a seamless
fade to the mark cue.

When you a insert a mark cue, it adopts the time s tting for the preceding cue.

Example: Cue 2 has a delay-in time of 4 seconds Cue 2.5, a mark cue inserted between cues 2 and
3, will also have a delay in time of 4 seconds. Also, Cue 2 automatically becomes a follow-on cue.

If you update the cue following the mar cu with new parameter values, the mark cue is updated as
well.

ATTENTION! Do n tedit he mark cue. If you want to add parameters to the dark posi-
tioning, edit the cue after the mark cue. Mark cues should only contain the dimmer at
ZETo0.

To insert a mark cue
Example: Insert a mark cue between cues 3 and 4. The mark cue will be cue 3.5.
1 Press CUE and 3.5.
2 Tap [{EE<E on the Editor tool bar.
3 Press STORE.

(E]

To insert a mark cue
Example: Insert a mark cue between cues 3 and 4. The mark cue will be cue 3.5.
1 Press STORE.
2 Press CUE and 3.5.
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3 Tap on the Editor tool bar.

4 Press ENTER.

Force Black cues

Diis

Force Black cues are another way of positioning parameters in the dark. As it name implies, Force

Black cues quickly force the dimmer to zero, then immediately moves the parameter levels, and

finally follows on to the next cue, returning the dimmer to its stored level.

Example - Channel 1 is a scroller channel and its dimmer is on in cues 2 and 3.

Cue Dimmer | Scroller What happens during fades
2 FL 1
3 FL 11 The move to the new scroller setting is 1 ible.

In this example, you program cue 3 as Force Black to move from scrolle frame 1 to 11 in the dark.
Vector automatically inserts a cue between cues 2 and 3. The ns rted cue number is the closest
available number. In our example, the Force Black cueisi  rte before cue 3 and is numbered

2.99.

The inserted cue runs inherits one third of the fad time or, in our example, cue 3. This is then
divided in half. Half of the time is used to fad he dimmer to zero. The remaining half moves the

parameters.
Cue Dimmer | Scroller Wha happens during fades
2 FL 1
2.99 The dimmer fades quickly to zero.
Then the scroller moves to frame 11.
There is an automatic follow on to cue 3.
3 FL 11 The dimmer fades up in cue time.

ATTENTION! If the dimmer comes back on before the parameter move is complete, give
the inserted cue a longer fade time. Example: if the inserted cue has inherited a 6 second
ade time, make the time of the inserted cue, in our example this is cue 2.99, longer.

To store a Force Black cue

1 Select the cue.

2 Tap on the Editor tool bar.
3 Press STORE.
To manually set Force Black time

1 Select the cue.
2 Tap FORCE BLACK CUE on the Editor tool bar.
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Press TIME and enter time in #/#/# format, where the first time setting is dimmer fade to zr,
the second time setting is delay-in time to allow parameter moves, and the third time
setting is dimmer up time.

Press STORE.

To convert a Force Black cue to a normal cue

1
2
3

[E]

Select the cue.
Tap FORCE BLACK CUE on the Editor tool bar.
Press DELETE.

To store a Force Black cue

1
2
3

5

Edit and store the cue.

Press STORE.

Select the cue.

5 on the Editor tool bar.

Press ENTER.

To manually set Force Black time

A WO DN =

5

Press STORE.
Select the cue.
Tap FORCE BLACK CUE n the Editor tool bar.

Press TIME and enter time in #/#/# format, where the first time setting is dimmer fade to zr,
the second tome setting is delay-in time to allow parameter moves, and the third time
setting is dimm up ime.

Press ENT R.

To convert a Force Black cue to a normal cue

1
2

P ss DELETE.

Select the cue.

3 Tap FORCE BLACK CUE on the Editor tool bar.
4 Press ENTER.

Pre positioning examples

Example 1: Channel 1 is a scroller channel and its dimmer is dark in cue 2.

Cue Dimmer | Scroller What happens during fades
2 /R unknown
3 FL 11 Scroller frame may change on the fade to cue 2.




Compulite

Chapter 14

s

Table 1: Using Look Ahead
Cue Dimmer | Scroller What happens during fades
2 ZR unknown When the fade to cue 2 is complete, the scroller automati-
cally fades to frame 11.
3 FL 11 The scroller is ready on frame 11 when the fade to cue 3
begins.
Table 2: Using Mark Cue
Cue Dimmer | Scroller What happens during fades
2 ZR unknown
2.5 ZR 11 When the fade to cue 2.5 is complete nd the dimmer is at
mark zr, the scroller moves to frame 11.
cue
3 FL 11 The scroller is ready on fr me 11 when the fade to cue 3
begins.

Example 2 - Channel 1 is a scroller channel and its dimmer is on in cues 2 and 3.

Cue Dimmer | Scroller What happens during fades
2 FL unknown
3 FL 11 The move to the new scroller setting is visible.
Table 1: Using Look Ahead
Cue Dimmer | Scroller What happens during fades
2 F 1
2.1 ZR 1 When the fade to cue 2.1 is complete, the scroller automat-
ically moves to frame 11.
3 FL 11 The scroller is ready on frame 11 when the fade to cue 3
begins.
Table 2: Using Mark Cue - this will not give the desired result
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Cue Dimmer | Scroller What happens during fades

2 FL 1

2.5 7R 11 The frame moves and the dimmer fades at the same time,
so the move is visible.
Note: Mark cues should only contain the dimmer parameter
at zero.

3 FL 11 The scroller is on frame 11 when the fade to cue 3 beg s.

Table 3: Using Force Black cue - this is the solution

Cue Dimmer | Scroller | What happens during fades

2 FL 1

2.99 ZR 11 The scroller waits and begins it move only after dimmer

(Force has finished fading to zr.

Black) Note: Cues following For e Black cues are automatically
follow on cues.

3 FL 11 The scrolleri rea y on frame 11 when the fade to cue 3
begins.

Cloning parameter levels

The clone feature copies parameter values, including libraries and cell timing, to new fixtures and

stores them in all cues. This is a uick way to update all cues when fixtures have been added to your

show.

To clone param ter values

Examp e: spo s 1 = 10 are used throughout your show. Moving to a new venue, 10 spots

(sp ts 11 = 20) have been added. Copy parameter values from spots 1= 10 to spots 11 = 20.

1 Se ect the source spots (SPOT 1 = 10).

a A~ O DN

Press ENTER.

Tap >> to go to the next page of the toolbar.
Tap CLONE TO.
Select the target spots (SPOT 11 = 20).

A warning message is displayed.

6 Tap OK to continue or CANCEL to abort.
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Parameter fade profiles

i

Profiles determine a parameter’s behavior during a fade. Profiles are always relative to the cue time.
Profile options are available on the Editor tool bar in profile mode.

/ Jumpon | Jumpon | Jumpon

Figure 129: Profile mode on the Editor tool bar

Profile What happens on the fade

Linear On go, the parameter fades in cue time to its new levels.

Jump on start On go, the parameter jumps to its new levels.

Jump on end When the fade is complete, the parameter jumps to its n w levels.

Jump on 50% When the fade reaches 50% of cue time, the par meter jumps to new levels.

Fade profiles can be applied to the cue or an entire parameter ba k. View profiles on the live spot
and channel displays.

To set a fade profile

1 Select fixtures and set parameter levels
2 Tap PROFILE.

The Editor toolbar is now in profile mode.
3 Tap a profile.

4 Repeat as required b fore s oring the cue.

To set a bank p ofile

Sele tsp ts.

2 Selec the bank by pressing one of the bank keys (INTENS, POS, COLOR, BEAM, IMAGE,
SH PE).

Tap PROFILE.
4 Choose one of the profile options.

Press UPDATE, if editing a cue, or store a new cue.

_E]
To set a bank profile

Select spots.

2 Select the bank by pressing one of the bank keys (INTENS, POS, COLOR, BEAM, IMAGE,
SHAPE).

3 Tap PROFILE.
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4 Choose one of the profile options.
5 Press UPDATE, if editing a cue, or store a new cue.

6 Press ENTER.

To view profiles

1 Make sure the live spot or channel display is active.
2 Open the Format menu.
3 Tap Profile.

The profile appears in place of the parameter level.

Profle on pan parameter Profle on dmmer parameter

Jmp on start

Jmp on start
Jmp on start
Jmp on start
Jmp on start
Jmp on start
Jmp on start

Highlight / Lowlight

The highlight/lowlight feature is use as an aid to:
m [dentifying fixtures that re ac ive on stage
m Verifying pan and tilt orientation
m Verifying DMX a dress assignments

m Highlight/ owli ht can also be used as a quick method for updating libraries

About highlight/lowlight

Highligh lowlight can be used with all varieties of fixture selections. NEXT and PREVIOUS are
used t cycle through the fixtures. When reaching the end of the fixture selection, high-
light/lowlight loops back to the first fixture in the selection.

Note: Highlight/lowlight cycles through selections in the same order that the fixtures
were selected.

When highlight/lowlight is active the key’s LED is on. Highlight/lowlight remains active until
cancelled. Highlight or Lowlight appears in the command line as long as the mode is active.

Parameter values that are edited are retained in the editor, even when exiting highlight/lowlight
mode or updating a library.
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While in highlight or lowlight mode, most programming operations (such as storing and updating

cues, storing and updating libraries, and applying fans) are available. Selecting unavailable features

(such as, Rem Dim, flash, and all parameters except dimmer and position) generates the error

message Not available in Highlight mode.

Highlight or Lowlight appears in the command line as long as the mode is active.

Lowlight is highlight in solo mode. In lowlight mode, the intensity of the active fixtures goes to
30% and the selected fixture’s intensity goes to full. Use this mode when there are fixtures with

levels active in the editor.

Using highlight / lowlight

Highlight | What happens Lowlight What happens
Channel * Dimmer fades to FL or to the value set | Channel » Selected fixture s dimmer fades to
in the highlight palette. FL.
* O her fixtures fade to 30% or to
th value set in the lowlight palette.
Fixture * Dimmer fades to FL or to the value set | Fixture with |+ Selected fixture’s dimmer fades to
with in the highlight palette. scroller FL.
scroller * Scroller goes to its home value or to * Other fixtures fade to 30% or to the
the value set in the highlight palette. value set in the lowlight palette.
* Scroller goes to its home value.
Spot * Dimmer fades to FL or to the values | Spot » Selected fixture’s dimmer fades to

in the highlight palette.
All parameters (except pan and ilt)

are forced to home values or fade to
values set in the highlight alette.

Pan and tilt are not affected.

FL.

Other fixtures fade 30% or to the
value set in the lowlight palette.

All parameters (except pan and tilt)
are forced to home values or fade to
values set in the lowlight palette.

Pan and tilt are not affected.

s

Tip! When using highlight or lowlight, you can adjust pan and tilt for the entire range of

s ots. This is useful for changing all the pan and tilt parameters at the same time, for

instance when tweaking libraries.

To apply highlight or lowlight

1 Press HLLIGHT or LO.LIGHT.

Highlight or Lowlight appear in the command line.

2 Select a fixture, or a range of fixtures, or a group.

3 Move the pan/tilt wheel or trackball to initiate the highlight feature.

4 Press NEXT or PREVIOUS to move to the next or previous fixture.
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5 To jump to another fixture, select a new fixture and again move the pan/tilt wheel or track-

ball to initiate the highlight feature.

Note: You can edit the entire range of fixtures only if NEXT and PREVIOUS have not
yet been used to cycle through the spots.

To exit highlight or lowlight

1

Clear the command line by pressing SHIFT + @ or SHIFT+ CE.

2 Press the active mode -HIL.LIGHT or SHIFT + LO.LIGHT.

The mode is no longer indicated in the command line.

ATTENTION! Pressing HI.LIGHT or LO.LIGHT without clearing the comma d lin ,
clears the HI.LIGHT or LO.LIGHT values. Pan/tilt and dimmer changes a e retained in the
editor and the system is still in HLLIGHT or LO.LIGHT mode.

To switch between highlight and lowlight modes

Press SHIFT + HLLIGHT or SHIFT + LO.LIGHT

To edit position libraries without activating hig light or lowlight mode

Example: The current cue uses position ibra y 1. In the current venue the bar is a bit higher

than usual and the position library require editing.

-—

A WO DN

6

L\E

Press SHIFT + RESET.

Press POS and select a  sitio library.

Press HI.LLIGHT OR LO LIGHT.

Edit pan and tilt

Pan and til are djusted for all the selected spots.
Action syntax -Press STORE.

Ente syntax - Press UPDATE and then ENTER.

To continue editing positions, repeat the procedure from step 1.

To edit position libraries in highlight lowlight mode

a A WO N =

Press SHIFT + RESET.

Press HI.LIGHT OR LO.LIGHT.

Press POS and select a position library.

Press SPOT.

Edit pan and tilt.

The command line shows exactly which position library you are working on.

Action syntax -Press STORE.



Compulite
Chapter 14

Enter syntax - Press UPDATE and then ENTER.

7 To continue editing position libraries, press SHIFT + RESET and continue the procedure
from step 3.

Using highlight and lowlight palettes

You can store palettes to use with the highlight or lowlight features. These palettes apply the palette
values instead of the fixture’s home values. Pan and tilt are not included in the highlight and
lowlight palettes.

You can store only one highlight and one lowlight palette.

Note: Highlight and lowlight palettes are device specific.

To store highlight or lowlight palettes

Example: Create a highlight palette where the color setting are: cyan @ zr, magenta @ zr, and
yellow @ FL and dimmer is FL.

1 Select fixture. Set dimmer to full and set color p ram ter levels.
2 Press LIB.
3 Press HLLIGHT.
Or
Press SHIFT + LO.LIGHT to st r a owlight palette.
4 Press STORE. The highlight r lowlight palette is stored.

To delete the highlight or owlight palette
Press LIB.

Press HL.L GHT r LO.LIGHT.

Pres DE ETE. Vector requests confirmation.

W N -

Press DELETE again or tap OK.

T exa ine the highlight or lowlight palette

1 PressLIB
2 Press EXAM.
3 Press HIGHLIGHT or LOWLIGHT.

The highlight (or lowlight) parameter values are displayed.
E
To store highlight or lowlight palettes

Example: Create a highlight palette where the color settings are: cyan (@ zr, magenta @ zr, and
yellow @ FL and dimmer is FL.

1 Select fixture. Set dimmer to full and set color parameter levels.

sy
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Press ENTER.

Press STORE.

Press LIB.

Press HIGHLIGHT.

Or

Press SHIFT + LO.LIGHT to store a lowlight palette.
Press ENTER. The highlight or lowlight palette is stored.

To delete the highlight or lowlight palette

1
2
3
4

Press DELETE.

Press LIB.

Press HL.LIGHT or SHIFT + LO.LIGHT.

Press DELETE again or press ENTER or tap OK.

To examine the highlight or lowlight palette

1
2
3
4

Press EXAM.

Press LIB.

Press HL.LLIGHT or SHIFT + LO.LIGHT
Press ENTER.

The highlight (or lowlight) parameter values are displayed.

Using highlight to update libraries

Highlight can be used for quick updating of fixture specific libraries. This procedure can be used to

update all libraries, including position libraries.

Before beginn ng this procedure, press SHIFT + RESET to clear the editor entirely and make sure

that there is no ac ive selection. If there is an active selection the library will be applied to the

selection.

To update a library

Example: Update position library 3.

1
2

Press LIB.

Press POSITION and 3 on the numeric keypad.

Or

POSITION 3 on the position soft keys tab

Press HL.LLIGHT.

The dimmer, for first fixture in the library, it turned on.

Adjust the pan and tilt values using the trackball or the wheels or enter an absolute value.

325 €9
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5 Press NEXT.

The next fixture’s dimmer is turned on.
6 Repeat steps 4 and 5 as needed.

Press STORE or UPDATE.

The library is stored with the new values. The highlight feature is now inactive.

LE]

To update a library
Example: Update position library 3.
1 PressLIB.
2 Press POSITION and 3 on the numeric keypad.

Or
POSITION 3 on the position soft keys tab
3 Press HLLIGHT.
The dimmer, for first fixture in the library, is turned on.
4 Adjust the pan and tilt values using the trackball r the wheels or enter an absolute value.
5 Press NEXT.
The next fixture’s dimmer is turned on.
6 Repeat steps 4 and 5 as needed
Press STORE or UPDATE
Press ENTER.

The library is stored wi h the new values. The highlight feature is now inactive.

Identifying fixtures

Occas ona y you may need to identify a particular fixture. This can be done using REM DIM or by
blinking the fixture’s dimmer.

Using REM DIM

Dz

REM DIM behavior:

m If the dimmer of the selected fixture is at any level, it remains at that level and all other fixtures
fade to zero.

m If the dimmer of the selected fixture is at zero, it goes to the ON value and all other fixtures
fade to zero.

Since this is an editor function all parameters and wheels are available for fixture editing while
REM DIM is active. You can also apply a library to the REM DIM selection. You can store new cues
using REM DIM.
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Exiting REM DIM releases all unchanged values to playback device control. Parameter and dimmer

values that were modified while REM DIM was active are retained in the editor.

To blackout all fixtures except the selected fixture

1
2

Select the fixture(s).
Tap REM DIM on the Editor toolbar.

Only the selected fixture’s dimmer remains on. All other fixtures are entered to the editor
and forced to zr.

Tap REM DIM to exit.

Or

To select another fixture, repeat steps 1 and 2.

To locate a fixture

1

Select a fixture to start from.
Optional - set a dimmer level.
Tap REM DIM on the Editor toolbar.

Only the selected fixture’s dimmer remains n. All other fixtures are entered to the editor
and forced to zr.

Press NEXT or PREV to advance.

The active fixture is on at the specified level or, if no level was specified in step 2, at its

original level.
Tap REM DIM to exit and ret rn the dimmer levels to all fixtures.

Or

To skip a large numb r of fixtures without exiting, just select the fixture and tap REM DIM
again.

Note: NEXT and PREV cannot be used if a range of fixtures has been selected.

To store a ue using REM DIM

Ex mple: The next to last lighting look has back light, a cyclorama color wash, and a special

comprised of three fixtures. You want to quickly isolate the three fixture special and store only

he special as last cue.

1
2
3

Select the three fixtures.

Set an intensity level.

Press REM DIM.

The back light and color wash are forced to zero.

Store a new cue.

Note: All zero intensity values are stored in the new cue.
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Blinking fixtures

The blink feature provides an easy way to identify fixtures.

To blink fixtures

Select a single fixture (channel, spot, matrix, or media server) or a range of fixtures and tap
BLINK on the Editor toolbar.

The selected fixtures blink between 10% and 80%.

Using Sneak

Sneak fades parameter levels to their previous level or to zr in the default sn ak time. Sneak times
can also be changed on the fly. Also, specific parameter levels may be selected to override the
default.You can change the default sneak time in: Tools» Settings» Tim n

To sneak a parameter

1 Select the fixtures.

2 If the selection is a moving device, select the parameter using the wheel bank keys or tap
the parameter name in Wheel Assig ment

3 Press SNEAK.

The parameter level fades  its p evious level or to zr.

To sneak a parameter in elected time

1 Select the fixtur s

2 If the selec ion s a moving device, select the parameter using the wheel bank keys or tap
the par met r name in the Wheel Assignments.

3 Pr s TIME and enter a number on the numeric keypad.
4 P ss SNEAK.

The parameter level fades to its previous level or to zr in the selected time.

To sneak a parameter to a selected level

Example: Sneak spot 1 cyan parameter to 60 in 6 seconds.
1 Select spot 1.

2 Press TIME and 6 on the numeric keypad.

3 Select cyan.

4 Press @ and 60.

The cyan parameter fades to 60% in the selected time.

Do
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To sneak a parameter.

Select the fixtures.

2 [Ifthe selection is a moving device, select the parameter using the wheel bank keys or tap
the parameter name in Wheel Assignments.

Press SNEAK.
4 Press ENTER.

The parameter level fades to its previous level or to zr.

To sneak a parameter with selected time

1 Select the fixtures.

2 Ifthe selection is a moving device, select the parameter using the wheel bank keys or tap
the parameter name in Wheel Assignments.

Press TIME and enter a number on the numeric keypad
4 Press SNEAK.
The parameter level fades to its previous le el o to z in the selected time.

5 Press ENTER

Editing objects on the grid display

Some object attributes can be dited directly on the grids.

Grid What can be edit d

QList exam QList (playb ck) mode (toggle Normal or Chaser)

To change the QList playback mode
1 Toggle the QList soft keys to display as a grid.
2 Tap the Mode field.
3 Choose Normal or Chaser.
4 Press ENTER to move to Mode field in the next row.

QList name

To change a QList’s text tag

1 Toggle the QList soft keys to display as a grid.
2 Double click the QList Name field.
3 Type the new text tag.

4 Press ENTER to move to QList Name field in the next row.
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Grid What can be edited

Cue sheet Cue name

To change a cue’s text tag

1 Tap the Cue Sheet tab.
2 Double click the Cue Name field.
3 Type the new text tag.
4 Press ENTER to move to Cue Name field in the next row.

Fade times

To edit cue fade times
1 Tap the Cue Sheet tab.
2 Double click the Cue Name field.
3 Type the new text tag.

4 Press ENTER to move to Cue Name field in the next row.

Libraries Library name

To change a library’s text tag
1 Toggle the library soft keys to di play as a grid.
2 Double click the Library Nam field
3 Type the new text tag.
4 PressENTERtom  to L brary Name field in the next row.
Mode (Device Specific, Fixture Specific, Pattern)

To change the library mode

See _Fixtu e and device specific libraries” page 253

1 Toggle the library soft keys to display as a grid.

2 Tap the Mode field.

3 Choose Fixture Specific, Pattern, or Device specific.

4 Press ENTER to move to the Mode field in the next row.

Parameters (included in the library)

To add or remove parameters stored in the library

“To add parameters to libraries” on page 261.

1 Toggle the library soft keys to display as a grid.

2 Tap the checkbox in the parameter columns to add or remove parameters from the
library. Checked parameters are included in the library.

sz
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Grid What can be edited
Groups Group name
To change a group’s text tag
1 Toggle the group soft keys to display as a grid.
2 Double click the Group Name field.
3 Type the new text tag.
4 Press ENTER to move to Group Name field in the next row.
Macros Macro name
To change a macro’s text tag
1 Toggle the macro soft keys to display as a grid.
2 Double click the Macro Name field.
3 Type the new text tag.
4 Press ENTER to move to Macro Name field in the n xt ow.
Snaps Snap name
To change snap’s text tag
1 Toggle the snap soft keys to disp ay a a grid.
2 Double click the Snap Name f eld.
3 Type the new text tag
4 Press ENTER to mov to Snap Name field in the next row.
Time Line Time code

To edit event t me des

1 Togglet e time line soft keys to display as a grid.
2 Double click the Time Code field.

3 Edit the event time. Enter the new time code in 00 (hours):00 (minutes):00
(seconds):00 (frames) format using the external keyboard.

4 Press ENTER to move to Time Code field in the next row.

Note: Event time can also be changed on the graphical time line. See “Editing
time lines” page 382.

Fade times
To edit fade times

1 Toggle the time line soft keys to display as a grid.
2 Double click the Fade Time field.
3 Edit the fade time.

4 Press ENTER to move to Time Code field in the next row.
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Grid

What can be edited

Note: You can also display the various grids through the exam feature and edit the fields in the

exam display. Example:

To edit Qlist text tags
1 Press EXAM.
QLists are displayed on the exam grid.
2 Double click the text field.
3 Type the new text.

4 Press ENTER to move to QList Name field in the next row.

_E]
To edit QList text tags
1 Press QLIST and select the QList numb r on he keypad.
2 Press EXAM.
Press ENTER.
QLists are displayed on the exam grid.
4 Double click the text field
5 Type the new text.

6 Press ENTER tom ve to QList Name field in the next row.

sz

When SCROLLWIN i activ you can use console keys or the equivalent keys on an external
keyboard for diting and to navigate the grid.

Conso key External keyboard | What is does

ENTER Enter Applies the changes and moves to focus to the
cell below.

- Tab Moves one cell right.

SHIFT -» Shift + Tab Moves one cell left.

Arrows Arrows Navigate cells up and down or right and left.

NEXT and PREV Page up /Page down Cycle through options in a drop down list.

DELETE Delete Delete text.

CE Backspace Deletes one character.




Chapter 15 System Settings

This chapter contains the following sections:

m About system settings (see page 333)

m General (see page 334)

m Behavior (see page 335)

m Timing (see page 338)

m Hardware (see page 339)

m DMX Protocols (see page 341)
m MIDI/SMPTE (see page 342)

m Network (see page 343)

m Topo (see page 344)

m Default PB Definitions (see page 345)

About system settings

The settings in the System Sett ngs dialog box control Vector’s default behavior.

Customized settings are s ed w h the show. Opening a new show resets the System Settings fields
to their default settings.

Customized s tting can be saved as the default settings.

To open the system settings dialog box

Go to Tools menu P Settings

o save customized settings as default

1 When you have finished customizing the settings on all the tabs in the system settings
dialog box, go to the General tab.

2 Tap SAVE SETTINGS AS DEFAULT.

Your customized settings are now the default settings. Each time you open a new show
these settings will be used.

333&)
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General

Group

Fields/buttons

What it does

Default

System Settings

Behavior “ Tiving “ Harchoars ” DM Protocols “ MIDI/SMPTE H Network H Topo H Default PB DefinitionsJ

General

Auto-Save ]

—

Pratect Snap-GO

Grand Master ]

Black Out ]

Save Settings As Default J

AUTO-SAVE ENABLED * On - The show is a tomatically saved On
periodically
* Off - The utomatic save feature is disabled.
PROTECT SNAP - GO * On Lo k SNAP GO to prevent accidentally Off
See page 233 u hi g this key.
Off - SNAP GO is not locked.
GRAND MASTER On - GM controls output levels from the On
console.
» Off - All output is at Full and the GM level does
not affect the output.
BLACK OUT ENABLED * On - The B.O. key is active and can be used to
blackout the console’s dimmer output.
* Off - The B.O. key is disabled.
SAVE SETTINGS AS Save your customized settings as the default Off
DE AULT setting. Each time you open a new show, these
settings are valid.

s34
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VECTOR

SYSTEM SETTINGS

Group Fields/buttons

What it does

Default

System Settings

. Generali Behaviar |Timing_ Hardware | DM Pratacals | MIDI/SMPTE | Metwark Topo | Default PE Definitions

Operation Mode

Syntax Mode

[ Compulite Traditional I

’ Action [Compulite)

Sneak Active

[ Mormal Tracking l

I Enter

Look-Ahead dctive

Default Stage W alues

Automatic Parameter Grouping

l |Jze Drefault Home W alue ]

| l
| l
| l
| |

Temp Cues
[ Automatically dezign to Playback I
[ Maintain Last Yalue l
[ Ordered Flapback Priority l
Default Store Option 0N Function
[ GO As GOTO With Cue Time I | &l Editor [Red + Wihite) v Default Value: |50 I-
[ Dip X-Fade ] [ Al Params If Active

[ Orn Snap - Releazed PE to Top l I

All Params For Selected

|

kAuilti E ditors

Walue Input Method:

|
} [ T3t OM Recalls Last Stored Walue l
]
\

"Mext Store' Increment by i1 |

|American v

Auto Snap Update:

|Or New .t’;‘-.s_sig_nments Only |

Operation COMPULITE » The editor does not clear after storing a cue.
mode TRADITIONAL * All parameter values for the active fixtures are
See page 11 stored in each cue.

NORMAL TRACKING » The editor clears after storing a cue.

* Only changed values (hard moves) are stored in
the cue. All other values are tracked.

Syntax ACTION (Compulite) Each keypress is immediately acted upon.
Secp ae IS ENTER Pressing ENTER completes a sequence.

Note: Compulite mode and Action syntax are automatically set in the Behavior tab when loading shows

converted from Sabre or 4D.

Default stage
values

See page 116

USE DEFAULT HOME After RESET, parameter levels return to home as
VALUE defined for the device in the Device Builder.
MAINTAIN LAST VALUE | After RESET, the last parameter value is retained. | On

335 C)
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Group Fields/buttons What it does Default
Default store | Drop down list Determines what is stored in each cue: All
option « Al editor (red and white) editor
See page 134 .
» Active only (red)
» All stage
ALL PARAMS IF ACTIVE |+ On - If a spot’s dimmer intensity is more than zr,
all parameters will be stored in the cue.
» Off - Only the active parameters will be stored
in the cue.
ALL PARAMS FOR * On - All parameters (except dimmer) in the
SELECTED selected spot are stored in the cue even if there
are no levels set.
» Off - Only active parameters ar stored in the
cue.
Multi Editors * On - Allows saving the da a active in all the
local console and n d con ole editors.
* Off- Only the wrr teditor in the local console
is saved.
Other default | Value input method » European Enter 1 digit for levels (example: 6 | Amer-
behavior for 60% 5.5 for 55%). ican
* meri an - Enter 2 digits for levels (example:
60 f r 60%).
Next store incremented by | Sets the increment when storing cues using: 1
STORE+
OR
CUE, NEXT, STORE
CUE ONLY MODE * On - Edits to a cue are stored as cue only and do
Tra king mode only! not affect the tracking.
See page 157 » Off - Edits to a cue are tracked through the cues.
AUTOMATICALLY * On - Stored cues are automatically loaded to the | On
ASSIGN TO PLAYBACK master playback.
» Off - Stored cues are not automatically loaded to
the master playback.
ORDERED PLAYBACK |+ On - Playback devices are set in a rigid priority | Off
PRIORITY hierarchy.
» Off - Playback Device priority is LTP.
GO as GOTO with cue * On - GO key executes out of sequence fades. On
time

Dsss

See page 198

» Off - GO key does not execute out of sequence
fades.
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Group Fields/buttons What it does Default
DIP X-FADE * On - Dip crossfade mode active.
* Off - Dipless crossfade mode active.
ON SNAP - RELEASED |+ On - When a playback device was in a released
PB TO TOP state when the snap was stored or updated, the
QList always loads at the first cue.
* Off - When a playback device was in a released
state when the snap was stored or updated, the
QList always loads at the cue that was active
when the playback was released.
SNEAK ACTIVE * On - Sneak active. During editing, absol te val | On
ues fade in default sneak time.
» Off - During editing, absolute values bump in.
AUTO SNAP UPDATE Choose how snaps are updated.
Options are:
* No Auto Update
* On Any Change
* On New As ignm nts Only
LOOK AHEAD ACTIVE |+ On-L ok Ahead enabled.
* Off Lo k Ahead disabled.
AUTOMATIC PARAM- * O all parameters belonging to the same type
ETER GROUPING re active in the editor as soon as a level is set
for one of the parameters.
* Off - only the selected parameter is active in the
editor, isolated from the other parameters
belonging to the same parameter type.
TEMP CUES ENABLED |+ On - allow temporary cues.
e Off - create a new QList and its first cue with
the levels in the editor.
ON Function Default value spin box Sets the level for ON key. 50
Ist on recalls last value * On - pressing ON, fades levels to last value Off
stored for the selected fixtures. Press ON again,
levels go to default ON value.
e Off - pressing ON fades levels to the ON default
value.
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Timing
Group Fields/buttons What it does Default
VGeneraI i Behavior Timing 7Hardware ‘ DMX Protocols ‘ MIDI/SMPTE ‘ Network VTopo VDelauI PB Definitions
System Time: ‘ I Cut ]
Default Cue Time: ’,2 Cut
Default Back Time: i [ ca |
Defaul GOTO Time: 1 [ ca |
Default Release Time: ’1 [ cu |
Default Library Time: ’ m
Default Sneak Time: I [ cw |
Default Look-Ahead Time: ‘_2 Cut
System Time Speed at which levels fade in or out in the editor. |1
Default cue time The defa 1t time-in/time-out for cues. 2
Default back time Th d fa It time for back fades. 1
Default GOTO time Th default time used by GOTO. 1
Default release time Speed at which released parameters fade out when | 1
released from the editor or from a playback device.
Default libra y time Speed at which library levels fade in or out in the |1
editor.
Def It sneak time Speed at which levels fade in when using the sneak | 1
feature.

Default Look Ahead time | Speed at which levels fade when using the Look
Ahead feature.

Note: Default system time is automatically entered in the Time field if the CUT button is disabled.

To change default times

Open the Tools menu.
2 Tap Settings.
The System Settings dialog box opens.
Go to the Timing tab.
4 Enter time values in the default time fields.

5 Tap OK to save and exit.
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Hardware
Group Fields/buttons What it does Default
| General_ Behavior Timingi Hardware ‘DMX Pratocaols | MIDI/SMPTE _. Metwork | Topo Default PE Definitions |
l Dizplay Settings... I
l MHetwork, Settings... I
[ Motorized Faders I
Flapback ‘wingz In Show: |
System monitors 3 (Red)
2 (Blue)
Playback wings in show | Set the number of p ayback wings. 2 (Red)
1 (Blue)

Display settings

Opens he Display Properties dialog box.

In D play Properties set:

* Number of monitors

* Screen resolution

* Desktop wallpaper

 Other standard display settings

To improve display performance

1 Right click on monitor 1.
2 Choose Primary.
3 Tap OK.
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Group

Fields/buttons

What it does

Default

Network settings

Opens the Network Settings dialog box.

Touch Screen Calibration

Allows calibrating the touch screens.

To calibrate the touch screens

Tools menu.
Tap the Hardware tab.

Tap Touch Screen Calibration.

corner of the display.

corner of the display.

1 Open the System Settings dialog box through the

4 Tap the center of the x that appears in t e upper left

5 Tap the center of the x that appears in the lower right

Touch Screen Settings

Opens the Pointer Device P operti  dialog box.

s
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Group

Fields/buttons

What it does

Default

System Settings

General | Behavior | Timing | Hardware | DM Protocols | pIDI/SMPTE | Metwark | Topo | Default PE Definitions

Univerzes
Fort 1

]
w
-y
=
Al

Fort 2

Fort &

Fort 4

Fort 5

Fort &

Fort 7

Fort &

Fort 3

Fort 10

Fort 11

Fort 12

Fort 13

Fort 14

Fort 13

Fort 18

L H OO EEEEEOEOE e e =

OO O OO OC OO OeCEoec

[ Checkal |[ Checkan |
[ UnCheck &l |[ UnCheck &l |

Di-On-Ethermet

[ Wirtual Connectaors [WC's) ]

[ WL Compression }

[ Art-Met ]

Art-Met Subnet: iD |

[ Db Input }

Max. Transmission Fate Hz): |29 1

Accurate configuration of the VC and Art-Net output of the onsole helps to reduce network traffic and uses

less system resources.

DMX / DMX-
over-Ethernet

Virtual Connectors (VC’ ) |« n - Virtual channel transmission (for DMX On
over Ethernet) is enabled.
* Off - Virtual channel transmission is disabled.
VC Compre sion * On - VC compression is enabled. Off - VC com- | Off

pression is disabled.

Art-Net
Se page 377

Connect with Art-Net devices

A Net Subnet

Set the Art-Net offset. When Art-Net is enabled,
the Subnet setting defaults to 0.
Note: Generally the Art-Net IP subnet on Art-Net

devices, such as media servers, is set to the same
IP subnet as Vector.

DMX Input
See page 371

* On - The console responds to DMX512 input.

» Off - The console does not respond to DMX512
input.

Max Transmission Rate
(Hz)

Regulate the rate at which DMX over Ethernet is
transmitted. The available range is 25 - 40 Hz.
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MIDI/SMPTE
Group Fields/buttons What it does Default

System Settings

I
O

MIDI MIDI e n-MIDI over Ethernet is enabled. On
See page 389 » Off - MIDI over Ethernet is disabled.
MIDI Keys * On - Vector can receive MIDI keys transmitted

by an outside source.

* Off - Vector does not receive MIDI keys trans-
mitted by an outside source.

MIDI Macr ¢ On - Storing MIDI macros is permitted.
» Off - Storing MIDI macros is not permitted.
MIDI Channel Set the MIDI channel
MIDI Code Offset
MSC Enable/disable MSC (over Ethernet) On
MSC Device ID Set the MSC device ID
MSC Group ID Set the MSC group ID
MSC Peer’s ID Set the MSC ID
Frames per Second Set the frames per second value for SMPTE opera- | 30
(SMPTE) tion.
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Network
Group Fields/buttons What it does Default
| General [ Behavior | Timing Hardware- _l-DMX Praotocals MIDI;’SMF’TEI Metwork ‘ Topo Default PE Definition-sf
Congole Identify Multi Jzer Mode
Metwork D0 | ) [ Node ]
Console 1D: | | : | I e ]
Master Congole 10: im |
Console Network ID The Network ID number a pears in this field.
identifiers
Console ID The console ID num er appears in this field.
Multi User Node * On - The ¢ nsole or Vector Node operates as a | Off
Mode node.
See page 365 »  ff- The console is not designated as a node.
Slave * On - The console or Vector Node operates asa | Off
slave console.
e Off - The console is not a slave console.
Master Consol ID Identify the master console through its ID number.
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Topo
Group Fields/buttons What it does Default
System Settings
| General | Behavior | Timing | Hardware | DMX Frotocols | MIDI/SMPTE | Network ‘ Topo | Default PB Defirtons|
Stage Width (cm): 1800
Stage Depth (cm]): "121.‘0
Stage Width Enter stage dimensions. the unit of measureme tis [ 1800 cm
centimetres.
Stage Depth 1200 cm

sy
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Default PB Definitions

Set global defaults for playback device control keys according to the type of object loaded on the
playback device.

Group Fields/buttons What it does

Default

System Settings

| General | Behavior | Tiring | Hardware | DMX Prolocols | MIDI/SMFTE | Network | Topo | Default PB Defintions

[ Default PB Defiritions ]

B d-Keys

alist [N 6o
Single Cue ‘ - '
Chaser : Flash Behavior Flash Behavior
Hold/Back ¥ |Release OnRelease  « | iHaIaasa OnRelease  »
” ntensily Behavior
flntenss'ty Master ~ Intensity I:lr..s- ~

I

|Flazh v [ Releass On Bottom

e

Set default functions for: Set default functions for:
Control keys Qkeys

Slider

Flash

DEFAULT PB DEFINI IONS | Enabled - APPLY PB DEFAULT is available in the | Disabled
Editor tool bar and in Setup mode.

Disabled - APPLY PB DEFAULT is not available
in the Editor tool bar and in Setup mode.

Object Qlist The defaults defined here are applicable to the na
List S ngle (temporary) cue selected object.
* Chaser
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Group Fields/buttons What it does Default
PB Control key Set the function for upper control keys. Go
See (first combo box)
page 218
Control key Set the function for lower control keys. Hold/Back
(second combo box)
Fader Set the fader function. X-Fader
(third combo box) (In)
Flash key Set the flash keys function. Flash
(fourth combo box)
Flash Behavior Set default behavior for flash keys. Release on
Release
Slider Behavior Set default behavior for the slider when it is func- | Intensity
tioning as an intensity master. Master
Qkeys Control key Set the control key function Go

Flash Behavior

Set default behavior for la hk ys.

Release on
Release

Diss

To enable the playback defaults

Tap DEFAULT PB DEFINITIONS.

To set the playback device defau ts

1 Select the object from the object list.

2 Setthe keyor fad fun ions in the appropriate fields.

3 Tap OK.




Chapter 16 Multimedia Features

You can attach picture, *.avi or *.txt files to Vector show objects such as cues, libraries, groups,
snaps, and macros. You can also capture frames from a video transmission and attach them to show
objects.

This chapter contains the following sections:

m File attachments (see page 347)

m Media Server integration (see page 351)

File attachments

IMPORTANT! Windows Media Player 9 (at | ast) must be installed on your Vector in
order to use the attachment feature.

Attaching media and text files to show objec s can be a great aid in providing accurate documenta-
tion for rep companies or keeping light crew shifts up to speed. Each show object supports two
attachments; one media file attachment nd one text file attachment.

The attachment feature option - Attach, Note and Delete Attachment are available in the attach-
ment viewers and the Attachme t menu.

Note: When using the Attachment menu, make sure the attachment viewer is the active
pane.

Attachment view rs

Attached fi es are viewed in the attachment viewers.
here are two attachment viewers:

One viewer is connected to the master playback device and its’ title bar is Playback P Master
» Attachment.

The second attachment viewer is for show objects that are selected in grids or soft keys and its’ title
bar is labelled Editor Tools» Attachment Viewer. The Editor Tools viewer displays the selected show
object in the title bar. The master playback viewer displays the current cue in the title bar.
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Confrols:
Atachad fo. Delete, Altach, Text

ow - Qlists - 1.0List 1 Cue  Delete  Attach  Note

Figure 130: Attachment viewer

Both attachment viewers have three controls

Control | Use

ATTACH | Attach a media file or text file to an object.

NOTE Toggle between text and graphic attachments.

Type a note in the attachment viewer area.

DELETE Delete attached media file or text.

Working with attachments

To display the master playback attachme t viewer

1 Tap a pane to activate it.
2 Open the Workspace and pan Playback» Master.
3 Choose Attachment.

To display an attachme t viewer

1 Tap a pane to a tivate it.

2 Openth Workspace and expand Editor Tools and choose Attachment Viewer to attach or

view files attached to show objects.

To a tach a media or *.txt file to the current cue (on the master playback)

1 Tap ATTACH in the Master Playback Attachment Viewer. The Open dialog box is
displayed.

Or
Go to the Attachment menu and tap Add Attachment.
2 Browse to the correct location and select your media file.

3 Tap Open. The file is attached to the current cue and is displayed in the Attachment Viewer.

To attach free text to the current cue (on the master playback)

1 Tap NOTE in the Master Playback Attachment Viewer.
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The Open dialog box is displayed.
Or
Go to the Attachment menu and tap Note.

2 Type text in the Attachment Viewer.

To attach a media or *.txt file to an object
Example: Attach a media file QList 1 cue 1.
1 Select the cue in either soft key or grid display.
2 Tap ATTACH in the Attachment Viewer.
The Open dialog box is displayed.
Or
Go to the Attachment menu and tap Add Attachment.
3 Browse to the correct location and select your media file.
4 Tap Open.
The file is attached to the selected object and is di playe in the Attachment Viewer.

To attach free text to an object

Example: Attach a text file to macro 2.
1 Select the macro in either soft key or grid format.

2 Tap NOTE in the Attachment V ewe

Or
Go to the Attachment menu and tap Note.

3 Type text in the Atta hment Viewer.

To delete an attachment

1 Sele tth object in either soft key or grid format and tap cue 1 to select it. Skip this step if
the ue is currently output.

2 Tap DELETE in the Attachment Viewer or Attachment menu.

You are asked to confirm the delete command.

To toggle the viewer between text and graphics

Tap NOTE.

R ceiving video transmission

IMPORTANT!
Support for a USB camera requires updating the Windows OS image. Please contact
Compulite’s support team prior to installing any USB camera driver.
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Vector can receive and display video transmissions from a web cam connected at Vector’s USB port
or from digital cameras that are part of the general network and have an IP address. Frames can be
captured and attached to show objects and to cues on the master playback.

DirectX9 must be installed in order to use a web cam connected on Vector’s USB port.
If you are using cameras connected to Vector’s USB ports, you must connect the camera before
starting up Vector.

The Camera Viewer displays the input from the video source. The Camera Viewer has two controls:
ATTACH and MASTER PB.

Camera viewer controls

ATTACH Press to attach the displayed image to the selected object or to th
cue output on the master playback.

MASTER PB | Toggle between the master playback cue and the selected object.

To display the camera viewer
1 Open the Workspace and expand the Editor Tools node.
2 Choose Camera Viewer.

The transmission is visible in the active d spla pane.

To connect to a camera

Make sure the camera vieweri d played.
Open the Attachment menu
Choose Select Video Sou e.
The Video Device dialog box opens.
Tap USB to establish communication with a camera connected to Vector’s USB port.
Choo ac mera from the device list.
Tap OK.
OR
Open the Attachment menu.
2 Choose Select Video Source.
The Video Devices dialog box opens.
3 Tap IP (ETHERNET), to connect to a camera that is available on the general network.
Enter the camera’s IP address or URL.

Tap OK.

To capture and attach a video frame

Example 1: Attach a video frame to a cue on the master playback.
1 Make sure the Camera Viewer is open: Workspace» Editor Tools» Camera Viewer.

2 Make sure Master PB is enabled in the Camera Viewer.
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3 Tapping ATTACH in the Camera Viewer attaches the current frame to the cue that is output
on the master playback device.

Example 2: Attach a video frame to position library 1.
1 Make sure the Camera Viewer is open: Workspace P Editor Tools» Camera Viewer.

2 Select position library 1 by tapping its soft key or choose the library from the list in grid
format.

Make sure Master PB is disabled in the Camera Viewer.

4 Attach the current frame to the library by tapping ATTACH in the Camera Viewer

Media Server integration

Vector consoles support bi-directional communication with the popular media servers. Easy access
to media images by downloading thumbnails from the media serve Imag selection is through
pickers on Vector. Media servers can be controlled via standard DMX 12 or Art-Net, thus light and
video cues are controlled by the lighting console.

Overview

The live fixture display has dedicated fields f r media server devices. Set the live view format to
Text to display folder and thumbnail (image) ames in the fixture parameter fields.

Folder name Thumbnail (image) name

Live - Media Server

Fixture # |Fixture Dimmer [Folder |File |Contrast Brightness
Movies mir_metro Less-1.91%
Movies mir_grafitl Less-1
Folder 128 019av3_f Morm 5 -
Folder 128 D14AR_C Morm L Less-1.78%
Folder 178 031AR_G More Mormal-2.
Folder 178 D10AR_B Morm . Mormal-2.
Movies mir_grafit! N orm L MNormal-2.
Movies mir_urbarn Mormal-2. MNormal-2.

Figure 131 ive media server display

Patching media server devices and configuring for Art-Net control

Medi server devices are patched in Vector’s Patch Manager. By default they are in the Media
Server set (set 3). When creating the media server fixtures they can be organized in any other set,
for instance in the spot set (set 1).

To patch media server devices
1 Open the Tools menu and choose Patch Manager.
The Patch Manager opens.
2 Tap %- (Create and Patch).
The Create and Patch Fixtures dialog box opens.

3 Tap IMPORT DEVICE.
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The list of devices opens.

4 Scroll to the media server’s manufacturer folder and expand the folder to view the device
list.

Select the devices and click OK.

In the Number of Fixtures to Create field, enter the number of fixtures appropriate to your
media server.

Set the Start Number for the fixtures.

In the Name field, enter the name of the media server or the IP as described in the manuf c-
turer’s user’s guide.

IMPORTANT! To download thumbnails the fixture names must be identica to th
media server computer name or to the media server IP (see, “ Downloading thumbnails”

on page 361.) Consult the media server manufacturer’s instructions.

9 In the Set field, choose a set.
The default set is Media Server (set 3).
10 Tap NEXT.
11 Enter the port and DMX address.
12 Tap FINISH.
The patched fixtures are added to th selected set.

13 Save and exit the Patch Mana er

To control media servers over Art-Net

Two digits comprise the Art-Net configuration. The first digit is the Art-Net subnet and the
second digit is the rt N t port number. On most media servers, Art-Net digits are displayed
together. On Vect r, th Art-Net subnet is displayed in System Settings and the port number
can be vi wed in th Patch Manager. On the media server, the Art-Net port number is the
DMX p rtn mber minus 1.

Exampl : Vector Data connector and the media server are connected via a hub. The IP subnet
i iden cal on Vector and the media server (90.x.x.x). On Vector the media server devices are
pat hed to DMX port 4 and in System Settings » DMX Protocols the Art-Net subnet is 0 and
in the Art-Net column port 4 is checked. On the media server, the Art-Net configuration is 0
(subnet); 3 (DMX port number minus 1).

Vector can now communicate with the media server via Art-Net protocol.

1 Goto Tools P Settings » DMX Protocols and in the Art-Net column, check the DMX port
that the media server is patched to.

Example: If the media server is patched to DMX port 4, tap the check box for port 4 in the
Art-Net column.
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System Settings

General | Behavior | Timing | Hardware | DMx Protocols | MIDI | MultiUser | Topo | Default PB Definitions
Check thg DMX port where the- - " ) '
media sefver devices patched 1

Umiverses VC's Art-Net DMA-On-Ethernet
Port 1 [ []
Port 2 L] |
Fort 3 O [
Part 4 O [E]
Port 5 [ O
Fort 6 [ O Enable Art- Net
Fort 7 L) L]
Port 3 I Art-Net ‘
Port 9 L] |
Port 10 O LI
Fort 11 n 0 Art-Net Subnet: 1]
Port 12 [] O T
Port 13 L] [ Art-Net Subnet address
Port 14 ] []
Fort 15 - - I DM Input ]
Port 16 [l L]
[ Check Al ] [ Check Al ] Max. Transmission Rate [Hz) | 25
[ UnCheck Al |[ UnCheck All |

Figure 132: Art-Net setup in System Settings » DMX Proto ol
2 Enable ART-NET.

The Art-Net Subnet field is active.
3 Set the Art-Net subnet to the same subnet as he media server.
The default Art-Net subnet for Vector and mos media servers is 0.

4 Tap OK.

To control media servers over DMX

Some media servers have native DMX connector and are subject to normal DMX control. The
media server manufacturers r commend using Art-Net to control media servers. If you are
using DMX and want to download media file thumbnails, all Ethernet connections and config-
urations must be do  as described in this document.

Connecting media servers to Vector

Ethernet co nection | Cable type

HUB (r commended) Standard Ethernet cable

tor DATA port Crossover Ethernet cable
(direct connection)

Arkaos media server

To connect Arkaos to Vector

1 Change the Arkaos media server subnet to match Vector's subnet.

Example: If Vector IP is 91.xx.xx.xX, then the Arkaos IP must also begin with 91.
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To configure Arkaos

These instructions are for Arkaos version 3.6.5.
1 Change the Arkaos computer workgroup to COMPULITE.

Go to Control Panel » double click System P Select the Computer Name tab » Click
Change P Type COMPULITE in the Workgroup Name field. Click OK twice and close the
Control Panel.

Restart the Arkaos computer if the workgroup name or IP address was changed.
Run the Arkaos application - ﬁ
4 On Arkaos open the Edit menu, select Preferences, then select DMX Setup.

ATTENTION! If DMX Setup does not appear in Preferences (on Arkaos) Ark o is
either in demo mode or you do not have a DMX Key registration.
For full instructions consult Arkaos documentation.

5 From the shortcut menu, choose DMX Setup.

6 Configure according to Figure 133.

¢ B2 SETUP

[“]Use Device: | ArtNet v | [_Setupe—] ;::;:L":m —
O Simple Mode: 3::; z
DMX Channel Mapping: First Channel Last Channel Device name
Dimmers: l 1 [ \ 12 }
Controllers: [ 14 ’ [ 23 ]
Patch Selection (Bank): (13 |
Sequence Trigger (24 [
® Fixture Mode: ArkaosFull @3ch) v | Select Arkaos mode
First DMX channe | 1 (1-168) W
Number of layers: 8 (1-8) £ikaostien (31.64)
Priority Mode:
(® HTP Highest Takes Precedence
OLTP Latest Takes Precedence
Position Smooth Level: [0 | @-255)
[__Cancel ] [ Ok J

Figure 133: Arkaos DMX and Art-Net setup (see Arkaos user’s guide)

To patch Arkaos devices on Vector

1 Open the Vector Patch Manager.
2 Import the Arkaos devices according to the Arkaos mode (Maxi, Full, or Tiny).

3 Create and patch Arkaos devices according to the number of layers configured in the

Arkaos media server
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4 Save and exit the Patch Manager.

ATTENTION! To download thumbnails media server devices require exact names!

IF ARKAOS IS RUNNING ON WINDOWS! Make sure that the Arkaos device names
are identical to the Arkaos computer name. Example: If the Arkaos computer name is
Arkaos-00123, the devices must be named Arkaos-00123 1, Arkaos-00123 2, etc.

IF ARKAOS IS RUNNING ON MACINTOSH! The name of the Arkaos device must be
identical to the IP address of the Arkaos computer. If Arkaos computer IP is 90.2.6.8
the devices names must be 90.2.6.8 1,90.2.6.8 2,90.2.6.8 3, etc.

Hippotizer V2 media server

To connect Hippotizer V2 to Vector

1 Change the Hippotizer V2 IP subnet to match Vector's IP subn t.
If Vector IP is 91.xx.xx.xX, then the Hippotizer V2 IP must a so begin with 91.
2 On Hippotizer, check that the user name is 'vj' with no p ssword or with the password 'vj'".

This is default on all Hippotizer V2 systems.

To configure Hippotizer V2

These instructions are for Hippotizer v rsion 2.2.4.

1 On the Hippotizer computer, make sure that the media and mediamaps folders are shared
and there is a check in the Perm ssions check box to allow changes to the files.

2 Change the workgroup r the Hippotizer media server to COMPULITE. Go to Control
Panel » double click ystem P Select the Computer Name tab » Click Change® Type
COMPULITE in the Workgroup Name field. Click OK twice and close the Control Panel.

3 Restart the Hippotizer V2 computer if the workgroup name or IP address was changed.
4 On the Hipp tizer computer, run Hippotizer Setup - %ﬂﬁf

On he General tab, select the mode.
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i
{General’| DM (Ful] | DMX (Preset) | MIDI | RS232| Keyboard | Info |
I~ Autorun on Bootup Audio-Setup
™ deinterlacs clips

Select Hippotizer mode —— [~ Overwite Resolution

b Y
Testwe [7027  [768

O il l |
I~ TVAideo utput 1[04 768 set
Output 2 [7024 [762
Connections
VGAT: Control Centre z
DVI/TVI: Dutput 1 el
VGAZ: -

Discard Changes | Save Changes |

Figure 134: Hippotizer Setup dialog box, General tab s e th Hippotizer user’s guide)
6 On DMX Full tab, check Enabled and configure the Art Net subnet.

|| Hippotizer Setup

General [ DM {Full] | DMX (Preset)
~DMX(Ful)—

[v Enabled

SubNet 00 @———— Art-Net subnet + Port

Start Channet: 1

Number Channels:

EDMX Name: Hippo01

IP Address:

|

DMX-Tester |

Do NOT set the IP address in the Hippotizer Setup dialog box.
Set the Hippotizer PC IP address through:
Start > Control Panel > Network Connections

Figu 135: Hippotizer Setup dialog box, DMX tab detail (see the Hippotizer user’s guide)
7 Save changes and run the Hippotizer - E

To patch Hippotizer V2

1 Open the Patch Manager.
2 TImport, create, and patch Hippotizer devices.
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Device Mode

Number of devices to create and patch

Single mode

1 x Hippotizer Master V2
8 x Hippotizer Layer V2

Dual mode

1 x Hippotizer Master V2
4 x Hippotizer Layer V2
1 x Hippotizer Master V2
4 x Hippotizer Layer V2

Pan mode

1 x Hippotizer Master V2

1 x Hippo Pan Master V2

4 x Hippotizer Layer WIDE V2
4 x Hippotizer Layer V2

DMX 56.

IMPORTANT! The DMX address for the Master must always be before the
DMX address of the layers. Example: Masteris MX 1 and the layers start at

In each mode, set DMX addresses ccording o the order that the devices
appear in this table.

3 When naming the Hippotizer V2 dev ces, remember that to download thumbnails media

server devices require exact n mes!

Example: If the Hippotiz r mputer name is Hippov2-00123, the fixture layers must be
named Hippov2-00123 1 Hippov2-00123 2, etc.

4 Save and exit the Patch Manager.

Hippotizer V3 media server

To connect Hippotizer V3 to Vector

1 Change the Hippotizer V3 IP subnet to match Vector's IP subnet.

If Vector IP is 91.xx.xx.xx, then the Hippotizer V3 IP must also begin with 91.

o onfigure Hippotizer V3

These instructions are for Hippotizer version 3.0.12.

1 Change the workgroup for the Hippotizer media server to COMPULITE. Go to Control
Panel » double click System » Select the Computer Name tab » Click Change P Type
COMPULITE in the Workgroup Name field. Click OK twice and close the Control Panel.

2 Restart the Hippotizer computer if the workgroup name or IP address was changed.

On HippoNet Overview, open the Engine Settings to select the mode.
4 Run the Hippotizer Engine - ¥¥'and then the Zookeeper -
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Figure 136: Hippo V3 Setup (see the Hippotizer use s guide)

5 On HippoNet Overview, open DMX Component Sett gs o set DMX and Art-Net

configuration.

6 Check DMX On.
7 Uncheck Update.
8 Double click an Art-Net univers to ch nge the Art-Net configuration.

Start Address = Channels used

s: © Auo
® Maual
@ Disabled

DMX Status

Figure 137: Hippotizer V3 DMX setup (see the Hippotizer user’s guide)

ATTENTION! To connect with Vector, the Hippotizer media server must have a DMX
component and an Hmap2 Server Component. In HippoNet Overview, check if these
components are present. If they do not appear, add them to Hippotizer.

For full instructions consult Green Hippo documentation.
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1 Open the Vector Patch Manager.

2 TImport, create, and patch Hippotizer devices.

Device Mode

Number of devices to create and patch

Single

1 x Hippotizer Master V3
8 x Hippotizer Layer V3

Dual

1 x Hippotizer Master V3
4 x Hippotizer Layer V3
1 x Hippotizer Master V3
4 x Hippotizer Layer V3

Pan

1 x Hippotizer Master V3
1 x Hippo Pan Master V3
8 x Hippotizer Layer V3

DMX 46.

IMPORTANT! The DMX address for the M ster must always be before the
DMX address of the layers. Example Master is DMX 1 and the layers start at

In each mode, set DMX address s according to the order that the devices
appear in this table.

3 Save and exit the Patch Manager.

ATTENTION!

To download thumbnail media server devices require exact names! Example: If the

Hippotizer name is Hippov3-00123, the fixture layers must be named Hippov3-00123 1,

Hippov3-0 123 2, etc.

If medi files have been added to Hippotizer V3, it is necessary to restart the Hippotizer
sof are o download the new thumbnails.

Catalyst me ia server

Vector supports Catalyst media servers from Catalyst version 4.0.

To connect Catalyst to Vector

1 Change the Catalyst media server IP subnet to match Vector's IP subnet.

If Vector IP is 91.xx.xx.xX, then the Catalyst IP must also begin with 91.
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8o Network [=)
« = Aa® 3
Show All D;‘N:.;s Sound | Network Stanup Disk
Location: | Automatic [
Show: | Built-in Ethernet =

| TCPHP | PPPeE  AppleTalk = Proxies = Ethernet |

Configure IPv4: | Manually 4+

IP Address: |2.0.0.1
Subnet Mask: | 255.0.0.0

Router:

Search Domains: (Optionaly
IPvE Address:
(_ Lontigure IPve... ) (?\’
{J
U8 Click the lock to prevent further chinges. (Assistme. ) ( ApplyNow )

Figure 138: Catalyst Network dialog box (see the Catalyst user’s guide)

To verify the connection between Vector and Catalyst

1 Make sure the Catalyst computer is running.
2 On Vector, browse to http://[Catalyst IP]:8080/ tws iles.html.

Example: browse to http://91.0.0.5:8080/catws files html - where 91.0.0.5 is the Catalyst
computer IP.

You should see an HTML page with 11 the installed media thumbnails.
3 Then browse to http:/[Catalys TP] 080/catws/Images/000 002.jpg.

You should see the thumbnai for file 2 in folder 0. This verifies that the connection is OK
and the thumbnails are acc ssible.

Now the media picker for the file and the folder parameters are available.

To patch Catalyst

1 Patchth Catalyst layers in the Catalyst computer.

Con ult the Catalyst user’s guide for details.

Ope the Vector Patch Manager.

Import the Catalyst v4.cvd device files located in the High End folder.

Create and patch Catalyst fixtures.

g AW N

In the Name field enter the Catalyst computer IP address.

ATTENTION!

To download thumbnails media server devices require exact names! Example: If Catalyst
computer IP address is 2.0.0.5, the layer names must be 2.0.0.5_1,2.0.0.5_2,2.0.0.5_3,
etc. Note that Vector automatically appends _* to the layers.

6 Save and exit the Patch Manager.
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Downloading thumbnails

Vector supports thumbnails for:
m Arkaos
m Hippotizer V2
m Hippotizer V3
m Catalyst V4

Before downloading thumbnails, perform all connections and configurations required by th media
server. See “Arkaos media server” page 353, See “Hippotizer V2 media server” page 355,

See “Hippotizer V3 media server” page 357, See “Catalyst media server” page 359

ATTENTION! For Arkaos media server! Art-Net must be enabled to d wnload
thumbnails.

There is an option to save thumbnails when saving a show. The adv ntage of saving the thumbnails
with your show is that you can then program without the media erver being connected. If some
media files were added or changed, you must download the thumbnails again.

Note: Although it is allowed to save thumbna sin he how it significantly increases
show file size.
To download media server thumbnails
1 Select fixtures.
2 Tap DOWNLOAD THUMB located on the second page of the Editor tool bar.

Tap here to download
media server thumbnails

Download
Thumbs

BRI o Hippotizer Thumbs... 14:51:10 |

Figure 139: A progress bar shows the thumbnail download.

If there is a communication failure, an error message is generated and the procedure is
aborted. If the procedure does not succeed, thumbnails that were present in the system are
usually still available.

Selecting folders and media files

Vector supports media file previews for:
m Arkaos

m Catalyst

361 &)
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m Hippotizer V2 and Hippotizer V3

Media folders and media files are selected using the Select Files and Select Files pickers.

Select Folder

. owsnes |

Figure 140: Folder picker showing available media folders

Select File. Folder: grp_Q

i

"\\\\\3}:‘.\'.\‘;{

m
8

Figure 141: Media file picker showing images available in the selected folder

ATTENTION! Media server pickers have one tab for each layer (device). Make sure you
choose media for each layer.

To select folders and media

1 Select the media server fixtures.

2 To select a media folder:

Hippotizer V2 and V3 - Double tap the BANK parameter to open the Media Folder pickers.
Arkaos - Double tap the TYPE OF VISUAL parameter to open the Media Folder pickers.
Catalyst - Double tap the FOLDER parameter to open the Media Folder pickers.

The folders are displayed, showing a thumbnail for the first image in the folder.
3 Select an media folder.
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4 To open the Media File picker:

Hippotizer V2 and V3 - Double tap the CLIP parameter.

Arkaos - Double tap the INDEX OF VISUALS parameter.

Catalyst -Double tap the IMAGE FILE parameter.

Thumbnails of the media contained in the selected folder are displayed.
5 Select a media file.

6 Close the picker.
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Appendix 1 Backups, Peripherals,
DMX Input

This chapter contains the following sections:

m Master and slave consoles (see page 365)

m Multi Users (see page 368)

m Remote panels (see page 369)

m DMX Input (see page 371)

m Art-Net (see page 377)

Master and slave consoles

The master/slave feature enables connecting 2 Vect r lighting consoles in a master/slave configura-
tion. In slave mode, the console does not tra mit VC's. In case of master console failure, or loss of
connection, the slave takes over as mast  ons le after 10 seconds.

The master and slave consoles are automatically synchronized and the show running on the master
console is automatically loaded the lave console.

When connected, the master and slave consoles operate in parallel.
m The master and slave consoles display the same command line.
m The editor is shared by both consoles.
m Storing bje ts on one of the consoles stores the object on both consoles.
m The sho is saved on both consoles.

m The slave console receives changes in data as they occur. Data includes new, deleted, and
changed objects, such as cues, snaps, groups, libraries, etc. Editor levels are also transmitted to
the slave console.

m Playbacks are synchronized periodically, provided that a significant change, such as a new
assignment or a fade to a cue, has occurred.

Note: A PC/Laptop running version 3.06 (at least) of the Vector PC, can be connected as
the slave.

The advantage of the master console and slave console operating in parallel is that when master
console is in one location (the lighting booth, for instance) and the slave console is in another loca-
tion (the house), you can program and control your lighting system from the slave without running
DMX cables from the slave because the DMX output is from the master console.

3655)
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Status display

Master and slave status is displayed in the command line. The status indications show whether the
console is a master or a slave and to which console it is connected. If the connection is lost or
cannot be established, the indications do not appear.

m The master console shows: Master: Connected to # (slave console’s ID number).

m The slave console shows: Slave: Connected to # (master console’s ID number).

Connecting the consoles

The Master/Slave connection is over the Ethernet network.

IMPORTANT! The real time version in the master and the slave consoles must be iden-
tical for successful connection. If there is a mismatch in the RT softwar ver ions, a
warning is generated on the master console.

To connect the consoles

Connect the control ports, located on the back panel of ch console, using a crossed-linked
Ethernet cable. (Recommended)

OR

Use an Ethernet switching hub. Connect both consoles to the hub using standard Ethernet
cables from the Data port on each Vector.

Configuring the slave console
After the consoles are physical y connected, configure the slave console.

System Settings -51

General | Behavior | Timing | Hardware ~Communication |Tcrpo |

Console ID: IT Network 1D: ISU_ . IT

" Master / Slave

I Slave R? Master Console ID: |1 2

F gure 142: Master/Slave configuration

To configure the slave console

Go to the Tools menu and tap Settings. Open the Communication tab.
Tap Slave.

Set the ID of the master console. The master console's ID can be found on the master
console, ToolsP Settings» Communication.

4 Tap OK. The slave connects to the master. A successful connection is displayed in the
slave’s command line: Slave: Connected to # (master console’s ID number).
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ATTENTION! If the consoles do have the same RT version a warning is generated. It is
necessary to update the consoles so they are running the same RT version.

To return the slave console to normal operation mode

Tools P Settings» Communication and then disable SLAVE.

Rules governing master/slave switchover

The rules governing master/slave switchover in the case of master console failure are:
m If the master fails, the slave takes over in 100 milliseconds.

m When the master is restarted, it is automatically set as the slave console. All d ta f om the
current master console (formerly the slave console) is loaded to the new slav console.

m If the connection to the master is restored in less than 10 seconds after failure, it is re-estab-
lished as the master console.

Using the Vector PC as slave

You can set Vector PC as the slave console.

When using Vector PC as a slave console there ar a few rules governing the output:

m [f there are ePorts on the LAN, the slave s DMX output is according to the ePorts’ address
configuration.

m When using other Ethernet to DMX converters, that are not Compulite ePorts, only 1 DMX
universe is output.

Connecting to the Vector console

m Connect the computer running Vector PC to Vector’s DATA connector, on the back panel,
using a crossed-linked Ethernet cable. (Recommended)

OR

m Connec the pc running the off-line Editor to Vector’s CONTROL connector, on the back
panel, sing a standard Ethernet cable.

Setting the | ad ress on Vector PC

The PC’s network ID must be the same as the target console’s.
Note: Ifyou are using Art-Net set the network ID according to the Art-Net IP (10 or 2).

To set IP address for Vector PC

See “configure the slave console” page 366.
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Multi Users

In multi user mode, up to eight consoles can be used to run or program a show. Each node operator
has full access for storing, deleting, and playback.

To enable a console as a multi user node

1 Go to Tools P Settings » Communication tab.
2 Tap NODE.

When enabled the button’s field is light.
3 Enter the master console ID number.

All nodes in a multi user network must connect to the same master con ole

Multi User Mode

Node

Slave

Glaslel Console ID: » 10 ]

Figure 143: Master Con ole ID field

ATTENTION! A console an be designated as a node even if it is not yet connected to the
master console.

Live display
Each co ole perator sees the output of all the consoles. The current, local editor is displayed in

white Other local editors and editor values from other consoles are displayed in gray.

ach ode displays its own command line.

Storing all editors

The multi-editor option controls the source of information that is stored in cues. MULTI EDITORS is
accessed through STORE OPTIONS on the Editor tool bar in store mode or in Tools P Settings »
Behavior tab

m MULTI EDITORS enabled - all information active in the various editors is stored.This includes
the console’s internal editors, the Editor Wing in standalone mode, and Vector Node.

m MULTI EDITORS disabled - only information in the console’s current editor is stored.
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To store output from all the editors

1 Press CUE and select the cue number.

2 If necessary, tap STORE OPTIONS and enable MULTI EDITORS.
3 Press STORE.

(E]

To store output from all the editors
Press STORE.
Press CUE and select the cue number.

If necessary, tap STORE OPTIONS and enable MULTI EDITORS.
Press ENTER.

H WO DN -

MULTI EDITORS remains enabled until it is manually disabled.

Remote panels

Vector supports remote panels on two comm n p atforms:
m Pocket PC
m PC/laptop

Vector and the remote panels wor interlaced.

Use Vector’s remote panel ppli ations for editing functions.

Setting up the network

Setting up the Vec or network consists of:
m Set ing th P addresses for the console and the remote panel.

m Establishing the network connection

Vecto ’s IP address is defined as:

m Network ID - 2 bytes define the general network, to which Vector is connected.

m Console ID - 1 byte defines the console’s unique identifier.

m Component ID - a 1 byte identifier for network components within the console. The realtime
component ID is 10. The Windows component is 1. This is factory configured and cannot be

changed.

The remote panel’s IP address is defined as:
m Network ID - Same as the target console.
® Any number - 0 - 254
® Any number - 1 - 254
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Example:

Vector IP address

Network ID | Console ID | Component ID

90.10. 59. 1(Windows)
Remote panel IP address

Network ID | Any number | Any number

90.10. 0-254. 1-254

To set Vector’s network and console IDs

1 Tap the Tools menu and choose Settings. The System Settings dialog box opens.

2 Enter the console ID and network ID in the appropriate fie ds Se “DMZX Protocols”
page 341.

3 Tap OK.

To connect Vector and the remote panel

Connect the remote panel directly to the Contr | port on Vector’s back panel using a standard

Ethernet cable.

OR

Connect the remote panel via a hub. Use a standard Ethernet cable to connect between the
Control port and the hub’s Uplink port or use a crossed Ethernet cable and connect to one of the

hub’s ordinary ports.

To connect the Pocket PC remote

W N -

Connected.

To connect the PC remote

g A W N -

Select the target console.

Press OK.

Start the Ve tor iControl application.
Open the ew menu, located on the bottom toolbar, and choose Connections.
F m the Available Consoles combo box, select the target console.

Press Connect. When the connection is successful, the disconnected message is replaced by

Start the Vector Remote Panel application.
Move the mouse pointer to the top of the panel to open the menu bar.

Open the Application menu and choose Connect.
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DMX Input

A DMX source, such as a second lighting computer or a manual desk can be connected to the
Vector. DMX input controls all fixture types. DMX input for fixtures is integrated into the main
console output.

Vector has two DMX input ports. For every 4 DMX output ports, there is one DMX input port.

There are no constraints on the DMX Input; it is possible to patch DMX input to all available output
ports. There is no default DMX Input patch.

Each DMX input address can be patched:
m Dimmer to fixture (if no parameter is specified the system defaults to the dimmer parameter)
® Dimmer to macro

® Dimmer to fixture and macro

To enable/disable DMX Input

1 Open Tools P Settings » DMX Protocol tab.
2 Tap DMX INPUT.
When enabled, the button has a light field
When disabled, the button has a dark field.

To clear the DMX input patch

-—

Press DIM.
2 Select the dimmer num ron he keypad.

Range selections are al o valid.

Or
Tocl arth ent e DMX input patch, skip this step and continue with step 3.
Tap NPUT PATCH.
4 Tap CLEAR SELECTED/ALL.
The selection is cleared from the patch.
If there was no selection the entire DMX input patch is cleared.

5 For Enter syntax - Press ENTER.
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Triggering macros with DMX Input

One macro can be patched per DMX input channel. The intensity level of the input channel triggers
the macro. The default execution threshold is 50%. The execution threshold can be changed when
patching the DMX input address to the macro.

To patch DMX input channels and macros

—

Press DIMMER.

2 Select a DMX input channel.

3 Tap INPUT PATCH TO.

4 Press MACRO and select the macro number.

5 Optional: Press @ and enter a dimmer level to set a trigger threshold

FL. ZR, ON can be set as the trigger threshold for macros th t a e operated via DMX input.
Note: If no value is entered, the setting defaults to 50%

6 Press STORE

_E]

To patch DMX input channels and mac os
1 Press STORE.

Press DIMMER.

Select the patched output add ess (# = #)

Tap INPUT PATCH T

Press MACRO and se ect the macro number.

D s W N

Optional: Press @ and enter a dimmer level to set a trigger threshold.
FL, ZR, ON can be set as the trigger threshold for macros that are operated via DMX input.

Note: If no value is entered, the setting defaults to 50%.

7 Pr ss ENTER.

To c ear the DMX input /macros patch
1 Press DIM.
2 Select the patched input address (# = #).
3 Tap INPUT PATCH TO.
4 Press MACRO.
5 Press DELETE or RELEASE.
Confirmation is requested.

6 Tap DELETE to confirm or CANCEL to abort.
OR

s
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Press DIM.

Select the patched input address (# = #).

Tap INPUT PATCH TO.

Press MACRO.

Tap CLEAR SELECTED/ALL or (for Enter syntax) press ENTER.

Patching DMX input and fixture parameters

To patch DMX Input channels and fixture parameters

-—

a A WOD

Note: If no parameter is selected, Vector defa lts to th dimmer parameter.

6

(E]

Press DIMMER.

Select the patched output address (# = #).
Tap INPUT PATCH TO.

Select a fixture.

Select a parameter.

Press STORE.

To patch DMX Input channels and fix ure parameters

1
2
3

o g A

Press STORE.

Press DIMMER.

Select the patch d ou put address (# = #).
Tap INPUT PATCH TO.

Select a fixture.

Sele t a parameter.

Note: If no parameter is selected, Vector defaults to the dimmer parameter.

7

Press ENTER.

To clear the DMX Input /fixture parameter patch

1
2
3
4
5

Press DIM.

Select the patched input address (# = #)
Tap INPUT PATCH TO.

Select the fixture.

Press DELETE or RELEASE.

Confirmation is requested.
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6 Tap DELETE to confirm or CANCEL to abort.

Press DIM.
Select the patched input address (# = #)

1
2
3 Tap INPUT PATCH TO.
4 Select the fixture.

5

Tap CLEAR SELECTED/ALL or (for Enter syntax) press ENTER.

Playback input patch

Operate Vector playback devices through an external console. There is full access t all playback
pages, including pages that are not currently active on the main console.

ATTENTION! If your main Vector console has motorized faders we recommend not
working on the same page both on the main console and on the xternal console as you
may encounter resistance on the motorized faders.

To patch playback input

1 Press DIM.

2 Select the DMX address.
A range can also be selected
Tap INPUT PATCH TO.

4 Press PLAYBACK and specify the page and playback device number (#/#).
A range can al o be selected.
Or
Pre s PLAYBACK and specify the playback device number (#).
Th playback device(s) on the active page is selected.

5 Press STORE.

OR

1 Press DIM.

2 Tap INPUT PATCH TO.

3 Press the Select key for a playback device.

4 Press STORE.

To release playback input patch

1 Press DIM.
2 Select the DMX address.

sy
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A range can also be selected.

Tap INPUT PATCH TO.

Press PLAYBACK and specify the page and playback device number (#/#).

Press RELEASE.

Or
On the Editor tool bar, tap CLEAR ALL.

OR

1
2
3
4

(E]

Press DIM.

Tap INPUT PATCH TO.

Press the Select key for a playback device.
Press RELEASE.

Or

On the Editor tool bar, tap CLEAR ALL.

To patch playback input

1
2

5

Press DIM.

Select the DMX address.

A range can be selected.

Tap INPUT PATCH TO.

Press PB and specify the page and playback device number (#/#).
A range can also b sele ted.

Or

Press PLA BACK and specify the playback device number (#).
The playb ck device(s) on the active page is selected.

P ss NTER

OR

a A WO DN

Press DIM.

Select the DMX address.

Tap INPUT PATCH TO.

Press the Select key for a playback device.
Press ENTER.

To release playback input patch

1
2
3

Press RELEASE.
Press DIM.
Select the DMX address.
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A range can be selected.

4 Tap INPUT PATCH TO.

Press PB and specify the page and playback device number (#/#).
Or

Press PLAYBACK and specify the playback device number (#).
The playback device(s) on the active page is selected.

Press ENTER.

Press RELEASE.

Press DIM.

Select the DMX address.

Tap INPUT PATCH TO.

Press the Select key for a playback device.
Press ENTER.

Press DIM.

Select the DMX input address.

Tap INPUT PATCH TO.

Press PB and specify the page and playback device number (#/#).
On the Editor tool bar, tap CLEAR ALL.

Press ENTER.

Press DIM

Select th DMX input address.

Tap NPUT PATCH TO.

Pres the select key for a playback device.
Press RELEASE.

Or

On the Editor tool bar, tap CLEAR ALL.
Press ENTER.
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Art-Net
To use Art -Net protocol you must
* Connect the Vector and the Art- Connect the Art-Net device to Vector’s data connector.
Net device. Use regular Ethernet data cable.
+ Set the Vector network ID. To set the network ID
1 Open the Tools menu.
2 Go to the Communication tab.
3 In Network ID field, enter 2 or 1 dep nding on
the Art-Net device network setting.
* Enable Art-Net and set the Art- To enable Art-Net

Net subnet offset.
Open the Tools menu.

Open the Setti gs dialog box.

Go to the ommunication tab.

A WON -

Tap Art Ne Enabled.
When enabled the background is light.

5 Enter an integer from 0 - 15 in Art-Net Subnet
field.

6 Tap OK.

The data is saved and the dialog box closes.
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Appendix 2 Automated playback

Playback can be automated using time lines, MIDI or SMPTE.

This chapter contains the following sections:

m Time lines (see page 379)

m Scheduler (see page 386)
m MIDI (see page 389)
m MIDI tables (see page 397)

Time lines

A time line is a Vector show object comprised of a pr gres i n of events that are automatically trig-
gered when reaching the time set for the event.

Events can include:
m Playback commands such as go, rever e di ection, free, playback release, etc.
® Macros
® Snaps
The time line representati  in the indications bar flashes when time line is in teach mode.

Events can be trigger d from an external SMPTE source and MIDI time codes (MTC) or through
Vector’s inter al ¢ ck.

ATTE TION! Only commands are recorded in time line events. Changes in fader levels
ar n tre orded or recalled.

Time line views

Time lines can be viewed in spread sheet or graphic format.

Time line tool bar

1 1
" Spreadshest ”  Graphic |
B2 & alala|l®|o|o|eo|e
N Name Qlist 1 Cue1... & - > +
Event Properties ElProperties T 7 — [
. 00:00:02.1 ]
g:err;tt_l\lame Start 00:00:02.12 00:00:00.00 000001 00 00000200 | 00:00:03.00 a000:0400 = Time code

© Start time Event No 3 - =
« Event number Target Al =\ [ 4— Events on AB
+ Target (pb) Snep «4— Snaps as events
« Command
* Fade time ol

Figure 144: Time line graphical display
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To view time lines

1 Set a pane (or tab) for time line (Workspace tree P expand the Show node » expand the
Time Line node P select a time line).

The selected time line is displayed in spread sheet format.

2 To view the graphic format, click the Graphic tab.

Time line tool bars

Clear Teach + Teach Event Renumber

Rl B ol ZiE RELe Events Add New | Overwrite | Number Events

Figure 145: Time line mode on the Editor tool bar

Button What it does

RESTART Reset the time line clock to 00:00:00.00.

RUN Run the time line events.

PAUSE Pause the clock and remain in time 1 ne teach mode.
STOP Stop the time line clock and xit time line teach mode.
SET TIME Set time in [hours: minutes econds; frames] format.
CLEAR EVENTS Clear all events in th active time line.

TEACH + ADD NEW Teach a new time li e or add events to an existing time line.

TEACH + OVERWRITE | Overwrite an xisting time line.

EVENT NUMBER Choos an event for editing or deletion.

RENUMBER EVENTS | Renumber events after adding new events to the active time line.

Restart Run Pause Stop

a[<[<[e[o[e]«[s]e]
Show/Hide Properties Zoom in Zoom out Teach + Add New Teach + Overwrite

F gu e 146: Time line tools on the graphic display

Frame setting

You can set the frames per second (See “Frames per second” page 391). The options are:

e 24 * 30

e 25 * 30 Drop Frame
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To change the frame setting

Go to Tools P System Settings » Communication tab and choose from the options in the
Frames per Second drop down list.

Event fade times
m Fades to cues triggered by a time line event occur according to the cue fade times. If the cue’s
fade times are changed, the event fade time behaves according to the updated information.

m [f an event uses GOTO time, the fade will always occur in GOTO time. Any change to the
cue’s fade times are ignored.

m Temporary cue commands are stored as time line events.

Working with time lines

Time lines are taught and edited using the buttons on the Editor toolbar n time line mode.

Teaching and storing time lines

The TEACH + ADD NEW and TEACH OVERWRITE but ons on the Editor tool bar save events to
the time line.

To teach time lines

1 Press SHIFT + TIME LINE. The time ne toolbar opens.
2 Tap TEACH + ADD NEW.
3 Connect an external SMPTE r MIDI source.

When the SMPTE or MIDI source is active, it is automatically identified. You can start the
programming the time line.

Or
Tap RESTART to restart Vector’s internal clock and RUN to start the teach function.
4 Giv playback commands, operate snaps, and operate macros to create events.

Th events are stored on the time line.

To store time lines
1 After completing the teach-time line process, press SHIFT + TIME.
2 Enter the time line number on the keypad.
3 Press STORE.

The time line is stored.

(E]

To store time lines

1 Press STORE.
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Press SHIFT + TIME LINE.
Enter the time line number on the keypad.
Press ENTER.

The time line is stored.

To overwrite time lines

The overwrite feature deletes events when reaching the time line trigger for the event.

1

Press SHIFT + TIME LINE.

The time line toolbar opens.

Tap TEACH + OVERWRITE.

Tap RUN.

The time line begins processing events.

Give playback commands, operate snaps, and operate macr s  create events.
Store the updated time line.

When editing the active time line, remember that you ar editing a copy of that specific
time line. After editing be sure to save to the act ve time line number.

To playback time lines

1

Press SHIFT + TIME LINE and select the ime line number.

2 Press ENTER

3 Connect an external SMPTE or MIDI source, when the source begins its transmission the

Editing time lines

Vector clock synchronizes.
Or
Tap RESTARTt res art Vector’s internal clock and tap RUN.

The time 1 ne’s vents are executed.

You may ant to add events to the active time line.

When events are added to a time line they are arranged in the correct time sequence, however the
vent numbers are not automatically updated. The events must be renumbered.

Events can be edited using the time line keys and buttons or directly on the time line graphical

display.

To add events to a time line

1

s

Press SHIFT + TIME LINE.
The time line toolbar opens.
Tap TEACH + ADD NEW.
Tap RUN.

The time line begins processing events.
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4 Give playback commands, operate snaps, and operate macros to create events.
These events are added to the active time line.

5 Store the updated time line.

To renumber new events

When events are added to the time line, they appear in the correct time sequence, but the
numerical sequence of the events is not automatically update. You must renumber the events.

On the tool bar, tap RENUMBER EVENTS.

To edit event time

1 Press SHIFT + TIME LINE.
The Editor tool bar switches to time line mode.

2 On the tool bar, click EVENT NUMBER.

3 Enter the event number using the keypad.
Or
Select a range of events (# = #).

4 Press TIME LINE.
Set an absolute time for the selected even using the numeric keypad.
Or

Change the time by pressi g+ or to advance the event(s) on the time line or go backwards
on the time line.

For direct access to the frame, press \.
6 Press ENTER if you re editing the active time line.
Or
Press STORE if the time line you are editing is not the active time line.

7 pea steps 2 through 6, as necessary.

To edi he time for a single event on the grid
Press SHIFT + TIME LINE and select a time line.
2 Press EXAM.
The spread sheet for the selected time line is displayed.
Tap the Time Code cell.

4 Enter the new time code in 00 (hours):00 (minutes):00 (seconds):00 (frames) format using
the external keyboard.

(E]

To edit event time

1 Press SHIFT + TIME.
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The Editor Tool bar switches to time line mode.
On the tool bar, click EVENT NUMBER.
Enter the event number using the keypad.
Or
Select a range of events (# — #).
4 Press TIME.
Set an absolute time for the selected event using the numeric keypad.
Or

Change the time by pressing + or - to advance the event(s) on the time line rg backwards
on the time line.

For direct access to the frame, press \.
6 Press ENTER.
Repeat steps 2 through 6, as necessary.

To edit the time for a single event on the spreadsheet
1 Press EXAM.
2 Press SHIFT + TIME and select a time line
3 Press ENTER
The spread sheet for the selected time line is displayed.
4 Tap the Time Code cell.

Enter the new time code n 00 (hours):00 (minutes):00 (seconds):00 (frames) format using
the external keyboard

Note: When enter ng th time code, it is permitted to use single digits. Example:
Entering the time ode for 15 frames, you type 0.0.0.15.

To edit the time for a single event using the graphical display

1 Click he event and, holding down the mouse button, drag the event to a new time slot.
2 Release the mouse button.

3 Remember to save the updated time line.

To edit the time for more than one event using the graphical display

Press and hold Cntrl and click events to select them.

2 Without releasing the Cntrl key drag to a new time slot.
All selected events move relatively.
Release the Cntrl key.

4 Remember to save the updated time line.

To copy and paste events using the graphical display

1 Right click an event.

D ssy
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Choose Paste from the shortcut menu.
Select the new position using the Current Position counter.

Right click the source event and choose Paste from the shortcut menu.

a A W DN

Choose Cursor Position from the shortcut menu.

The event is pasted in the selected time slot.

To delete events using the graphical display

1 Right click an event.
2 Choose Delete from the shortcut menu.

3 The selected event is deleted from the time line.

To add text tags to time lines

Press SHIFT + TIME LINE and select the time line number.
Press TEXT.

Type text in the dialog box’s text field.

A WO DN -

Press STORE.

To delete time lines
1 Press SHIFT + TIME LINE and selectt tim line number.
2 Press DELETE. Vector asks for confirmation.
3 Press DELETE again.

To examine time lines
1 Press SHIFT + TIME LINE and select the time line number.
2 Press EXAM

The time | ne exam is displayed in the active pane or in the dedicated exam pane.

[(E]

To examine time lines
Press EXAM.
Press SHIFT + TIME LINE and select the time line number.
3 Press ENTER.

The time line exam is displayed in the active pane or in the dedicated exam pane.
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Scheduler

The scheduler is a tool for setting events that trigger macros according to date and time settings.

seasscava—| & | 2| [0 ]2 BIE[X]
Wednesday 2 — Selected date

Calendar—4 g August 2006 » paga
SMTWTFS

3031 12 3 4 S 4:00

67 8 9101112 s00| [ — e
13141516 17 18 19 6: Start Scheduled macros
0212223242526 7:00Y Run Effects J[17:15pm Stop Effects 4
2728293031 1 2 -
34567839 - e ity
9:00
10:00
11:00

Figure 147: Scheduler

The icons on the scheduler tool bar control the view and open dialog boxes.

Open event
Zoom in View 1 day View month  didlogbox  Delete event

| | | |

T T 1 i

« =] @ ] Jn]) o] ] ] S

|
Zoom out View week Jumpto today Open recurrence

dialog box

Figure 148: Scheduler tool bar
Clicking on a view icon changes the calend r disp ay in the right side pane. You can:
m View the selected day
m View one week (from Sunday hrough Saturday)
m View one month
m Zoom in or out

= Jump to the current date

Two dialog bo es a e u ed to schedule events:
m Edit Event - s hedule an event.

m Even Recurrence - set an event to repeat at specific intervals.

| Save and Close I Recurence... | Delete |

Subject: IEnd Show|

Action; IMac:o 'I # |1

Statttime: [02Aug-2006 « = [1200AM o

Figure 149: Edit Event dialog

Dsss
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Field/Button Information

Subject Free text that identifies the event.

Action This is always Macro.

# The macro number triggered by the event.
Start time Set the start date and time in the spin boxes.
SAVE AND CLOSE | Save the event and exit the dialog box.
RECURRENCE Open the Event Recurrence dialog box.
DELETE Delete the selected event.

x

— Event time

Stat:  [WE.004M 2

— Recurrence pattern

& Daily ¥ Every I‘1r dayls]
-
“Weekly ' Every weekday
= Monthly
 Yearly

— Range of recunence

Start:  |03-4ug-2006 + o

' Mo end date

" End after: I'I a OCCUMENCES
" End by: 03-40ug-2007 = o
ak. I Cancel Remove Recunence |

Figure 150: E ent Recur ence dialog box

Field

Information

Start

The start time set as in the Edit Event dialog box.

Recurre ce pattern

The repeat interval.

R ge of Recurrence

The start date set as in the Edit Event dialog box.

The end date.
OK Save the repeat information. and exit the dialog box.
CANCEL Exit the dialog box without saving.
REMOVE RECURRENCE Remove the entire series or the selected recurrence.

To open the scheduler

1 Chose a pane and tab for the scheduler.

2 Open the workspace.

387 €D
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3 Expand the Editor Tools node.
4 Chose scheduler.

The scheduler opens.

To select a date

Click on a date in the month calendar located in the left pane.

To change the view
Click one of the tool bar icons.

OR

Click zoom in or zoom out.

To schedule events
1 Click g‘ (New Event icon).
The Edit Event dialog box opens.
Type free text in the Subject field that gives information about the event.
In the # field, enter the macro number.

In the Start time fields enter the date and hour t trigger the event.

g s W N

Click SAVE AND CLOSE.

To repeat scheduled events
1 Click [ (Repeat Eventi on).
The Event Recurrence dialog opens.

Enter the relevan information in the fields.

3 Click OK.

To edit or de ete  heduled events

1 Dou le click the event in the scheduler.
Th Edit Event dialog box opens.

2 Edit the information in the fields and click SAVE AND CLOSE.
Or
Click DELETE.

The new information is saved.

Tip! When the view is set to 1 day, you can drag an event to a different hour.

To edit a scheduled recurrence

1 Double click an event in the scheduler.

The Open Recurring Item dialog box opens.

D ss
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2 Choose Open this occurrence to edit the selected occurrence or choose Open the series to
edit the entire series of recurrences.

The Edit Event dialog box opens.
3 Edit the information in the fields and click SAVE AND CLOSE.

Or
Click RECURRENCE.
The Event Recurrence dialog opens.
4 Click OK.
Click SAVE AND CLOSE in the Edit Event dialog box.

6 The new information is saved.

ATTENTION! Vector consoles, 4D consoles, and Sab  con oles can send and receive
MIDI over Ethernet without needing a MIDI ¢ ble. Impo tant! MIDI-over-Ethernet is a
unique, proprietary protocol for Compulite conso s. It works only when communication
among Compulite consoles and not with exter al MIDI generators.

MIDI (Musical Instrument Digital Inter ac ), is an industry-standard protocol that enables elec-
tronic musical instruments and other el tronic equipment to communicate, control, and
synchronize with each other. MIDI tr nsmits event messages that trigger console operations.
Console operations are mapp d to MIDI notes, so the MIDI note received determines which
console operation is activ  d. The exterior instrument, which transmits MIDI, can be a synthesizer
or a PC with a music program or any other instrument that communicates via MIDI.

For instance, syn esiz ris connected to the lighting console and a specific note is programmed to
send a go comm d that activates a crossfade pre-determined light cue. Specific notes can also be
programme to flash the contents of a playback device, thus allowing the musician to “play” the
lights sh or she plays the instrument.

MIDI tr smission is often used to control other lighting consoles.
F more information on MIDI go to: www midi.org.
MIDI options, accessed through Tools P Settings » MIDI/SMPTE tab.
Vector supports MIDI in/out/thru. You can use MIDI to:
m Carry out panel commands
m Access some show control functions
m Remote trigger for macros 101 = 106 and 901 = 902

Note: To use this feature a MIDI card must be installed. If your Vector is not equipped
with a MIDI card, contact your distributor or Compulite support.
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Tip! Instead of sending long MIDI strings, use Vector’s macro feature. Program macros
101 = 106 (Note On 96 - 101) and macros 901 = 920 (Note ON 115 -124; Note Off 21 -
29) and trigger them via single MIDI note. See “MIDI tables” page 397.

MIDI settings

MIDI settings are located in the Tools» Settings (dialog box), MIDI/SMPTE (tab).

System Settings

o T s | e

[ wowormcs
e

Figure 151: MIDI tab in t e System Settings dialog box

Buttons/F elds

What it does

Default

1 MIDI/ MTC

* Disabled - Vector does not receive or send MIDI
transmission.

* Enabled - Vector receives and sends MIDI
transmission.

Disabled

2 | MIDI KEYS

» Disabled - MIDI keys from an external MIDI device
are not displayed on the Vector command line.

* Enabled - MIDI keys from an external MIDI device
are displayed on the Vector command line.

Disabled

3 | MIDIMACRO

* Disabled - Vector does not receive or send MIDI
macros.

* Enabled - Vector receives and sends MIDI macros.

Disabled

9 390
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Buttons/Fields What it does Default
4 MIDI Channel Set the MIDI channel. none
This is the channel that transmits MIDI. Consult your
MIDI source for the correct channel.
Legal values are from 1 - 16.
5 | MIDI Code Offset Support for MIDI devices broadcasting notes that are 1
offset.
6 mMsc Enable/disable MSC (MIDI Show Control). Dis bled
7 MSC Device ID See “MSC Device ID” page 391 none
(Send to)
8 MSC Group ID See “MSC Group ID” page 391 none
9 MSC Peer ID See “MSC Peer ID” page 391 none
(Get from)
10 | SMPTE/MIDI Time | There are four standard frame-rate ormats:

code
Frames per second

24 - Mainly used in film work

25 - European Broad asting Union standard used in
countries where th mai s frequency is 50 Hz. (mainly
Europe and Au trali )

30 - Standard in the USA and Japan.

30 Drop frame - Compensates for the discrepancy that
accrues the 30 (it is actually 23.97) frames per sec-

dra .

Note: MIDI Time Code or MTC allows a MIDI connection
to carry the SMPTE time code, thus a suitably equipped
MIDI sequencer can be synchronized to an absolute
timing reference.

To enabl MIDI

N =

Go to Tools» Settings. The System Settings dialog box opens.

Tap the MIDI tab.

Tap MIDI.

The MIDI Channel and MIDI Code Offset fields are now available.

Optional: Enter the MIDI channel in the MIDI Channel field.

Make sure that the MIDI channel matches the channel in your MIDI generating device.

Optional: Enter the offset in the MIDI Code Offset field.
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MIDI macro

The MIDI Macro feature allows you to program a macro by transmitting MIDI code to Vector using
a MIDI generator. The macro collects the MIDI codes received from the MIDI transmitting source.

MIDI macros can be attached to cues. Use the usual macro procedures to store, attach, and delete
MIDI macros.

To enable Vector for MIDI macros

1 Go to Tools P Settings » Communication tab.
2 Tap MIDI MACRO ENABLED.
Make sure MIDI ENABLED is also enabled.
3 Tap OK. The System Settings dialog box closes.

To store MIDI macros

1 Press MACRO.
The Editor tool bar is now in macro mode.
2 Press SHIFT + MACRO (TEACH).
(M) now precedes the command line default ode
Tap MIDI MACRO
4 Transmit MIDI commands from an xtern 1 device to the console.
The MIDI commands are received and collected in a macro.

5 Press SHIFT + MACRO.

(2]

Press STORE and tap am cro soft key.

Or
Press MACRO elect the macro number on the numeric keypad, and press STORE.

_E]

Pres STORE, select the macro number on the numeric keypad, and press ENTER.

(See “Storing macros” page 299).

MIDI Show Control (MSC)

Dso

MIDI Show Control, or MSC, is an extension of the Musical Instrument Digital Interface (MIDI)
standard. MSC enables all types of entertainment equipment to communicate with each other
through the process of show control. MSC messages are transmitted serially and are compatible
with conventional MIDI hardware. MSC compatible instruments have a built-in MIDI interface and
many use the MIDI-over-Ethernet protocols to take advantage of higher bandwidth and the flexi-
bility of networks.

MSC functioning is supported for the master playback only. Vector supports MSC’s full frame
format.
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MSC commands can be sent to a single console or a group of consoles. ID numbers set in System

Settings » MIDI determine the command destination.

Buttons/Fields Default
MSC Device ID Units assigned a Device ID receive MSC commands explic- | none
(receive) itly addressed to that unit. The valid range for Device IDs is

0-111. Use 111 for ‘AllCall’ Deviceld.
MSC Group ID Units assigned a Group ID receive MSC commands addressed | none
(receive) to a group of units. Units may be assigned both Device and

Group ID numbers. Valid Group ID numbers are 112 - 126.
MSC Peer ID The Peer ID number provides the address for outgoing none
(send) commands. Peer ID numbers are 0 - 126. MSC comman  are

sent from the console to the Peer address. MSC commands

must be actually done on the board. Example: To send a Go

command to AB, the AB [GO] key mustbepe danda

crossfade executed.

MSC group addresses

MSC provides 15 Group addresses.

MSC Compulite MSC Compulite
Group Group ID Group Group ID

1 112 9 120

2 113 10 121

3 114 11 122

4 115 12 123

5 116 13 124

7 117 14 125

8 118 15 126

9 119
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Vector 1 Vector 2
Compulite Group ID 112
MSC Group ID 1
Peer ID 1 Device ID 1
Vector 3 Vector 4
Peer ID 3 gy Device ID 3
Compulite Group ID 120
MSC Group ID 9 Vector 5 Vector 6
Peer ID 5 =13 Device ID 5

® MSC commands are sent to Peers.
The Peer ID is set in the console transmitting MSC commands.

® The Device ID is set in the console receiving the MSC commands
and is identical to the Peer ID.

® Consoles 1 and 2 receive MSC commands sent to Group 112.

® Consoles 3, 4, 5, and 6 receive MSC commands sent to Group 120.

Figure 152: Examples of Group, P er, and Device setup for MSC

Playback operations using MSC
MSC is supported for th master playback only.

Command What happens

Go Initiates a fade to the next cue.

Hold (pa se) Pauses the fade in progress.

Timed G Applies a specified fade time to the incoming cue.
Resume Restarts a fade that is paused.

Fire (trigger) Operates macros 1 = 255.

To enable MIDI Show Control

1 Go to Tools P Settings.
The System Settings dialog box opens.
2 Tap the MIDI tab.
3 Tap MIDI.
The MIDI Channel and MIDI Code Offset fields are now available.
4 Optional: Enter the MIDI channel in the MIDI Channel field.

D304
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Make sure that the MIDI channel matches the channel in your MIDI generating device.
Optional: Enter the offset in the MIDI Code Offset field.
6 Tap MIDI SHOW CONTROL (MSC).

Vector is now enabled for MSC. The Device ID, Group ID, and PEER ID fields are now
available.

7 Enter the ID numbers, as suits your setup, in the various fields.
Tap OK to save and exit System Settings.
Tap APPLY to save and remain in the System Settings dialog box.

SMPTE

Within the scope of the Vector lighting console, the SMPTE time cod is used to trigger time line
events and, of course, as the MIDI Time Code. See “SMPTE/MIDI Time code” page 391 and ¢
Time lines” on page 379.

%}05 @)ele
o |

0000

SMPTE  MIDI In/Out/Thru

igure 153: SMPTE and MIDI connectors on the left side of Vector’s back panel
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MIDI tables

These MIDI tables are arranged according to MIDI note

numbers.

MIDI Note On table

VECTOR

MIDI Note On table

Command Note On #
(not used) 0
DELAY (tool bar) 1
RELEASE 2
TIME 3
Macro 913 4
(not used) 5
SUB(MASTER) 6
FREE 7
CLEAR 8
REM DIM (tool bar) 9
- (thru) 10
EDITOR FADE (tool bar) 11
» and NEXT 12
« and PREV 13
FLASH (Fixtur Test /tool bar) 14
ENTER 15
o 16
2 17
5 18
8 19
9 20

MIDI TABLES

MIDI Note On table (continued)
Command Note On #
6 21
3 22
CE 23
(not used) 24
ZR 25
ON 26

L 27
7 28
4 29
1 30
0 31
STORE 32
FAN 33
TIME LINE 34
TEXT 35
DELETE 36
LOORP (tool bar) 37
EDITOR 38
STORE+ 39
CUE 40
SPOT 41

397 &)
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MIDI Note On table (continued)

MIDI Note On table (continued)

Command Note On #
EFFECT 42
UNDO 43
REDO 44
PASTE 45
DIMMER 46
RESET 47
CHANNEL 48
LINK (tool bar) 49
EXAM 50
STAGE 51
BLIND 52
COPY 53
SNAP GO (protect - pb faders) | 54
@ 55
PB RELEASE 56
MACRO 106 57
MACRO 105 58
MACRO 104 59
MACRO 103 60
MACRO 102 61
MACRO 101 62
SETU 63
PB/QKEY 64
master pb) GO 65
(master pb) HOLD 66
(master pb) BACK 67
GOTO 68

D398

Command Note On #
SEQ (PB control) 69
SELECT AB 70
(not used) 71
Pkey 1 3
(see, Figure 1 p.400)

P key 2 74
(see, Figure 1 p.400)

P key 3 75
(see, Figure 1 p. 00)

AB (righ key 76
AB (Ie key) 77
(not used) 78
P key 4 79
PB (fader mode) 80
PB RATE (fader mode) 81
CHANNEL (pb mode) 82
SHAPE 83
P key 4 84
(see, Figure 1 p.400)

Pkey 5 85
(see, Figure 1 p.400)

P key 6 86
(see, Figure 1 p.400)

Pkey 7 87
(see, Figure 1 p.400)

TEACH MACRO 88
SHIFT +/ (slash) 89
SHIFT+ RESET 90
/ (slash) 91




MIDI Note On table (continued)

VECTOR

MIDI TABLES

MIDI Note On table (continued)
Command Note On #
COLOR 117

Macro 914 118

Macro 915 119

+ 120

Macro 916 121

Macro 917 122

Macro 918 123

Macro 919 124

Macro 920 125

RATE 126

C NTROL (tool bar) 127

Command Note On #
SHIFT + Il €(Back/Hold All) 92
P key 9 93
(see, Figure 1 p.400)

PARK (SHIFT + SNEAK) 94
P key 10 95
(see, Figure 1 p.400)

MATRIX 96
Macro 901 97
Macro 902 98
Macro 903 99
Macro 904 100
Macro 905 101
Macro 906 102
LOCK X 103
LOCKY 104
Macro 907 105
Macro 908 106
Macro 909 0
Macro 910 108
+@ (tool bar button) 109
SET 110
Macro 911 111
Ma ro 912 112
PB (SHIFT + QLIST) 113
B.O. 114
SHIFT+ ACTIVE 115
Deselect (SHIFT + @) 116
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PKey 1 P Key 3 P Key 5 P Key 7 P Key 9
MIDI On 73 MIDI On 75 MIDI On 84 MIDI On 86 MIDI On 93
P Key 2 P Key 4 P Key 6 P Key 8 P Key 10
MIDI On 74 MIDI On 79 MIDI On 85 MIDI On 87 MIDI On 95

[ N N —

Figure 1: P keys (Vector Red, Vector Blue, and Vector PC)
and their MIDI Notes

Playback device

'.‘ <“+Select key
<+Top key
<+Middle key

<+Bottom key

MIDI notes for these keys are found in the MIDI Notes Off and Control Change tables.

Figure 2: Playback device keys and QKeys are described
in the MIDI t bles by their location (Top, Middle, Bottom)

9400
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MIDI Note Off table

VECTOR

Command Note Off#
(not used) 0
CUT (SHIFT + COPY) 1
UPDATE 2
SHIFT + FREE (Free All) 3
SHIFT + PB RELEAS 4
(PB Release All)

HOME 5
INTENSITY 6
BEAM 7
Bottom key PB 10 off 8
SELECT (playback 1) 9
SELECT (playback 2) 10
SELECT (playback 3) 11
SELECT (playback 4) 12
SELECT (playback 5) 13
SELECT (playback 6) 1
SELECT (playback 7) 15
SELECT (playback 8) 16
SELECT (playb ck 9) 17
SELECT (playback 10) 18
SELE T QKey 1 19
SELECT QKey 2 20
SELECT QKey 3 21
SELECT QKey 4 22
SELECT QKey 5 23

MIDI TABLES

MIDI Note Off table (continued)
Command Note Off#
SELECT QKey 6) 24
SELECT (QKey 7) 25
SELECT (QKey 8) 26
SELECT (QKey 9) 27
SELECT (QKey 10) 28
SCROLL WIN 29
A (PB page up) 30
V (PB page down) 31
HIGHLIGHT 32

L WLIGHT 33
G OuUP 34
QLIST 35
ACTIVE 36
Top key PB 4 37
Top key PB 5 38
Top key PB 6 39
Top key PB 7 40
Top key PB 8 41
Top key PB 9 42
MOUSE 43
(not used) 44
Bottom QKey 2 45
Bottom QKey 3 46
Bottom QKey 4 47
Bottom QKey 5 48
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MIDI Note Off table (continued)

MIDI Note Off table (continued)

Command Note Off#
Bottom Q key 6 49
A (STEP UP) (tool bar) 50
V (STEP DOWN) (tool bar) | 51
Top key PB10 52
Bottom QKey 7 52
Bottom QKey 8 54
IMAGE 55
(not used) 56
Bottom QKey 1 57
Bottom QKey 9 58
Bottom QKey 10 59
Top key PB1 60
Top key PB2 61
Top key PB3 62
Middle key PB1 63
Middle key PB2 64
Middle key PB3 65
Middle key PB4 66
Middle key PB5 67
Middle key PB 68
Middle k y PB7 69
Middle key PBS8 70
Middle key PB 9 71
Middle key PB 10 72
Bottom key PB 1 73
Bottom key PB 2 74
Bottom key PB 3 75

a2

Command Note Off#
Bottom key PB 4 76
Bottom key PB5 77
Bottom key PB 6 78
Bottom key PB 7 79
Bottom key PB 8 80
Bottom key PB 9 81
Bottom key PB 10 82
Bottom key PB lof 83
Bottom key PB  off 84
Bottom ey PB 3 off 85
B ttom ey PB4 off 86
B ttom key PB 5 off 87
Bottom key PB 6 off 88
Bottom key PB 7 off 89
MACRO 90
Bottom key PB 8 off 91
Bottom key PB 9 off 92
SELECT PB loff 93
SELECT PB 2 off 94
SELECT PB 3 off 95
SELECT PB 4 off 96
SELECT PB 5 off 97
- @ (tool bar button) 98
SELECT PB 6 off 99
SELECT PB 7 off 100
SELECT PB 8 off 101
SELECT PB 9 off 102
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MIDI Note Off table (continued)

Command Note Off#
SNAP GO 103
SELECT PB 10 off 104
SELECT QKey 1 off 105
SELECT QKey 2 off 106
SELECT QKey 3 off 107
SELECT QKey 4 off 108
SELECT QKey 5 off 109
SELECT QKey 6 off 110
SELECT QKey 7 off 111
(not used) 112
SOLO 113
LIB 114
POSITION 115
LIB (tool bar) or 116
SHIFT +LIB

PB PARAM (fader mode) 117
SELECT QKey 8 off 18
SELECT QKey 9 off 19
SELECT QKey 10 off 120
SNEAK 121
(not used) 122
SNAP 123
- minus) 124
(not used) 125
SHIFT + SNAP GO 126
(not used) 127

MIDI TABLES
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MIDI Control Change table

MIDI Control Change table

MIDI Control Change table (continued)

Command g::;g
Middle key PBS off 25
Middle key PB6 off 26
Middle key PB7 off 27
Middle key PBS off 28
Middle key PB9 off 9
Middle key PB10 of 30
MOVE 31
SHIFT + GO (PB 32
con ol)

G (PB control) 33
ON (PB control) 34
PB RELEASE off 35
PB controls OFF (except | 36
PB RELEASE)

PRIO 37
JOIN 38
STEP 39
© (PB control) 40
Il € (PB control) 41
SHIFT + BLIND 42
MEDIA SERVER 43

Command Sl?:r:rgoe!
(not used) 0
Bottom QKey 1 off 1
Bottom QKey 2 off 2
Bottom QKey 3 off 3
Bottom QKey 4 off 4
Bottom QKey 5 off 5
Bottom QKey 6 off 6
Bottom QKey 7 off 7
Bottom QKey 8 off 8
Bottom QKey 9 off 9
Bottom QKey 10 off 10
Top key PB1 off 11
Top key PB2 off 12
Top key PB3 off 13
Top key PB4 off 14
Top key PBS5 off 15
Top key PB6 off 16
Top key PB7 off 17
Top key PBS off 18
Top k y PB9off 19
T p key PB10 off 20
Middle key PB1 off 21
Middle key PB2 off 22
Middle key PB3 off 23
Middle key PB4 off 24
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MIDI Notes for triggering macros

VECTOR

MIDI TABLES

MIDI Note ON for triggering CONSOLE
MACROS

Command MIDI Note On
MACRO 101 62

MACRO 102 61

MACRO 103 60

MACRO 104 59

MACRO 105 58

MACRO 106 57

Macro 901 97

Macro 902 98

Macro 903 99

Macro 904 100

Macro 905 101

Macro 906 102

Macro 907 105

Macro 908 106

MIDI Note ON for triggering CONSOLE
MACROS

Command MIDI Note On
Macro 909 107

Macro 910 108

Macro 911 111

Macro 912 112

Macro 913

Macro 914 118

Macro 915 119

Macro 916 121

Macr 917 122

Macro 918 123

Macro 919 124

Macro 920 125

For more information about.Macros (see
page 299)

MIDI Notes for operating playback controls

MIDI Notes for triggering

MIDI Notes fo trigg ring
PLAYBACK ON ROLS
Command MIDI Note
FREE MIDI On 7
SUB(MASTER) MIDI On 6
PB RELEASE MIDI On 56
SEQ MIDI On 69

PLAYBACK CONTROLS
Command MIDI Note
TRIGGER MIDI On 72
AB (right key) MIDI On 76
AB (left key) MIDI On 77
SHIFT + Il €(Hold All) | MIDI On 92
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MIDI Notes for triggering

PLAYBACK CONTROLS
Command MIDI Note
SHIFT + FREE MIDI Off 3

SHIFT + PB RELEAS MIDI Off 4

SHIFT + GO Control Change 22
GO Control Change 33
ON Control Change 34

SHIFT + PB RELEAS off | Control Change 35

PB controls OFF (except | Control Change 36
PB RELEASE)

PRIO Control Change 37
JOIN Control Change 38
STEP Control Change 39
© Control Change 40
< Control Change 41

For more information about.Playback device
controls (see page 199)

MIDI Notes for operating master playback controls

MIDI Notes for triggering
MASTER PLAYBACK CONTROLS

Command

GO MIDI On 65
HOLD MIDI On 66
B CK MIDI On 67

For more information about.Master playback
(see page 196)
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Appendix 3 Visualizers

You can pre-program a virtual show in live mode with the Vector (or Vector PC) and 3D CAD
lighting design software running on a PC.

Connecting the console and a PC

Consoles are connected to the computer running the visualizer via their Ethernet ports. The a ling
used depends on whether the console is connected directly to the PC or is connected to the PC via
an Ethernet network. Wireless communication is also supported.

Connecting Vector

Use either the Data port or the Control port to connect to the computer running WYSIWYG.

Cabling and connection

Connect from port Connect to Cable e uirements
Data PC Cros over cable

Data Ethernet hub Standard cable

Control Ethernet hub Crossover cable
Control PC Standard cable

After connecting to the PC, wheth r directly or via network equipment, there is no further
requirement.
Verifying the connection onth PC

When the LED s on, it verifies that the physical connection is viable.

To verify t e connection on PC’s running Windows 2000 and Windows XP

Start P (Settings) » Control Panel » Network connections

When the connection is enabled, but not connected, it appears in blue with a red X super-
imposed.

When the connection is enabled and working, the red X does not appear.

Configuring the network

To set up communication between the PC and the console, you must set the IP addresses.

The console and the PC must have Identical network ID numbers, Identical. subnet mask number.

To find the network ID for Vector

1 Open the Tools menu on Vector.

2 Tap Settings.
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3 Open the Communication tab.
4 Jot down the network ID number and the console ID number and add the number 10.

Example:

Network ID | Console ID

90.10. 59 10
Console PC
IP address: 90.0.0.10 IP address: 90.0.0.10

Subnet mask: 255.0.0.0 Subnet mask: 255.0.0.0

Control or Data por’rI

Figure 3: Vector lighting console and PC connected via an Ethernet hub

Configuring network settings on the PC

IMPORTANT! The network ID must be identical to th co ole’s network ID.

To set the IP address on the PC

Follow your operating system’s instruct ons for configuring network connections. When you
have set the PC’s IP address verify the co nectivity.

To verify connectivity

1 Press WINKEY + R
2 In the Open field, type CMD.
3 Press Enter or click OK.
The cmd.e eis unning.
4 Typ : ping [IP], in our example: 90.10.15.10.
5 P ess Enter.
The result should look like this: Reply from [IP]: bytes=32 times<Ims TTL=128.

6 Close the window.

Transmitting virtual connectors (VC)

The console must be transmitting VCs in order to communicate with the visualizer.

To enable VC transmission for Vector

Open the Tools menu.
Tap Settings.
Open the Communication tab.

Tap VC’S ENABLED.

A WO DN =
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When enabled, the button’s background is light.

Note: Itis recommended to enable VC COMPRESSION to conserve network
resources.

5 Tap OK.

The console automatically transmits all patched ports over the network.

WYSIWYG

WYSIWYG can be installed on a PC or directly on the Vector console. WYSIWYG CE  packaged
with Vector Red.

Installing WYSIWYG and the Compulite driver on the PC

Requirements:
m Windows XP & 2000
m NTFS-formatted hard drive
® WYSIWYG dongle (SE or CE)
m Compulite driver for WYSIWYG

ATTENTION! Do not connect the WYSIWYG dongle. If it is connected remove it before
installing the application. If you ha  he Standard Edition (SE), be aware that it is some-
times called Perform. This arning also appears when installing the application.

To install WYSIWYG

1 Insert the nstall tion disk or download the software version from http://www.cast-
soft.com » Downloads P WYSIWYG.

Do nload the latest release.
2 Ru the installation wizard.
3 Connect the dongle when requested.

4 Reboot the computer when requested.
Note: Do not run the WYSIWYG application yet.

To install the Compulite driver

1 Download the Compulite driver from:_http://www.compulite.com » Downloads »
Visualizers.

The driver file name is: CompuliteWYSIWYG_DriverSetup.exe.
2 Run the installation wizard.

3 Read the licence terms and click Yes to continue.
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4 Choose the dongle you are using and click Next.
5 If you are using the SE (Perform) dongle, choose your console from the console list.

6 Click Finish.

Note: It is not necessary to reboot the computer after installing the Compulite driver.

Establishing communication between Vector and WYSIWYG

Requirements

m CE dongle. If using a console (CE) dongle, you must have at least one (1) fixture p ched in
the console before connecting to WYSIWYG. The console must set to transmit V s.

m SE dongle. If using a standard (SE) dongle there are no patch requirements before connecting
to WYSIWYG.

m VC transmission enabled on the lighting console. See “DMX Protocols” page 341

After completing the patch procedures, you can establish the connect on between the console and
the WYSIWYG application.

Conzole
M anufacturer
Pratacal | Compulite Ethernet ~
Model - Wector
Mame : Wechor

Address: [90.10.59.10

Partz Univerze Chanz ~

Output 1 D1 512

Output 2 Db 2 512

Output 3 Dbt 3 512

Output 4 Db 4 512

Output & MHone i]

Output & Hone i]

QOutput 7 Hore i]

Output 8 MHone i]

Outout 9 Mane 0 s
I Ok l [ Cancel ] l Apply

Figure 4: Connecting WYSWIG and Vector

To connect Vector and WYSIWYG
In the WYSIWYG application, click the Live tab.

Open the Live menu.

Choose Device Manger.

1

2

3

4 Expand the Consoles node.
5 Expand the Compulite node.
6

Choose your console.
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Click Insert.

Click on the console and choose Properties.
9 In the Protocol field, change to Compulite Ethernet.

If Vector is your console, Compulite Ethernet is the only protocol available.
10 In the Address field, enter the console’s IP address.

Make sure the last byte is 10.

11 The Bind procedure, opens the communication between the VC’s defined in the con le
and the output defined in the WYSIWYG patch.

m Click on the required output.

m Click Bind.

m Select the relevant WYSIWYG ID number.

m Click Select.

m Check that the Universe column has been updated and show the propriate outputs.
m Repeat this procedure for all required universes.

m When the binding is complete, click OK.

12 Click Connect.

13 Verify that the status now shows Connect d.

14 Click Close.

IMPORTANT! Inthe WYSIWYG patch, you must set up ports. Do not use the default
EDMX port, as this s rves different console.

IMPORTANT! In he WYSIWYG patch, you must set up ports. Do not use the default
EDMX port as this serve a different console.

To instal the Compulite driver

ee “install the Compulite driver” page 409.

Establishing communication

After completing the patch procedures, you can establish communication between the console and
the WYSIWYG application. If you intend to use the auto patch feature to transfer the patch to
Vector, see *“ Patching” on page 411.

To open communication between the console and WYSIWYG

1 Inthe WYSIWYG application, click on the Live tab.
2 Open the Live menu.

3 Choose Device Manger.
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Expand the Consoles node.

Expand the Compulite node.

Choose your Vector.

Click Insert.

Click on the console and choose Properties.

Check that, in the Protocol field, Compulite Ethernet is displayed.

= © 00 N o 0 »

0 In the Address field, enter the console’s IP address.
Make sure the last byte is 10.

11 The Bind procedure, opens the communication between the VC’s defined in he ¢ nsole
and the output defined in the WYSIWYG patch.

m Click on the required output.

m Click Bind.

m Select the relevant WYSIWYG ID number.

m Click on Select.

m Check that the Universe column has been updated an sh ws the appropriate outputs.
m Repeat this procedure for all universes.

m When the binding is complete, click OK.

12 Click Connect.

13 Verify that the status now shows Connected.

14 Click Close.

Installing WYSIWYG on the Vector PC

Requirements:
m Window XP & 20 0
m NTFS- orma ted hard drive
m WYSIWYG dongle (SE or CE)
m Compulite driver for WYSIWYG

Finding the ne work ID

To find the network ID for Vector PC

-—

Press WINKEY + R for the LAN IP.
In the Open field, type CMD.
Press Enter or click OK.

N

The cmd.exe is running.
4 Type: IPCONFIG and the IP computer’s address.

Close the window.
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IMPORTANT! If your PC has more than one network card, make sure you are entered
the correct IP address for the correct LAN.

Installing WYSIWYG

Requirements:

m The WYSIWYG installation disk. If you do not have an installation disk, download the current
software from the CAST website.

m The WYSIWYG dongle.

m The Compulite driver

ATTENTION! Do not plug in the dongle yet.

To install WYSIWYG

Insert the installation disk into your PC’s disk drive and foll w he installation directions.
When the installation is complete, you are asked to go t file sntnllusb.sys.

When prompted, plug in the WYSIWYG dongle

H WO DN -

Restart your computer.

IMPORTANT! Do not run the WYSIWYG pplication yet!

To install the Compulite driver

See “install the Compulite driver page 409.

Martin Show Designer (MSD)

Requi emen s:
m Windows XP & 2000
Martin Show designer software
m Compulite MSD driver. Download the driver from http://www.lighthouse nl/download/msd/
drivers/Compulite_v4500.zip

To connect MSD and console

1 On the lighting console, enable VC transmission.
2 Run Martin Show Designer.

3 Go to the Control menu and choose Select Driver.
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(%50 DffLine - Gokden Curtain 'I2.sm
Fi= Edt View ‘wWieedosr DOiply Mode Opssstions Ceames Seltngs Conlid Help

D= &%) S8 %S aEE g

Figure 5: Martin Show Designer
4 Choose Compulite DMX.

Create the patch for your show on both the lighting console and on MSD
6 Go to the Control menu and choose Follow DMX.

MSD now receives the VCs transmitted on the network.
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Capture is supplied with the Compulite driver already installed in Capture versions 3.0 and Capture

2005. Patching must done on both the Vector console and in Capture.

To establish communication between Capture 3.0 and Vector

A WO DN =

On Capture, go to the Tools menu.
Choose Providers.

Right click on Compulite Ethernet.
Click Enable.

To patch VC’s (for Capture 3.0)

o a A~ W DN

On the lighting console, enable VC’s.

On Capture, go to the Setup Properties screen.
Right click the universe you want to patch.
From the shortcut menu, choose Provider.
Choose Setup.

Select the VC that the selected universe w 1l be listening to.

To establish communication between Capture 2005 and Vector

There is no need to do anything special Capture automatically recognizes the console.

To patch VC'’s (for Capture 2005)

1

2
3
4

On the lighting console enable VC transmission.
On Capture, go to the Universes tab.
Click a un verse in the Project Universe pane.

Right cli k a universe in the External Universes pane and then click Connect to selected
proj ct universe that appears in the short cut menu.

LIF
Design] Fistures Universes ] Cnnlrnl] Library]
Praject universes External universes
Mame | Usage | External | Mame
a 1.1-512 Compulit | Compulite WC 1
B z.1-512 Compulit | Compulite Vi 2
Z he I L= ) aramlib
o Connect to selected project universe 4
E 5151z
F 6.1512
G 7.1-512
H 53.1-512

Figure 6: Connecting Capture and Vector

To begin working

On Capture, go to the View menu and choose Live mode.

415



Compulite

Appendix 3

416



Appendix 4 Device Builder

About Device Builder

The Device Builder is an application used to define devices (personalities) for Vector consoles.The
devices can then be imported to Vector’s Patch Manager.

You can open the Device Builder application from Vector’s Tools menu as a stand alone applic tion
or open it in the Patch Manager. Devices that were edited and saved when the Device Bu ld r was
opened from the Patch Manager are saved with the show and are not added to the device ist in
stand alone mode. You can add them to the general device library, using the SAVE TO LIBRARY
option (See * Saving and importing devices” page 430.)

The file extension for Vector devices is *.cvd.

Opening the Device Builder in Vector

To open the stand alone Device Builder
Open Windows Start » Programs » Compulite Ve or Device Builder.
OR
1 On Vector’s main screen, go to the T ols menu.

2 Tap ‘ Device Builder | |

The Device Builder opens

To open the Device Builder in the patch manager
1 In the Patch Ma age workspace, select the Device node.
2 Rightclick ad vice in the Devices spread sheet.
3 Choose Prop ies from the shortcut menu.

Th Device Builder opens to the selected device.

Tip! Put a shortcut to the Device Builder on your desktop.

To exit the Device Builder

Tap | 0].

The Device Builder closes.
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Previous / Next screen Save options Exit

Compulite - Devi ‘e E uil

OH QU e | s | s o o] e[| see |3

Device list

Device image

Free text area

Selected device Last device loaded Control offset
Figure 7: Device details tab - Vector

m The left pane shows a list of existing dev s organized alphabetically by manufacturer.
m The fields in the right pane tabs are used o edit existing devices and define new devices

Tab What you d her

Device details * Enter he d vice ID, device name, pan and tilt spans.
» Attach a bitmap picture of the device.

W i e remarks.

Parameter Set p Map parameters to their DMX offset.

» Set step ranges and properties.

» Enter the control channel settings.

» Set external DMX devices (yoke, scroller, etc.)

Con rols » Map parameters to wheel banks and layers.

* Determine wheel sensitivity.
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Building and editing devices

The work flow for building devices is:

Tab What you do here

Device Details * Name and identify the device.
» Each device must have a unique name and identifier.
Device names can be up to 32 characters.
Device IDs can be up to 5 digits.

Note: ID numbers 9901 - 9999 have been reserved for user-d fined
devices.

Parameter Setup * Map parameters to their DMX offsets and edit p rameters.

* Consult the manufacturer’s manual for p amet rs” DMX offsets.

Wheel Assignments ¢ Map parameters to parameter banks and wheel layers.

+ Set wheel sensitivity.

ATTENTION! When the Device Builder is open d through the Tools menu, all device
files open as read-only files. They cannot be dited. To edit devices open the Device
Builder as stand-alone or through the Pa ch Manager.

To build a new device

Make sure that the Dev  Details tab is on top and the device list is set for your console.
Locate the folder for th fixture’s manufacturer in the device list and open it.
3 Tap NEW located on he upper button bar.
The New Device dialog box opens.
4 Type the device’s name in the text field and tap OK.
The vice is added to the list in the folder that was selected.
5 Under Device Properties, enter a unique identifier in the Device ID field.
Note: An error message is displayed, if the ID number that is already in use. Correct the
identifier and continue working.
6 The text in the Short Name field is the default name for fixtures created from the device.

The short name is automatically generated using the first two letters of the device’s name.
You can change the short name.

7 Under Extra Data, enter the pan and tilt spans.
Consult the manufacturer’s specifications for this information.

8 Select the manufacturer from the Manufacturer combo box. If your device’s manufacturer
does not appear in the list, select Generic.

9 Free text can be typed in the Device Remarks field.
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10 Optional- Display a picture of the device. Browse to the folder where the *.bmp images are

stored and select the image.
11 Tap SAVE to save the new device.

A message confirming a successful export is displayed. The file name and path are also

displayed.
12 Tap OK to confirm.

To delete a device

1 Select a device in the device list.

2 Tap DELETE.
Note: There is no undo when deleting devices.

3 Tap YES to confirm or NO to cancel the command.

Mapping parameter types to their DMX offsets

Each parameter must be mapped to its DMX offset. Consult the manufacturer’s specifications for
the correct DMX offsets.

Parameter list DMX offset grid

—
Loadefl Device ZR 24_7 Haze Cot*olSldm:IUnDﬂutZZ

|
Control channel  External device parameter Control parameter offset

Figure 8: Parameter Setup tab

There may be two or more instances of the same parameter type. Example: a device may have three
color wheels. In this case, the same parameter type is mapped to three DMX offsets. In Parameter
Properties, the parameter names are automatically set as Color Wheel, Color Wheel 2, Color Wheel
3.

Do
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To map parameters to DMX offsets

1 Tap the Parameter Setup tab.

2 Drag aicon from the parameter list and drop it in the map cell that corresponds to its DMX
offset.

Consult the manufacturer’s specifications for the correct DMX offset for each parameter.
Repeat Step 2 until all the parameters are mapped to their DMX offsets.

4 Double click the parameter icon to open the Parameter Properties dialog box for parameter
editing.

5 Tap SAVE.

Note: To configure the control channel, See “To configure the control param ter”
page 428.

To map external parameters

Select the external parameter in the parameter list and drag it to he Extern area located below
the parameter list.

To map shared DMX offsets

Sometimes different parameter types share th sam DMX offset. Example: dimmer and the
shutter may share DMX offset 1.

1 Drag the dimmer icon from the parameter list to the cell for offset 1.

2 Drag the shutter icon from the parameter list and drop it in the cell for offset 1.

Jimmet

i rzrn': t n]

1 E Shutter k

DMX offset controlling 2 parameter types

3 To v ew all the parameters mapped to offset 1, click the arrow for the drop down list.

Note: The parameters are automatically assigned to separate wheels.

To delete parameters from the DMX offset map

Right click on the parameter and choose DELETE in the shortcut menu.
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Editing parameters

After mapping parameters to their DMX offsets, by dragging from the list and dropping in the
appropriate DMX offset cell, you may want to edit the parameter settings. Parameters are edited in
the Parameter Properties dialog box.

Gobo Wheel
Gobo Wheel
Image g S
Open 0 0 No No No
Pebbels 18 18 No No No
Dust BrkUp 36 36 No No No
Y Med Circle 55 55 No Mo Mo
- Night Sky 73 73 No No No
Linsar Leaves 9 91 No No No
Vertical Bars. 108 108 Mo No No
ERIDGITY Wave 126 126 Mo No No
Block BrkUp 143 143 No No No
8 bit Tribal BrkUp 162 162 No No No

Figure 9: Parameter properties dialog box

To open the Parameter Properties dialog box
Double click on a parameter i the DMX offset map.
OR

Right click on a par meter in the DMX offset map and choose Properties.
The title bar how he selected parameter and its DMX offset.

To open the Parameter Properties dialog box for external dimmers

Double lick on the external parameter located below the parameter list.

Dimime
Exterm

9 ‘
Figure 10: External parameter box

OR

Right click and choose Properties.

The title bar shows the selected parameter and its DMX offset.
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Field/Group

Type The parameter type determines the default wheel bank assignment.

Name This is the text that appears on the Wheel Assignments display in
Vector.

Note: This is not available for Dlite and Rave.

Bank The default wheel bank. Example: all gobo related parameters are auto-
matically assigned to the image wheel bank and all color related param
eters are assigned to the color wheel bank. The default assign ent an
be easily changed.

Invert * Check to invert the parameter.

* Clear to uninvert the parameter.

Exclude from Lib * Check to exclude the parameter from libra ies.
 Clear to include the parameter in libraries

Profile Set the parameter’s behavior during fa e .

Priority Set to LTP (Priority) or H P

Resolution Choose 8-bit or 16-bit re olution.

LSB Offset Set lowest signific t bit for 16-bit resolution.

Edit Steps Buttons for ¢ pying, cutting, and pasting steps.

Edit Step Table Add  delet steps.

Step icon You ca display an icon for the step. The icon displayed here is shown
in the step picker. Vector only.

Offset Home Valu Set the home value for the parameter. This is the value the parameter
goes to when you press HOME or RESET. Example: Pan and tilt home
values are usually set to 50% (128 -decimal or, in the case of 16-bit
parameters, 32768).

Mode Set the home value display mode to percent, decimal, hexadecimal.

S ep Table Shows the step settings.

Changing the default wheel assignment

When defining a new device, parameters are automatically assigned to wheels according to the
parameter type, as set in the Parameter Properties dialog box: color parameters are assigned to the
color bank, gobo parameters to the image bank, etc.

Parameters are assigned to wheels in the order that they appear in the DMX offset map. Example: If
the color parameter order is color wheel and color speed, then color wheel is automatically assigned
to wheel land color speed to wheel 2.
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Tip! If the fixture has only a few parameters, you may want to group all parameters in the
same wheel bank.

To change the default wheel bank assignment

1 Inthe DMX offset grid, right click on a parameter.
A short cut menu opens.

2 Choose Properties.
The Parameter Properties dialog box opens.

3 Open the Bank combo box and select another wheel bank.

R Parameter Properties

Parameter type

|Gobo ‘Wheel

Bank

Ilmage ZI

Default wheel bank

Figure 11: Parameter Properties tab detail

Generating steps

Some parameters, such as dimme or cyan, have only one step. Other parameters, such as gobo
wheels or color wheels, may have many steps. When building a new device, all parameters initially
have only one step. Add step using the Edit Step Table buttons.

Button What it does

BUILD STEPS Tapping Build Steps opens the Step Generator dialog box where you
set the number of steps. DMX values (0 - 255) are automatically
divided equally among the steps. This can be edited later.

ADD STEP Tap this button to add a step at the end of the step list. Added steps must
be further defined in the step generator

INSERT STEP Tap this button to insert a step above the selected step.

DELETE STEP Delete the selected step.
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After setting the number of steps, fill in the Step Table fields.

Step Table Fields

# (number) Enter the number of steps for this parameter.

Name Type the step’s name. For example, you might name a step in the gobo
wheel ‘Starburst’.

Discrete Click in the cell to toggle between Yes and No.
* No - There is continuous control between steps. This is the d fault
setting.

* Yes - There is not continuous control between st ps. When setting
values using the wheel, the value jumps from st p to tep without
any intermediate values.

Stopper Click in the cell to toggle between Yes and No.
* No - There is no stopper between st ps This is the default setting.

* Yes - There is a stopper between steps. Use STEP UP and STEP
DOWN, on the Editor to | ba to move past the stoppers.

Min (from) The step’s DMX start va ue.
Max (to) The step’s DMX end value.
Dark Gel For color scr llers The dark gel feature keeps two consecutive color

frames in  otion as long as the fixture’s dimmer is at more than 10%
inten ity This saves on gel burn when using very dark colors, as no
singl area of the gel is constantly exposed to the heat of the lamp.
Wh n assembling the gel ribbon cut a double length for dark colors.

S rollers are usually defined with external DMX offsets.

Click in the cell to toggle between Yes and No.

Note: Use ENTER and the arrow keys to navigate the Step Table.

To b ild steps

1 Open the Parameter Properties dialog box by double clicking on a parameter in the DMX
offset map.

Or
Right click on a parameter in the DMX offset map and choose Properties.
The title bar shows the selected parameter and its DMX offset.
Tap BUILD STEPS. The Step Generator opens.
Fill in the fields in the Step Generator.
4 Tap BUILD STEPS to overwrite the current step table.
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1 In the Parameter Properties dialog box, tap ADD STEP.
The new step is added to the end of the step table. The added step is labelled New.
Type a text tag for the new step.
Manually enter the settings for discrete, stopper, and DMX values range.
To insert steps
In the Parameter Properties dialog box, Step Table, tap a step to select it.
2 Tap INSERT STEP.
The new step is added above the selected step.The added step is labelled New.
Type a text tag for the new step.
4 Manually enter the settings for discrete, stopper, and DMX values range.
OR
1 Tap a step to select it.
2 Tap BUILD STEPS. The Step Generator opens.
3 Fill in the fields in the Step Generator.
4 Tap INSERT STEP RANGE.
The new steps are added above the s lect d step.The new steps are labelled Step 1, Step 2,
etc.
To delete steps
1 In the Parameter Properti s dialog box, tap a step to select it.
2 Tap DELETE STEP.
The number of steps is automatically adjusted to accommodate the deletion.
IMPORTANT! The DMX offsets are NOT automatically reconfigured when you delete
a step You must reset them manually.
Editing steps

To add a text tag

In the Step Table, click the step and type the new text.

To change DMX values

In the Step Table, click the Min or Max for the step and type the new values.

To copy or cut a step

1 In the Step Table, stand on the step’s name.
2 Tap COPY or CUT.

OR

s
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In the Step Table, stand on the step’s name, right click, and choose Copy or Cut.

To paste a step
In the Step Table, stand on a cell where you intend to paste the step, and tap PASTE.
OR

In the Step Table, stand on the cell where you intend to paste step, right click, and choose
Paste.

Note: The pasted step overwrites all existing information.

To set scroller steps and dark gel
1 Open the Parameter Properties dialog box by double clicking on the external parameter.
Or

Open the Parameter Properties dialog box by right clicking the external parameter and
choosing Properties.

2 Click in the Dark Gel column where you have inserted a double sized frame.
Yes appears in the Dark Gel column.

3 Tap OK.

Attaching a bitmap to a step

You can display a graphic representation f the step in the Step Icon area. Vector supports *.bmp or
* ico files.

Note: The graphic you ch ose h re represents the step in the gobo or color pickers.

To attach a bitmap to a step

1 Inthestept le, lecta step.

2 Brows tot ef lder where the *.bmp images are stored and select the bitmap.
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Configuring the control parameter

The control parameter controls the lamp on, lamp off, and reset functions of the fixture. These func-
tions are accessed via the control function on the console. The control parameter is not controlled
by a wheel, therefore it has no wheel assignment. The control parameter is configured in the Control

Properties dialog box.
h Control Propetties 4 _l_,- [m) lj
e Step lcan
Name Value| Time ﬂ lm
Lamp ON 64 6
RESET 64 -]
v Use Contiol ol | .|
Lamp OFF 128 [
Oifset IIW
Retum Value ID_
I~ Broadcast on all offsets
Name Value Time
]

Figure 12: Control Properties dialog box

To configure the control parameter

1 Go to the Parameter Setup tab

2 Open the Control Properties dia g box by tapping the control icon below the parameter
list.

Check the Use Control heck box.

4 In the Offset field, en er the control channel’s DMX offset.
Or
Che k Br adcast on all offsets.

5 In the Return Value field, enter the return value. Sometimes, the return value is called the
afe value. The return value is usually 0.

6 In the Name column, type the step names such as: Lamp ON, Reset, Lamp OFF.

In the Value column, fill in the step’s DMX value. Example: The DMX value for Martin
fixtures” Lamp ON for is 228; the DMX value for High End fixtures’ Reset is 64.

8 In the Time column, enter in the number of seconds the value is sent. This is usually 6
seconds.

s
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Setting up wheel assignments

Setting up the wheel assignments is done under the Wheel Assignments tab.

Devices =~ Device Details | Parameters Setup

D

-5y ADB Bank

D) Arkans

D) Avolites

() BRASH!

2 Cameleon

D) CindyLight

D) Clary Paky

D) Coemar

D) Compulite —

D) Coolux

[ DHA

[ DTS

[ ETC

D) Futurelight

D) Generic

D) G-Lec

H[5) Green-Hippo

D) Griven

H[5) High End

D) Jem
----- : Glac Xstream
B IR 24_7 Haze

- Le Maitre 4
4 3

Dlite/Rave Yector r

Beam

Intensity Poszition Color Image Shape

Intensity @) [ [ [ [ ﬂ

Wheel 1 | Wheel 2 Vheel 4 | Wheel &

Dimmer | Shifter

" Track-Ball————— "Vertical wheel—

Figure 13: Wheel assignments tab

The six parameter types correspond to the six wh el banks:

m Intensity m Position
m Color m Beam
® [mage = Shape

£}

When setting up the d vic > parameters, each parameter type is automatically assigned to its

default wheel ank Each bank can have up to six layers. A single parameter can be assigned up to 8
times. Param ter ypes can be assigned to any wheel bank, regardless of its default assignment.

Wheel s siti ity can be configured for each wheel and in each layer:
m ( through 3 is coarse.
m ( through -3 is fine.

Note: In each wheel bank, pan and tilt are always assigned to the trackball and dimmer
is always assigned to the vertical wheel.

To assign parameters to wheels

Example: Assign cyan to wheel 1, magenta to wheel 2, yellow to wheel 3, and color wheel to
wheel 4.

1 Show the Controls tab.
2 Tap on COLOR to select the color wheel bank.

3 Drag cyan from the parameter list to wheel 1.



Compulite

Appendix 4

Drag magenta from the parameter list to wheel 2.
Drag yellow from the parameter list to wheel 3.

Drag color wheel from the parameter list to wheel 4.

~N o g s

Optional: set the wheel sensitivity by double clicking on the sensitivity cell, located
beneath the parameter name, and choose a setting from the combo box.

8 Choose another wheel bank and assign the appropriate parameters.
9 Repeat step 9 until all the parameters are assigned to wheels.

10 Tap SAVE.

To remove a wheel assignment

Select the parameter and drag it to the trash can or right click on the param ter nd choose
Delete from the shortcut menu.

Saving and importing devices

The save options buttons control where new and m dified devices are saved and allow importing

devices to the device library.

New | Save | Saveln | 7 Delete | Diectory | About
Figure 14: Save Options buttons
Button Wha it does
NEW De ine a new device.
SAVE Save the selected device with the current show.
SAVEIN *+ Select a folder.

» Convert a Vector device for use with Dlite / Rave or a Dlite /
Rave device for use with Vector.

SAVE TO LIBRARY Enabled only when you open the Device Builder from Vector’s
patch manager. This allows you to save the new or modified device

to the device library default folder.

IMPORT TO LIBRARY | Import a device definition from an external file or the show file to
the device library default folder.

Its name and ID number are added to the IdToNameTable, an auto-
matic Excel file that is stored in the device library default folder.

DELETE Delete the selected device.

DIRECTORY New and modified devices are saved to the default directory
selected here.

ABOUT Shows the current Device Builder version.

D0



Numerics

4D 335
60 64, 400

A

A/B crossfader 188
dip mode 188
priority 193

absolute values 111

action syntax 13, 335

active 93, 118
editor output 119
filter selections 120
per parameter bank 119
selection sources 118

active in editor 56

active on stage 56

active snap 231

add tabs 38

all editor 134

all params for selected 134
all stage 134

animated graphics 292, 293
apply pb defaults 222
Arkaos 353

art -net 377

Art-Net 341, 352
attachment viewer 37
attachments 57

auto follow loops 172
automatic groups 96
automatic libraries 246
automatic trigger 233, 303

B

back 202
back tim 338
backt ck 143,162
ba k fiters 252
base 274
be m 105, 245
behavior 335
blackout 207
blind 127, 185
blinking
fixtures 328
block 162



C

calibrate display 6
camera viewer 38
Catalyst 359

channels 91
examining 84
flash 84
park 85
patch exam 89
set 67
testing 82
track sheet 137

chases 228
jump 231
patterns 228
rate 223, 230
shadow chase 229
xfade 231

clear 84
clear on master go 226

clearing
patch 73,79, 81
proportional patch 82

clock 7, 15,28
clone 319

color 105, 245
picker 109
color code
context 266
fader LEDs 187
import object selection 241
libraries 265
live display 208
master playback output 197
output 101
playback control LEDs 92
playback wing 209
command line 15,2 , 95
gm status 15 28
progress bar 16
SMPTE indic i n 17
system clock 15,28
Compulite mode 12, 141, 335
cons le ID 343
co text sensitive keys 37
control 103
copying 21
cues 141
delta 154
groups 100, 237
libraries 252
macros 302
QLists 126



values 113
cue only 143
Cue sheet 210
cue sheets 210

cues 126, 130
block 162
copying 141
cue only 143, 157
default cue time 164
deleting 136
enter to editor 163
examining 137
force black 316
home 117
linking 174
mark cue 315
point cues 129, 131
renumbering 155
restore released 200
storing 127
storing on sks 132
temporary 183
try cue 132
unblock 163
updating 142
custom colors 110
customize dialog box 54

cutting 21

D

defaults
back time 338
command line 16
cue fade time 338
cue time 164
exam pane 57
exam view 31
fader commands 88
fader controls 189
library mode 253
QList 123
sneak ime 328
sta vaues 102
syst m settings 333
d lay in 165
d yout 165
deleting 19
cues 136
fixtures 73
groups 99
libraries 250, 251
macros 301

parameter time 168, 170



QLists 124, 125
snaps 235, 236
tabs 29

time lines 385

delta 152
copy 154
copy new 143
options 153

desk lights 7
dim 7

desktop
customizing 43
deleting 42
hot keys 46
overview 40
populating 43
renaming 41
setup 41
transparency 45

device builder 77, 104
bitmap for steps 427
control parameter 428
deleting device 420
device picture 420
editing parameters 422
editing steps 424
exiting 417
external parameters 421, 422
importing devices 430
mapping offsets 420
new device 419
opening 417
patch manager 417
saving devices 430
shared offsets 421
stand alone 417
wheel assignments 423, 429

device headers 52
device specific library 2 2
devices
importing 65
dialog boxes
reset position 33
scroll win 33
dim 7
d mmer 78
di mer curve 76
dimmers
curve 76
flash 84
non-dim 76
park 85
patching 63
preheat 77



testing 82
dip 188
display
active snap 231
add tabs 38
calibrate 6, 340
change tab order 31
grid 59
new view pane 29
parameter values 55
park 36
short cut menu 29
displays
channels 36
collapse 65
cue sheet 210
cue sheets 210
desktop 40
device headers 52
editor tool bar 58
format menu 55
full screen 32
grid format 40
improve performance 339
Live Mode 56
master pb 209
matrix 36
media servers 36
navigation 32
open layout 57
pane title bar 30
parameter attributes 55
patched fixtures 56
playback devices 36, 208
playback indications 213
QKeys 37
save layout 57
spots 36
tab 30
tool bars 49
topo view 36
used in show 56
wheel assignments 59
windows set up 29
wo ksp ce 47
DMX
addresses 68
xamine 89
input 371
ports 65
properties dialog box 76
test offset 82
DMX Input 341
DMX input 371

DMX over Ethernet 341



DMX transmission defaults 341
duty cycle 269

E

editing
cues 148
exchange values 152
groups 100
libraries 323
time lines 382

editor 118, 163
restore values 22

editor fades 224
group fade 224
move fade 224
shaft fade 224
x-fade 224

editor tool bar 58
display 37, 58
editor toolbar
playback selection 202

editors 17

effects 245, 267
base 274
duty cycle 269
effect editor 267
fixture grouping 280
include base 271
offset 269, 279
primitive 271
rate 269
size 277
storing 271
swing 274
wave 268

enter syntax 13, 335

Ethernet 341
master/slave 366

evens 94

events 386

every 93

exam displ ys 31

ex min ng
channel patch fixture

patch exam 89

channels 84, 137
cues 137
DMX port 89
fixture patch 89
fixtures 139
groups 100
highlight palette 324, 325
home cue 117



libraries 251
Look Ahead mask 314, 315
lowlight palette 324, 325
macros 301
patch 84
QLists 125, 139
snaps 236, 237
spots 84, 137
time lines 385
track sheet 139
exchange values 152
exiting application 50
external dimmers 68, 70, 79, 81
external screens 5

F

fade rates 222, 223
fade time 165
fade times 164, 338
parameter profiles 320
using goto 198
faders 190
default controls 189
definitions 215
mismatched 191
paging 191
priority 193
fan 175,270
setting 177
timing 179
file management 8§
fixture
settings 74
fixture grouping 280
fixture mode 71, 92
fixture specific library 252
fixtures
fixture mode 92
interactive s lection 91
patched 56
selecti g 91
set 67
sag 140
used in show 56
fl h 84
flip 114
follow on cues 165, 315
force black cues 316
format menu 55
frames 380
free



locked key 199
freeing playback devices 195
full 112
full screen 32

G

general master 207
status 15, 28
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